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1 Introduction
1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and skills:

 Advanced knowledge of the robot controller system

 Advanced KRL programming skills

1.2 Industrial robot documentation

The industrial robot documentation consists of the following parts:

 Documentation for the manipulator

 Documentation for the robot controller

 Operating and programming instructions for the System Software

 Instructions for options and accessories

 Parts catalog on storage medium

Each of these sets of instructions is a separate document.

1.3 Representation of warnings and notes

Safety These warnings are relevant to safety and must be observed.

This warning draws attention to procedures which serve to prevent or remedy 
emergencies or malfunctions: 

Hints These notices serve to make your work easier or contain references to further 
information.

 

t

t

For optimal use of our products, we recommend that our customers 
take part in a course of training at KUKA College. Information about 
the training program can be found at www.kuka.com or can be ob-

tained directly from our subsidiaries.

These warnings mean that it is certain or highly probable 
that death or severe injuries will occur, if no precautions 

are taken.

These warnings mean that death or severe injuries may 
occur, if no precautions are taken.

These warnings mean that minor injuries may occur, if 
no precautions are taken.

These warnings mean that damage to property may oc-
cur, if no precautions are taken.

These warnings contain references to safety-relevant information or 
general safety measures. 
These warnings do not refer to individual hazards or individual pre-

cautionary measures.

Procedures marked with this warning must be followed 
exactly.
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1.4 Trademarks

Windows is a trademark of Microsoft Corporation.

WordPad is a trademark of Microsoft Corporation.

Tip to make your work easier or reference to further information.
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2 Product description
2 Product description

2.1 Overview of the industrial robot

The industrial robot consists of the following components:

 Manipulator

 Robot controller

 Teach pendant

 Connecting cables

 Software

 Options, accessories

2.2 Overview of KUKA System Software (KSS)

Description The KUKA System Software (KSS) is responsible for all the basic operator 
control functions of the industrial robot.

 Path planning

 I/O management

 Data and file management

 etc.

Additional technology packages, containing application-specific instructions 
and configurations, can be installed.

smartHMI The user interface of the KUKA System Software is called KUKA smartHMI 
(smart Human-Machine Interface).

Features:

 User administration

 Program editor

 KRL (KUKA Robot Language)

2

 

t

 

s

Fig. 2-1: Example of an industrial robot

1 Manipulator 3 Teach pendant

2 Robot controller 4 Connecting cables
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 Inline forms for programming

 Message display

 Configuration window

 etc.

 (>>> 4.2 "KUKA smartHMI user interface" Page 49)

Depending on customer-specific settings, the user interface may vary from the 
standard interface.

2.3 System requirements

KSS 8.3 can be run on the following robot controller:

 KR C4 

 with Windows Embedded Standard 7 V4.x

 and with 2 GB RAM

2.4 Intended use of the KUKA System Software

Use The KUKA System Software is intended exclusively for the operation of a 
KUKA industrial robot or customer-specific kinematic system. 

Each version of the KUKA System Software may be operated exclusively in 
accordance with the specified system requirements.

Misuse Any use or application deviating from the intended use is deemed to be misuse 
and is not allowed. KUKA Roboter GmbH is not liable for any damage resulting 
from such misuse. The risk lies entirely with the user. 

Examples of such misuse include:

 Operation of a kinematic system that is neither a KUKA industrial robot nor 
a customer-specific kinematic system

 Operation of the KSS not in accordance with the specified system require-
ments

2.5 KUKA USB sticks

The following KUKA USB sticks exist for the KR C4 robot controller:

KUKA USB stick 2.0 NB 4 GB

 Data storage medium for software and archives

 Not bootable

 Art. no. 00-197-266

KUKA.Recovery USB stick 2.1 8 GB

 For generating and restoring system images

 Bootable

 Art. no. 00-220-397

Fig. 2-2: KUKA USB stick 2.0 NB 4 GB (art. no. 00-197-266)
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Fig. 2-3: KUKA.Recovery USB stick 2.1 8 GB (art. no. 00-220-397)
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3 Safety
3 Safety

3.1 General

3.1.1 Liability

The device described in this document is either an industrial robot or a com-
ponent thereof.

Components of the industrial robot:

 Manipulator

 Robot controller

 Teach pendant

 Connecting cables

 External axes (optional)

e.g. linear unit, turn-tilt table, positioner

 Software

 Options, accessories

The industrial robot is built using state-of-the-art technology and in accor-
dance with the recognized safety rules. Nevertheless, misuse of the industrial 
robot may constitute a risk to life and limb or cause damage to the industrial 
robot and to other material property.

The industrial robot may only be used in perfect technical condition in accor-
dance with its designated use and only by safety-conscious persons who are 
fully aware of the risks involved in its operation. Use of the industrial robot is 
subject to compliance with this document and with the declaration of incorpo-
ration supplied together with the industrial robot. Any functional disorders af-
fecting safety must be rectified immediately.

Safety infor-

mation

Safety information cannot be held against KUKA Roboter GmbH. Even if all 
safety instructions are followed, this is not a guarantee that the industrial robot 
will not cause personal injuries or material damage.

No modifications may be carried out to the industrial robot without the autho-
rization of KUKA Roboter GmbH. Additional components (tools, software, 
etc.), not supplied by KUKA Roboter GmbH, may be integrated into the indus-
trial robot. The user is liable for any damage these components may cause to 
the industrial robot or to other material property.

In addition to the Safety chapter, this document contains further safety instruc-
tions. These must also be observed.

3.1.2 Intended use of the industrial robot

The industrial robot is intended exclusively for the use designated in the “Pur-
pose” chapter of the operating instructions or assembly instructions.

Any use or application deviating from the intended use is deemed to be misuse 
and is not allowed. The manufacturer is not liable for any damage resulting 
from such misuse. The risk lies entirely with the user.

Operation of the industrial robot in accordance with its intended use also re-
quires compliance with the operating and assembly instructions for the individ-
ual components, with particular reference to the maintenance specifications.

Misuse Any use or application deviating from the intended use is deemed to be misuse 
and is not allowed. This includes e.g.:

 

f

t

y
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 Transportation of persons and animals

 Use as a climbing aid

 Operation outside the specified operating parameters

 Use in potentially explosive environments

 Operation without additional safeguards

 Outdoor operation

 Underground operation

3.1.3 EC declaration of conformity and declaration of incorporation

The industrial robot constitutes partly completed machinery as defined by the 
EC Machinery Directive. The industrial robot may only be put into operation if 
the following preconditions are met:

 The industrial robot is integrated into a complete system.

Or: The industrial robot, together with other machinery, constitutes a com-
plete system.

Or: All safety functions and safeguards required for operation in the com-
plete machine as defined by the EC Machinery Directive have been added 
to the industrial robot.

 The complete system complies with the EC Machinery Directive. This has 
been confirmed by means of an assessment of conformity.

Declaration of 

conformity

The system integrator must issue a declaration of conformity for the complete 
system in accordance with the Machinery Directive. The declaration of confor-
mity forms the basis for the CE mark for the system. The industrial robot must 
always be operated in accordance with the applicable national laws, regula-
tions and standards.

The robot controller is CE certified under the EMC Directive and the Low Volt-
age Directive.

Declaration of 

incorporation

The industrial robot as partly completed machinery is supplied with a declara-
tion of incorporation in accordance with Annex II B of the EC Machinery Direc-
tive 2006/42/EC. The assembly instructions and a list of essential 
requirements complied with in accordance with Annex I are integral parts of 
this declaration of incorporation.

The declaration of incorporation declares that the start-up of the partly com-
pleted machinery is not allowed until the partly completed machinery has been 
incorporated into machinery, or has been assembled with other parts to form 
machinery, and this machinery complies with the terms of the EC Machinery 
Directive, and the EC declaration of conformity is present in accordance with 
Annex II A.

3.1.4 Terms used

STOP 0, STOP 1 and STOP 2 are the stop definitions according to EN 60204-
1:2006.

Term Description

Axis range Range of each axis, in degrees or millimeters, within which it may move. 
The axis range must be defined for each axis.

Stopping distance Stopping distance = reaction distance + braking distance

The stopping distance is part of the danger zone.

Workspace Area within which the robot may move. The workspace is derived from 
the individual axis ranges.
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User The user of the industrial robot can be the management, employer or 
delegated person responsible for use of the industrial robot.

Danger zone The danger zone consists of the workspace and the stopping distances 
of the manipulator and external axes (optional).

Service life The service life of a safety-relevant component begins at the time of 
delivery of the component to the customer.

The service life is not affected by whether the component is used or not, 
as safety-relevant components are also subject to aging during storage.

KUKA smartPAD see “smartPAD”

Manipulator The robot arm and the associated electrical installations

Safety zone The safety zone is situated outside the danger zone.

Safe operational stop The safe operational stop is a standstill monitoring function. It does not 
stop the robot motion, but monitors whether the robot axes are station-
ary. If these are moved during the safe operational stop, a safety stop 
STOP 0 is triggered.

The safe operational stop can also be triggered externally.

When a safe operational stop is triggered, the robot controller sets an 
output to the field bus. The output is set even if not all the axes were sta-
tionary at the time of triggering, thereby causing a safety stop STOP 0 to 
be triggered.

Safety STOP 0 A stop that is triggered and executed by the safety controller. The safety 
controller immediately switches off the drives and the power supply to 
the brakes.

Note: This stop is called safety STOP 0 in this document.

Safety STOP 1 A stop that is triggered and monitored by the safety controller. The brak-
ing process is performed by the non-safety-oriented part of the robot 
controller and monitored by the safety controller. As soon as the manip-
ulator is at a standstill, the safety controller switches off the drives and 
the power supply to the brakes.

When a safety STOP 1 is triggered, the robot controller sets an output to 
the field bus.

The safety STOP 1 can also be triggered externally.

Note: This stop is called safety STOP 1 in this document.

Safety STOP 2 A stop that is triggered and monitored by the safety controller. The brak-
ing process is performed by the non-safety-oriented part of the robot 
controller and monitored by the safety controller. The drives remain acti-
vated and the brakes released. As soon as the manipulator is at a stand-
still, a safe operational stop is triggered. 

When a safety STOP 2 is triggered, the robot controller sets an output to 
the field bus.

The safety STOP 2 can also be triggered externally.

Note: This stop is called safety STOP 2 in this document.

Safety options Generic term for options which make it possible to configure additional 
safe monitoring functions in addition to the standard safety functions. 

Example: SafeOperation

smartPAD Teach pendant for the KR C4

The smartPAD has all the operator control and display functions 
required for operating and programming the industrial robot.

Term Description
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3.2 Personnel

The following persons or groups of persons are defined for the industrial robot:

 User

 Personnel

User The user must observe the labor laws and regulations. This includes e.g.:

 The user must comply with his monitoring obligations.

 The user must carry out instructions at defined intervals.

Personnel Personnel must be instructed, before any work is commenced, in the type of 
work involved and what exactly it entails as well as any hazards which may ex-
ist. Instruction must be carried out regularly. Instruction is also required after 
particular incidents or technical modifications.

Personnel includes:

 System integrator

 Operators, subdivided into:

 Start-up, maintenance and service personnel

 Operator

 Cleaning personnel

Stop category 0 The drives are deactivated immediately and the brakes are applied. The 
manipulator and any external axes (optional) perform path-oriented 
braking.

Note: This stop category is called STOP 0 in this document.

Stop category 1 The manipulator and any external axes (optional) perform path-main-
taining braking. 

 Operating mode T1: The drives are deactivated as soon as the robot 
has stopped, but no later than after 680 ms.

 Operating mode T2, AUT, AUT EXT: The drives are switched off after 
1.5 s.

Note: This stop category is called STOP 1 in this document.

Stop category 2 The drives are not deactivated and the brakes are not applied. The 
manipulator and any external axes (optional) are braked with a path-
maintaining braking ramp.

Note: This stop category is called STOP 2 in this document.

System integrator
(plant integrator)

The system integrator is responsible for safely integrating the industrial 
robot into a complete system and commissioning it.

T1 Test mode, Manual Reduced Velocity (<= 250 mm/s)

T2 Test mode, Manual High Velocity (> 250 mm/s permissible)

External axis Motion axis which is not part of the manipulator but which is controlled 
using the robot controller, e.g. KUKA linear unit, turn-tilt table, Posiflex.

Term Description

All persons working with the industrial robot must have read and un-
derstood the industrial robot documentation, including the safety 
chapter.

Installation, exchange, adjustment, operation, maintenance and re-
pair must be performed only as specified in the operating or assembly 
instructions for the relevant component of the industrial robot and only 

by personnel specially trained for this purpose.
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System integrator The industrial robot is safely integrated into a complete system by the system 
integrator.

The system integrator is responsible for the following tasks:

 Installing the industrial robot

 Connecting the industrial robot

 Performing risk assessment

 Implementing the required safety functions and safeguards

 Issuing the declaration of conformity

 Attaching the CE mark

 Creating the operating instructions for the complete system

Operator The operator must meet the following preconditions:

 The operator must be trained for the work to be carried out.

 Work on the industrial robot must only be carried out by qualified person-
nel. These are people who, due to their specialist training, knowledge and 
experience, and their familiarization with the relevant standards, are able 
to assess the work to be carried out and detect any potential hazards.

3.3 Workspace, safety zone and danger zone

Workspaces are to be restricted to the necessary minimum size. A workspace 
must be safeguarded using appropriate safeguards.

The safeguards (e.g. safety gate) must be situated inside the safety zone. In 
the case of a stop, the manipulator and external axes (optional) are braked 
and come to a stop within the danger zone.

The danger zone consists of the workspace and the stopping distances of the 
manipulator and external axes (optional). It must be safeguarded by means of 
physical safeguards to prevent danger to persons or the risk of material dam-
age.

3.3.1 Determining stopping distances

The system integrator’s risk assessment may indicate that the stopping dis-
tances must be determined for an application. In order to determine the stop-
ping distances, the system integrator must identify the safety-relevant points 
on the programmed path.

When determining the stopping distances, the robot must be moved with the 
tool and loads which are also used in the application. The robot must be at op-
erating temperature. This is the case after approx. 1 h in normal operation.

During execution of the application, the robot must be stopped at the point 
from which the stopping distance is to be calculated. This process must be re-
peated several times with a safety stop 0 and a safety stop 1. The least favor-
able stopping distance is decisive.

A safety stop 0 can be triggered by a safe operational stop via the safety inter-
face, for example. If a safety option is installed, it can be triggered, for in-
stance, by a space violation (e.g. the robot exceeds the limit of an activated 
workspace in Automatic mode).

A safety stop 1 can be triggered by pressing the EMERGENCY STOP device 
on the smartPAD, for example.

Work on the electrical and mechanical equipment of the industrial ro-
bot may only be carried out by specially trained personnel.
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3.4 Triggers for stop reactions

Stop reactions of the industrial robot are triggered in response to operator ac-
tions or as a reaction to monitoring functions and error messages. The follow-
ing table shows the different stop reactions according to the operating mode 
that has been set.

3.5 Safety functions

3.5.1 Overview of the safety functions

The following safety functions are present in the industrial robot:

 Mode selection

 Operator safety (= connection for the guard interlock)

 EMERGENCY STOP device

 Enabling device

 External safe operational stop

 External safety stop 1 (not for the controller variant “KR C4 compact”)

 External safety stop 2

 Velocity monitoring in T1

The safety functions of the industrial robot meet the following requirements:

 Category 3 and Performance Level d in accordance with EN ISO 13849-
1:2008

The requirements are only met on the following condition, however:

 The EMERGENCY STOP device is pressed at least once every 6 months.

The following components are involved in the safety functions:

 Safety controller in the control PC

Trigger T1, T2 AUT, AUT EXT

Start key released STOP 2 -

STOP key pressed STOP 2

Drives OFF STOP 1

“Motion enable” input 
drops out

STOP 2

Power switched off via 
main switch or power fail-
ure

STOP 0

Internal error in non-
safety-oriented part of the 
robot controller

STOP 0 or STOP 1

(dependent on the cause of the error)

Operating mode changed 
during operation

Safety stop 2

Safety gate opened (oper-
ator safety)

- Safety stop 1

Enabling switch released Safety stop 2 -

Enabling switch pressed 
fully down or error

Safety stop 1 -

E-STOP pressed Safety stop 1

Error in safety controller 
or periphery of the safety 
controller

Safety stop 0
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3 Safety
 KUKA smartPAD

 Cabinet Control Unit (CCU)

 Resolver Digital Converter (RDC)

 KUKA Power Pack (KPP)

 KUKA Servo Pack (KSP)

 Safety Interface Board (SIB) (if used)

There are also interfaces to components outside the industrial robot and to 
other robot controllers.

3.5.2 Safety controller

The safety controller is a unit inside the control PC. It links safety-relevant sig-
nals and safety-relevant monitoring functions.

Safety controller tasks:

 Switching off the drives; applying the brakes

 Monitoring the braking ramp

 Standstill monitoring (after the stop)

 Velocity monitoring in T1

 Evaluation of safety-relevant signals

 Setting of safety-oriented outputs

3.5.3 Mode selection

The industrial robot can be operated in the following modes:

 Manual Reduced Velocity (T1)

 Manual High Velocity (T2)

 Automatic (AUT)

 Automatic External (AUT EXT)

In the absence of operational safety functions and safe-
guards, the industrial robot can cause personal injury or 

material damage. If safety functions or safeguards are dismantled or deacti-
vated, the industrial robot may not be operated.

During system planning, the safety functions of the overall system 
must also be planned and designed. The industrial robot must be in-
tegrated into this safety system of the overall system.

Do not change the operating mode while a program is running. If the 
operating mode is changed during program execution, the industrial 
robot is stopped with a safety stop 2.
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3.5.4 “Operator safety” signal

The “operator safety” signal is used for interlocking physical safeguards, e.g. 
safety gates. Automatic operation is not possible without this signal. In the 
event of a loss of signal during automatic operation (e.g. safety gate is 
opened), the manipulator stops with a safety stop 1.

Operator safety is not active in modes T1 (Manual Reduced Velocity) and T2 
(Manual High Velocity).

3.5.5 EMERGENCY STOP device

The EMERGENCY STOP device for the industrial robot is the EMERGENCY 
STOP device on the smartPAD. The device must be pressed in the event of a 
hazardous situation or emergency.

Reactions of the industrial robot if the EMERGENCY STOP device is pressed:

 The manipulator and any external axes (optional) are stopped with a safe-
ty stop 1.

Before operation can be resumed, the EMERGENCY STOP device must be 
turned to release it.

Operatin

g mode
Use Velocities

T1
For test operation, pro-
gramming and teach-
ing

 Program verification:

Programmed velocity, maxi-
mum 250 mm/s

 Jog mode:

Jog velocity, maximum 250 mm/
s

T2 For test operation

 Program verification:

Programmed velocity

 Jog mode: Not possible

AUT
For industrial robots 
without higher-level 
controllers

 Program mode:

Programmed velocity

 Jog mode: Not possible

AUT EXT
For industrial robots 
with higher-level con-
trollers, e.g. PLC

 Program mode:

Programmed velocity

 Jog mode: Not possible

Following a loss of signal, automatic operation may only 
be resumed when the safeguard has been closed and 

when the closing has been acknowledged. This acknowledgement is to pre-
vent automatic operation from being resumed inadvertently while there are 
still persons in the danger zone, e.g. due to the safety gate closing acciden-
tally.
The acknowledgement must be designed in such a way that an actual check 
of the danger zone can be carried out first. Other acknowledgement functions 
(e.g. an acknowlegement which is automatically triggered by closure of the 
safeguard) are not permitted.
The system integrator is responsible for ensuring that these criteria are met. 
Failure to met them may result in death, severe injuries or considerable dam-
age to property.
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There must always be at least one external EMERGENCY STOP device in-
stalled. This ensures that an EMERGENCY STOP device is available even 
when the smartPAD is disconnected.

 (>>> 3.5.7 "External EMERGENCY STOP device" Page 29)

3.5.6 Logging off from the higher-level safety controller

If the robot controller is connected to a higher-level safety controller, this con-
nection will inevitably be terminated in the following cases:

 Switching off the voltage via the main switch of the robot

Or power failure

 Shutdown of the robot controller via the smartHMI

 Activation of a WorkVisual project in WorkVisual or directly on the robot 
controller

 Changes to Start-up > Network configuration

 Changes to Configuration > Safety configuration

 I/O drivers > Reconfigure

 Restoration of an archive

Effect of the interruption:

 If a discrete safety interface is used, this triggers an EMERGENCY STOP 
for the overall system.

 If the Ethernet interface is used, the KUKA safety controller generates a 
signal that prevents the higher-level controller from triggering an EMER-
GENCY STOP for the overall system. 

3.5.7 External EMERGENCY STOP device

Every operator station that can initiate a robot motion or other potentially haz-
ardous situation must be equipped with an EMERGENCY STOP device. The 
system integrator is responsible for ensuring this.

Tools and other equipment connected to the manipulator 
must be integrated into the EMERGENCY STOP circuit 

on the system side if they could constitute a potential hazard.
Failure to observe this precaution may result in death, severe injuries or con-
siderable damage to property.

If the Ethernet safety interface is used: In his risk assessment, the 
system integrator must take into consideration whether the fact that 
switching off the robot controller does not trigger an EMERGENCY 

STOP of the overall system could constitute a hazard and, if so, how this haz-
ard can be countered.
Failure to take this into consideration may result in death, injuries or damage 
to property.

If a robot controller is switched off, the E-STOP device on 
the smartPAD is no longer functional. The user is re-

sponsible for ensuring that the smartPAD is either covered or removed from 
the system. This serves to prevent operational and non-operational EMER-
GENCY STOP devices from becoming interchanged.
Failure to observe this precaution may result in death, injuries or damage to 
property.
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There must always be at least one external EMERGENCY STOP device in-
stalled. This ensures that an EMERGENCY STOP device is available even 
when the smartPAD is disconnected.

External EMERGENCY STOP devices are connected via the customer inter-
face. External EMERGENCY STOP devices are not included in the scope of 
supply of the industrial robot.

3.5.8 Enabling device

The enabling devices of the industrial robot are the enabling switches on the 
smartPAD.

There are 3 enabling switches installed on the smartPAD. The enabling 
switches have 3 positions:

 Not pressed

 Center position

 Panic position

In the test modes, the manipulator can only be moved if one of the enabling 
switches is held in the central position.

 Releasing the enabling switch triggers a safety stop 2. 

 Pressing the enabling switch down fully (panic position) triggers a safety 
stop 1.

 It is possible to hold 2 enabling switches in the center position simultane-
ously for up to 15 seconds. This makes it possible to adjust grip from one 
enabling switch to another one. If 2 enabling switches are held simultane-
ously in the center position for longer than 15 seconds, this triggers a safe-
ty stop 1.

If an enabling switch malfunctions (jams), the industrial robot can be stopped 
using the following methods:

 Press the enabling switch down fully

 Actuate the EMERGENCY STOP system

 Release the Start key

3.5.9 External enabling device

External enabling devices are required if it is necessary for more than one per-
son to be in the danger zone of the industrial robot. 

External enabling devices are not included in the scope of supply of the indus-
trial robot.

3.5.10 External safe operational stop

The safe operational stop can be triggered via an input on the customer inter-
face. The state is maintained as long as the external signal is FALSE. If the 

The enabling switches must not be held down by adhe-
sive tape or other means or tampered with in any other 

way.
Death, injuries or damage to property may result.

Which interface can be used for connecting external enabling devices 
is described in the “Planning” chapter of the robot controller operating 
instructions and assembly instructions.
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external signal is TRUE, the manipulator can be moved again. No acknowl-
edgement is required.

3.5.11 External safety stop 1 and external safety stop 2

Safety stop 1 and safety stop 2 can be triggered via an input on the customer 
interface. The state is maintained as long as the external signal is FALSE. If 
the external signal is TRUE, the manipulator can be moved again. No ac-
knowledgement is required.

3.5.12 Velocity monitoring in T1

The velocity at the TCP is monitored in T1 mode. If the velocity exceeds 
250 mm/s, a safety stop 0 is triggered.

3.6 Additional protective equipment

3.6.1 Jog mode

In the operating modes T1 (Manual Reduced Velocity) and T2 (Manual High 
Velocity), the robot controller can only execute programs in jog mode. This 
means that it is necessary to hold down an enabling switch and the Start key 
in order to execute a program.

 Releasing the enabling switch triggers a safety stop 2. 

 Pressing the enabling switch down fully (panic position) triggers a safety 
stop 1.

 Releasing the Start key triggers a STOP 2.

3.6.2 Software limit switches

The axis ranges of all manipulator and positioner axes are limited by means of 
adjustable software limit switches. These software limit switches only serve as 
machine protection and must be adjusted in such a way that the manipulator/
positioner cannot hit the mechanical end stops.

The software limit switches are set during commissioning of an industrial ro-
bot.

3.6.3 Mechanical end stops

Depending on the robot variant, the axis ranges of the main and wrist axes of 
the manipulator are partially limited by mechanical end stops.

Additional mechanical end stops can be installed on the external axes.

No external safety stop 1 is available for the controller variant “KR C4 
compact”.

Further information is contained in the operating and programming in-
structions.
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3.6.4 Mechanical axis range limitation (optional)

Some manipulators can be fitted with mechanical axis range limitation in axes 
A1 to A3. The adjustable axis range limitation systems restrict the working 
range to the required minimum. This increases personal safety and protection 
of the system.

In the case of manipulators that are not designed to be fitted with mechanical 
axis range limitation, the workspace must be laid out in such a way that there 
is no danger to persons or material property, even in the absence of mechan-
ical axis range limitation.

If this is not possible, the workspace must be limited by means of photoelectric 
barriers, photoelectric curtains or obstacles on the system side. There must be 
no shearing or crushing hazards at the loading and transfer areas.

3.6.5 Axis range monitoring (optional)

Some manipulators can be fitted with dual-channel axis range monitoring sys-
tems in main axes A1 to A3. The positioner axes may be fitted with additional 
axis range monitoring systems. The safety zone for an axis can be adjusted 
and monitored using an axis range monitoring system. This increases person-
al safety and protection of the system.

3.6.6 Options for moving the manipulator without drive energy

Description The following options are available for moving the manipulator without drive 
energy after an accident or malfunction:

 Release device (optional)

The release device can be used for the main axis drive motors and, de-
pending on the robot variant, also for the wrist axis drive motors. 

 Brake release device (option)

The brake release device is designed for robot variants whose motors are 
not freely accessible.

If the manipulator or an external axis hits an obstruction 
or a mechanical end stop or axis range limitation, the ma-

nipulator can no longer be operated safely. The manipulator must be taken 
out of operation and KUKA Roboter GmbH must be consulted before it is put 
back into operation  (>>> 15 "KUKA Service" Page 475).

This option is not available for all robot models. Information on spe-
cific robot models can be obtained from KUKA Roboter GmbH.

This option is not available for all robot models. Information on spe-
cific robot models can be obtained from KUKA Roboter GmbH.

The system user is responsible for ensuring that the training of per-
sonnel with regard to the response to emergencies or exceptional sit-
uations also includes how the manipulator can be moved without 

drive energy.
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3 Safety
 Moving the wrist axes directly by hand

There is no release device available for the wrist axes of variants in the low 
payload category. This is not necessary because the wrist axes can be 
moved directly by hand.

3.6.7 Labeling on the industrial robot

All plates, labels, symbols and marks constitute safety-relevant parts of the in-
dustrial robot. They must not be modified or removed.

Labeling on the industrial robot consists of:

 Identification plates

 Warning signs

 Safety symbols

 Designation labels

 Cable markings

 Rating plates

3.6.8 External safeguards

The access of persons to the danger zone of the industrial robot must be pre-
vented by means of safeguards. It is the responsibility of the system integrator 
to ensure this.

Physical safeguards must meet the following requirements:

 They meet the requirements of EN 953.

 They prevent access of persons to the danger zone and cannot be easily 
circumvented.

 They are sufficiently fastened and can withstand all forces that are likely 
to occur in the course of operation, whether from inside or outside the en-
closure.

 They do not, themselves, represent a hazard or potential hazard.

 The prescribed minimum clearance from the danger zone is maintained.

Safety gates (maintenance gates) must meet the following requirements:

 They are reduced to an absolute minimum.

 The interlocks (e.g. safety gate switches) are linked to the operator safety 
input of the robot controller via safety gate switching devices or safety 
PLC.

Information about the options available for the various robot models 
and about how to use them can be found in the assembly and oper-
ating instructions for the robot or requested from KUKA Roboter 

GmbH.

Moving the manipulator without drive energy can dam-
age the motor brakes of the axes concerned. The motor 

must be replaced if the brake has been damaged. The manipulator may 
therefore be moved without drive energy only in emergencies, e.g. for rescu-
ing persons.

Further information is contained in the technical data of the operating 
instructions or assembly instructions of the components of the indus-
trial robot.
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 Switching devices, switches and the type of switching conform to the re-
quirements of Performance Level d and category 3 according to EN ISO 
13849-1.

 Depending on the risk situation: the safety gate is additionally safeguarded 
by means of a locking mechanism that only allows the gate to be opened 
if the manipulator is safely at a standstill.

 The button for acknowledging the safety gate is located outside the space 
limited by the safeguards.

Other safety 

equipment

Other safety equipment must be integrated into the system in accordance with 
the corresponding standards and regulations.

3.7 Overview of operating modes and safety functions

The following table indicates the operating modes in which the safety functions 
are active.

3.8 Safety measures

3.8.1 General safety measures

The industrial robot may only be used in perfect technical condition in accor-
dance with its intended use and only by safety-conscious persons. Operator 
errors can result in personal injury and damage to property.

It is important to be prepared for possible movements of the industrial robot 
even after the robot controller has been switched off and locked out. Incorrect 
installation (e.g. overload) or mechanical defects (e.g. brake defect) can cause 
the manipulator or external axes to sag. If work is to be carried out on a 
switched-off industrial robot, the manipulator and external axes must first be 
moved into a position in which they are unable to move on their own, whether 
the payload is mounted or not. If this is not possible, the manipulator and ex-
ternal axes must be secured by appropriate means.

Further information is contained in the corresponding standards and 
regulations. These also include EN 953.

Safety functions T1 T2 AUT AUT EXT

Operator safety - - active active

EMERGENCY STOP device active active active active

Enabling device active active - -

Reduced velocity during pro-
gram verification

active - - -

Jog mode active active - -

Software limit switches active active active active

In the absence of operational safety functions and safe-
guards, the industrial robot can cause personal injury or 

material damage. If safety functions or safeguards are dismantled or deacti-
vated, the industrial robot may not be operated.

Standing underneath the robot arm can cause death or 
injuries. For this reason, standing underneath the robot 

arm is prohibited!
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smartPAD The user must ensure that the industrial robot is only operated with the smart-
PAD by authorized persons.

If more than one smartPAD is used in the overall system, it must be ensured 
that each smartPAD is unambiguously assigned to the corresponding indus-
trial robot. They must not be interchanged.

Modifications After modifications to the industrial robot, checks must be carried out to ensure 
the required safety level. The valid national or regional work safety regulations 
must be observed for this check. The correct functioning of all safety functions 
must also be tested.

New or modified programs must always be tested first in Manual Reduced Ve-
locity mode (T1).

After modifications to the industrial robot, existing programs must always be 
tested first in Manual Reduced Velocity mode (T1). This applies to all compo-
nents of the industrial robot and includes modifications to the software and 
configuration settings.

Faults The following tasks must be carried out in the case of faults in the industrial 
robot:

 Switch off the robot controller and secure it (e.g. with a padlock) to prevent 
unauthorized persons from switching it on again. 

 Indicate the fault by means of a label with a corresponding warning (tag-
out).

 Keep a record of the faults.

 Eliminate the fault and carry out a function test.

3.8.2 Transportation

Manipulator The prescribed transport position of the manipulator must be observed. Trans-
portation must be carried out in accordance with the operating instructions or 
assembly instructions of the robot.

Avoid vibrations and impacts during transportation in order to prevent damage 
to the manipulator.

Robot controller The prescribed transport position of the robot controller must be observed. 
Transportation must be carried out in accordance with the operating instruc-
tions or assembly instructions of the robot controller.

Avoid vibrations and impacts during transportation in order to prevent damage 
to the robot controller.

External axis 

(optional)

The prescribed transport position of the external axis (e.g. KUKA linear unit, 
turn-tilt table, positioner) must be observed. Transportation must be carried 

The motors reach temperatures during operation which 
can cause burns to the skin. Contact must be avoided. 

Appropriate safety precautions must be taken, e.g. protective gloves must be 
worn.

The operator must ensure that decoupled smartPADs 
are immediately removed from the system and stored out 

of sight and reach of personnel working on the industrial robot. This serves 
to prevent operational and non-operational EMERGENCY STOP devices 
from becoming interchanged.
Failure to observe this precaution may result in death, severe injuries or con-
siderable damage to property.
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out in accordance with the operating instructions or assembly instructions of 
the external axis.

3.8.3 Start-up and recommissioning

Before starting up systems and devices for the first time, a check must be car-
ried out to ensure that the systems and devices are complete and operational, 
that they can be operated safely and that any damage is detected.

The valid national or regional work safety regulations must be observed for this 
check. The correct functioning of all safety functions must also be tested.

Function test The following tests must be carried out before start-up and recommissioning:

General test:

It must be ensured that:

 The industrial robot is correctly installed and fastened in accordance with 
the specifications in the documentation.

 There are no foreign bodies or loose parts on the industrial robot.

 All required safety equipment is correctly installed and operational.

 The power supply ratings of the industrial robot correspond to the local 
supply voltage and mains type.

 The ground conductor and the equipotential bonding cable are sufficiently 
rated and correctly connected.

 The connecting cables are correctly connected and the connectors are 
locked.

Test of the safety functions:

A function test must be carried out for the following safety functions to ensure 
that they are functioning correctly:

 Local EMERGENCY STOP device

 External EMERGENCY STOP device (input and output)

 Enabling device (in the test modes)

 Operator safety

The passwords for the user groups must be changed in the KUKA 
System Software before start-up. The passwords must only be com-
municated to authorized personnel.

The robot controller is preconfigured for the specific industrial robot. 
If cables are interchanged, the manipulator and the external axes (op-
tional) may receive incorrect data and can thus cause personal injury 

or material damage. If a system consists of more than one manipulator, al-
ways connect the connecting cables to the manipulators and their corre-
sponding robot controllers.

If additional components (e.g. cables), which are not part of the scope 
of supply of KUKA Roboter GmbH, are integrated into the industrial 
robot, the user is responsible for ensuring that these components do 

not adversely affect or disable safety functions.

If the internal cabinet temperature of the robot controller 
differs greatly from the ambient temperature, condensa-

tion can form, which may cause damage to the electrical components. Do not 
put the robot controller into operation until the internal temperature of the 
cabinet has adjusted to the ambient temperature.
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 All other safety-relevant inputs and outputs used

 Other external safety functions

3.8.3.1 Checking machine data and safety configuration

 It must be ensured that the rating plate on the robot controller has the 
same machine data as those entered in the declaration of incorporation. 
The machine data on the rating plate of the manipulator and the external 
axes (optional) must be entered during start-up.

 The practical tests for the machine data must be carried out within the 
scope of the start-up procedure.

 Following modifications to the machine data, the safety configuration must 
be checked. 

 After activation of a WorkVisual project on the robot controller, the safety 
configuration must be checked!

 If machine data are adopted when checking the safety configuration (re-
gardless of the reason for the safety configuration check), the practical 
tests for the machine data must be carried out.

 System Software 8.3 or higher: If the checksum of the safety configuration 
has changed, the safe axis monitoring functions must be checked.

If the practical tests are not successfully completed in the initial start-up, KUKA 
Roboter GmbH must be contacted.

If the practical tests are not successfully completed during a different proce-
dure, the machine data and the safety-relevant controller configuration must 
be checked and corrected.

General practical 

test

If practical tests are required for the machine data, this test must always be 
carried out. 

The following methods are available for performing the practical test:

 TCP calibration with the XYZ 4-point method

The practical test is passed if the TCP has been successfully calibrated.

Or: 

1. Align the TCP with a freely selected point. 

The point serves as a reference point. It must be located so that reorien-
tation is possible.

2. Move the TCP manually at least 45° once in each of the A, B and C direc-
tions.

The movements do not have to be accumulative, i.e. after motion in one 
direction it is possible to return to the original position before moving in the 
next direction.

The practical test is passed if the TCP does not deviate from the reference 
point by more than 2 cm in total.

The industrial robot must not be moved if incorrect ma-
chine data or an incorrect controller configuration are 

loaded. Death, severe injuries or considerable damage to property may oth-
erwise result. The correct data must be loaded.

Information about checking the safety configuration and the safe axis 
monitoring functions is contained in the Operating and Programming 
Instructions for System Integrators.
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Practical test for 

axes that are not 

mathematically 

coupled

If practical tests are required for the machine data, this test must be carried out 
when axes are present that are not mathematically coupled. 

1. Mark the starting position of the axis that is not mathematically coupled.

2. Move the axis manually by a freely selected path length. Determine the 
path length from the display Actual position on the smartHMI.

 Move linear axes a specific distance.

 Move rotational axes through a specific angle.

3. Measure the length of the path covered and compare it with the value dis-
played on the smartHMI.

The practical test is passed if the values differ by no more than 10%.

4. Repeat the test for each axis that is not mathematically coupled.

Practical test for 

couplable axes

If practical tests are required for the machine data, this test must be carried out 
when axes are present that can be physically coupled and uncoupled, e.g. a 
servo gun. 

1. Physically uncouple the couplable axis.

2. Move all the remaining axes individually.

The practical test is passed if it has been possible to move all the remain-
ing axes.

3.8.3.2 Start-up mode

Description The industrial robot can be set to Start-up mode via the smartHMI user inter-
face. In this mode, the manipulator can be moved in T1 without the external 
safeguards being put into operation.

When Start-up mode is possible depends on the safety interface that is used.

Discrete safety interface

 System Software 8.2 or earlier: 

Start-up mode is always possible if all input signals at the discrete safety 
interface have the state “logic zero”. If this is not the case, the robot con-
troller prevents or terminates Start-up mode.

If an additional discrete safety interface for safety options is used, the in-
puts there must also have the state “logic zero”.

 System Software 8.3 or higher: 

Start-up mode is always possible. This also means that it is independent 
of the state of the inputs at the discrete safety interface.

If an additional discrete safety interface is used for safety options: The 
states of these inputs are also irrelevant.

Ethernet safety interface 

The robot controller prevents or terminates Start-up mode if a connection to a 
higher-level safety system exists or is established.

Effect When the Start-up mode is activated, all outputs are automatically set to the 
state “logic zero”. 

If the robot controller has a peripheral contactor (US2), and if the safety con-
figuration specifies for this to switch in accordance with the motion enable, 
then the same also applies in Start-up mode. This means that if motion enable 
is present, the US2 voltage is switched on – even in Start-up mode.

Hazards Possible hazards and risks involved in using Start-up mode:

 A person walks into the manipulator’s danger zone.

 In a hazardous situation, a disabled external EMERGENCY STOP device 
is actuated and the manipulator is not shut down.
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Additional measures for avoiding risks in Start-up mode:

 Cover disabled EMERGENCY STOP devices or attach a warning sign in-
dicating that the EMERGENCY STOP device is out of operation.

 If there is no safety fence, other measures must be taken to prevent per-
sons from entering the manipulator’s danger zone, e.g. use of warning 
tape.

Use Intended use of Start-up mode:

 Start-up in T1 mode when the external safeguards have not yet been in-
stalled or put into operation. The danger zone must be delimited at least 
by means of warning tape.

 Fault localization (periphery fault).

 Use of Start-up mode must be minimized as much as possible. 

Misuse Any use or application deviating from the intended use is deemed to be misuse 
and is not allowed. KUKA Roboter GmbH is not liable for any damage resulting 
from such misuse. The risk lies entirely with the user.

3.8.4 Manual mode

Manual mode is the mode for setup work. Setup work is all the tasks that have 
to be carried out on the industrial robot to enable automatic operation. Setup 
work includes:

 Jog mode

 Teaching

 Programming

 Program verification

The following must be taken into consideration in manual mode:

 New or modified programs must always be tested first in Manual Reduced 
Velocity mode (T1).

 The manipulator, tooling or external axes (optional) must never touch or 
project beyond the safety fence. 

 Workpieces, tooling and other objects must not become jammed as a re-
sult of the industrial robot motion, nor must they lead to short-circuits or be 
liable to fall off.

 All setup work must be carried out, where possible, from outside the safe-
guarded area.

If the setup work has to be carried out inside the safeguarded area, the follow-
ing must be taken into consideration:

In Manual Reduced Velocity mode (T1):

 If it can be avoided, there must be no other persons inside the safeguard-
ed area.

If it is necessary for there to be several persons inside the safeguarded ar-
ea, the following must be observed:

 Each person must have an enabling device.

 All persons must have an unimpeded view of the industrial robot.

Use of Start-up mode disables all external safeguards. 
The service personnel are responsible for ensuring that 

there is no-one in or near the danger zone of the manipulator as long as the 
safeguards are disabled.
Failure to observe this precaution may result in death, injuries or damage to 
property.
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 Eye-contact between all persons must be possible at all times.

 The operator must be so positioned that he can see into the danger area 
and get out of harm’s way.

In Manual High Velocity mode (T2):

 This mode may only be used if the application requires a test at a velocity 
higher than Manual Reduced Velocity.

 Teaching and programming are not permissible in this operating mode.

 Before commencing the test, the operator must ensure that the enabling 
devices are operational.

 The operator must be positioned outside the danger zone.

 There must be no other persons inside the safeguarded area. It is the re-
sponsibility of the operator to ensure this.

3.8.5 Simulation

Simulation programs do not correspond exactly to reality. Robot programs cre-
ated in simulation programs must be tested in the system in Manual Reduced 
Velocity mode (T1). It may be necessary to modify the program.

3.8.6 Automatic mode

Automatic mode is only permissible in compliance with the following safety 
measures:

 All safety equipment and safeguards are present and operational.

 There are no persons in the system.

 The defined working procedures are adhered to.

If the manipulator or an external axis (optional) comes to a standstill for no ap-
parent reason, the danger zone must not be entered until an EMERGENCY 
STOP has been triggered.

3.8.7 Maintenance and repair

After maintenance and repair work, checks must be carried out to ensure the 
required safety level. The valid national or regional work safety regulations 
must be observed for this check. The correct functioning of all safety functions 
must also be tested.

The purpose of maintenance and repair work is to ensure that the system is 
kept operational or, in the event of a fault, to return the system to an operation-
al state. Repair work includes troubleshooting in addition to the actual repair 
itself.

The following safety measures must be carried out when working on the indus-
trial robot:

 Carry out work outside the danger zone. If work inside the danger zone is 
necessary, the user must define additional safety measures to ensure the 
safe protection of personnel.

 Switch off the industrial robot and secure it (e.g. with a padlock) to prevent 
it from being switched on again. If it is necessary to carry out work with the 
robot controller switched on, the user must define additional safety mea-
sures to ensure the safe protection of personnel.

 If it is necessary to carry out work with the robot controller switched on, this 
may only be done in operating mode T1.

 Label the system with a sign indicating that work is in progress. This sign 
must remain in place, even during temporary interruptions to the work.
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3 Safety
 The EMERGENCY STOP systems must remain active. If safety functions 
or safeguards are deactivated during maintenance or repair work, they 
must be reactivated immediately after the work is completed.

Faulty components must be replaced using new components with the same 
article numbers or equivalent components approved by KUKA Roboter GmbH 
for this purpose.

Cleaning and preventive maintenance work is to be carried out in accordance 
with the operating instructions.

Robot controller Even when the robot controller is switched off, parts connected to peripheral 
devices may still carry voltage. The external power sources must therefore be 
switched off if work is to be carried out on the robot controller.

The ESD regulations must be adhered to when working on components in the 
robot controller. 

Voltages in excess of 50 V (up to 780 V) can be present in various components 
for several minutes after the robot controller has been switched off! To prevent 
life-threatening injuries, no work may be carried out on the industrial robot in 
this time.

Water and dust must be prevented from entering the robot controller.

Counterbal-

ancing system

Some robot variants are equipped with a hydropneumatic, spring or gas cylin-
der counterbalancing system. 

The hydropneumatic and gas cylinder counterbalancing systems are pressure 
equipment and, as such, are subject to obligatory equipment monitoring and 
the provisions of the Pressure Equipment Directive.

The user must comply with the applicable national laws, regulations and stan-
dards pertaining to pressure equipment. 

Inspection intervals in Germany in accordance with Industrial Safety Order, 
Sections 14 and 15. Inspection by the user before commissioning at the instal-
lation site.

The following safety measures must be carried out when working on the coun-
terbalancing system:

 The manipulator assemblies supported by the counterbalancing systems 
must be secured.

 Work on the counterbalancing systems must only be carried out by quali-
fied personnel.

Hazardous 

substances

The following safety measures must be carried out when handling hazardous 
substances:

 Avoid prolonged and repeated intensive contact with the skin.

 Avoid breathing in oil spray or vapors.

 Clean skin and apply skin cream.

Before work is commenced on live parts of the robot sys-
tem, the main switch must be turned off and secured 

against being switched on again. The system must then be checked to en-
sure that it is deenergized.
It is not sufficient, before commencing work on live parts, to execute an 
EMERGENCY STOP or a safety stop, or to switch off the drives, as this does 
not disconnect the robot system from the mains power supply. Parts remain 
energized. Death or severe injuries may result. 

To ensure safe use of our products, we recommend that our custom-
ers regularly request up-to-date safety data sheets from the manufac-
turers of hazardous substances.
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3.8.8 Decommissioning, storage and disposal

The industrial robot must be decommissioned, stored and disposed of in ac-
cordance with the applicable national laws, regulations and standards.

3.8.9 Safety measures for “single point of control”

Overview If certain components in the industrial robot are operated, safety measures 
must be taken to ensure complete implementation of the principle of “single 
point of control” (SPOC).

The relevant components are:

 Submit interpreter

 PLC

 OPC Server

 Remote control tools

 Tools for configuration of bus systems with online functionality

 KUKA.RobotSensorInterface

Since only the system integrator knows the safe states of actuators in the pe-
riphery of the robot controller, it is his task to set these actuators to a safe 
state, e.g. in the event of an EMERGENCY STOP.

T1, T2 In modes T1 and T2, the components referred to above may only access the 
industrial robot if the following signals have the following states:

Submit inter-

preter, PLC

If motions, (e.g. drives or grippers) are controlled with the submit interpreter or 
the PLC via the I/O system, and if they are not safeguarded by other means, 
then this control will take effect even in T1 and T2 modes or while an EMER-
GENCY STOP is active.

If variables that affect the robot motion (e.g. override) are modified with the 
submit interpreter or the PLC, this takes effect even in T1 and T2 modes or 
while an EMERGENCY STOP is active.

Safety measures:

 In T1 and T2, the system variable $OV_PRO must not be written to by the 
submit interpreter or the PLC.

 Do not modify safety-relevant signals and variables (e.g. operating mode, 
EMERGENCY STOP, safety gate contact) via the submit interpreter or 
PLC.

If modifications are nonetheless required, all safety-relevant signals and 
variables must be linked in such a way that they cannot be set to a dan-
gerous state by the submit interpreter or PLC. This is the responsibility of 
the system integrator.

OPC server, 

remote control 

tools

These components can be used with write access to modify programs, outputs 
or other parameters of the robot controller, without this being noticed by any 
persons located inside the system.

Safety measure:

The implementation of additional safety measures may be required. 
This must be clarified for each specific application; this is the respon-
sibility of the system integrator, programmer or user of the system.

Signal State required for SPOC

$USER_SAF TRUE

$SPOC_MOTION_ENABLE TRUE
Issued: 14.01.2015 Version: KSS 8.3 SI V4



3 Safety
If these components are used, outputs that could cause a hazard must be de-
termined in a risk assessment. These outputs must be designed in such a way 
that they cannot be set without being enabled. This can be done using an ex-
ternal enabling device, for example.

Tools for configu-

ration of bus 

systems

If these components have an online functionality, they can be used with write 
access to modify programs, outputs or other parameters of the robot control-
ler, without this being noticed by any persons located inside the system.

 WorkVisual from KUKA

 Tools from other manufacturers

Safety measure:

In the test modes, programs, outputs or other parameters of the robot control-
ler must not be modified using these components.

3.9 Applied norms and regulations

Name Definition Edition

2006/42/EC Machinery Directive:

Directive 2006/42/EC of the European Parliament and of the 
Council of 17 May 2006 on machinery, and amending Direc-
tive 95/16/EC (recast)

2006

2004/108/EC EMC Directive:

Directive 2004/108/EC of the European Parliament and of the 
Council of 15 December 2004 on the approximation of the 
laws of the Member States relating to electromagnetic com-
patibility and repealing Directive 89/336/EEC

2004

97/23/EC Pressure Equipment Directive:

Directive 97/23/EC of the European Parliament and of the 
Council of 29 May 1997 on the approximation of the laws of 
the Member States concerning pressure equipment

(Only applicable for robots with hydropneumatic counterbal-
ancing system.)

1997

EN ISO 13850 Safety of machinery:

Emergency stop - Principles for design

2008

EN ISO 13849-1 Safety of machinery:

Safety-related parts of control systems - Part 1: General prin-
ciples of design

2008

EN ISO 13849-2 Safety of machinery:

Safety-related parts of control systems - Part 2: Validation

2012

EN ISO 12100 Safety of machinery:

General principles of design, risk assessment and risk reduc-
tion

2010
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EN ISO 10218-1 Industrial robots: 

Safety

Note: Content equivalent to ANSI/RIA R.15.06-2012, Part 1

2011

EN 614-1 Safety of machinery:

Ergonomic design principles - Part 1: Terms and general prin-
ciples

2009

EN 61000-6-2 Electromagnetic compatibility (EMC):

Part 6-2: Generic standards; Immunity for industrial environ-
ments

2005

EN 61000-6-4 + A1 Electromagnetic compatibility (EMC):

Part 6-4: Generic standards; Emission standard for industrial 
environments

2011

EN 60204-1 + A1 Safety of machinery:

Electrical equipment of machines - Part 1: General require-
ments

2009
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4 Operation

4.1 KUKA smartPAD teach pendant

4.1.1 Front view

Function The smartPAD is the teach pendant for the industrial robot. The smartPAD has 
all the operator control and display functions required for operating and pro-
gramming the industrial robot.

The smartPAD has a touch screen: the smartHMI can be operated with a fin-
ger or stylus. An external mouse or external keyboard is not necessary.

Overview

4

 

t

Fig. 4-1: KUKA smartPAD, front view

Item Description

1 Button for disconnecting the smartPAD

 (>>> 4.1.3 "Disconnecting and connecting the smartPAD" 
Page 48)

2 Keyswitch for calling the connection manager. The switch can only 
be turned if the key is inserted.

The operating mode can be changed by using the connection man-
ager.

 (>>> 4.12 "Changing operating mode" Page 63)
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3 EMERGENCY STOP button. Stops the robot in hazardous situa-
tions. The EMERGENCY STOP button locks itself in place when it 
is pressed.

4 Space Mouse: For moving the robot manually.

 (>>> 4.14 "Jogging the robot" Page 65)

5 Jog keys: For moving the robot manually.

 (>>> 4.14 "Jogging the robot" Page 65)

6 Key for setting the program override

7 Key for setting the jog override

8 Main menu key: Shows the menu items on the smartHMI

 (>>> 4.4 "Calling the main menu" Page 54)

9 Status keys. The status keys are used primarily for setting param-
eters in technology packages. Their exact function depends on the 
technology packages installed.

10 Start key: The Start key is used to start a program.

11 Start backwards key: The Start backwards key is used to start a 
program backwards. The program is executed step by step.

12 STOP key: The STOP key is used to stop a program that is run-
ning.

13 Keyboard key

Displays the keyboard. It is generally not necessary to press this 
key to display the keyboard, as the smartHMI detects when key-
board input is required and displays the keyboard automatically.

 (>>> 4.2.1 "Keypad" Page 50)

Item Description
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4.1.2 Rear view

Overview

Description

Fig. 4-2: KUKA smartPAD, rear view

1 Enabling switch 4 USB connection

2 Start key (green) 5 Enabling switch

3 Enabling switch 6 Identification plate

Element Description

Identification 
plate

Identification plate

Start key The Start key is used to start a program.

Enabling 
switch

The enabling switch has 3 positions:

 Not pressed

 Center position

 Panic position

The enabling switch must be held in the center position 
in operating modes T1 and T2 in order to be able to jog 
the manipulator.

In the operating modes Automatic and Automatic Exter-
nal, the enabling switch has no function.

USB connec-
tion

The USB connection is used, for example, for archiving 
and restoring data.

Only for FAT32-formatted USB sticks.
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4.1.3 Disconnecting and connecting the smartPAD

Description The smartPAD can be disconnected while the robot controller is running.

Procedure Disconnection:

1. Press the disconnect button on the smartPAD.

A message and a counter are displayed on the smartHMI. The counter 
runs for 30 s. During this time, the smartPAD can be disconnected from 
the robot controller.

2. Disconnect the smartPAD from the robot controller.

If the counter expires without the smartPAD having been disconnected, 
this has no effect. The disconnect button can be pressed again at any time 
to display the counter again.

Connection:

 Connect the smartPAD to the robot controller.

A smartPAD can be connected at any time. Precondition: Same smartPAD 
variant as the disconnected device. The EMERGENCY STOP and enabling 
switches are operational again 30 s after connection. The smartHMI is auto-
matically displayed again. (This may take longer than 30 s.)

The connected smartPAD assumes the current operating mode of the robot 
controller.

If the smartPAD is disconnected, the system can no lon-
ger be switched off by means of the EMERGENCY 

STOP device on the smartPAD. For this reason, an external EMERGENCY 
STOP must be connected to the robot controller.
The user is responsible for ensuring that the smartPAD is immediately re-
moved from the system when it has been disconnected. The smartPAD must 
be stored out of sight and reach of personnel working on the industrial robot. 
This prevents operational and non-operational EMERGENCY STOP devices 
from becoming interchanged.
Failure to observe these precautions may result in death, injuries or damage 
to property.

If the smartPAD is disconnected without the counter running, this trig-
gers an EMERGENCY STOP. The EMERGENCY STOP can only be 
canceled by plugging the smartPAD back in.

The current operating mode is not, in all cases, the same as that be-
fore the smartPAD was disconnected: if the robot controller is part of 
a RoboTeam, the operating mode may have been changed after dis-

connection, e.g. by the master.

The user connecting a smartPAD to the robot controller 
must subsequently stay with the smartPAD for at least 

30 s, i.e. until the EMERGENCY STOP and enabling switches are operation-
al once again. This prevents another user from trying to activate a non-oper-
ational EMERGENCY STOP in an emergency situation, for example.
Failure to observe this precaution may result in death, injuries or damage to 
property.
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4.2 KUKA smartHMI user interface

Fig. 4-3: KUKA smartHMI user interface

Item Description

1 Status bar (>>> 4.2.2 "Status bar" Page 51)

2 Message counter

The message counter indicates how many messages of each mes-
sage type are active. Touching the message counter enlarges the 
display.

3 Message window

By default, only the last message is displayed. Touching the mes-
sage window expands it so that all active messages are displayed.

An acknowledgeable message can be acknowledged with OK. All 
acknowledgeable messages can be acknowledged at once with 
All OK.

4 Space Mouse status indicator

This indicator shows the current coordinate system for jogging with 
the Space Mouse. Touching the indicator displays all coordinate 
systems, allowing a different one to be selected.
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4.2.1 Keypad

The smartPAD has a touch screen: the smartHMI can be operated with a fin-
ger or stylus.

There is a keypad on the smartHMI for entering letters and numbers. The sm-
artHMI detects when the entry of letters or numbers is required and automati-
cally displays the keypad.

The keypad only ever displays the characters that are required. If, for example, 
a box is edited in which only numbers can be entered, then only numbers are 
displayed and not letters.

5 Space Mouse alignment indicator

Touching this indicator opens a window in which the current align-
ment of the Space Mouse is indicated and can be changed.

 (>>> 4.14.8 "Defining the alignment of the Space Mouse" 
Page 74)

6 Jog keys status indicator

This indicator shows the current coordinate system for jogging with 
the jog keys. Touching the indicator displays all coordinate sys-
tems, allowing a different one to be selected.

7 Jog key labels

If axis-specific jogging is selected, the axis numbers are displayed 
here (A1, A2, etc.). If Cartesian jogging is selected, the coordinate 
system axes are displayed here (X, Y, Z, A, B, C).

Touching the label causes the selected kinematics group to be dis-
played.

8 Program override

 (>>> 8.5 "Setting the program override (POV)" Page 267)

9 Jog override

 (>>> 4.14.3 "Setting the jog override (HOV)" Page 70)

10 Button bar. The buttons change dynamically and always refer to 
the window that is currently active in the smartHMI.

At the right-hand end is the Edit button. This can be used to call 
numerous commands relating to the Navigator.

11 WorkVisual icon

Touching the icon takes you to the Project management window.

 (>>> 7.11.3 "Project management window" Page 252)

12 Clock

The clock displays the system time. Touching the clock displays 
the system time in digital format, together with the current date.

13 Life sign display

If the display flashes in the following manner, this indicates that the 
smartHMI is active:

The left-hand and right-hand lamps alternately light up green. The 
change is slow (approx. 3 s) and uniform.

Item Description
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4.2.2 Status bar

The status bar indicates the status of certain central settings of the industrial 
robot. In most cases, touching the display opens a window in which the set-
tings can be modified.

Overview

Fig. 4-4: Example keypad

Fig. 4-5: KUKA smartHMI status bar

Item Description

1 Main menu key. Shows the menu items on the smartHMI.

 (>>> 4.4 "Calling the main menu" Page 54)

2 Robot name. The robot name can be changed.

 (>>> 4.17.15 "Displaying/editing robot data" Page 90)

3 If a program has been selected, the name is displayed here.

4 Submit interpreter status indicator

 (>>> 12 "Submit interpreter" Page 453)

5 Drives status indicator. Touching the display opens a window in 
which the drives can be switched on or off.

 (>>> 4.2.3 "Drives status indicator and Motion conditions window" 
Page 52)

6 Robot interpreter status indicator. Programs can be reset or can-
celed here.

 (>>> 8.6 "Robot interpreter status indicator" Page 267)

 (>>> 7.5.1 "Selecting and deselecting a program" Page 237)

 (>>> 8.10 "Resetting a program" Page 269)

7 Current operating mode

 (>>> 4.12 "Changing operating mode" Page 63)
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4.2.3 Drives status indicator and Motion conditions window

Drives status 

indicator

The Drives status indicator can display the following statuses:

Meaning of the icons and colors:

“Motion condi-

tions” window

Touching the Drives status indicator opens the Motion conditions window. 
The drives can be switched on or off here.

8 POV/HOV status indicator. Indicates the current program override 
and the current jog override.

 (>>> 8.5 "Setting the program override (POV)" Page 267)

 (>>> 4.14.3 "Setting the jog override (HOV)" Page 70)

9 Program run mode status indicator. Indicates the current program 
run mode.

 (>>> 8.2 "Program run modes" Page 263)

10 Tool/base status indicator. Indicates the current tool and base.

 (>>> 4.14.4 "Selecting the tool and base" Page 71)

11 Incremental jogging status indicator.

 (>>> 4.14.10 "Incremental jogging" Page 75)

Item Description

Statuses

Symbol: I
The drives are ON. ($PERI_RDY == TRUE)

 The intermediate circuit is fully charged.

Symbol: O

The drives are OFF. ($PERI_RDY == FALSE)

 The intermediate circuit is not charged or incom-
pletely charged.

Color: Green

$COULD_START_MOTION == TRUE

 The enabling switch has been pressed (center posi-
tion) or is not required.

 And: There are no active messages preventing ro-
bot motion.

Color: Gray

$COULD_START_MOTION == FALSE

 The enabling switch has not been pressed or fully 
pressed.

 And/or: There are active messages preventing ro-
bot motion.

Drives ON does not automatically mean that the KSPs switch to ser-
vo-control and supply the motors with current.

Drives OFF does not automatically mean that the KSPs terminate 
the power supply to the motors.

Whether or not the KSPs supply the motors with current depends on whether 
the drives enable signal has been received from the safety controller.
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$USER_SAF == 

TRUE

The conditions under which $USER_SAF is TRUE depend on the controller 
variant and the operating mode:

Fig. 4-6: “Motion conditions” window

Item Description

1 I: Touch to switch on the drives.

O: Touch to switch off the drives.

2 Green: The drives enable signal has been received from the safety 
controller.

Gray: The safety controller has triggered a safety stop 0 or termi-
nated a safety stop 1. No drives enable signal present, i.e. the 
KSPs are not under servo-control and are not supplying the motors 
with current.

3 Operator safety signal

Green: $USER_SAF == TRUE

Gray: $USER_SAF == FALSE

 (>>>  "$USER_SAF == TRUE" Page 53)

4 Green: The motion enable signal has been received from the safe-
ty controller.

Gray: The safety controller has triggered a safety stop 1 or a safety 
stop 2. No motion enable present.

Note:  The status of Motion enable from Safety does not corre-
late with the status of $MOVE_ENABLE!

5 Green: The enabling switch is pressed (center position).

Gray: The enabling switch has not been pressed or fully pressed, 
or is not required.

Controller
Operating 

mode
Condition

KR C4 T1, T2  The enabling switch is pressed.

AUT, AUT EXT  The physical safeguard is 
closed.
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4.2.4 Minimizing KUKA smartHMI (displaying Windows interface)

Precondition  User group "Expert".

 Operating mode T1 or T2.

Procedure 1. In the main menu, select Start-up > Service > Minimize HMI.

The smartHMI is minimized and the Windows interface is displayed.

2. To maximize the smartHMI again, touch the following icon in the task bar:

4.3 Switching on the robot controller and starting the KSS

Procedure  Turn the main switch on the robot controller to ON.

The operating system and the KSS start automatically.

If the KSS does not start automatically, e.g. because the Startup function has 
been disabled, execute the file StartKRC.exe in the directory C:\KRC.

If the robot controller is logged onto the network, the start may take longer.

4.4 Calling the main menu

Procedure  Press the main menu key on the smartPAD. The Main menu window 
opens. 

The display is always the same as that which was in the window before it 
was last closed. 

Description Properties of the Main Menu window:

 The main menu is displayed in the left-hand column.

 Touching a menu item that contains an arrow opens the corresponding 
submenu (e.g. Configure).

Depending on how many nested submenus are open, the Main Menu col-
umn may no longer be visible, with only the submenus remaining visible.

 The arrow key in the top right-hand corner closes the most recently 
opened submenu.

 The Home key in the top right-hand corner closes all open submenus.

 The most recently selected menu items are displayed in the bottom sec-
tion (maximum 6). 

This makes it possible to select these menu items again directly without 
first having to close other submenus that might be open.

 The white cross on the left-hand side closes the window.

VKR C4 T1  The enabling switch is pressed.

 E2 is closed.

T2  The enabling switch is pressed.

 E2 and E7 are closed.

AUT EXT  The physical safeguard is 
closed.

 E2 and E7 are open.

Controller
Operating 

mode
Condition
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4.5 Defining the start type for KSS

Description You can choose whether to boot the robot controller by default with a cold start 
or with Hibernate. 

Precondition  “Expert” user group

Procedure 1. In the main menu, select Shutdown. A window opens.

2. Select the start type: Cold start or Hibernate.

 (>>>  "Start types" Page 58)

3. Close the window. The selected start type is applied.

It is possible to select settings which deviate from the standard start type and 
are valid only for the next start.

 (>>> 4.6 "Exiting or restarting KSS" Page 55)

4.6 Exiting or restarting KSS

Precondition  For certain options: “Expert” user group

Fig. 4-7: Example: Configuration submenu is open.

In the following situations, the robot controller always performs an ini-
tial cold start, irrespective of what start type has been defined:

Following installation or update of the KSS

 When the robot controller has detected an error while shutting down

If, on shutting down, the option Reboot control PC is se-
lected, the main switch on the robot controller must not 

be pressed until the reboot has been completed. System files may otherwise 
be destroyed.
If this option was not selected on shutting down, the main switch can be 
pressed once the controller has shut down.
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Procedure 1. Select the menu item Shutdown in the main menu.

2. Select the desired options.

3. Press Shut down control PC or Reboot control PC. 

4. Confirm the request for confirmation with Yes. The System Software is ter-
minated and restarted in accordance with the selected option.

After the restart, the following message is displayed:

 Cold start of controller

 Or, if Reload files has been selected: Initial cold start of controller

Description

Fig. 4-8: “Shutdown” window

Option Description

Default settings for switching off the system

These settings can only be modified in the user group “Expert”.

Cold start Cold start is the standard start type.  (>>>  "Start types" Page 58)

Hibernate Hibernate is the standard start type.
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Power-off delay time If the robot controller is switched off at the main switch, it is only shut 
down after the delay time defined here. During the delay time, the robot 
controller is powered by its battery. 

The delay time can only be modified in the user group “Expert”.

Note: 

 The power-off delay time only applies if the voltage is switched off via 
the main switch. The power failure delay time applies for genuine 
power failures.

 Exception for “KR C4 compact”: The power-off delay time has no 
function for this controller variant! The power failure delay time ap-
plies here, even when switching off via the main switch. 

 (>>> 4.6.1 "Shutting down after power failure" Page 58)

Settings that are only valid next time the system is switched off

Force cold start Activated: The next start is a cold start. 

Only available if Hibernate has been selected.

Reload files Activated: The next start is an initial cold start. 

This option must be selected in the following cases:

 If XML files have been changed directly, i.e. the user has opened the 
file and modified it. 

(Any other changes to XML files, e.g. if the robot controller modifies 
them in the background, are irrelevant.)

 If hardware components are to be exchanged after shutdown.

Can only be selected in the “Expert” user group. Only available if Cold 
start or Force cold start has been selected.

Depending on the hardware, the initial cold start takes approx. 30 to 
150 seconds longer than a normal cold start. 

Power-off delay time Activated: The delay time is adhered to the next time the system is shut 
down.

Deactivated: The delay time is ignored the next time the system is shut 
down.

Instant actions

Only available in operating modes T1 and T2.

Shut down control 
PC

The robot controller shuts down.

Reboot control PC The robot controller shuts down and then reboots with a cold start.

Drive bus

OFF / ON

The drive bus can be switched off or on.

Drive bus status indicator:

 Green: Drive bus is on.

 Red: Drive bus is off.

 Gray: Status of the drive bus is unknown.

Option Description
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Start types

4.6.1 Shutting down after power failure

In the case of a power failure, the robot comes to a standstill. However, the 
robot controller does not shut down immediately but rather only after the power 
failure delay time. In other words, brief power failures are overriden through 
this delay time. The error messages must then only be acknowledged and the 
program can then be resumed. 

During the delay time, the robot controller is powered by its battery. 

If the power failure lasts longer than the power failure delay time and the robot 
controller shuts down, then the standard start type defined in the Shutdown 
window applies for the restart.

 (>>> 4.6 "Exiting or restarting KSS" Page 55)

4.7 Switching drives on/off

Procedure 1. In the status bar, touch the Drives status indicator. The Motion condi-
tions window opens.

 (>>> 4.2.3 "Drives status indicator and Motion conditions window" 
Page 52)

Start type Description

Cold start After a cold start the robot controller displays the Navi-
gator. No program is selected. The robot controller is 
reinitialized, e.g. all user outputs are set to FALSE.

Note: If XML files have been changed directly, i.e. the 
user has opened the file and modified it, these changes 
are taken into consideration in the case of a cold start 
with Reload files. This cold start is called an “initial 
cold start”.

In the case of a cold start without Reload files, these 
changes are not taken into consideration.

Hibernate After a start with Hibernate, the previously selected 
robot program can be resumed. The state of the kernel 
system: programs, block pointer, variable contents and 
outputs, is completely restored.

Additionally, all programs that were open parallel to the 
robot controller are reopened and have the same state 
that they had before the system was shut down. The 
last state of Windows is also restored.

Robot controller
Power failure delay 

time

“KR C4 compact” variant 1 s

All other variants of KR C4 3 s

The power failure delay time does not apply if the voltage is switched 
off via the main switch. The power-off delay time applies for this.

Exception for “KR C4 compact”: For this controller variant, the power 
failure delay time also applies when switching off via the main switch. 

 The power failure delay time is particularly important for systems without 
a reliable mains supply. Delay times of up to 240 s are possible. If the ex-
isting times are to be modified, please contact KUKA Roboter GmbH.
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2. Switch the drives on or off.

4.8 Switching the robot controller off

Procedure  Turn the main switch on the robot controller to OFF.

Description The robot stops and the robot controller shuts down. The robot controller au-
tomatically backs up data.

If a power-off delay time is configured, the robot controller shuts down only af-
ter this time has passed. In other words, brief power-downs are overriden 
through this delay time. The error messages must then only be acknowledged 
and the program can then be resumed.

During the delay time, the robot controller is powered by its battery. 

4.9 Setting the user interface language

Procedure 1. In the main menu, select Configuration > Miscellaneous > Language.

2. Select the desired language. Confirm with OK.

Description The following languages are available:

4.10 Online documentation and online help

4.10.1 Calling online documentation

Description The documentation of the KUKA System Software can be displayed on the ro-
bot controller. Certain technology packages also have documentation that can 
be displayed on the robot controller.

Procedure 1. In the main menu, select Help > Documentation. Then select either Sys-
tem Software or the menu item for the technology package.

The KUKA Embedded Information Service window is opened. The table 
of contents of the documentation is displayed.

2. Touch a chapter. The topics it contains are displayed.

3. Touch a topic. The description is displayed.

The main switch must not be operated if the robot controller has been 
exited with the option Reboot control PC and the reboot has not yet 
been completed. System files may otherwise be destroyed.

Chinese (simplified) Polish

Danish Portuguese

German Romanian

English Russian

Finnish Swedish

French Slovak

Greek Slovenian

Italian Spanish

Japanese Czech

Korean Turkish

Dutch Hungarian
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Example

4.10.2 Calling online help

Description The online help refers to the messages. The online help can be called in the 
following ways:

 Call the help for a message that is currently displayed in the message win-
dow.

 Display an overview of the possible messages and call the help for a mes-
sage there.

Procedure Calling the online help for a message in the message window

Most messages contain a button with a question mark. Online help is available 
for these messages.

1. Touch the button containing the question mark. The KUKA Embedded In-
formation Service – Message page window is opened. 

The window contains a variety of information about the message.  
(>>> Fig. 4-10 )

2. The window often also contains information about the causes of the mes-
sage and the corresponding solutions. Details can be displayed:

a. Touch the magnifying glass button next to the cause. The detail page 
is opened.  (>>> Fig. 4-11 )

Fig. 4-9: Online documentation – Example from the KUKA System Soft-
ware

Item Description

1, 2 Displays the table of contents.

3 Displays the previous topic in the table of contents.

4 Displays the next topic.
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4 Operation
b. Open the descriptions of the cause and solution.

c. If the message has several possible causes: the magnifying glass but-
tons with arrows can be used to jump to the previous or next detail 
page.

Procedure Displaying an overview of the messages and calling the online help for 
a message there

1. In the main menu, select Help > Messages. Then select either System 
Software or the menu item for the technology package.

The KUKA Embedded Information Service – Index page window is 
opened. The messages are sorted by module (“module” refers here to a 
subsection of the software).

2. Touch an entry. The messages of this module are displayed.

3. Touch a message. The message page is displayed. 

The window contains a variety of information about the message.  
(>>> Fig. 4-10 )

4. The window often also contains information about the causes of the mes-
sage and the corresponding solutions. Details can be displayed:

a. Touch the magnifying glass button next to the cause. The detail page 
is opened.  (>>> Fig. 4-11 )

b. Open the descriptions of the cause and solution.

c. If the message has several possible causes: the magnifying glass but-
tons with arrows can be used to jump to the previous or next detail 
page.

Message page

Fig. 4-10: Message page – Example from the KUKA System Software
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Detail page

4.11 Changing user group

Procedure 1. Select Configuration > User group in the main menu. The current user 
group is displayed.

2. Press Default to switch to the default user group. (Default is not available 
if the default user group is already selected.)

Press Login... to switch to a different user group. Select the desired user 
group.

3. If prompted: Enter password and confirm with Log-on.

Item Description

1 Displays the previous page.

2 This button is only active if the other arrow button has been used 
to jump to the previous page. This button can then be used to 
return to the original page.

3 Displays the list with the software modules.

4 Message number and text

5 Information about the message

There may be less information available than in the example.

6 Displays details about this cause/solution.  (>>> Fig. 4-11 )

Fig. 4-11: Detail page – Example from the KUKA System Software
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Description Different functions are available in the KSS, depending on the user group. The 
following user groups are available:

 Operator

User group for the operator. This is the default user group.

 User

User group for the operator. (By default, the user groups “Operator” and 
“User” are defined for the same target group.)

 Expert

User group for the programmer. This user group is protected by means of 
a password.

 Safety recovery

This user group can activate and configure the safety configuration of the 
robot. This user group is protected by means of a password.

 Safety maintenance

This user group is only relevant if KUKA.SafeOperation or KUKA.Saf-
eRangeMonitoring is used. The user group is protected by means of a 
password.

 Administrator

The range of functions is the same as that for the user group “Expert”. It is 
additionally possible, in this user group, to integrate plug-ins into the robot 
controller.

This user group is protected by means of a password.

The default password is “kuka”. The password can be changed.

 (>>> 6.9 "Changing the password" Page 170)

When the system is booted, the default user group is selected.

If the mode is switched to AUT or AUT EXT, the robot controller switches to 
the default user group for safety reasons. If a different user group is desired, 
this must be selected subsequently.

If no actions are carried out in the user interface within a certain period of time, 
the robot controller switches to the default user group for safety reasons. The 
default setting is 300 s.

4.12 Changing operating mode

Precondition  The robot controller is not executing a program.

 Key for the switch for calling the connection manager

Procedure 1. On the smartPAD, turn the switch for the connection manager. The con-
nection manager is displayed.

2. Select the operating mode (>>> 3.5.3 "Mode selection" Page 27)..

3. Return the switch for the connection manager to its original position.

The selected operating mode is displayed in the status bar of the smart-
PAD.

Do not change the operating mode while a program is running. If the 
operating mode is changed during program execution, the industrial 
robot is stopped with a safety stop 2.
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4.13 Coordinate systems

Overview The following Cartesian coordinate systems are defined in the robot controller:

 WORLD

 ROBROOT

 BASE

 TOOL

Description WORLD

Operatin

g mode
Use Velocities

T1
For test operation, pro-
gramming and teach-
ing

 Program verification:

Programmed velocity, maxi-
mum 250 mm/s

 Jog mode:

Jog velocity, maximum 250 mm/
s

T2 For test operation

 Program verification:

Programmed velocity

 Jog mode: Not possible

AUT
For industrial robots 
without higher-level 
controllers

 Program mode:

Programmed velocity

 Jog mode: Not possible

AUT EXT
For industrial robots 
with higher-level con-
trollers, e.g. PLC

 Program mode:

Programmed velocity

 Jog mode: Not possible

Fig. 4-12: Overview of coordinate systems
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The WORLD coordinate system is a permanently defined Cartesian coordi-
nate system. It is the root coordinate system for the ROBROOT and BASE co-
ordinate systems.

By default, the WORLD coordinate system is located at the robot base.

ROBROOT

The ROBROOT coordinate system is a Cartesian coordinate system, which is 
always located at the robot base. It defines the position of the robot relative to 
the WORLD coordinate system.

By default, the ROBROOT coordinate system is identical to the WORLD coor-
dinate system. $ROBROOT allows the definition of an offset of the robot rela-
tive to the WORLD coordinate system.

BASE

The BASE coordinate system is a Cartesian coordinate system that defines 
the position of the workpiece. It is relative to the WORLD coordinate system.

By default, the BASE coordinate system is identical to the WORLD coordinate 
system. It is offset to the workpiece by the user.

 (>>> 5.10.3 "Base calibration" Page 131)

TOOL

The TOOL coordinate system is a Cartesian coordinate system which is locat-
ed at the tool center point.

By default, the origin of the TOOL coordinate system is located at the flange 
center point. (In this case it is called the FLANGE coordinate system.) The 
TOOL coordinate system is offset to the tool center point by the user.

 (>>> 5.10.2 "Tool calibration" Page 124)

Angles of rotation of the robot coordinate systems

4.14 Jogging the robot

Description There are 2 ways of jogging the robot:

 Cartesian jogging

The TCP is jogged in the positive or negative direction along the axes of a 
coordinate system.

 Axis-specific jogging

Each axis can be moved individually in a positive and negative direction.

Angle Rotation about axis

Angle A Rotation about the Z axis

Angle B Rotation about the Y axis

Angle C Rotation about the X axis
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There are 2 operator control elements that can be used for jogging the robot:

 Jog keys

 Space Mouse

Overview

4.14.1 “Jog options” window

Description All parameters for jogging the robot can be set in the Jogging Options win-
dow.

Procedure Open the Jogging Options window:

1. Open a status indicator on the smartHMI, e.g. the POV status indicator.

(Not possible for the Submit interpreter, Drives and Robot interpreter 
status indicators.)

A window opens.

2. Press Options. The Jogging Options window is opened.

For most parameters, it is not necessary to open the Jogging Options win-
dow. They can be set directly via the smartHMI status indicators.

Fig. 4-13: Axis-specific jogging

Cartesian jogging Axis-specific jogging

Jog keys  (>>> 4.14.6 "Cartesian jog-
ging with the jog keys" 
Page 71)

 (>>> 4.14.5 "Axis-specific 
jogging with the jog keys" 
Page 71)

Space 
Mouse

 (>>> 4.14.9 "Cartesian jog-
ging with the Space Mouse" 
Page 75)

Axis-specific jogging with 
the Space Mouse is possi-
ble, but is not described 
here.
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4 Operation
4.14.1.1 “General” tab

Description

4.14.1.2 “Keys” tab

Fig. 4-14: General tab

Item Description

1 Set program override

 (>>> 8.5 "Setting the program override (POV)" Page 267)

2 Set jog override

 (>>> 4.14.3 "Setting the jog override (HOV)" Page 70)

3 Select the program run mode

 (>>> 8.2 "Program run modes" Page 263)

Fig. 4-15: Keys tab
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Description

4.14.1.3 “Mouse” tab

Description

Item Description

1 Activate jog mode “Jog keys”

 (>>> 4.14.2 "Activating the jog mode" Page 70)

2 Select a kinematics group. The kinematics group defines the axes 
to which the jog keys refer.

Default: Robot axes (= A1 to A6)

Depending on the system configuration, other kinematics groups 
may be available.

 (>>> 4.15 "Jogging external axes" Page 76)

3 Select the coordinate system for jogging with the jog keys:

 Axes, World, Base or Tool

Check box Sync.:

 Check box not active (default): On the Keys and Mouse tabs, 
different coordinate systems can be selected.

 Check box active: On the Keys and Mouse tabs, only one co-
ordinate system can be selected, which is the same in each 
case. If the coordinate system is changed on one tab, the set-
ting on the other is adapted automatically.

4 Incremental jogging

 (>>> 4.14.10 "Incremental jogging" Page 75)

Fig. 4-16: Mouse tab

Item Description

1 Activate jog mode “Space Mouse”

 (>>> 4.14.2 "Activating the jog mode" Page 70)
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4.14.1.4 “KCP pos.” tab

Description

2 Configure the Space Mouse

 (>>> 4.14.7 "Configuring the Space Mouse" Page 72)

3 Select the coordinate system for jogging with the Space Mouse:

 Axes, World, Base or Tool

Check box Sync.:

 Check box not active (default): On the Keys and Mouse tabs, 
different coordinate systems can be selected.

 Check box active: On the Keys and Mouse tabs, only one co-
ordinate system can be selected, which is the same in each 
case. If the coordinate system is changed on one tab, the set-
ting on the other is adapted automatically.

Item Description

Fig. 4-17: Kcp Pos. tab

Item Description

1  (>>> 4.14.8 "Defining the alignment of the Space Mouse" 
Page 74)
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4.14.1.5 “Cur. tool/base” tab

Description

4.14.2 Activating the jog mode

Procedure 1. Open the Jogging Options window.

 (>>> 4.14.1 "“Jog options” window" Page 66)

2. To activate the jog mode “Jog keys”:

On the Keys tab, activate the Activate Keys check box.

To activate the jog mode “Space Mouse”:

On the Mouse tab, activate the Activate Mouse check box.

Description Both jog modes “Jog keys” and “Space Mouse” can be activated simultane-
ously. If the robot is jogged using the keys, the Space Mouse is disabled until 
the robot comes to a standstill. If the Space Mouse is actuated, the keys are 
disabled.

4.14.3 Setting the jog override (HOV)

Description Jog override determines the velocity of the robot during jogging. The velocity 
actually achieved by the robot with a jog override setting of 100% depends on 

Fig. 4-18: Act. Tool/Base tab

Item Description

1 The current tool is displayed here. A different tool can be selected.

 (>>> 4.14.4 "Selecting the tool and base" Page 71)

The display Unknown [?] means that no tool has yet been calibrat-
ed.

2 The current base is displayed here. A different base can be select-
ed.

 (>>> 4.14.4 "Selecting the tool and base" Page 71)

The display Unknown [?] means that no base has yet been cali-
brated.

3 Select the interpolation mode:

 Flange: The tool is mounted on the mounting flange.

 ext. Tool: The tool is a fixed tool.
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various factors, including the robot type. The velocity cannot exceed 250 mm/
s however.

Procedure 1. Touch the POV/HOV status indicator. The Overrides window is opened.

2. Set the desired jog override. It can be set using either the plus/minus keys 
or by means of the slide controller.

 Plus/minus keys: The value can be set to 100%, 75%, 50%, 30%, 
10%, 3%, 1%

 Slide controller: The override can be adjusted in 1% steps.

3. Touch the POV/HOV status indicator again. (Or touch the area outside the 
window.) 

The window closes and the selected override value is applied.

Alternative 

procedure

Alternatively, the override can be set using the plus/minus key on the right of 
the smartPAD.

The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%.

4.14.4 Selecting the tool and base

Description A maximum of 16 TOOL and 32 BASE coordinate systems can be saved in 
the robot controller. One tool (TOOL coordinate system) and one base (BASE 
coordinate system) must be selected for Cartesian jogging.

Procedure 1. Touch the Tool/base status indicator. The Act. Tool/Base window is 
opened.

2. Select the desired tool and base.

3. The window closes and the selection is applied.

4.14.5 Axis-specific jogging with the jog keys

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

Procedure 1. Select Axes as the coordinate system for the jog keys.

2. Set jog override.

3. Hold down the enabling switch.

Axes A1 to A6 are displayed next to the jog keys.

4. Press the Plus or Minus jog key to move an axis in the positive or negative 
direction.

4.14.6 Cartesian jogging with the jog keys

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

 Tool and base have been selected.

 (>>> 4.14.4 "Selecting the tool and base" Page 71)

Procedure 1. Select World, Base or Tool as the coordinate system for the jog keys.

The Jog options window can be opened via Options in the Over-
rides window.

The position of the robot during jogging can be displayed: select Dis-
play > Actual position in the main menu.
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2. Set jog override.

3. Hold down the enabling switch.

The following designations are displayed next to the jog keys:

 X, Y, Z: for the linear motions along the axes of the selected coordinate 
system

 A, B, C: for the rotational motions about the axes of the selected coor-
dinate system

4. Press the Plus or Minus jog key to move the robot in the positive or nega-
tive direction.

4.14.7 Configuring the Space Mouse

Procedure 1. Open the Jogging Options window and select the Mouse tab.

 (>>> 4.14.1 "“Jog options” window" Page 66)

2. Mouse Settings group:

 Dominant check box: 

Activate or deactivate dominant mode as desired.

 6D/XYZ/ABC option box: 

Select whether the TCP is to be moved using translational motions, ro-
tational motions, or both.

3. Close the Jogging Options window.

Description

Dominant check box:

Depending on the dominant mode, the Space Mouse can be used to move just 
one axis or several axes simultaneously.

The position of the robot during jogging can be displayed: select Dis-
play > Actual position in the main menu.

Fig. 4-19: Mouse settings

Check box Description

Active Dominant mode is activated. Only the coordinate axis 
with the greatest deflection of the Space Mouse is 
moved.

Inactive Dominant mode is deactivated. Depending on the axis 
selection, either 3 or 6 axes can be moved simultane-
ously.
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Option Description

6D The robot can be moved by pulling, pushing, rotating or 
tilting the Space Mouse.

The following motions are possible with Cartesian jog-
ging:

 Translational motions in the X, Y and Z directions

 Rotational motions about the X, Y and Z axes

XYZ The robot can only be moved by pulling or pushing the 
Space Mouse.

The following motions are possible with Cartesian jog-
ging:

 Translational motions in the X, Y and Z directions

ABC The robot can only be moved by rotating or tilting the 
Space Mouse.

The following motions are possible with Cartesian jog-
ging:

 Rotational motions about the X, Y and Z axes

Fig. 4-20: Pushing and pulling the Space Mouse

Fig. 4-21: Rotating and tilting the Space Mouse
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4.14.8 Defining the alignment of the Space Mouse

Description The functioning of the Space Mouse can be adapted to the location of the user 
so that the motion direction of the TCP corresponds to the deflection of the 
Space Mouse.

The location of the user is specified in degrees. The reference point for the 
specification in degrees is the junction box on the base frame. The position of 
the robot arm or axes is irrelevant.

Default setting: 0°. This corresponds to a user standing opposite the junction 
box.

Switching to Automatic External mode automatically resets the alignment of 
the Space Mouse to 0°.

Precondition  Operating mode T1

Procedure 1. Open the Jog options window and select the KCP pos. tab.

2. Drag the smartPAD to the position corresponding to the location of the 
user (in 45° steps).

3. Close the Jog options window.

Fig. 4-22:  Space Mouse: 0° and 270°

Fig. 4-23: Defining the alignment of the Space Mouse
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4.14.9 Cartesian jogging with the Space Mouse

Precondition  The jog mode “Space Mouse” is active.

 Operating mode T1

 Tool and base have been selected.

 (>>> 4.14.4 "Selecting the tool and base" Page 71)

 The Space Mouse is configured.

 (>>> 4.14.7 "Configuring the Space Mouse" Page 72)

 The alignment of the Space Mouse has been defined.

 (>>> 4.14.8 "Defining the alignment of the Space Mouse" Page 74)

Procedure 1. Select World, Base or Tool as the coordinate system for the 
Space Mouse.

2. Set jog override.

3. Hold down the enabling switch.

4. Move the robot in the desired direction using the Space Mouse.

4.14.10 Incremental jogging

Description Incremental jogging makes it possible to move the robot a defined distance, 
e.g. 10 mm or 3°. The robot then stops by itself.

Incremental jogging can be activated for jogging with the jog keys. Incremental 
jogging is not possible in the case of jogging with the Space Mouse.

Areas of application:

 Positioning of equidistant points

 Moving a defined distance away from a position, e.g. in the event of a fault

 Mastering with the dial gauge

The following options are available:

Increments in mm:

 Valid for Cartesian jogging in the X, Y or Z direction.

Increments in degrees:

 Valid for Cartesian jogging in the A, B or C direction.

 Valid for axis-specific jogging.

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

Procedure 1. Select the size of the increment in the status bar.

2. Jog the robot using the jog keys. Jogging can be Cartesian or axis-specif-
ic.

The position of the robot during jogging can be displayed: select Dis-
play > Actual position in the main menu.

Setting Description

Continuous Incremental jogging is deactivated.

100 mm / 10° 1 increment = 100 mm or 10°

10 mm / 3° 1 increment = 10 mm or 3°

1 mm / 1° 1 increment = 1 mm or 1°

0.1 mm / 0.005° 1 increment = 0.1 mm or 0.005°
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Once the set increment has been reached, the robot stops.

If the robot motion is interrupted, e.g. by releasing the enabling switch, the in-
terrupted increment is not resumed with the next motion; a new increment is 
started instead.

4.15 Jogging external axes

External axes cannot be moved using the Space Mouse. If “Space Mouse” 
mode is selected, only the robot can be jogged with the Space Mouse. The ex-
ternal axes, on the other hand, must be jogged using the jog keys.

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

Procedure 1. Select the desired kinematics group, e.g. External axes, on the Keys tab 
in the Jog options window.

The type and number of kinematics groups available depend on the sys-
tem configuration.

2. Set jog override.

3. Hold down the enabling switch.

The axes of the selected kinematics group are displayed next to the jog 
keys.

4. Press the Plus or Minus jog key to move an axis in the positive or negative 
direction.

Description Depending on the system configuration, the following kinematics groups may 
be available.

4.16 Bypassing workspace monitoring

Description Workspaces can be configured for a robot. Workspaces serve to protect the 
system.

There are 2 types of workspace:

 The workspace is an exclusion zone.

The robot may only move outside the workspace.

 Only the workspace is a permitted zone.

The robot may not move outside the workspace.

Kinematics group Description

Robot Axes The robot axes can be moved using the jog keys. 
The external axes cannot be jogged.

External Axes All configured external axes (e.g. external axes 
E1 to E5) can be moved using the jog keys.

NAME / 

External Kinematics 
Groupn

The axes of an external kinematics group can be 
moved using the jog keys.

The name is taken from the system variable 
$ETn_NAME (n = number of the external kinemat-
ic system). If $ETn_NAME is empty, the default 
name External Kinematics Groupn is dis-
played.

[User-defined kinemat-
ics group]

The axes of a user-defined kinematics group can 
be moved using the jog keys.

The name corresponds to the name of the user-
defined kinematics group.
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Exactly what reactions occur when the robot violates a workspace depends on 
the configuration.  (>>> 6.11 "Configuring workspaces" Page 171)

One possible reaction, for example, is that the robot stops and an error mes-
sage is generated. The workspace monitoring must be bypassed in such a 
case. The robot can then move back out of the prohibited workspace.

Precondition  User group “Expert”

 Operating mode T1

Procedure 1. In the main menu, select Configuration > Miscellaneous > Workspace 
monitoring > Override.

2. Move the robot manually out of the prohibited workspace.

Once the robot has left the prohibited workspace, the workspace monitor-
ing is automatically active again.

4.17 Display functions

4.17.1 Measuring and displaying energy consumption

Description The overall energy consumption of the robot and robot controller can be dis-
played on the smartHMI. A prerequisite for this is that measurement of energy 
consumption is possible for the robot type used. 

The energy consumption of optional robot controller components (e.g. US1, 
US2, etc.) and of other controllers is not taken into consideration. It is always 
the consumption for the last 60 minutes since the most recent cold start that is 
displayed. Furthermore, the user has the option of starting and stopping mea-
surements manually.

Traces can be made for the consumption values. The predefined configuration 
Tracedef_KRC_EnergyCalc is available for this.

The data can also be transferred to a higher-level controller by means of PRO-
FIenergy. PROFIenergy is a component of KR C4 PROFINET.

There are two ways of starting and stopping measurements:

 In the Energy consumption window  (>>> Fig. 4-24 )

 Via KRL

Precondition  Measurement of energy consumption is possible for the robot type used. 

If not, the boxes in the Energy consumption window are grayed out.

Procedure Starting and stopping a measurement in the Energy consumption window:

1. In the main menu, select Display > Energy consumption. The Energy 
consumption window opens.

2. If required, activate the check box Refresh.

3. Press Start measuring. A red dot to the right of the top line now indicates 
that a measurement is in progress.

4. To stop the measurement, press Stop measurement. The result is dis-
played.

Starting and stopping a measurement via KRL:

1. Start the measurement via $ENERGY_MEASURING.ACTIVE = TRUE 
(possible via the KRL program or variable correction function). The mea-
surement starts.

2. In the main menu, select Display > Energy consumption. The Energy 
consumption window opens. A red dot to the right of the top line indicates 
the measurement that is in progress.
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3. If required, activate the check box Refresh.

4. Stop the measurement by means of $ENERGY_MEASURING.ACTIVE = 
FALSE. 

The Energy consumption window can also be opened independently of the 
measurement. The top line always indicates the result of the active or most re-
cent measurement.

Measurement 

properties

 A measurement that has been started runs until it is stopped. This is not 
dependent on whether the Energy consumption window is open or 
closed.

 A measurement that has been started via KRL can be stopped via KRL or 
via the Stop measurement button.

 A measurement that has been started by means of Start measuring can 
only be stopped by means of Stop measurement as long as the Energy 
consumption window remains open. If an attempt is made to stop the 
measurement via KRL, the robot controller displays the following mes-
sage: Energy measurement cannot currently be stopped.

Once the Energy consumption window has been closed again, the mea-
surement can also be stopped via KRL. This prevents a measurement 
started in the Energy consumption window from permanently blocking 
measurements via KRL.

 It is not possible to start a measurement while a measurement is already 
active. In this case, the robot controller displays the following message: An 
energy measurement is already active.. The active measurement must be 
stopped first.

“Energy 

consumption” 

window

Fig. 4-24: Energy consumption window

Item Description

1 Results of the measurements started by the user

The last 3 results are displayed. The most recent result is dis-
played in the top line. If a measurement is currently active, this is 
indicated by means of a red dot to the right of the line.

2 Energy consumption for the last 60 minutes since the most recent 
cold start

3 Starts a measurement. 

Start measuring is not available if a measurement is currently 
active.
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4.17.2 Displaying the actual position

Procedure 1. In the main menu, select Display > Actual position. The Cartesian actual 
position is displayed.

2. To display the axis-specific actual position, press Axis-specific.

3. To display the Cartesian actual position again, press Cartesian.

Description Actual position, Cartesian:

The current position (X, Y, Z) and orientation (A, B, C) of the TCP are dis-
played. Status and Turn are also displayed.

Actual position, axis-specific:

The current position of axes A1 to A6 is indicated. If external axes are being 
used, the position of the external axes is also displayed.

The actual position can also be displayed while the robot is moving.

4.17.3 Displaying digital inputs/outputs

Procedure 1. In the main menu, select Display > Inputs/outputs > Digital I/O.

2. To display a specific input/output:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the input/output with this number.

4 Stops an active measurement. 

How the measurement was started (by means of Start measuring 
or via KRL) is irrelevant.

5  Check box active: While a measurement is being carried out, 
the result display is continually refreshed.

 Check box not active: While a measurement is being carried 
out, the most recently refreshed value is displayed. The result 
is not displayed until the measurement is stopped.

Item Description

Fig. 4-25: Actual position, axis-specific
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Description

The following buttons are available:

Fig. 4-26: Digital inputs

Fig. 4-27: Digital outputs

Item Description

1 Input/output number

2 Value of the input/output. The icon is red if the input or output is 
TRUE.

3 SIM entry: The input/output is simulated.

SYS entry: The value of the input/output is saved in a system vari-
able. This input/output is write-protected.

4 Name of the input/output

Button Description

-100 Toggles back 100 inputs or outputs in the display.

+100 Toggles forward 100 inputs or outputs in the dis-
play.

Go to The number of the input or output being searched 
for can be entered.
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4.17.4 Displaying analog inputs/outputs

Procedure 1. In the main menu, select Display > Inputs/outputs > Analog I/O.

2. To display a specific input/output:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the input/output with this number.

The following buttons are available:

4.17.5 Displaying inputs/outputs for Automatic External

Procedure  In the main menu, select Display > Inputs/outputs > Automatic Exter-
nal.

Description

Value Toggles the selected input/output between TRUE 
and FALSE. Precondition: The enabling switch is 
pressed.

This button is not available in AUT EXT mode, 
and is only available for inputs if simulation is ac-
tivated.

Name The name of the selected input or output can be 
changed.

Button Description

Button Description

Go to The number of the input or output being searched 
for can be entered.

Voltage A voltage can be entered for the selected output.

 -10 … 10 V

This button is only available for outputs.

Name The name of the selected input or output can be 
changed.

Fig. 4-28: Automatic External inputs (detail view)
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Columns 4, 5 and 6 are only displayed if Details has been pressed.

The following buttons are available:

4.17.6 Displaying and modifying the value of a variable

This function is also called “variable correction”.

Precondition To modify a variable:

 “Expert” user group

Procedure 1. In the main menu, select Display > Variable > Single.

The Variable display – Single window opens.

2. Enter the name of the variable in the Name box and confirm with the Enter 
key.

3. If a program has been selected, it is automatically entered in the Module 
box.

If a variable from a different program is to be displayed, enter the program 
as follows:

/R1/Program name

Fig. 4-29: Automatic External outputs (detail view)

Item Description

1 Number

2 Status

 Gray: inactive (FALSE)

 Red: active (TRUE)

3 Long text name of the input/output

4 Type

 Green: input/output

 Yellow: variable or system variable ($...)

5 Name of the signal or variable

6 Input/output number or channel number

Button Description

Config. Switches to the configuration of the Automatic 
External interface.  (>>> 6.17.2 "Configuring Au-
tomatic External inputs/outputs" Page 191)

Inputs/Outputs Toggles between the windows for inputs and out-
puts.

Details/Normal Toggles between the Details and Normal views. 
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 Do not specify a folder between /R1/ and the program name. Do not 
add a file extension to the file name.

 In the case of system variables, no program needs to be specified in 
the Module box.

4. The current value of the variable is displayed in the Current value box. If 
nothing is displayed, no value has yet been assigned to the variable.

To modify the variable:

5. Enter the desired value in the New value box.

6. Press the Set value button. The new value is displayed in the Current val-
ue box.

Description

4.17.7 Displaying the state of a variable

Description Variables can have the following states:

 UNKNOWN: The variable is unknown.

 DECLARED: The variable is declared.

 INITIALIZED: The variable is initialized.

Procedure 1. In the main menu, select Display > Variable > Single.

The Variable display - Single window is opened.

2. In the Name box, enter: =VARSTATE("name")

name = name of the variable whose state is to be displayed.

3. If a program has been selected, it is automatically entered in the Module 
box.

Fig. 4-30: Variable Overview - Single window

Item Description

1 Name of the variable to be modified.

2 New value to be assigned to the variable.

3 Program in which the search for the variable is to be carried out.

In the case of system variables, the Module box is irrelevant.

4 This box has two states:

 : The displayed value is not refreshed automatically.

 : The displayed value is refreshed automatically.

Switching between the states:

 Press Refresh.
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If a variable from a different program is to be displayed, enter the program 
as follows:

/R1/Program name

 Do not specify a folder between /R1/ and the program name. Do not 
add a file extension to the file name.

 In the case of system variables, no program needs to be specified in 
the Module box.

4. Press Update.

The current state of the variable is displayed in the Current value box.

4.17.8 Displaying the variable overview and modifying variables

In the variable overview, variables are displayed in groups. The variables can 
be modified.

The number of groups and which variables they contain are defined in the con-
figuration. By default, the variable overview is empty.

 (>>> 6.8 "Configuring the variable overview" Page 168)

Procedure 1. In the main menu, select Display > Variable > Overview > Display.

The Variable overview – Display window is opened.

2. Select the desired group.

3. Select the cell to be modified. Carry out modification using the buttons.

4. Press OK to save the change and close the window.

Description

Variables can only be displayed and modified in the user group “User” 
if these functions have been enabled in the configuration.

Fig. 4-31: Variable overview - Monitor window

Item Description

1
Arrow symbol : If the value of the variable changes, the display 
is automatically refreshed.

No arrow symbol: The display is not automatically refreshed.

2 Descriptive name
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The following buttons are available:

4.17.9 Displaying cyclical flags

Procedure 1. In the main menu, select Display > Variable > Cyclical flags. The Cycli-
cal flags window is opened.

2. To display a specific flag:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the flag with this number.

3 Value of the variable. In the case of inputs/outputs, the state is in-
dicated:

 Gray: inactive (FALSE)

 Red: active (TRUE)

4 There is one tab per group.

Button Description

Config. Switches to the configuration of the variable over-
view.

 (>>> 6.8 "Configuring the variable overview" 
Page 168)

This button is not available in the user group “Us-
er”.

Refresh all Refreshes the display.

Cancel info Deactivates the automatic refreshing function.

Start info Activates the automatic refreshing function.

A maximum of 12 variables per group can be re-
freshed automatically.

Edit Switches the current cell to edit mode so that the 
name or value can be modified. In the Value col-
umn, this button changes the state of inputs/out-
puts (TRUE/FALSE).

This button is only available in the user group 
“User” if it has been enabled in the configuration.

Note: The values of write-protected variables 
cannot be changed.

Item Description
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Description

The following buttons are available:

4.17.10 Displaying flags

Procedure 1. In the main menu, select Display > Variable > Flags. The Flags window 
is opened.

2. To display a specific flag:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the flag with this number.

Fig. 4-32: Cyclical flags

Item Description

1 Number of the flag

2 Value of the flag. The icon is red if a flag is set.

3 Name of the flag

4 The conditions linked to the setting of a cyclical flag are indicated 
here.

Button Description

-100 Toggles back 100 flags in the display.

+100 Toggles forward 100 flags in the display.

Go to The number of the flag being searched for can be 
entered.

Name The name of the selected flag can be modified.
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Description

The following buttons are available:

4.17.11 Displaying counters

Procedure 1. In the main menu, select Display > Variable > Counter. The Counter 
window is opened.

2. To display a specific counter:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the counter with this number.

Fig. 4-33: Flags

Item Description

1 Number of the flag

2 Value of the flag. The icon is red if a flag is set.

3 Name of the flag

Button Description

-100 Toggles back 100 flags in the display.

+100 Toggles forward 100 flags in the display.

Go to The number of the flag being searched for can be 
entered.

Value Toggles the selected flag between TRUE and 
FALSE. Precondition: The enabling switch is 
pressed.

This button is not available in AUT EXT mode.

Name The name of the selected flag can be modified.
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Description

The following buttons are available:

4.17.12 Displaying timers

Procedure 1. In the main menu, select Display > Variable > Timer. The Timer window 
is opened.

2. To display a specific timer:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the timer with this number.

Fig. 4-34: Counter

Item Description

1 Counter number

4 Value of the counter.

5 Name of counter

Button Description

Go to The number of the counter being searched for 
can be entered.

Value A value can be entered for the selected counter.

Name The name of the selected counter can be modi-
fied.
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Description

The following buttons are available:

4.17.13 Displaying calibration data

Procedure 1. In the main menu, select Start-up > Calibrate > Calibration points and 
the desired menu item:

 Tool type

 Base type

 External axis

2. Enter the number of the tool, base or external kinematic system.

The calibration method and the calibration data are displayed.

Fig. 4-35: Timer

Item Description

1 Number of the timer

2 Status of the timer

 If the timer is activated, this is indicated in green.

 If the timer is deactivated, this is indicated in red.

3 State of the timer

 If the value of the timer is > 0, the timer flag is set (red check 
mark).

 If the value of the timer is ≤ 0, no timer flag is set.

4 Value of the timer (unit: ms)

5 Name of timer

Button Description

Go to The number of the timer being searched for can 
be entered.

State Toggles the selected timer between TRUE and 
FALSE. Precondition: The enabling switch is 
pressed.

Value A value can be entered for the selected timer.

Name The name of the selected timer can be modified.
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4.17.14 Displaying information about the robot and robot controller

Procedure  In the main menu, select Help > Info.

Description The information is required, for example, when requesting help from KUKA 
Customer Support.

The tabs contain the following information:

4.17.15 Displaying/editing robot data

Precondition  T1 or T2 operating mode

 No program is selected.

Procedure  In the main menu, select Start-up > Robot data.

Tab Description

Info  Robot controller type

 Robot controller version

 User interface version

 Kernel system version

Robot  Robot name

 Robot type and configuration

 Service life

The operating hours meter is running as long as the 
drives are switched on. Alternatively, the operating 
hours can also be displayed via the variable $ROB-
RUNTIME.

 Number of axes

 List of external axes

 Machine data version

System  Control PC name

 Operating system version

 Storage capacities

Options Additionally installed options and technology packages

Comments Additional comments

Modules Names and versions of important system files

The Export button exports the contents of the Mod-
ules tab to the file C:\KRC\ROBOTER\LOG\FILEVER-
SIONS.TXT.
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Description

The following buttons are available in the user group “Expert”:

Fig. 4-36: Robot data window

Item Description

1 Serial number

2 Operating hours. The operating hours meter is running as long as 
the drives are switched on. Alternatively, the operating hours can 
also be displayed via the variable $ROBRUNTIME.

3 Machine data name

4 Robot name. The robot name can be changed.

5 Robot controller data can be archived. The target directory can be 
defined here. It can be a network directory or a local directory.

If a directory is defined here, it is also available for importing/ex-
porting long texts.

6 If archiving to the network requires a user name and password, 
these can be entered here. It is then no longer necessary to enter 
them every time for archiving.

7

8 This box is only displayed if the check box Incorporate robot 
name into
archive name. is not activated.

A name for the archive file can be defined here.

9  Check box active: The robot name is used as the name for the 
archive file. If no robot name is defined, the name archive is 
used.

 Check box not active: A separate name can be defined for 
the archive file.
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4.18 Displaying the battery state

Description If the voltage is switched off (i.e. via the main switch) or in the event of power 
failure, the robot controller is backed up by a battery and is shut down in a con-
trolled manner (without loss of data). The battery charge can be displayed for 
the user. The user can also transfer it to the PLC.

The battery charge is displayed by means of the system variable 
$ACCU_STATE.

The state can only be displayed and not modified.

The charging current characteristic is monitored every time the robot controller 
is booted. An additional battery test is carried out cyclically. The state indicated 
by $ACCU_STATE is derived from the information regarding the charging cur-
rent and the battery test.

States The following tables indicate the possible states of $ACCU_STATE.

The user must configure the info to the PLC himself.

Button Description

Transfer PID>>RDC Only relevant for positionally accurate robots: the XML file with 
the data for the positionally accurate robot can be transferred 
manually to the RDC.

Pressing this button displays the directory structure. The directo-
ry containing the file with the current serial number is selected 
here. The file can be selected and transferred to the RDC.

Transfer MAM>>RDC Only relevant for robots with fixed mastering marks: the MAM file 
with the robot-specific mastering offset data can be transferred 
manually to the RDC.

Pressing this button displays the directory structure. The directo-
ry containing the file with the current serial number is selected 
here. The file can be selected and transferred to the RDC.

Transfer CAL>>RDC The CAL file with the EMD mastering data can be transferred 
manually to the RDC.

Pressing this button displays the directory structure. The directo-
ry containing the file with the current serial number is selected 
here. The file can be selected and transferred to the RDC.

Save RDC data The data on the RDC can be backed up temporarily in the direc-
tory C:\KRC\Roboter\RDC by pressing this button.

Note: The directory is deleted when the robot controller is re-
booted or data are archived. If the RDC data are to be retained 
permanently, they must be backed up elsewhere.

Information about exchanging the battery can be found in the operat-
ing instructions for the robot controller.

#CHARGE_OK

Meaning: The charging current dropped as required after booting and/or 
the battery tested positive in the battery test.

Action required by the user: Do not exchange the battery.

Info to PLC: Supply voltage disconnection OK.

Message: No message.
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#CHARGE_OK_LOW

Meaning: The charging current dropped as required after booting and/or 
the battery tested positive in the battery test. The battery is not fully 
charged, however, after the maximum charging time.

Action required by the user: Exchange the battery.

Info to PLC: Supply voltage disconnection OK.

Message: Battery warning - full charge not possible

#CHARGE_UNKNOWN

Meaning: The battery is being charged. Or the battery has not yet been 
checked since the controller was booted. Or the charging current has not 
yet dropped sufficiently.

Action required by the user: Do not exchange the battery.

Info to PLC: Supply voltage disconnection can cause errors in Hibernate 
mode.

Message:  No message

#CHARGE_TEST_NOK

Meaning: The result of the battery test was negative.

Action required by the user: Exchange the battery.

Info to PLC: Supply voltage disconnection can cause errors in Hibernate 
mode.

Message: Battery defective - load test failed

#CHARGE_NOK

Meaning: No battery test possible. The battery is not fully charged after 
the maximum charging time.

Action required by the user: Exchange the battery.

Info to PLC: Supply voltage disconnection can cause errors in the case of 
a warm start.

Message: Battery defective - reliable backup cannot be assured

#CHARGE_OFF

Meaning: There is no battery present or the battery is defective.

Action required by the user: Exchange the battery.

Info to PLC: Supply voltage disconnection can cause errors in the case of 
a warm start.

Message: Battery defective - backup not possible
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5 Start-up and recommissioning
5 Start-up and recommissioning

5.1 Start-up wizard

Description Start-up can be carried out using the Start-up wizard. This guides the user 
through the basic start-up steps.

Precondition  No program is selected.

 Operating mode T1

Procedure  Select Start-up > Start-up wizard in the main menu.

5.2 Checking the machine data

Description The correct machine data must be loaded. This must be checked by compar-
ing the loaded machine data with the machine data on the rating plate.

If machine data are reloaded, the version of the machine data must corre-
spond exactly to the KSS version. This is ensured if the machine data supplied 
together with the KSS release are used.

The file path of the machine data on the CD is specified on the rating plate in 
the line ...\MADA\.

Precondition  T1 or T2 operating mode

 No program is selected.

Procedure 1. In the main menu, select Start-up > Robot data.

The Robot data window is opened.

2. Compare the following entries:

 In the Robot data window: the entry in the Machine data box

 

t

t

 

 

The industrial robot must not be moved if incorrect ma-
chine data are loaded. Death, severe injuries or consid-

erable damage to property may otherwise result. The correct machine data 
must be loaded.

Fig. 5-1: Rating plate
95 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



96 / 491

KUKA System Software 8.3
 On the rating plate on the base of the robot: the entry in the line $TRA-
FONAME()=“# ..... ”

5.3 Defining hardware options

Precondition  User group “Safety recovery”

 Operating mode T1 or T2

Procedure 1. In the main menu, select Configuration > Safety configuration.

2. Press Hardware options.

3. Modify hardware options and press Save.

Description

5.4 Changing the safety ID of the PROFINET device

Description If multiple KUKA robot controllers are operated with a single PROFIsafe mas-
ter PLC, each PROFINET device must have a unique safety ID. The default 
ID is always 7.

Precondition  User group “Safety recovery”

 Operating mode T1 or T2

Following modifications to the safety configuration, the 
safe axis monitoring functions must be checked.

 (>>> 6.4 "Checking safe axis monitoring functions" Page 165)

Parameter Description

Customer interface Select here which interface is used:

 Automatic

 SIB with operating mode output

Input signal for 
peripheral contactor 
(US2)

 Deactivated: The peripheral contactor is not used. (Default)

 By external PLC: The peripheral contactor is switched by an exter-
nal PLC via input US2.

 By KRC: The peripheral contactor is switched in accordance with the 
motion enable. If motion enable is present, the contactor is ener-
gized.

Notes:

 For robot controllers with peripheral contactors and the “UL” option, 
this parameter must be set to By KRC.

 For robot controllers with no peripheral contactors, this parameter 
has no effect. 

The system variable $US2_VOLTAGE_ON indicates the status of the 
peripheral voltage US2:

 TRUE: Voltage is switched on.

 FALSE: Voltage is switched off.

Operator safety 
acknowledgement

If the “Operator Safety” signal is lost and set again in Automatic mode, it 
must be acknowledged before operation can be continued.

 By acknowledgement button: Acknowledgement is given e.g. by 
an acknowledgement button (situated outside the cell). Acknowl-
edgement is communicated to the safety controller. The safety con-
troller re-enables automatic operation only after acknowledgement.

 External unit: Acknowledgement is given by the system PLC.
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Procedure 1. In the main menu, select Configuration > Safety configuration.

2. Press Communication parameters.

3. In the column New safety ID, press the ID to be modified and change the 
ID.

4. Press Apply safety IDs.

5. A request for confirmation is displayed, asking if the change should be 
saved. Confirm the request with Yes.

6. A message is displayed, indicating that the change has been saved. Con-
firm the message with OK.

5.5 Jogging the robot without a higher-level safety controller

Description To jog the robot without a higher-level safety controller, Start-up mode must 
first be activated. The robot can then be jogged in T1 mode. 

If the RoboTeam option is used, it is only possible to activate Start-up mode 
and jog the robot using the local smartPAD.

The robot controller automatically deactivates Start-up mode in the following 
cases:

 If no operator action has been carried out within 30 min of activation.

 If the smartPAD is switched to passive mode or disconnected from the ro-
bot controller.

 If the Ethernet safety interface is used: when a connection to a higher-level 
safety controller is established.

If one of the options KUKA.SafeOperation or KUKA.SafeRangeMon-
itoring is installed on the robot controller, different user groups may 
apply. Information can be found in the documentation for these op-

tions.

This procedure can only be used to save changes to the safety ID. If 
other unsaved changes have been made elsewhere in the safety con-
figuration, these are not saved here. 

If an attempt is now made to close the safety configuration, a query is gener-
ated asking whether you wish to reject the changes or cancel the action. To 
save the changes, proceed as follows:

1. Cancel the action.

2. In the safety configuration, press Save. (If the Save button is not avail-
able, first go back a level by pressing Back.)

3. A request for confirmation is displayed, asking if all the changes should 
be saved. Confirm the request with Yes.

4. A message is displayed, indicating that the change has been saved. Con-
firm the message with OK.

All changes in the safety configuration are saved.

Following modifications to the safety configuration, the 
safe axis monitoring functions must be checked.

 (>>> 6.4 "Checking safe axis monitoring functions" Page 165)

External safeguards are disabled in Start-up mode. Ob-
serve the safety instructions relating to Start-up mode.

 (>>> 3.8.3.2 "Start-up mode" Page 38)
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 If a discrete safety interface is used:

System Software 8.2 or earlier: The robot controller automatically deacti-
vates Start-up mode if it is no longer the case that all input signals at the 
discrete interface (and, if used, at the discrete safety interface for safety 
options) have the state “logic zero”. 

From System Software 8.3 onwards, on the other hand, Start-up mode is 
not dependent on the inputs at the discrete safety interfaces.

Effect When the Start-up mode is activated, all outputs are automatically set to the 
state “logic zero”. 

If the robot controller has a peripheral contactor (US2), and if the safety con-
figuration specifies for this to switch in accordance with the motion enable, 
then the same also applies in Start-up mode. This means that if motion enable 
is present, the US2 voltage is switched on – even in Start-up mode.

In Start-up mode, the system switches to the following simulated input image:

 The external EMERGENCY STOP is not active.

 The safety gate is open.

 No safety stop 1 has been requested.

 No safety stop 2 has been requested.

 No safe operational stop has been requested.

 Only for VKR C4: E2 is closed.

If SafeOperation or SafeRangeMonitoring is used, Start-up mode also influ-
ences other signals.

Precondition  Operating mode T1

 In the case of VKR C4: no E2/E7 signals are activated via a USB stick or 
retrofit interface.

 In the case of RoboTeam: the local smartPAD is used.

 If the Ethernet safety interface is used: No connection to a higher-level 
safety controller

 If a discrete safety interface is used: 

For System Software 8.2 only: all input signals have the state “logic zero”. 
If the additional discrete safety interface for safety options is used, the in-
puts there must also have the state “logic zero”.

(From System Software 8.3 onwards, Start-up mode is not dependent on 
the state of these inputs.)

Procedure  In the main menu, select Start-up > Service > Start-up mode.

Information about the effects of Start-up mode in conjunction with Sa-
feOperation or SafeRangeMonitoring can be found in the documen-
tation SafeOperation and SafeRangeMonitoring.

Menu Description

Start-up mode is active. Touching 
the menu item deactivates the 
mode.

Start-up mode is not active. Touch-
ing the menu item activates the 
mode.
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5.6 Checking the activation of the positionally accurate robot model

Description If a positionally accurate robot is used, it must be checked that the positionally 
accurate robot model is activated.

In the case of positionally accurate robots, position deviations resulting from 
workpiece tolerances and elastic effects of the individual robots are compen-
sated for. The positionally accurate robot positions the programmed TCP any-
where in the Cartesian workspace within the tolerance limits. The model 
parameters of the positionally accurate robot are determined at a calibration 
station and permanently saved on the robot (RDC).

Functions A positionally accurate robot has the following functions:

 Increased positioning accuracy, approximately by the factor 10

 Increased path accuracy

 Simplified transfer of programs if the robot is exchanged (no reteaching)

 Simplified transfer of programs after offline programming with WorkVisual 
(no reteaching)

Procedure 1. In the main menu, select Help > Info.

2. Check on the Robot tab that the positionally accurate robot model is acti-
vated. (= specification Positionally accurate robot).

5.7 Activating palletizing mode

Description

In the case of palletizing robots with 6 axes, palletizing mode is deactivated by 
default and must be activated. When palletizing mode is active, A4 is locked 
at 0° and the mounting flange is parallel to the floor.

Precondition  The robot is mastered.

 There is no load on the robot; i.e. there is no tool, workpiece or supplemen-
tary load mounted.

Procedure  Activate palletizing mode in the program as follows:

Alternative 

procedure

1. Set $PAL_MODE to TRUE via the variable correction function.

2. The following message is displayed: Palletizing mode: Move axis A4 [direction] 
into position.

Move A4 in the direction specified in the message (plus or minus).

3. Once A4 has reached its position (0°), the following message is displayed: 
Palletizing mode: Move axis A5 [direction] into position.

Move A5 in the direction specified in the message (plus or minus).

Once A5 has reached its position (90°), the message disappears. 

The positionally accurate robot model is only valid for the robot as de-
livered.
Following conversion or retrofitting of the robot, e.g. with an arm ex-

tension or a new wrist, the robot must be recalibrated.

A precondition for the increased positioning and path accuracy is the 
correct input of the load data into the robot controller.

Only relevant for palletizing robots with 6 axes!

$PAL_MODE = TRUE
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The labels A4 and A5 next to the jog keys now disappear. These axes can no 
longer be jogged.

Restrictions  After every cold restart of the robot controller, $PAL_MODE is automati-
cally set to FALSE.

 In the case of robots with palletizing mode active, payload determination 
with KUKA.LoadDataDetermination is not possible.

 If palletizing mode is active, the robot cannot be mastered. If mastering is 
nonetheless required, proceed as follows:

a. Remove all loads from the robot.

b. Set $PAL_MODE to FALSE via the variable correction function.

c. Master the robot.

d. Set $PAL_MODE to TRUE.

(Not necessary if $PAL_MODE = TRUE is in the initialization section 
of all programs for the palletizing robot.)

e. Move the robot to the palletizing position.

f. Re-attach all loads to the robot.

5.8 Mastering

Overview Every robot must be mastered. Only if the robot has been mastered can it 
move to programmed positions and be moved using Cartesian coordinates. 
During mastering, the mechanical position and the electronic position of the ro-
bot are aligned. For this purpose, the robot is moved to a defined mechanical 
position, the mastering position. The encoder value for each axis is then 
saved.

The mastering position is similar, but not identical, for all robots. The exact po-
sitions may even vary between individual robots of a single robot type.

Recommendation: Integrate $PAL_MODE = TRUE into the initializa-
tion section of all programs for the palletizing robot.

In the case of robots with palletizing mode active, pay-
load determination with KUKA.LoadDataDetermination 

must not be carried out. Injuries or damage to property may result.
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A robot must be mastered in the following cases:

5.8.1 Mastering methods

Overview The mastering methods that can be used for a robot depend on the type of 
gauge cartridge with which it is equipped. The types differ in terms of the size 
of their protective caps.

Fig. 5-2: Mastering position – approximate position

Case Comments

During commissioning - - -

After maintenance work during 
which the robot loses its mastering, 
e.g. exchange of motor or RDC

 (>>> 5.8.8 "Reference mastering" 
Page 113)

When the robot has been moved 
without the robot controller (e.g. 
with the release device)

- - -

After exchanging a gear unit Before carrying out a new master-
ing procedure, the old mastering 
data must first be deleted! Master-
ing data are deleted by manually 
unmastering the axes.

 (>>> 5.8.10 "Manually unmastering 
axes" Page 121)

After an impact with an end stop at 
more than 250 mm/s

After a collision.
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SEMD/MEMD SEMD and/or MEMD are contained in the KUKA mastering kit. There are sev-
eral variants of the mastering kit. 

The thinner cable is the signal cable. It connects the SEMD or MEMD to the 
mastering box.

The thicker cable is the EtherCAT cable. It is connected to the mastering box 
and to the robot at X32.

Type of gauge cartridge Mastering methods

Gauge cartridge for SEMD

(Standard Electronic Master-
ing Device)

Protective cap with fine 
thread, M20

Mastering with the probe, type SEMD

 (>>> 5.8.5 "Mastering with the SEMD" 
Page 106)

Mastering with the dial gauge

 (>>> 5.8.6 "Mastering with the dial 
gauge" Page 112)

Reference mastering

Only for mastering after certain mainte-
nance work

 (>>> 5.8.8 "Reference mastering" 
Page 113)

Gauge cartridge for MEMD

(Micro Electronic Mastering 
Device)

Protective cap with fine 
thread, M8

Mastering with the probe, type MEMD

On A6 in certain cases: mastering to the 
mark

 (>>> 5.8.9 "Mastering with the MEMD 
and mark" Page 114)

Fig. 5-3: Mastering kit with SEMD and MEMD

1 Mastering box 4 SEMD

2 Screwdriver for MEMD 5 Cables

3 MEMD
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5.8.2 Moving axes to the pre-mastering position using mastering marks

Description The axes must be moved to the pre-mastering position before every mastering 
operation. To do so, each axis is moved so that the mastering marks line up.

The following figure shows where on the robot the mastering marks are situ-
ated. Depending on the specific robot model, the positions may deviate slightly 
from those illustrated.

Leave the signal cable connected to the mastering box 
and disconnect it as little as possible. The pluggability of 

the M8 sensor connector is limited. Frequent connection/disconnection 
can result in damage to the connector.

 In the case of probes to which the signal cable is not permanently at-
tached, always screw the device onto the gauge cartridge without the sig-
nal cable. Only then may the cable be attached to the device. Otherwise, 
the cable could be damaged. Similarly, when removing the device, the 
signal cable must always be removed from the device first. Only then 
may the device be removed from the gauge cartridge.

 After mastering, remove the EtherCAT cable from connection X32. Fail-
ure to do so may result in interference signals or damage.

Fig. 5-4: Moving an axis to the pre-mastering position

In some cases it is not possible to align the axes using the mastering 
marks, e.g. because the marks can no longer be recognized due to 
fouling. The axes can also be mastered using the probe instead of the 

mastering marks.
 (>>> 5.8.3 "Moving axes to the pre-mastering position using the probe" 
Page 104)
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Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

Procedure 1. Select Axes as the coordinate system for the jog keys.

2. Press and hold down the enabling switch.

Axes A1 to A6 are displayed next to the jog keys.

3. Press the plus or minus jog key to move an axis in the positive or negative 
direction.

4. Move each axis, starting from A1 and working upwards, so that the mas-
tering marks line up. (An exception is made for A6 of robots for which this 
axis is mastered using the mark.)

5.8.3 Moving axes to the pre-mastering position using the probe

Description The axes must be moved to the pre-mastering position before every mastering 
operation. This is generally done using the mastering marks. 

It is sometimes not possible, however, e.g. because the marks can no longer 
be recognized due to fouling. The axes can also be mastered using the probe 
instead of the mastering marks. An LED on the smartHMI indicates when the 
pre-mastering position has been reached.

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

 No program is selected.

 The user knows the approximate pre-mastering position of the axes.

Fig. 5-5: Mastering marks on the robot

Before A4 and A6 are moved to the pre-mastering posi-
tion, ensure that the energy supply system – if present – 

is in its correct position and not rotated through 360°.
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Procedure 1. Jog the robot to a position in which the axes are close to their pre-master-
ing position. It should subsequently be possible to move them in the minus 
direction to the pre-mastering position. 

2. In the main menu, select Start-up > Master > EMD > With load correc-
tion.

Depending on the method for which the axes are to be aligned, the option 
First mastering or Teach offset or With offset is now selected.

3. Proceed in accordance with the instructions for the relevant mastering pro-
cedure until the probe is attached to A1 and connected via the mastering 
box to X32.

4. The LED EMD in mastering range is displayed on the smartHMI. It must 
now be red. Observe this LED closely. 

 (>>> 5.8.4 "Mastering LEDs" Page 105)

5. Jog the robot in the minus direction. As soon as the LED switches from red 
to green, stop the robot.

A1 is now in the pre-mastering position.

6. Remove the probe from the gauge cartridge as described in the mastering 
procedure and replace the protective cap.

7. Move the remaining axes to the pre-mastering position in the same way in 
ascending order. (An exception is made for A6 of robots for which this axis 
is mastered using the mark.)

8. Close the window containing the mastering LEDs.

9. Disconnect the EtherCAT cable from X32 and the mastering box.

5.8.4 Mastering LEDs

For most mastering operations, the smartHMI displays a list of axes. There are 
2 LEDs to the right of the list. 

Before A4 and A6 are moved to the pre-mastering posi-
tion, ensure that the energy supply system – if present – 

is in its correct position and not rotated through 360°.

Thereafter, do NOT continue to follow the description of the mastering 
procedure! 
i.e. do NOT press Master or Learn or Check!

The axes indicated next to the LEDs do not disappear one after the 
other in the usual way. This does not occur until the actual mastering. 

Do not yet master the axis. The actual mastering operation must not 
be carried out until all axes are in the pre-mastering position. If this is 
not observed, correct mastering cannot be achieved.

Leave the signal cable connected to the mastering box 
and disconnect it as little as possible. The pluggability of 

the M8 sensor connector is limited. Frequent connection/disconnection can 
result in damage to the connector.
105 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



106 / 491

KUKA System Software 8.3
The LED EMD in mastering range can be used to move the axes to the pre-
mastering position with the aid of the probe. The pre-mastering position is 
reached at the moment when the LED changes from red to green during jog-
ging in the minus direction.

 (>>> 5.8.3 "Moving axes to the pre-mastering position using the probe" 
Page 104)

5.8.5 Mastering with the SEMD

Overview In SEMD mastering, the axis is automatically moved by the robot controller to 
the mastering position. Mastering is carried out first without and then with a 
load. It is possible to save mastering data for different loads.

Fig. 5-6: Mastering LEDs

LED Description

Connection to EMD  Red: The probe is not connected to connec-
tion X32. 

 Green: The probe is connected to connection 
X32. 

If this LED is red, the LED EMD in mastering 
range is gray.

EMD in mastering 
range

 Gray: The probe is not connected to connec-
tion X32. 

 Red: The probe is in a position where master-
ing is not possible.

 Green: The probe is either immediately next 
to or in the mastering notch. 

Step Description

1 First mastering

 (>>> 5.8.5.1 "First mastering (with SEMD)" Page 107)

First mastering is carried out without a load.
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5.8.5.1 First mastering (with SEMD)

Precondition  There is no load on the robot; i.e. there is no tool, workpiece or supplemen-
tary load mounted.

 All axes are in the pre-mastering position.

 No program is selected.

 Operating mode T1

Procedure

1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > First mastering.

A window opens. All axes to be mastered are displayed. The axis with the 
lowest number is highlighted.

2. Remove the cover from connection X32.

2 Teach offset

 (>>> 5.8.5.2 "Teach offset (with SEMD)" Page 110)

“Teach offset” is carried out with a load. The difference from 
the first mastering is saved.

3 If required: Master load with offset

 (>>> 5.8.5.3 "Check load mastering with offset (with 
SEMD)" Page 111)

“Load mastering with offset” is carried out with a load for 
which an offset has already been taught.

Area of application:

 Checking first mastering

 Restoring first mastering if it has been lost (e.g. follow-
ing exchange of motor or collision). Since an offset that 
has been taught is retained, even if mastering is lost, the 
robot controller can calculate the first mastering.

Step Description

The SEMD must always be screwed onto the gauge car-
tridge without the signal cable attached. Only then may 

the cable be attached to the SEMD. Otherwise, the cable could be damaged. 
Similarly, when removing the SEMD, the signal cable must always be re-
moved from the SEMD first. Only then may the SEMD be removed from the 
gauge cartridge.
After mastering, remove the EtherCAT cable from connection X32. Failure to 
do so may result in interference signals or damage.

The SEMD actually used need not necessarily look exactly like the 
model illustrated in the figures. The procedure for using it is the same, 
however.
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3. Connect the EtherCAT cable to X32 and to the mastering box.

4. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. (Turned around, the SEMD can be used as a screwdriver.)

5. Screw the SEMD onto the gauge cartridge.

Fig. 5-7: Removing cover from X32

Fig. 5-8: Connecting the EtherCAT cable to X32

Fig. 5-9: Removing protective cap from gauge cartridge
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6. Attach the signal cable to the SEMD. It is possible to see from the cable 
socket which way round it has to be on the connector pins at the SEMD.

7. Connect the signal cable to the mastering box if it is not already connect-
ed.

8. Press Master.

9. Press an enabling switch and the Start key.

When the SEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. The values are 
saved. The axis is no longer displayed in the window.

10. Remove the signal cable from the SEMD. Then remove the SEMD from 
the gauge cartridge and replace the protective cap.

11. Repeat steps 4 to 10 for all axes to be mastered.

12. Close the window.

13. Disconnect the EtherCAT cable from X32 and the mastering box.

Fig. 5-10: Screwing SEMD onto gauge cartridge

Fig. 5-11: Attaching signal cable to SEMD

Leave the signal cable connected to the mastering box 
and disconnect it as little as possible. The pluggability of 

the M8 sensor connector is limited. Frequent connection/disconnection can 
result in damage to the connector.
109 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



110 / 491

KUKA System Software 8.3
5.8.5.2 Teach offset (with SEMD)

Description Teach offset is carried out with a load. The difference from the first mastering 
is saved.

If the robot is operated with different loads, Teach offset must be carried out 
for every load. In the case of grippers used for picking up heavy workpieces, 
Teach offset must be carried out for the gripper both with and without the 
workpiece.

Precondition  Same ambient conditions (temperature, etc.) as for first mastering.

 The load is mounted on the robot.

 All axes are in the pre-mastering position.

 No program is selected.

 Operating mode T1

Procedure

1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > Teach offset.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which the tool has not yet been taught are 
displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32. Connect the EtherCAT cable to 
X32 and to the mastering box.

4. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. (Turned around, the SEMD can be used as a screwdriver.)

5. Screw the SEMD onto the gauge cartridge.

6. Attach the signal cable to the SEMD. It is possible to see from the cable 
socket which way round it has to be on the connector pins at the SEMD.

7. Connect the signal cable to the mastering box if it is not already connect-
ed.

8. Press Learn.

9. Press an enabling switch and the Start key.

When the SEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. A window opens. The 
deviation of this axis from the first mastering is indicated in degrees and 
increments.

10. Confirm with OK. The axis is no longer displayed in the window.

11. Remove the signal cable from the SEMD. Then remove the SEMD from 
the gauge cartridge and replace the protective cap.

12. Repeat steps 4 to 11 for all axes to be mastered.

13. Close the window.

14. Disconnect the EtherCAT cable from X32 and the mastering box.

The SEMD must always be screwed onto the gauge car-
tridge without the signal cable attached. Only then may 

the cable be attached to the SEMD. Otherwise, the cable could be damaged. 
Similarly, when removing the SEMD, the signal cable must always be re-
moved from the SEMD first. Only then may the SEMD be removed from the 
gauge cartridge.
After mastering, remove the EtherCAT cable from connection X32. Failure to 
do so may result in interference signals or damage.

Leave the signal cable connected to the mastering box 
and disconnect it as little as possible. The pluggability of 

the M8 sensor connector is limited. Frequent connection/disconnection can 
result in damage to the connector.
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5.8.5.3 Check load mastering with offset (with SEMD)

Description Area of application:

 Checking first mastering

 Restoring first mastering if it has been lost (e.g. following exchange of mo-
tor or collision). Since an offset that has been taught is retained, even if 
mastering is lost, the robot controller can calculate the first mastering.

An axis can only be checked if all axes with lower numbers have been mas-
tered.

Precondition  Same ambient conditions (temperature, etc.) as for first mastering.

 A load for which Teach offset has been carried out is mounted on the ro-
bot.

 All axes are in the pre-mastering position.

 No program is selected.

 Operating mode T1

Procedure

1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > Load mastering > With offset.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which an offset has been taught with this tool 
are displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32. Connect the EtherCAT cable to 
X32 and to the mastering box.

4. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. (Turned around, the SEMD can be used as a screwdriver.)

5. Screw the SEMD onto the gauge cartridge.

6. Attach the signal cable to the SEMD. It is possible to see from the cable 
socket which way round it has to be on the connector pins at the SEMD.

7. Connect the signal cable to the mastering box if it is not already connect-
ed.

8. Press Check.

9. Hold down an enabling switch and press the Start key.

When the SEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. The difference from 
“Teach offset” is displayed.

10. If required, press Save to save the values. The old mastering values are 
deleted.

To restore a lost first mastering, always save the values.

11. Remove the signal cable from the SEMD. Then remove the SEMD from 
the gauge cartridge and replace the protective cap.

The SEMD must always be screwed onto the gauge car-
tridge without the signal cable attached. Only then may 

the cable be attached to the SEMD. Otherwise, the cable could be damaged. 
Similarly, when removing the SEMD, the signal cable must always be re-
moved from the SEMD first. Only then may the SEMD be removed from the 
gauge cartridge.
After mastering, remove the EtherCAT cable from connection X32. Failure to 
do so may result in interference signals or damage.

Axes A4, A5 and A6 are mechanically coupled. This means:
If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.
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12. Repeat steps 4 to 11 for all axes to be mastered.

13. Close the window.

14. Disconnect the EtherCAT cable from X32 and the mastering box.

5.8.6 Mastering with the dial gauge

Description In dial mastering, the axis is moved manually by the user to the mastering po-
sition. Mastering is always carried out with a load. It is not possible to save 
mastering data for different loads.

Precondition  The load is mounted on the robot.

 All axes are in the pre-mastering position.

 The jog mode “Jog keys” is active and the coordinate system Axis has 
been selected.

 No program is selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > Dial.

A window opens. All axes that have not been mastered are displayed. The 
axis that must be mastered first is selected.

2. Remove the protective cap from the gauge cartridge on this axis and 
mount the dial gauge on the gauge cartridge.

Using the Allen key, loosen the screws on the neck of the dial gauge. Turn 
the dial so that it can be viewed easily. Push the pin of the dial gauge in as 
far as the stop.

Using the Allen key, tighten the screws on the neck of the dial gauge.

3. Reduce jog override to 1%.

4. Jog axis from “+” to “-”. At the lowest position of the reference notch, rec-
ognizable by the change in direction of the pointer, set the dial gauge to 0.

If the axis inadvertently overshoots the lowest position, jog the axis back-
wards and forwards until the lowest position is reached. It is immaterial 
whether the axis is moved from “+” to “-” or from “-” to “+”.

5. Move the axis back to the pre-mastering position.

Leave the signal cable connected to the mastering box 
and disconnect it as little as possible. The pluggability of 

the M8 sensor connector is limited. Frequent connection/disconnection can 
result in damage to the connector.

Fig. 5-12: Dial gauge
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6. Move the axis from “+” to “-” until the pointer is about 5-10 scale divisions 
before zero.

7. Switch to incremental jogging.

8. Move the axis from “+” to “-” until zero is reached.

9. Press Master. The axis that has been mastered is removed from the win-
dow.

10. Remove the dial gauge from the gauge cartridge and replace the protec-
tive cap.

11. Switch back from incremental jogging to the normal jog mode.

12. Repeat steps 2 to 11 for all axes to be mastered.

13. Close the window.

5.8.7 Mastering external axes

Description  KUKA external axes can be mastered using either the probe or the dial 
gauge.

 Non-KUKA external axes can be mastered using the dial gauge. If master-
ing with the probe is desired, the external axis must be fitted with gauge 
cartridges.

Procedure  The procedure for mastering external axes is the same as that for master-
ing robot axes. Alongside the robot axes, the configured external axes now 
also appear in the axis selection window.

5.8.8 Reference mastering

If the axis overshoots zero, repeat steps 5 to 8.

Fig. 5-13: Selection list of axes to be mastered

Mastering in the case of industrial robots with more than 2 external 
axes: if the system contains more than 8 axes, it may be necessary 
to connect the signal cable of the probe to the second RDC.

The procedure described here must not be used when commission-
ing the robot.
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Description Reference mastering is suitable if maintenance work is due on a correctly 
mastered robot and it is to be expected that the robot will lose its mastering. 
Examples:

 Exchange of RDC

 Exchange of motor

The robot is moved to the $MAMES position before the maintenance work is 
commenced. Afterwards, the axis values of this system variable are reas-
signed to the robot by means of reference mastering. The state of the robot is 
then the same as before the loss of mastering. Taught offsets are retained. No 
EMD or dial gauge is required.

In the case of reference mastering, it is irrelevant whether or not there is a load 
mounted on the robot. Reference mastering can also be used for external ax-
es.

Preparation  Move the robot to the $MAMES position before commencing the mainte-
nance work. To do so, program a point PTP $MAMES and move the robot 
to it. This is only possible in the user group “Expert”!

Precondition  No program is selected.

 Operating mode T1

 The position of the robot was not changed during the maintenance work.

 If the RDC has been exchanged: the robot data have been transferred 
from the hard drive to the RDC (this can only be done in the user group 
“Expert”!)

 (>>> 4.17.15 "Displaying/editing robot data" Page 90)

Procedure 1. In the main menu, select Start-up > Master > Reference.

The option window Reference mastering is opened. All axes that have 
not been mastered are displayed. The axis that must be mastered first is 
selected.

2. Press Master. The selected axis is mastered and removed from the option 
window.

3. Repeat step 2 for all axes to be mastered.

5.8.9 Mastering with the MEMD and mark

Overview In MEMD mastering, the axis is automatically moved by the robot controller to 
the mastering position. Mastering is carried out first without and then with a 
load. It is possible to save mastering data for different loads.

 In the case of robots with line marks on A6 instead of conventional mas-
tering marks, A6 is mastered without MEMD. 

 (>>> 5.8.9.1 "Moving A6 to the mastering position (with line mark)" 
Page 115)

 In the case of robots with mastering marks on A6, A6 is mastered in the 
same way as the other axes.

The robot must not move to the default HOME position 
instead of to $MAMES. $MAMES may be, but is not al-

ways, identical to the default HOME position. Only in the $MAMES position 
will the robot be correctly mastered by means of reference mastering. If the 
robot is reference mastered at any position other than $MAMES, this may re-
sult in injury and material damage.
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5.8.9.1 Moving A6 to the mastering position (with line mark)

Description In the case of robots with line marks on A6 instead of conventional mastering 
marks, A6 is mastered without MEMD. 

Before mastering, A6 must be moved to its mastering position. (This means 
before the overall mastering process, not directly before mastering A6 itself). 
For this purpose, A6 has fine marks in the metal.

 To move A6 to the mastering position, the marks must be aligned exactly.

Step Description

1 First mastering

 (>>> 5.8.9.2 "First mastering (with MEMD)" Page 116)

First mastering is carried out without a load.

2 Teach offset

 (>>> 5.8.9.3 "Teach offset (with MEMD)" Page 119)

“Teach offset” is carried out with a load. The difference from 
the first mastering is saved.

3 If required: Master load with offset

 (>>> 5.8.9.4 "Check load mastering with offset (with 
MEMD)" Page 120)

“Load mastering with offset” is carried out with a load for 
which an offset has already been taught.

Area of application:

 Checking first mastering

 Restoring first mastering if it has been lost (e.g. follow-
ing exchange of motor or collision). Since an offset that 
has been taught is retained, even if mastering is lost, the 
robot controller can calculate the first mastering.

When moving to the mastering position, it is important to look at the 
fixed mark in a straight line from in front. If the mark is observed from 
the side, the movable mark cannot be aligned accurately enough. 

This results in incorrect mastering.
115 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



116 / 491

KUKA System Software 8.3
Mastering fixture A mastering fixture is available for mastering A6 of the KR AGILUS. Use of this 
fixture is optional. Using the fixture allows mastering with greater accuracy and 
greater repeatability. 

5.8.9.2 First mastering (with MEMD)

Precondition  There is no load on the robot; i.e. there is no tool, workpiece or supplemen-
tary load mounted.

 The axes are in the pre-mastering position. 

Exception A6, if this axis has a line mark: A6 is in the mastering position.

 No program is selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > First mastering.

A window opens. All axes to be mastered are displayed. The axis with the 
lowest number is highlighted.

2. Remove the cover from connection X32.

Fig. 5-14: Mastering position A6 – view from above

More information about the mastering fixture is contained in the Mas-
tering fixture A6 documentation.
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5 Start-up and recommissioning
3. Connect the EtherCAT cable to X32 and to the mastering box.

4. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. 

Fig. 5-15: X32 without cover

Fig. 5-16: Connecting the cable to X32
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5. Screw the MEMD onto the gauge cartridge.

6. Connect the signal cable to the mastering box if it is not already connect-
ed.

7. Press Master.

8. Press an enabling switch and the Start key.

When the MEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. The values are 
saved. The axis is no longer displayed in the window.

9. Remove the MEMD from the gauge cartridge and replace the protective 
cap.

10. Repeat steps 4 to 9 for all axes to be mastered. 

Exception: Not for A6 if this axis has a line mark.

11. Close the window.

12. This step is only to be performed if A6 has a line mark.

a. In the main menu, select Start-up > Master > Reference.

Fig. 5-17: Removing protective cap from gauge cartridge

Fig. 5-18: Screwing MEMD onto gauge cartridge
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The option window Reference mastering is opened. A6 is displayed 
and is selected. 

b. Press Master. A6 is mastered and removed from the option window.

c. Close the window.

13. Disconnect the EtherCAT cable from X32 and the mastering box.

5.8.9.3 Teach offset (with MEMD)

Description Teach offset is carried out with a load. The difference from the first mastering 
is saved.

If the robot is operated with different loads, Teach offset must be carried out 
for every load. In the case of grippers used for picking up heavy workpieces, 
Teach offset must be carried out for the gripper both with and without the 
workpiece.

Precondition  Same ambient conditions (temperature, etc.) as for first mastering.

 The load is mounted on the robot.

 The axes are in the pre-mastering position. 

Exception A6, if this axis has a line mark: A6 is in the mastering position.

 No program is selected.

 Operating mode T1

Procedure 1. Select Start-up > Master > EMD > With load correction > Teach offset 
in the main menu.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which the tool has not yet been taught are 
displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32.

4. Connect the EtherCAT cable to X32 and to the mastering box.

5. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window.

6. Screw the MEMD onto the gauge cartridge.

7. Connect the signal cable to the mastering box if it is not already connect-
ed.

8. Press Learn.

9. Press an enabling switch and the Start key.

When the MEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. A window opens. The 
deviation of this axis from the first mastering is indicated in degrees and 
increments.

10. Confirm with OK. The axis is no longer displayed in the window.

11. Remove the MEMD from the gauge cartridge and replace the protective 
cap.

12. Repeat steps 5 to 11 for all axes to be mastered.

Exception: Not for A6 if this axis has a line mark.

13. Close the window.

14. This step is only to be performed if A6 has a line mark.

a. In the main menu, select Start-up > Master > Reference.

Leave the signal cable connected to the mastering box 
and disconnect it as little as possible. The pluggability of 

the M8 sensor connector is limited. Frequent connection/disconnection can 
result in damage to the connector.
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The option window Reference mastering is opened. A6 is displayed 
and is selected. 

b. Press Master. A6 is mastered and removed from the option window.

c. Close the window.

15. Disconnect the EtherCAT cable from X32 and the mastering box.

5.8.9.4 Check load mastering with offset (with MEMD)

Description Area of application:

 Checking first mastering

 Restoring first mastering if it has been lost (e.g. following exchange of mo-
tor or collision). Since an offset that has been taught is retained, even if 
mastering is lost, the robot controller can calculate the first mastering.

An axis can only be checked if all axes with lower numbers have been mas-
tered.

In the case of robots where A6 has a line mark, the value determined for this 
axis is not displayed, i.e. first mastering cannot be checked for A6. It is possi-
ble to restore lost first mastering, however.

Precondition  Same ambient conditions (temperature, etc.) as for first mastering.

 A load for which Teach offset has been carried out is mounted on the ro-
bot.

 The axes are in the pre-mastering position. 

Exception A6, if this axis has a line mark: A6 is in the mastering position.

 No program is selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > Master load > With offset.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which an offset has been taught with this tool 
are displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32.

4. Connect the EtherCAT cable to X32 and to the mastering box.

5. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. 

6. Screw the MEMD onto the gauge cartridge.

7. Connect the signal cable to the mastering box if it is not already connect-
ed.

8. Press Check.

9. Hold down an enabling switch and press the Start key.

When the MEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. The difference from 
“Teach offset” is displayed.

10. If required, press Save to save the values. The old mastering values are 
deleted.

To restore a lost first mastering, always save the values.

Leave the signal cable connected to the mastering box 
and disconnect it as little as possible. The pluggability of 

the M8 sensor connector is limited. Frequent connection/disconnection can 
result in damage to the connector.
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11. Remove the MEMD from the gauge cartridge and replace the protective 
cap.

12. Repeat steps 5 to 11 for all axes to be mastered.

Exception: Not for A6 if this axis has a line mark.

13. Close the window.

14. This step is only to be performed if A6 has a line mark.

a. In the main menu, select Start-up > Master > Reference.

The option window Reference mastering is opened. A6 is displayed 
and is selected. 

b. Press Master to restore lost first mastering. A6 is removed from the 
option window.

c. Close the window.

15. Disconnect the EtherCAT cable from X32 and the mastering box.

5.8.10 Manually unmastering axes

Description The mastering values of the individual axes can be deleted. The axes do not 
move during unmastering.

Precondition  No program is selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > Unmaster. A window 
opens.

2. Select the axis to be unmastered.

3. Press Unmaster. The mastering data of the axis are deleted.

4. Repeat steps 2 and 3 for all axes to be unmastered.

5. Close the window.

5.9 Modifying software limit switches

There are 2 ways of modifying the software limit switches:

 Enter the desired values manually.

Axes A4, A5 and A6 are mechanically coupled. This means:
If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.

Leave the signal cable connected to the mastering box 
and disconnect it as little as possible. The pluggability of 

the M8 sensor connector is limited. Frequent connection/disconnection can 
result in damage to the connector.

Axes A4, A5 and A6 are mechanically coupled. This means:
If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.

The software limit switches of an unmastered robot are 
deactivated. The robot can hit the end stop buffers, thus 

damaging the robot and making it necessary to exchange the buffers. An un-
mastered robot must not be jogged, if at all avoidable. If it must be jogged, 
the jog override must be reduced as far as possible.
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 Or automatically adapt the limit switches to one or more programs.

The robot controller determines the minimum and maximum axis positions 
occurring in the program. These values can then be set as software limit 
switches. 

Precondition  “Expert” user group

 T1, T2 or AUT mode

Procedure Modifying software limit switches manually:

1. In the main menu, select Start-up > Service > Software limit switch. The 
Software limit switch window is opened.

2. Modify the limit switches as required in the columns Negative and Posi-
tive.

3. Save the changes with Save.

Adapting software limit switches to a program:

1. In the main menu, select Start-up > Service > Software limit switch. The 
Software limit switch window is opened.

2. Click on Auto detection. The following message is displayed: Auto detec-
tion is running.

3. Start the program to which the limit switches are to be adapted. Execute 
the program completely and then cancel it.

The maximum and minimum position reached by each axis is displayed in 
the Software limit switch window.

4. Repeat step 3 for all programs to which the limit switches are to be adapt-
ed.

The maximum and minimum position reached by each axis in all executed 
programs is displayed in the Software limit switch window.

5. Once all desired programs have been executed, press End in the Soft-
ware limit switch window.

6. Press Save to save the determined values as software limit switches.

7. If required, modify the automatically determined values manually. 

8. Save the changes with Save.

Description Software limit switch window:

Recommendation: Reduce the determined minimum values by 5°. In-
crease the determined maximum values by 5°. 
This margin prevents the axes from reaching the limit switches during 

program execution and thus triggering a stop.
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Buttons The following buttons are available (only in the “Expert” user group):

Fig. 5-19: Before automatic determination

Item Description

1 Current negative limit switch

2 Current position of the axis

3 Current positive limit switch

Fig. 5-20: During automatic determination

Item Description

4 Minimum position of the axis since the start of determination

5 Maximum position of the axis since the start of determination
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5.10 Calibration

5.10.1 Defining the tool direction

Description By default, the X axis is defined in the system as the tool direction. The tool 
direction can be changed using the system variable $TOOL_DIRECTION. 

 The change relates only to spline motions. For LIN and CIRC motions, the 
tool direction is the X axis and cannot be changed.

 The change applies to all tools. It is not possible to define different tool di-
rections for different tools.

Precondition  “Expert” user group

Procedure  Set the system variable $TOOL_DIRECTION to the desired value in the 
file $CUSTOM.DAT, located in the directory KRC\Steu\MaDa.

Possible values: #X (default); #Y; #Z

It is not possible to modify $TOOL_DIRECTION by means of the variable cor-
rection function or by writing to the variable from the program.

5.10.2 Tool calibration

Description During tool calibration, the user assigns a Cartesian coordinate system (TOOL 
coordinate system) to the tool mounted on the mounting flange.

The TOOL coordinate system has its origin at a user-defined point. This is 
called the TCP (Tool Center Point). The TCP is generally situated at the work-
ing point of the tool.

Advantages of tool calibration:

 The tool can be moved in a straight line in the tool direction.

 The tool can be rotated about the TCP without changing the position of the 
TCP.

Button Description

Auto detection Starts the automatic determination: 

The robot controller writes the minimum and 
maximum positions adopted by the axes from 
now on to the columns Minimum and Maximum 
in the Software limit switch window.

End Ends the automatic determination. Transfers the 
calculated minimum/maximum positions to the 
columns Negative and Positive, but does not yet 
save them.

Save Saves the values in the columns Negative and 
Positive as software limit switches.

The tool direction must be defined before calibration and 
before program creation. It cannot be modified subse-

quently. Failure to observe this may result in unexpected changes to the mo-
tion characteristics of the robot. Death, injuries or damage to property may 
result.

In the case of a fixed tool, the type of calibration described here must 
not be used. A separate type of calibration must be used for fixed 
tools. (>>> 5.10.4 "Fixed tool calibration" Page 134)
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5 Start-up and recommissioning
 In program mode: The programmed velocity is maintained at the TCP 
along the path.

A maximum of 16 TOOL coordinate systems can be saved. Variable: 
TOOL_DATA[1…16].

The following data are saved:

 X, Y, Z:

Origin of the TOOL coordinate system relative to the FLANGE coordinate 
system

 A, B, C:

Orientation of the TOOL coordinate system relative to the FLANGE coor-
dinate system

Overview Tool calibration consists of 2 steps:

Fig. 5-21: TCP calibration principle
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If the calibration data are already known, they can be entered directly.  
(>>> 5.10.2.5 "Numeric input" Page 131)

5.10.2.1 TCP calibration: XYZ 4-point method

Description The TCP of the tool to be calibrated is moved to a reference point from 4 dif-
ferent directions. The reference point can be freely selected. The robot con-
troller calculates the TCP from the different flange positions.

Step Description

1 Definition of the origin of the TOOL coordinate system

The following methods are available:

 XYZ 4-point

 (>>> 5.10.2.1 "TCP calibration: XYZ 4-point method" 
Page 126)

 XYZ Reference

 (>>> 5.10.2.2 "TCP calibration: XYZ Reference method" 
Page 128)

2 Definition of the orientation of the TOOL coordinate sys-
tem

The following methods are available:

 ABC 2-point

 (>>> 5.10.2.4 "Defining the orientation: ABC 2-point 
method" Page 129)

 ABC World

 (>>> 5.10.2.3 "Defining the orientation: ABC World meth-
od" Page 129)

The XYZ 4-point method cannot be used for palletizing robots.

The 4 flange positions at the reference point must be sufficiently dif-
ferent from one another.
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Precondition  The tool to be calibrated is mounted on the mounting flange.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > XYZ 4-point.

2. Assign a number and a name for the tool to be calibrated. Confirm with 
Next.

3. Move the TCP to a reference point. Press Calibrate. Answer the request 
for confirmation with Yes.

4. Move the TCP to the reference point from a different direction. Press Cal-
ibrate. Answer the request for confirmation with Yes.

5. Repeat step 4 twice.

6. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.11.3 "Entering payload data" Page 148)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Either: press Save and then close the window via the Close icon.

Or: press ABC 2-point or ABC World. The previous data are automatical-
ly saved and a window is opened in which the orientation of the TOOL co-
ordinate system can be defined.

 (>>> 5.10.2.4 "Defining the orientation: ABC 2-point method" Page 129)

 (>>> 5.10.2.3 "Defining the orientation: ABC World method" Page 129)

Fig. 5-22: XYZ 4-Point method
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5.10.2.2 TCP calibration: XYZ Reference method

Description In the case of the XYZ Reference method, a new tool is calibrated with a tool 
that has already been calibrated. The robot controller compares the flange po-
sitions and calculates the TCP of the new tool.

Precondition  A previously calibrated tool is mounted on the mounting flange.

 Operating mode T1

Preparation Calculate the TCP data of the calibrated tool:

1. In the main menu, select Start-up > Calibrate > Tool > XYZ Reference.

2. Enter the number of the calibrated tool.

3. The tool data are displayed. Note the X, Y and Z values.

4. Close the window.

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > XYZ Reference.

2. Assign a number and a name for the new tool. Confirm with Next.

3. Enter the TCP data of the calibrated tool. Confirm with Next.

4. Move the TCP to a reference point. Press Calibrate. Answer the request 
for confirmation with Yes.

5. Move the tool away and remove it. Mount the new tool.

6. Move the TCP of the new tool to the reference point. Press Calibrate. An-
swer the request for confirmation with Yes.

7. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.11.3 "Entering payload data" Page 148)

8. Confirm with Next.

9. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

10. Either: press Save and then close the window via the Close icon.

Or: press ABC 2-point or ABC World. The previous data are automatical-
ly saved and a window is opened in which the orientation of the TOOL co-
ordinate system can be defined.

 (>>> 5.10.2.4 "Defining the orientation: ABC 2-point method" Page 129)

 (>>> 5.10.2.3 "Defining the orientation: ABC World method" Page 129)

Fig. 5-23: XYZ Reference method
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5.10.2.3 Defining the orientation: ABC World method

Description The axes of the TOOL coordinate system are aligned parallel to the axes of 
the WORLD coordinate system. This communicates the orientation of the 
TOOL coordinate system to the robot controller.

There are 2 variants of this method:

 5D: Only the tool direction is communicated to the robot controller. By de-
fault, the tool direction is the X axis. The directions of the other axes are 
defined by the system and cannot be detected easily by the user.

Area of application: e.g. MIG/MAG welding, laser cutting or waterjet cutting

 6D: The directions of all 3 axes are communicated to the robot controller.

Area of application: e.g. for weld guns, grippers or adhesive nozzles

Precondition  The tool to be calibrated is mounted on the mounting flange.

 The TCP of the tool has already been measured.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > ABC World.

2. Enter the number of the tool. Confirm with Next.

3. Select a variant in the box 5D/6D. Confirm with Next.

4. If 5D is selected: 

Align +XTOOL parallel to -ZWORLD. (+XTOOL = tool direction)

If 6D is selected:

Align the axes of the TOOL coordinate system as follows.

 +XTOOL parallel to -ZWORLD. (+XTOOL = tool direction)

 +YTOOL parallel to +YWORLD

 +ZTOOL parallel to +XWORLD

5. Press Calibrate. Answer the request for confirmation with Yes.

6. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.11.3 "Entering payload data" Page 148)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Press Save.

5.10.2.4 Defining the orientation: ABC 2-point method

Description The axes of the TOOL coordinate system are communicated to the robot con-
troller by moving to a point on the X axis and a point in the XY plane.

This method is used if it is necessary to define the axis directions with partic-
ular precision.

The following procedure applies if the tool direction is the default tool 
direction (= X axis). If the tool direction has been changed to Y or Z, 
the procedure must also be changed accordingly.  

(>>> 5.10.1 "Defining the tool direction" Page 124)

The following two steps are not required if the procedure is not called 
via the main menu, but by means of the ABC World button after TCP 
calibration.
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Precondition  The tool to be calibrated is mounted on the mounting flange.

 The TCP of the tool has already been measured.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > ABC 2-point.

2. Enter the number of the mounted tool. Confirm with Next.

3. Move the TCP to any reference point. Press Calibrate. Answer the re-
quest for confirmation with Yes.

4. Move the tool so that the reference point on the X axis has a negative X 
value (i.e. move against the tool direction). Press Calibrate. Answer the 
request for confirmation with Yes.

5. Move the tool so that the reference point in the XY plane has a negative Y 
value. Press Calibrate. Answer the request for confirmation with Yes.

Fig. 5-24: ABC 2-Point method

The following procedure applies if the tool direction is the default tool 
direction (= X axis). If the tool direction has been changed to Y or Z, 
the procedure must also be changed accordingly.  

(>>> 5.10.1 "Defining the tool direction" Page 124)
Issued: 14.01.2015 Version: KSS 8.3 SI V4



5 Start-up and recommissioning
6. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.11.3 "Entering payload data" Page 148)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Press Save.

5.10.2.5 Numeric input

Description The tool data can be entered manually.

Possible sources of data:

 CAD

 Externally calibrated tool

 Tool manufacturer specifications

Precondition  The following values are known:

 X, Y and Z relative to the FLANGE coordinate system

 A, B and C relative to the FLANGE coordinate system

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > Numeric input.

2. Assign a number and a name for the tool to be calibrated. Confirm with 
Next.

3. Enter the tool data. Confirm with Next.

4. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.11.3 "Entering payload data" Page 148)

5. If online load data verification is available (this depends on the robot type): 
configure as required.

 (>>> 5.11.5 "Online load data check (OLDC)" Page 149)

6. Confirm with Next.

7. Press Save.

5.10.3 Base calibration

Description During base calibration, the user assigns a Cartesian coordinate system 
(BASE coordinate system) to a work surface or the workpiece. The BASE co-
ordinate system has its origin at a user-defined point.

The following two steps are not required if the procedure is not called 
via the main menu, but by means of the ABC 2-point button after 
TCP calibration.

In the case of palletizing robots with 4 axes, the tool data must be en-
tered numerically. The XYZ and ABC methods cannot be used as re-
orientation of these robots is highly restricted.

If the workpiece is mounted on the mounting flange, the type of cali-
bration described here must not be used. A separate type of calibra-
tion must be used for workpieces mounted on the mounting flange.  

(>>> 5.10.4 "Fixed tool calibration" Page 134)
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Advantages of base calibration:

 The TCP can be jogged along the edges of the work surface or workpiece.

 Points can be taught relative to the base. If it is necessary to offset the 
base, e.g. because the work surface has been offset, the points move with 
it and do not need to be retaught.

A maximum of 32 BASE coordinate systems can be saved. Variable: 
BASE_DATA[1…32].

Overview There are 2 ways of calibrating a base:

 3-point method  (>>> 5.10.3.1 "3-point method" Page 132)

 Indirect method  (>>> 5.10.3.2 "Indirect method" Page 133)

If the calibration data are already known, they can be entered directly.  
(>>> 5.10.3.3 "Numeric input" Page 134)

5.10.3.1 3-point method

Description The robot moves to the origin and 2 further points of the new base. These 3 
points define the new base.

Precondition  A previously calibrated tool is mounted on the mounting flange.

Fig. 5-25: 3-point method
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 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Base > ABC 3-point.

2. Assign a number and a name for the base. Confirm with Next.

3. Enter the number of the mounted tool. Confirm with Next.

4. Move the TCP to the origin of the new base. Press Calibrate. Answer the 
request for confirmation with Yes.

5. Move the TCP to a point on the positive X axis of the new base. Press Cal-
ibrate. Answer the request for confirmation with Yes.

6. Move the TCP to a point in the XY plane with a positive Y value. Press Cal-
ibrate. Answer the request for confirmation with Yes.

7. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

8. Press Save.

5.10.3.2 Indirect method

Description The indirect method is used if it is not possible to move to the origin of the 
base, e.g. because it is inside a workpiece or outside the workspace of the ro-
bot.

The TCP is moved to 4 points in the base, the coordinates of which must be 
known. The robot controller calculates the base from these points.

Precondition  A calibrated tool is mounted on the mounting flange.

 The coordinates of 4 points in the new base are known, e.g. from CAD da-
ta. The 4 points are accessible to the TCP.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Base > Indirect.

Fig. 5-26: Indirect method
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2. Assign a number and a name for the base. Confirm with Next.

3. Enter the number of the mounted tool. Confirm with Next.

4. Enter the coordinates of a known point in the new base and move the TCP 
to this point. Press Calibrate. Answer the request for confirmation with 
Yes.

5. Repeat step 4 three times.

6. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

7. Press Save.

5.10.3.3 Numeric input

Precondition  The following numerical values are known, e.g. from CAD data:

Distance between the origin of the base and the origin of the WORLD co-
ordinate system

Rotation of the base axes relative to the WORLD coordinate system

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Base > Numeric input.

2. Assign a number and a name for the base. Confirm with Next.

3. Enter data. Confirm with Next.

4. Press Save.

5.10.4 Fixed tool calibration

Overview Calibration of a fixed tool consists of 2 steps:

The robot controller saves the external TCP as the BASE coordinate system 
and the workpiece as the TOOL coordinate system. A maximum of 32 BASE 
coordinate systems and 16 TOOL coordinate systems can be saved.

Step Description

1 Calibration of the TCP of the fixed tool

The TCP of a fixed tool is called an external TCP.

 (>>> 5.10.4.1 "Calibrating an external TCP" Page 135)

If the calibration data are already known, they can be entered 
directly.

 (>>> 5.10.4.2 "Entering the external TCP numerically" 
Page 136)

2 Calibration of the workpiece

The following methods are available:

 Direct method 

 (>>> 5.10.4.3 "Workpiece calibration: direct method" 
Page 136)

 Indirect method 

 (>>> 5.10.4.4 "Workpiece calibration: indirect method" 
Page 138)
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5.10.4.1 Calibrating an external TCP

Description First of all, the TCP of the fixed tool is communicated to the robot controller. 
This is done by moving a calibrated tool to it.

Then, the orientation of the coordinate system of the fixed tool is communicat-
ed to the robot controller. For this purpose, the coordinate system of the cali-
brated tool is aligned parallel to the new coordinate system. There are 2 
variants:

 5D: Only the tool direction of the fixed tool is communicated to the robot 
controller. By default, the tool direction is the X axis. The orientation of the 
other axes is defined by the system and cannot be detected easily by the 
user.

 6D: The orientation of all 3 axes is communicated to the robot controller.

Precondition  A previously calibrated tool is mounted on the mounting flange.

Fig. 5-27: Moving to the external TCP

Fig. 5-28: Aligning the coordinate systems parallel to one another
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 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Tool.

2. Assign a number and a name for the fixed tool. Confirm with Next.

3. Enter the number of the calibrated tool. Confirm with Next.

4. Select a variant in the box 5D/6D. Confirm with Next.

5. Move the TCP of the calibrated tool to the TCP of the fixed tool. Press Cal-
ibrate. Answer the request for confirmation with Yes.

6. If 5D is selected: 

Align +XBASE parallel to -ZFLANGE.

(i.e. align the mounting flange perpendicular to the tool direction of the 
fixed tool.)

If 6D is selected: 

Align the mounting flange so that its axes are parallel to the axes of the 
fixed tool:

 +XBASE parallel to -ZFLANGE

(i.e. align the mounting flange perpendicular to the tool direction.)

 +YBASE parallel to +YFLANGE

 +ZBASE parallel to +XFLANGE

7. Press Calibrate. Answer the request for confirmation with Yes.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Press Save.

5.10.4.2 Entering the external TCP numerically

Precondition  The following numerical values are known, e.g. from CAD data:

 Distance between the TCP of the fixed tool and the origin of the 
WORLD coordinate system (X, Y, Z)

 Rotation of the axes of the fixed tool relative to the WORLD coordinate 
system (A, B, C)

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Numeric in-
put.

2. Assign a number and a name for the fixed tool. Confirm with Next.

3. Enter data. Confirm with Next.

4. Press Save.

5.10.4.3 Workpiece calibration: direct method

Description The origin and 2 further points of the workpiece are communicated to the robot 
controller. These 3 points uniquely define the workpiece.

The following procedure applies if the tool direction is the default tool 
direction (= X axis). If the tool direction has been changed to Y or Z, 
the procedure must also be changed accordingly.  

(>>> 5.10.1 "Defining the tool direction" Page 124)
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Precondition  The workpiece is mounted on the mounting flange.

 A previously calibrated fixed tool is mounted.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Workpiece 
> Direct calibration.

2. Assign a number and a name for the workpiece. Confirm with Next.

3. Enter the number of the fixed tool. Confirm with Next.

4. Move the origin of the workpiece coordinate system to the TCP of the fixed 
tool. Press Calibrate. Answer the request for confirmation with Yes.

5. Move a point on the positive X axis of the workpiece coordinate system to 
the TCP of the fixed tool. Press Calibrate. Answer the request for confir-
mation with Yes.

6. Move a point with a positive Y value in the XY plane of the workpiece co-
ordinate system to the TCP of the fixed tool. Press Calibrate. Answer the 
request for confirmation with Yes.

7. Enter the load data of the workpiece. (This step can be skipped if the load 
data are entered separately instead.)

 (>>> 5.11.3 "Entering payload data" Page 148)

Fig. 5-29

Fig. 5-30: Workpiece calibration: direct method
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8. Confirm with Next.

9. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

10. Press Save.

5.10.4.4 Workpiece calibration: indirect method

Description The robot controller calculates the workpiece on the basis of 4 points whose 
coordinates must be known. The robot does not move to the origin of the work-
piece.

Precondition  A previously calibrated fixed tool is mounted.

 The workpiece to be calibrated is mounted on the mounting flange.

 The coordinates of 4 points of the new workpiece are known, e.g. from 
CAD data. The 4 points are accessible to the TCP.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Workpiece 
> Indirect calibration.

2. Assign a number and a name for the workpiece. Confirm with Next.

3. Enter the number of the fixed tool. Confirm with Next.

4. Enter the coordinates of a known point on the workpiece and move this 
point to the TCP of the fixed tool. Press Calibrate. Answer the request for 
confirmation with Yes.

5. Repeat step 4 three times.

6. Enter the load data of the workpiece. (This step can be skipped if the load 
data are entered separately instead.)

 (>>> 5.11.3 "Entering payload data" Page 148)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-

Fig. 5-31: Workpiece calibration: indirect method
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tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Press Save.

5.10.5 Renaming the tool/base

Precondition  Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool or Base > Change 
name.

2. Select the tool or base and press Name.

3. Enter the new name and confirm with Save.

5.10.6 Linear unit

The KUKA linear unit is a self-contained, one-axis linear unit mounted on the 
floor or ceiling. It is used for linear traversing of the robot and is controlled by 
the robot controller as an external axis.

The linear unit is a ROBROOT kinematic system. When the linear unit is 
moved, the position of the robot in the WORLD coordinate system changes. 
The current position of the robot in the WORLD coordinate system is defined 
by the vector $ROBROOT_C.

$ROBROOT_C consists of:

 $ERSYSROOT (static component)

Root point of the linear unit relative to $WORLD. The root point is situated 
by default at the zero position of the linear unit and is not dependent on 
$MAMES.

 #ERSYS (dynamic component)

Current position of the robot on the linear unit relative to the $ERSYS-
ROOT

5.10.6.1 Checking whether the linear unit needs to be calibrated

Description The robot is standing on the flange of the linear unit. Ideally, the ROBROOT 
coordinate system of the robot should be identical to the FLANGE coordinate 
system of the linear unit. In reality, there are often slight discrepancies which 
mean that positions cannot be moved to correctly. Calibration allows mathe-

Fig. 5-32: ROBROOT kinematic system – linear unit
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matical correction of these discrepancies. (Rotations about the direction of 
motion of the linear unit cannot be corrected. They do not, however, cause er-
rors when moving to positions.)

If there are no discrepancies, the linear unit does not need to be calibrated. 
The following procedure can be used to determine whether calibration is re-
quired.

Precondition  The machine data of the linear unit have been configured and loaded into 
the robot controller.

 A previously calibrated tool is mounted on the mounting flange.

 No program is open or selected.

 Operating mode T1

Procedure 1. Align the TCP against a freely selected point and observe it.

2. Execute a Cartesian (not axis-specific!) motion with the linear unit.

 If the TCP stops: the linear unit does not require calibration.

 If the TCP moves: the linear unit does require calibration.

 (>>> 5.10.6.2 "Calibrating the linear unit" Page 140)

If the calibration data are already known (e.g. from CAD), they can be entered 
directly. (>>> 5.10.6.3 "Entering the linear unit numerically" Page 141)

5.10.6.2 Calibrating the linear unit

Description During calibration, the TCP of a tool that has already been calibrated is moved 
to a reference point 3 times.

 The reference point can be freely selected.

 The position of the robot on the linear unit from which the reference point 
is approached must be different all 3 times. The 3 positions must be far 
enough apart.

The correction values determined by the calibration are factored into the sys-
tem variable $ETx_TFLA3.

Precondition  The machine data of the linear unit have been configured and loaded into 
the robot controller.

 A previously calibrated tool is mounted on the mounting flange.

 No program is open or selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Linear unit.

The robot controller detects the linear unit automatically and displays the 
following data:

 Ext. kinematic system no.: number of the external kinematic system 
(1 … 6) ($EX_KIN)

 Axis: number of the external axis (1 … 6) ($ETx_AX)

 Name of the external kinematic system ($ETx_NAME)

(If the robot controller is unable to determine these values, e.g. because 
the linear unit has not yet been configured, calibration cannot be contin-
ued.)

2. Move the linear unit with the jog key “+”.

3. Specify whether the linear unit is moving to “+” or “-”. Confirm with Next.

4. Move the TCP to the reference point.

5. Press Calibrate.
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6. Repeat steps 4 and 5 twice, but move the linear unit first each time in order 
to address the reference point from different positions.

7. Press Save. The calibration data are saved.

8. The system asks whether the positions that have already been taught are 
to be corrected.

 If no positions have been taught prior to the calibration, it makes no dif-
ference whether the question is answered with Yes or No.

 If positions have been taught prior to the calibration:

Answering Yes will cause positions with base 0 to be corrected auto-
matically. Other positions will not be corrected!

Answering No will cause no positions to be corrected.

5.10.6.3 Entering the linear unit numerically

Precondition  The machine data of the linear unit have been configured and loaded into 
the robot controller.

 No program is open or selected.

 The following numerical values are known, e.g. from CAD data:

 Distance between the robot base flange and the origin of the ERSYS-
ROOT coordinate system (X, Y, Z)

 Orientation of the robot base flange relative to the ERSYSROOT coor-
dinate system (A, B, C)

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Linear unit (numeric).

The robot controller detects the linear unit automatically and displays the 
following data:

 Ext. kinematic system no.: number of the external kinematic system 
(1 … 6)

 Axis: number of the external axis (1 … 6)

 Name of the kinematic system

(If the robot controller is unable to determine these values, e.g. because 
the linear unit has not yet been configured, calibration cannot be contin-
ued.)

2. Move the linear unit with the jog key “+”.

3. Specify whether the linear unit is moving to “+” or “-”. Confirm with Next.

4. Enter data. Confirm with Next.

5. Press Save. The calibration data are saved.

6. The system asks whether the positions that have already been taught are 
to be corrected.

 If no positions have been taught prior to the calibration, it makes no dif-
ference whether the question is answered with Yes or No.

 If positions have been taught prior to the calibration:

Answering Yes will cause positions with base 0 to be corrected auto-
matically. Other positions will not be corrected!

After calibration of a linear unit, the following safety mea-
sures must be carried out:

1. Check the software limit switches of the linear unit and adapt them if re-
quired.

2. Test programs in T1.

Damage to property may otherwise result.
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Answering No will cause no positions to be corrected.

5.10.7 Calibrating an external kinematic system

Description Calibration of the external kinematic system is necessary to enable the motion 
of the axes of the kinematic system to be synchronized and mathematically 
coupled with the robot axes. An external kinematic system can be a turn-tilt ta-
ble or positioner, for example.

Overview Calibration of an external kinematic system consists of 2 steps:

5.10.7.1 Calibrating the root point

Description In order to be able to move the robot with a mathematical coupling to a kine-
matic system, the robot must know the precise location of the kinematic sys-
tem. This location is determined by means of root point calibration.

The TCP of a tool that has already been calibrated is moved to a reference 
point on the kinematic system 4 times. The position of the reference point must 
be different each time. This is achieved by moving the axes of the kinematic 

After calibration of a linear unit, the following safety mea-
sures must be carried out:

1. Check the software limit switches of the linear unit and adapt them if re-
quired.

2. Test programs in T1.

Damage to property may otherwise result.

For linear units, the type of calibration described here must not be 
used. A separate type of calibration must be used for linear units. 
 (>>> 5.10.6 "Linear unit" Page 139)

Step Description

1 Calibrate the root point of the external kinematic system.

 (>>> 5.10.7.1 "Calibrating the root point" Page 142)

If the calibration data are already known, they can be entered 
directly.

 (>>> 5.10.7.2 "Entering the root point numerically" Page 144)

2 If there is a workpiece on the external kinematic system: cali-
brate the base of the workpiece.

 (>>> 5.10.7.3 "Workpiece base calibration" Page 144)

If the calibration data are already known, they can be entered 
directly.

 (>>> 5.10.7.4 "Entering the workpiece base numerically" 
Page 146)

If there is a tool mounted on the external kinematic system: 
calibrate the external tool.

 (>>> 5.10.7.5 "Calibrating an external tool" Page 146)

If the calibration data are already known, they can be entered 
directly.

 (>>> 5.10.7.6 "Entering the external tool numerically" 
Page 147)
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system. The robot controller uses the different positions of the reference point 
to calculate the root point of the kinematic system.

In the case of external kinematic systems from KUKA, the reference point is 
configured in the system variable $ETx_TPINFL in the machine data. This 
contains the position of the reference point relative to the FLANGE coordinate 
system of the kinematic system. (x = number of the kinematic system.) The ref-
erence point is also marked on the kinematic system. During calibration, this 
reference point must be addressed.

In the case of non-KUKA external kinematic systems, the reference point must 
be configured in the machine data.

The robot controller saves the coordinates of the root point as the BASE coor-
dinate system.

Precondition  The machine data of the kinematic system have been configured and load-
ed into the robot controller.

 The number of the external kinematic system is known.

 A previously calibrated tool is mounted on the mounting flange.

 If $ETx_TPINFL is to be modified: user group “Expert”

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Root point.

2. Select the number of the BASE coordinate system the root point is to be 
saved as. Confirm with Next.

3. Enter the number of the external kinematic system.

4. Assign a name for the external kinematic system. Confirm with Next.

5. Enter the number of the reference tool. Confirm with Next.

6. The value of $ETx_TPINFL is displayed.

 If the value is not correct: the value can be modified here in the user 
group “Expert”.

 If the value is correct: confirm with Next.

7. Move the TCP to the reference point.

Fig. 5-33: Root point calibration principle
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8. Press Calibrate. Confirm with Next.

9. Repeat steps 7 and 8 three times. Each time, move the kinematic system 
first so that the reference point is approached from different positions.

10. Press Save.

5.10.7.2 Entering the root point numerically

Precondition  The following numerical values are known, e.g. from CAD data:

 Distance between the origin of the ROOT coordinate system and the 
origin of the WORLD coordinate system (X, Y, Z)

 Orientation of the ROOT coordinate system relative to the WORLD co-
ordinate system (A, B, C)

 The number of the external kinematic system is known.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Root point (numeric).

2. Select the number of the BASE coordinate system the root point is to be 
saved as. Confirm with Next.

3. Enter the number of the external kinematic system.

4. Assign a name for the external kinematic system. Confirm with Next.

(The name is automatically also assigned to the BASE coordinate sys-
tem.)

5. Enter the data of the ROOT coordinate system. Confirm with Next.

6. Press Save.

5.10.7.3 Workpiece base calibration

Description During this calibration, the user assigns a BASE coordinate system to a work-
piece located on the kinematic system. This BASE coordinate system is rela-
tive to the FLANGE coordinate system of the kinematic system. The base is 
thus a moving base that moves in the same way as the kinematic system.

It is not strictly necessary to calibrate a base. If none is calibrated, the 
FLANGE coordinate system of the kinematic system is taken as the base.

During calibration, the TCP of a calibrated tool is moved to the origin and 2 oth-
er points of the desired base. These 3 points define the base. Only one base 
can be calibrated per kinematic system.
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Precondition  The machine data of the kinematic system have been configured and load-
ed into the robot controller.

 A previously calibrated tool is mounted on the mounting flange.

 The root point of the external kinematic system has been calibrated.

 The number of the external kinematic system is known.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Offset.

2. Enter the number of the BASE coordinate system the root point was saved 
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed. 

Confirm with Next.

Fig. 5-34: Base calibration principle
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4. Enter the number of the reference tool. Confirm with Next.

5. Move the TCP to the origin of the workpiece base. Press Calibrate and 
confirm with Next.

6. Move the TCP to a point on the positive X axis of the workpiece base. 
Press Calibrate and confirm with Next.

7. Move the TCP to a point in the XY plane with a positive Y value. Press Cal-
ibrate and confirm with Next.

8. Press Save.

5.10.7.4 Entering the workpiece base numerically

Precondition  The following numerical values are known, e.g. from CAD data:

 Distance between the origin of the workpiece base and the origin of the 
FLANGE coordinate system of the kinematic system (X, Y, Z)

 Rotation of the axes of the workpiece base relative to the FLANGE co-
ordinate system of the kinematic system (A, B, C) 

 The root point of the external kinematic system has been calibrated.

 The number of the external kinematic system is known.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Offset (numeric).

2. Enter the number of the BASE coordinate system the root point was saved 
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed. 

Confirm with Next.

4. Enter data. Confirm with Next.

5. Press Save.

5.10.7.5 Calibrating an external tool

Description During calibration of the external tool, the user assigns a coordinate system to 
the tool mounted on the kinematic system. This coordinate system has its or-
igin in the TCP of the external tool and is relative to the FLANGE coordinate 
system of the kinematic system.

First of all, the user communicates to the robot controller the TCP of the tool 
mounted on the kinematic system. This is done by moving a calibrated tool to 
the TCP.

Then, the orientation of the coordinate system of the tool is communicated to 
the robot controller. For this purpose, the user aligns the coordinate system of 
the calibrated tool parallel to the new coordinate system. There are 2 variants:

 5D: The user communicates the tool direction to the robot controller. By 
default, the tool direction is the X axis. The orientation of the other axes is 
defined by the system and cannot be influenced by the user.

The system always defines the orientation of the other axes in the same 
way. If the tool subsequently has to be calibrated again, e.g. after a crash, 
it is therefore sufficient to define the tool direction again. Rotation about 
the tool direction need not be taken into consideration.

 6D: The user communicates the direction of all 3 axes to the robot control-
ler.
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The robot controller saves the coordinates of the external tool as the BASE co-
ordinate system.

Precondition  The machine data of the kinematic system have been configured and load-
ed into the robot controller.

 A previously calibrated tool is mounted on the mounting flange.

 The root point of the external kinematic system has been calibrated.

 The number of the external kinematic system is known.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > External ki-
nematic offset.

2. Enter the number of the BASE coordinate system the root point was saved 
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed. 

Confirm with Next.

4. Enter the number of the reference tool. Confirm with Next.

5. Select a variant in the box 5D/6D. Confirm with Next.

6. Move the TCP of the calibrated tool to the TCP of the external tool. Press 
Calibrate and confirm with Next.

7. If 5D is selected: 

Align +XBASE parallel to -ZFLANGE.

(i.e. align the mounting flange perpendicular to the tool direction of the ex-
ternal tool.)

If 6D is selected: 

Align the mounting flange so that its axes are parallel to the axes of the 
external tool:

 +XBASE parallel to -ZFLANGE

(i.e. align the mounting flange perpendicular to the tool direction of the 
external tool.)

 +YBASE parallel to +YFLANGE

 +ZBASE parallel to +XFLANGE

8. Press Calibrate and confirm with Next.

9. Press Save.

5.10.7.6 Entering the external tool numerically

Precondition  The following numerical values are known, e.g. from CAD data:

 Distance between the TCP of the external tool and the origin of the 
FLANGE coordinate system of the kinematic system (X, Y, Z)

If 6D is selected: it is advisable to document the alignment of all axes. 
If the tool subsequently has to be calibrated again, e.g. after a crash, 
the axes must be aligned the same way as the first time in order to be 

able to continue moving to existing points correctly.

The following procedure applies if the tool direction is the default tool 
direction (= X axis). If the tool direction has been changed to Y or Z, 
the procedure must also be changed accordingly.  

(>>> 5.10.1 "Defining the tool direction" Page 124)
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 Rotation of the axes of the external tool relative to the FLANGE coor-
dinate system of the kinematic system (A, B, C) 

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Numeric in-
put.

2. Assign a number and a name for the external tool. Confirm with Next.

3. Enter data. Confirm with Next.

4. Press Save.

5.11 Load data

The load data are factored into the calculation of the paths and accelerations 
and help to optimize the cycle times. The load data must be entered in the ro-
bot controller.

Sources Load data can be obtained from the following sources:

 Software option KUKA.LoadDataDetermination (only for payloads on the 
flange)

 Manufacturer information

 Manual calculation

 CAD programs

5.11.1 Checking loads with KUKA.Load

All load data (payload and supplementary loads) must be checked with the 
KUKA.Load software. Exception: If the payload is checked with KUKA.Load-
DataDetermination, it is not necessary to check it with KUKA.Load.

A sign-off sheet can be generated for the loads with KUKA.Load. KUKA.Load 
can be downloaded free of charge, complete with the documentation, from the 
KUKA website www.kuka.com.

5.11.2 Calculating payloads with KUKA.LoadDataDetermination

Description KUKA.LoadDataDetermination can be used to calculate payloads exactly and 
transfer them to the robot controller. 

Precondition  T1 or T2 operating mode

 No program is selected.

Procedure  In the main menu, select Start-up > Service > Load data determination.

5.11.3 Entering payload data

Description The payload data must be entered in the robot controller and assigned to the 
correct tool.

More information is contained in the KUKA.Load documentation.

More information is contained in the KUKA.LoadDataDetermination 
documentation.
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Exception: If the payload data have already been transferred to the robot con-
troller by KUKA.LoadDataDetermination, no manual entry is required.

Precondition  The payload data have been checked with KUKA.Load or KUKA.Load-
DataDetermination and the robot is suitable for these payloads.

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > Payload data.

2. Enter the number of the tool in the box Tool no.. Confirm with Next.

3. Enter the payload data:

 Box M: Mass

 Boxes X, Y, Z: Position of the center of gravity relative to the flange

 Boxes A, B, C: Orientation of the principal inertia axes relative to the 
flange

 Boxes JX, JY, JZ: Mass moments of inertia

(JX is the inertia about the X axis of the coordinate system that is ro-
tated relative to the flange by A, B and C. JY and JZ are the analogous 
inertia about the Y and Z axes.)

Or, if the default values for this robot type are to be used: press Default.

4. If online load data verification is available (this depends on the robot type): 
configure as required.

 (>>> 5.11.5 "Online load data check (OLDC)" Page 149)

5. Confirm with Next.

6. Press Save.

5.11.4 Entering supplementary load data

Description The supplementary load data must be entered in the robot controller.

Reference systems of the X, Y and Z values for each supplementary load:

Precondition  The supplementary loads have been verified with KUKA.Load and are 
suitable for this robot type.

Procedure 1. In the main menu, select Start-up > Calibrate > Supplementary load da-
ta.

2. Enter the number of the axis on which the supplementary load is to be 
mounted. Confirm with Continue.

3. Enter the load data. Confirm with Continue.

4. Press Save.

5.11.5 Online load data check (OLDC)

Description For many robot types, the robot controller monitors whether or not there is an 
overload or underload during operation. This monitoring is called “Online load 
data check” (OLDC). 

Load Reference system

Supplementary load 
A1

ROBROOT coordinate system

A1 = 0°

Supplementary load 
A2

ROBROOT coordinate system

A2 = -90°

Supplementary load 
A3

FLANGE coordinate system

A4 = 0°, A5 = 0°, A6 = 0°
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If the OLDC detects an underload, for example, the robot controller reacts, e.g. 
by displaying a message. The reactions can be configured.

The results of the check can be polled using the system variable 
$LDC_RESULT.  (>>>  "$LDC_RESULT" Page 151)

OLDC is available for those robot types for which KUKA.LoadDataDetermina-
tion can also be used. Whether or not OLDC is available for the current robot 
type can be checked by means of $LDC_LOADED (TRUE = yes). 

Configuration OLDC can be configured as follows:

 During manual entry of the tool data

 (>>> 5.10.2.5 "Numeric input" Page 131)

 During separate entry of the payload data

 (>>> 5.11.3 "Entering payload data" Page 148)

The following boxes are displayed in the same window in which the payload 
data are also entered:

The reactions can be modified in the KRL program using the system variable 
$LDC_CONFIG.  (>>>  "$LDC_CONFIG" Page 151)

Overload There is an overload if the actual load is greater than 
the configured load.

Underload There is an underload if the actual load is less than the 
configured load.

Fig. 5-35: Online load data check

Item Description

1 TRUE: OLDC is activated for the tool displayed in the same win-
dow. The defined reactions are carried out in the case of an over-
load or underload.

FALSE: OLDC is deactivated for the tool displayed in the same 
window. There is no reaction in the case of an overload or under-
load.

2 The overload reaction can be defined here.

 None: No reaction.

 Warning: The robot controller generates the following status 
message: Check of robot load (Tool {No.}) calculated overload.

 Stop robot: The robot controller generates an acknowledge-
ment message with the same content as that generated under 
Warning. The robot stops with a STOP 2.

3 The underload reaction can be defined here. The possible reac-
tions are analogous to those for an overload.
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NULLFRAME OLDC cannot be configured for motions to which the tool NULLFRAME has 
been assigned. The reactions are defined for this case and cannot be influ-
enced by the user.

 Overload reaction: Stop robot

The following acknowledgement message is generated: Overload calcu-
lated when checking robot load (no tool defined) and the set load data. The 
robot stops with a STOP 2.

 Underload reaction: Warning

The following status message is generated: Underload calculated when 
checking robot load (no tool defined) and the set load data.

$LDC_CONFIG $LDC_CONFIG[Index]= {UNDERLOAD Reaction, OVERLOAD Reaction}

Example:

$LDC_RESULT $LDC_RESULT[Index]= Result

Element Description

Index Type: INT

Tool number

 1 … 32

Reaction Type: CHAR

 #NONE (= None)

 #WARNONLY (= Warning)

 #STOPROBOT (= Stop robot)

 1  ...

 2  $LDC_CONFIG[1]={UNDERLOAD #NONE, OVERLOAD #NONE}

 3  ...

 4  $LDC_CONFIG[1]={UNDERLOAD #WARNONLY, OVERLOAD #WARNONLY}

 5  ...

Line Description

2 The reaction for both underload and overload is set to None. 

4 The reaction is set to Warning. If there is an underload or 
overload, the corresponding status messages will be dis-
played in the message window.

Element Description

Index Type: INT

Tool number

 1 … 32

Result Type: CHAR

 #OK: The payload is OK. (Neither overload nor under-
load.)

 #OVERLOAD: There is an overload.

 #UNDERLOAD: There is an underload.

 #CHECKING

 #NONE: There are currently no results, e.g. because 
the tool has been changed.
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5.12 Exporting/importing long texts

Description If names have been assigned to inputs/outputs, flags, etc., these names (so-
called “long texts”) can be exported to a file. It is also possible to import a file 
with long text names. In this way, the long texts do not need to be re-entered 
manually for each robot after reinstallation.

The long texts can be exported to a USB stick or to the directory defined in the 
Network archive path box in the Robot data window. The same directories 
are also available as sources for the import function.

Precondition  Either: USB stick

 Or: The target is configured in the Network archive path box in the Robot 
data window.

For import only:

 The long text names are present in a TXT or CSV file.

 The file is structured in such a way that it can be imported.

A file that originated as a long text export is automatically structured in such a 
way that it can be re-imported. If a file is to be filled with names manually, it is 
advisable first to assign a few dummy long texts in the robot controller, then to 
perform an export and fill the exported file.

Procedure 1. If a USB stick is used, connect it to the cabinet or smartPAD.

2. In the main menu, select Start-up > Service > Long texts. The Long 
texts window opens.

3. Select the Export or Import tab as required. Make the required settings.

4. Press the Export or Import button.

When the import is finished, the message Import successful. is displayed.

When the export is finished, the message Export successful. is displayed.

“Export” tab

Fig. 5-36: Exporting long texts
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“Import” tab

Item Description

1 Select the destination for the exported file.

The entry Network is only available here if a path has been config-
ured in the Robot data window.

2 Specify the desired file name. 

If Network is selected under item 1, the archive name configured 
in the Robot data window is displayed. The name can be changed 
here. This does not change it in the Robot data window.

A suffix corresponding to the language selected is automatically 
appended to the name.

3 Select the language from which the long texts are to be exported. 
If, for example, the smartHMI is set to “English” and “Italiano” is 
selected here, a file with the suffix “it” is created. It contains the 
long texts that have been stored on the Italian smartHMI. 

It is also possible to select All languages.

4 Select the desired file format.

5 Starts the export.

Fig. 5-37: Importing long texts

Item Description

1 Specify the source from which files are to be imported.

The entry Network is only available here if a path has been config-
ured in the Robot data window.

2 Specify the name of the file to be imported, but without the lan-
guage suffix.

If Network is selected under item 1, the archive name configured 
in the Robot data window is displayed. The name can be changed 
here. This does not change it in the Robot data window.

3 Specify the language matching the language suffix of the file.

4 Specify the format of the file.

5  Activated: All existing long texts are deleted. The contents of 
the file are applied.

 Deactivated: Entries in the file overwrite existing long texts. 
Existing long texts for which there is no entry in the file are re-
tained.

6 Starts the import.
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5.13 Maintenance handbook

The Maintenance handbook functionality is available in the KUKA System 
Software. The maintenance handbook enables logging of the maintenance 
work. The logged maintenance work can be displayed in an overview.

The robot controller uses messages to indicate when maintenance is due:

 A message is generated one month before the maintenance work is due. 
This message can be acknowledged.

 At the end of the month, the robot controller generates a message indicat-
ing that the maintenance is now due. This message cannot be acknowl-
edged. Additionally, LED4 on the Controller System Panel flashes (= first 
LED from the left in the bottom row).

Only when the corresponding maintenance work has been logged does 
the robot controller reset the message and the LED stops flashing.

The due dates are determined by the maintenance intervals specified in the 
KUKA maintenance agreements. The intervals are counted from the initial 
start-up of the robot controller. The operating hours of the robot are counted.

5.13.1 Logging maintenance

Description It is not possible to log multiple maintenance activities of the same kind on one 
day.

Precondition  “Expert” user group

Procedure 1. In the main menu, select Start-up > Service > Maintenance handbook. 
The Maintenance handbook window is opened.

2. Select the Maintenance input tab and enter the maintenance details. En-
tries must be made in all boxes.

3. Press Save. A request for confirmation is displayed.

4. If all entries are correct, answer the request for confirmation with Yes.

The entries are now saved. Switching to the Maintenance overview tab 
causes the maintenance to be displayed there. 

The controller variant “KR C4 compact” has no Controller System 
Panel and no flashing lights to indicate when maintenance work is 
due.

Once saved, changes can no longer be made.
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Maintenance 

types

By default, the following maintenance types can be selected:

 Basic inspection

 In-line wrist maintenance

 Main axis maintenance

 Gear backlash measurement

 Minor electrical maintenance

 Major electrical maintenance

 Data backup with spare hard drive

 Repair

These maintenance types correspond to those in the KUKA maintenance 
agreements. Depending on the options used (e.g. linear axis or technology 
packages), other maintenance types may be available for selection.

5.13.2 Displaying a maintenance log

Description The logged maintenance work can be displayed in an overview. If the KUKA 
System Software is updated, this overview is retained.

Fig. 5-38: Maintenance input

Item Description

1 Select which type of maintenance has been carried out.

2 Enter who performed the maintenance.

3 For maintenance carried out and logged by KUKA employees: en-
ter the order number.

For other maintenance: enter any number.

4 Enter a comment.
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When archiving is carried out, the maintenance logs are also archived. If, 
when the data are restored, other maintenance work has been logged on the 
robot controller in the meantime, these logs are not overwritten; instead, the 
restored logs are added to the overview.

Procedure 1. In the main menu, select Start-up > Service > Maintenance handbook. 
The Maintenance handbook window is opened.

2. Select the Maintenance overview tab.

Fig. 5-39: Maintenance overview
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6 Configuration

6.1 Configuring the KUKA Line Interface (KLI)

The KLI is the Ethernet interface of the robot controller for external communi-
cation. It is a physical interface and can contain multiple virtual interfaces.

In order for external PCs to be able to connect to the robot controller via a net-
work, the KLI must be configured accordingly. This is a precondition, for ex-
ample, for being able to transfer WorkVisual projects to the robot controller via 
the network.

6.1.1 Configuring the Windows interface (without PROFINET)

Description The Windows interface is a virtual interface of the KLI. It has a preconfigured 
static IP address: 

 IP address: 172.31.1.147

 Subnet mask: 255.255.0.0

These values can be modified by the user. If required, it is also possible to 
switch to dynamic address assignment. Similarly, it is also possible to switch 
back from a dynamic address to a static address.

DNS server address:

If required, a DNS server address can be specified. 

If the robot controller is connected to the IT network, name resolution of the 
devices can be carried out via the DNS server address. (In other words, the 
DNS server receives a query with a device name and responds with the cor-
responding IP address.)

“0.0.0.0” is admissible and is ignored by the system.

Precondition  PROFINET is not used.

 If the address type Dynamic IP address is to be selected: there is a DHCP 
server present in the network.

 No program is selected.

 Operating mode T1 or T2

 “Expert” user group

Procedure

1. In the main menu, select Start-up > Network configuration. The Net-
work configuration window opens. The active Windows interface is dis-
played. (Default: "virtual5")

2. Select the desired type in the Address type box: Dynamic IP address or 
Fixed IP address

 

f

t

The following address ranges are used by default by the robot con-
troller for internal purposes. IP addresses from this range cannot 
therefore be assigned by the user via the smartHMI. The system in-

dicates an error.

 192.168.0.0 … 192.168.0.255

 172.16.0.0 … 172.16.255.255

 172.17.0.0 … 172.17.255.255

The Address and Subnet boxes may be displayed with a red frame. 
This means that there is an error.
 (>>> 6.1.6 "Error display in the Address and Subnet boxes" 

Page 162)
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3. Only for Dynamic IP address: 

 The following boxes are deactivated, as the values are automatically 
assigned by the DHCP server: IP address, Subnet mask, Standard 
gateway

 Fill out the DNS Server box (if required).

4. Only for Fixed IP address: fill out the following boxes:

 IP address: Enter the IP address of the robot controller.

 Subnet mask: The selected subnet mask must match the IP network.

 Standard gateway (if required): specifies the IP address that can be 
used to leave the network.

“0.0.0.0” is admissible and is ignored by the system.

 DNS Server (if required)

5. Press Save.

6. Reboot the robot controller so that the change takes effect.

6.1.2 Configuring the PROFINET interface and creating the Windows interface

Description PROFINET automatically occupies the virtual interface “virtual5”. This must be 
adapted to PROFINET. 

“Virtual5” can also be used as a Windows interface, but the static IP address 
of PROFINET must then be used for Windows access.

If a different IP configuration is to be used for the Windows interface, an addi-
tional virtual interface, e.g. “virtual6”, must be added and configured for this 
purpose.

The other types in this box (e.g. Real-time IP address) must not be 
selected.

Fig. 6-1: Example: Fixed IP address
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Precondition  PROFINET is used.

 PROFINET device naming has been completed.

 No program is selected.

 T1 or T2 mode

 “Expert” user group

Procedure

1. In the main menu, select Start-up > Network configuration. The Net-
work configuration window opens. The “virtual5” interface is displayed.

2. If it has not already been selected: select the type Fixed IP address in the 
Address type box.

3. Fill out the boxes IP address and Subnet mask. Enter the address and 
mask that are also assigned by the PROFINET PLC.

4. Press Advanced.... The window for advanced network configuration 
opens. 

5. Select the Interfaces tab.

6. Select the entry “virtual5” in the Configured interfaces area and enter 
“PROFINET” in the Interface name box.

7. Several “Reception task” entries are displayed under the entry “virtual5”. 
Select the bottom one.

8. The Reception filter box indicates Accept all. Change the entry to Target 
IP address.

9. Select the entry “virtual5” and press the Add interface button. The entry 
“virtual6” is automatically created.

10. Select the entry “virtual6” and enter “WINDOWS” in the Interface name 
box.

11. Select the type Dynamic IP address in the Address type box.

12. Set the check mark in the check box Windows interface.

Information about device naming can be found in the documentation 
KR C4 PROFINET.

The Address and Subnet boxes may be displayed with a red frame. 
This means that there is an error.
 (>>> 6.1.6 "Error display in the Address and Subnet boxes" 

Page 162)

Fig. 6-2: Reception filter

Fixed IP address can also be selected here if a static IP address is 
desired. The static address must be in a different address range, 
however, than the address of “virtual5”.
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13. Select the “Reception task” entry under the “virtual6” entry.

14. If not already the case, change the Reception filter box to Accept all.

15. Press Save.

16. Close the Network configuration window using the Close icon.

17. Reboot the robot controller. For this, select Shutdown in the main menu 
and select the option Reload files.

The check mark in the check box Windows interface cannot be removed. De-
selection is only possible by defining a different interface as the Windows in-
terface.

6.1.3 Displaying ports of the Windows interface or enabling an additional port

Precondition  User group “Expert”

 Operating mode T1 or T2.

 No program is selected.

Procedure 1. In the main menu, select Start-up > Network configuration. The Net-
work configuration window is opened.

2. Press Activate. The window for advanced network configuration opens.

3. Select the NAT tab. A list of all the enabled ports of the Windows interface 
is displayed in the Available ports area.

4. Only if a port is to be enabled:

a. Press Add port. A new port with the number “0” is added to the list.

b. Complete the boxes Port number and Permitted protocols.

c. Press Save.

Fig. 6-3: Interface “virtual6”

It is not generally necessary to enable additional ports. If this is nev-
ertheless to be done, KUKA Roboter GmbH must be contacted be-
forehand.

The ports enabled by KUKA by default must not be re-
moved. Doing so may result in the loss of functions of the 

robot controller.
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A maximum total of 40 ports can be enabled.

5. Close the Network configuration window using the Close icon.

6. Only if modifications have been made:

Reboot the robot controller so that the changes take effect. To do so, if 
PROFINET is used, select Shutdown in the main menu and select the op-
tion Reload files.

6.1.4 Displaying or modifying filters

Precondition  User group “Expert”

 Operating mode T1 or T2.

 No program is selected.

Procedure 1. In the main menu, select Start-up > Network configuration. The Net-
work configuration window is opened.

2. Press Activate. The window for advanced network configuration opens.

3. Select the Internal subnets tab. The filters of the KUKA Line Interface and 
their properties are displayed here.

4. Only if modifications are required: Carry them out and press Save.

5. Close the Network configuration window using the Close icon.

6. Only if modifications have been made:

Reboot the robot controller so that the changes take effect. To do so, if 
PROFINET is used, select Shutdown in the main menu and select the op-
tion Reload files.

6.1.5 Displaying the subnet configuration of the robot controller

Description The subnet configuration of the robot controller can be displayed. This makes 
it possible to compare it with the subnets of the customer network.

Precondition  User group “Expert”

 Operating mode T1 or T2.

 No program is selected.

Procedure 1. In the main menu, select Start-up > Network configuration. The Net-
work configuration window is opened.

2. Press Activate. The window for advanced network configuration opens.

3. Select the Internal subnets tab. The subnet configuration of the robot 
controller is displayed.

Only the network address is displayed. The range containing the address 
of the device is indicated by an “x”.

It is not generally necessary to modify the filters. If this is nevertheless 
to be done, KUKA Roboter GmbH must be contacted beforehand.

The filters set by KUKA by default must not be modified 
or removed. Doing so may result in the loss of functions 

of the robot controller.

The subnet configuration of the robot controller may be 
modified only in consultation with KUKA Roboter GmbH. 

Modifications carried out without consultation may result in the loss of func-
tions of the robot controller.
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6.1.6 Error display in the Address and Subnet boxes

Description The Address and Subnet boxes may be displayed with a red frame. This indi-
cates an error and may have the following causes:

Example Example of an entry that is not system-compliant:

In the binary display, subnet masks may only contain closed groups of leading 
ones.

 The subnet mask “255.255.208.0” is entered.

 The box is now displayed with a red frame. 

Reason: the binary representation of “208” corresponds to “11010000” 
and is thus not a valid entry.

 Possible remedy: enter 255.255.240.0.

The binary representation of “240” corresponds to “11110000” and is thus 
a valid entry.

The Address and Subnet boxes may be displayed with a red frame. 
This means that there is an error.
 (>>> 6.1.6 "Error display in the Address and Subnet boxes" 

Page 162)

Fig. 6-4: Example: Internal subnets

Cause Possible remedy

The entry does not conform to the 
IP system.

Example: The number ranges of the 
IP address and subnet do not 
match.

Check the box with the red frame 
and correct it. 

The red frame disappears.

This address is already used in one 
of the internal subnets.

In this case, both the address and 
the corresponding box on the Inter-
nal subnets tab are displayed with 
a red frame.

 Change the actual address.

 Or, only after consultation with 
KUKA, change the address of 
the internal subnet.

The red frame disappears.

The subnet configuration of the robot controller may be 
modified only in consultation with KUKA Roboter GmbH. 

Modifications carried out without consultation may result in the loss of func-
tions of the robot controller.
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6.2 Reconfiguring the I/O driver

Description The command I/O drivers > Reconfigure causes all files in the directory 
C:\KRC\ROBOTER\Config\User to be reloaded. Changes made in these files 
are applied.

Precondition  User group "Expert".

 Operating mode T1 or T2.

Procedure 1. In the main menu, select Configuration > Inputs/outputs > I/O drivers.

2. Press the Reconfigure button.

It makes no difference whether the State or Configuration tab is selected.

3. Answer the request for confirmation Do you really want to reconfigure all 
I/O drivers? with Yes.

The message Reconfiguration in progress ... is displayed. When the mes-
sage disappears, reconfiguration is completed.

6.3 Configuring safe axis monitoring functions

Precondition  User group “Safety recovery”

 Operating mode T1 or T2

Procedure

1. In the main menu, select Configuration > Safety configuration.

The Safety configuration window opens.

2. Select the Axis monitoring tab.

3. Edit the parameters as required and press Save.

4. Answer the request for confirmation with Yes. The controller is reconfig-
ured.

5. Once the reconfiguration has been completed, the following message is 
displayed: Changes saved successfully.

Confirm the message with OK.

Editable param-

eters

The following parameters can be set for each axis. It is not generally neces-
sary to change the default values, however.

During reconfiguration, all outputs are briefly set to zero before return-
ing to their original state.

In order to be able to save the configuration values, a reconfiguration 
must be carried out. During reconfiguration, all outputs are briefly set 
to zero before returning to their original state.

Following modifications to the safety configuration, the 
safe axis monitoring functions must be checked.

 (>>> 6.4 "Checking safe axis monitoring functions" Page 165)
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6.3.1 Parameter: Braking time

Description If a safety stop 1 or 2 occurs, the safety controller monitors the braking pro-
cess. Among other things, it monitors whether the axis-specific velocity re-
mains below the braking ramp. If the velocity is too high, i.e. if the braking ramp 
is violated, then the safety controller triggers a safety stop 0.

The braking ramp results from an internal factor for the ramp gradient and from 
the value Braking time.

This means: the parameter Braking time influences a monitoring function. 
Braking time does not influence the actual motion characteristics of the kine-
matic system, however.

The parameter Braking time has no effect in T1, since the value refers to the 
axis-specific monitoring. In T1, however, there is another (non-configurable) 
monitoring function for the Cartesian velocity on the flange. This is stricter, 
which is why the axis-specific monitoring has no effect.

Parameter Description

Braking time Duration of the monitored axis-specific braking 
ramp for safety stop 1 and safety stop 2 

Default: 1,500 ms

 (>>> 6.3.1 "Parameter: Braking time" Page 164)

Maximum velocity T1 Maximum velocity in T1

 Rotational axes: 1.00 … 100.00 °/s

Default: 30 °/s

 Linear axes: 1.00 … 1,500.00 mm/s

Default: 250 mm/s

This parameter enables a servo gun, for exam-
ple, to be calibrated in T1 with a higher velocity 
than 250 mm/s.

Note: The Cartesian velocities at the flange and 
at the TCP are monitored independently of this 
parameter and cannot exceed 250 mm/s. 

Position tolerance Tolerance for standstill monitoring in the case of 
safe operational stop. The axis may still move 
within this tolerance when a safe operational 
stop is active. 

 Rotational axes: 0.001 … 1 °

Default: 0.01 °

 Linear axes: 0.003 … 3 mm

Default: 0.1 mm

Only alter the default time if it is necessary to do so. This 
might be required, for example, in the case of very heavy 

machines and/or very heavy loads as these cannot stop within the default 
time.
The safety maintenance technician must check whether and to what extent 
the Braking time value needs to be modified in each specific application. He 
must also check whether the modification makes additional safety measures 
necessary, e.g. installation of a gate lock. 
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Braking time 

modified

If the value Braking time is increased, this has the following conse-
quences: 

The braking ramp becomes longer and flatter, i.e. monitoring is now less strict. 
The same braking process is now less likely to violate the braking ramp than 
before.

The start velocity of the axis-specific braking ramp is always 106% of the rated 
speed of the axis. The ramp falls to 10.6%. The velocity then remains constant 
for 300 ms, before falling to 0%.

If the value “Braking time” is reduced, this has the following consequenc-
es: 

The braking ramp becomes shorter and steeper, i.e. monitoring is now stricter. 
The same braking process is now more likely to violate the braking ramp than 
before.

6.4 Checking safe axis monitoring functions

Description When the safety configuration is saved, random errors can occur in the sys-
tem, resulting in the safety configuration ultimately containing values that differ 
from those programmed by the user. This is an exceptional occurrence, but 
cannot be ruled out entirely. 

To rule out the possibility of such an error occurring for the parameters Brak-
ing time and Position tolerance, the values of these parameters must be ver-

Braking time can be entered separately for each axis; at the moment 
of braking, however, the value used for all axes is always the highest 
value entered. 

Recommendation: for greater transparency, enter the same value for all ax-
es.

Fig. 6-5: Example: value is increased

1 Velocity profile during braking (example)

2 Braking ramp (original value Braking time)

3 Braking ramp (higher value of Braking time)

v0 Velocity of the kinematic system at the moment when braking be-
gins

t0 Start time of the braking ramp

tend End of the braking ramp

tend' End of the braking ramp with a higher value for Braking time
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ified in the diagnostic monitor. No other type of verification is possible for these 
parameters.

Precondition  The values most recently saved for the parameters Braking time and Po-
sition tolerance are known.

The most recently saved values can generally be found in a checklist, 
sign-off sheet, or similar.

Procedure

1. In the main menu, select Diagnosis > Diagnostic monitor.

The Diagnostic monitor window opens.

2. Select the Safety controller (HnfHlp) area in the Module box.

Data are now displayed for this area.

3. Compare the values displayed for Braking time and Position tolerance 
with the most recently saved values.

4. Result:

 If the values match: OK. 

Close the Diagnostic monitor window. No further action is neces-
sary.

 If the values do not match: 

Enter and save the values again. If necessary, transfer the WorkVisual 
project to the robot controller again. 

Then carry out the check again. KUKA Roboter GmbH must be con-
tacted if the values still do not match.

6.5 Checking the safety configuration of the robot controller

Description The safety configuration of the robot controller must be checked in the follow-
ing cases:

 After activation of a WorkVisual project on the robot controller

 Generally after changes to the machine data (independent of WorkVisual).

Precondition  User group “Safety recovery”

Procedure

1. In the main menu, select Configuration > Safety configuration.

2. The safety configuration checks whether there are any relevant deviations 
between the data in the robot controller and those in the safety controller.

3. The following situations can now occur:

The values must always be checked if the checksum has 
changed on the General tab in the Safety configuration 

window, i.e. not only if the values themselves have been changed, but if any 
changes have been made that affect the safety configuration.
If this check is not carried out, the safety configuration may contain incorrect 
data. Death to persons, severe injuries or considerable damage to property 
may result.

The following procedure must be followed exactly!

If the safety configuration is not checked and updated 
where necessary, it may contain incorrect data. Death, 

injuries or damage to property may result.

The following procedure must be followed exactly!
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a. If there are no deviations, the Safety configuration window is 
opened. No message is displayed. No further action is necessary.

b. If there are deviations regarding the machine data, a dialog message 
is displayed. The deviations can now be synchronized or left unsyn-
chronized. In either case, safety-relevant measures must be taken into 
consideration.

 (>>>  "Deviations" Page 167)

c. The safety configuration also checks whether there are any other de-
viations (other than in the machine data) between the robot controller 
and the safety controller.

If so, the Troubleshooting wizard window is opened. A description of 
the problem and a list of possible causes is displayed. The user can 
select the applicable cause. The wizard then suggests a solution.

Deviations The dialog message indicates which machine data in the robot controller de-
viate from those in the safety controller. 

The message asks whether the safety configuration is to be updated, i.e. 
whether the machine data of the robot controller are to be applied to the safety 
configuration. 

 If so: Answer the query with Yes. 

 If not: Answer the query with No.

6.6 Checksum of the safety configuration

Description The checksum is updated each time the safety configuration is saved. The ro-
bot controller displays the checksum in the following locations:

 In the Safety configuration window on the General tab :

The window can be opened from the main menu by selecting Configura-
tion > Safety configuration.

 For user group Expert or higher:

In the file SGTLCRC.XML in the directory C:\KRC\ROBOTER\Config\Us-
er\Common

The SCTLCRC.XML file is available so that, if required, the system integrator 
can read the checksum there via the higher-level controller.

SCTLCRC.XML

If deviations are applied, the safety measures for start-up 
and recommissioning must then be carried out. 

In this case, the robot must not be operated. The ma-
chine data must be checked and corrected so that either 

the safety configuration detects no further deviations or the detected devia-
tions can be applied.

During start-up of the industrial robot, it is advisable to check that the 
value is correctly read from the SCTLCRC.XML file and transferred to 
the higher-level controller.

Fig. 6-6: Example: Checksum in the SCTLCRC.XML file
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6.7 Exporting the safety configuration (XML export)

Description Parts of the safety configuration can be exported. The export creates an XML 
file. This contains only those parameters which are relevant for the safety op-
tions, e.g. SafeOperation. 

 Exporting is always possible, irrespective of whether a safety option is in-
stalled or not. However, an export only makes sense if a safety option is 
installed.

 If no safety option is installed on the robot controller, the parameters in the 
XML file are filled with default values (often “0”). 

Procedure 1. In the main menu, select Configuration > Safety configuration.

The Safety configuration window opens.

2. Press Export. The available drives are displayed.

3. Select the desired file path and press Export.

The safety configuration is saved in an XML file. The file name is generat-
ed automatically.

6.8 Configuring the variable overview

This is where the variables to be displayed in the variable overview and the 
number of groups are defined. A maximum of 10 groups is possible. A maxi-
mum of 25 variables per group is possible. System variables and user-defined 
variables can be displayed.

Precondition  “Expert” user group

Procedure 1. In the main menu, select Display > Variable > Overview > Configura-
tion.

The Variable overview – Configuration window is opened.

2. Make the desired settings. To edit a cell, select it.

3. Press OK to save the configuration and close the window.

In addition to exporting, it is also possible to import a safety configu-
ration when a safety option is installed. More detailed information 
about exporting and importing can be found in the safety option doc-

umentation.
It is also possible to import or export safety configurations in WorkVisual. In-
formation about this can be found in the WorkVisual documentation.
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Description

The following buttons are available:

Fig. 6-7: Variable overview - Configuration

Item Description

1
Arrow symbol : If the value of the variable changes, the display 
is automatically refreshed.

No arrow symbol: The display is not automatically refreshed.

2 Descriptive name

3 Path and name of the variable

Note: For system variables, the name is sufficient. Other variables 
must be specified as follows:

/R1/Program name/Variable name

Do not specify a folder between /R1/ and the program name. Do 
not add a file extension to the file name.

4 Lowest user group in which the current group can be modified.

5 Lowest user group in which the current group can be displayed.

6 Column width in mm. Enter the desired value via the keypad and 
confirm it with the Enter key.

7 Row height in mm. Enter the desired value via the keypad and con-
firm it with the Enter key.
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6.9 Changing the password

Procedure 1. Select Configuration > User group in the main menu. The current user 
group is displayed.

2. Press Login....

3. Select the user group for which the password is to be changed.

4. Press Password ....

5. Enter the old password. Enter the new password twice.

For security reasons, the entries are displayed encrypted. Upper and low-
er case are taken into consideration.

6. Press OK. The new password is valid immediately.

6.10 Energy saving mode ($ECO_LEVEL)

Description The system variable $ECO_LEVEL can be used to operate the robot in energy 
saving mode. The degree of energy saving can be set to “Low”, “Middle” or 
“High”. Energy saving mode causes the robot axes and external axes to move 
more slowly. The higher the saving, the lower the velocity. How much energy 
is saved relative to full power depends primarily on the axis positions and can-
not be predicted.

$ECO_LEVEL does not affect all motions. The following table indicates which 
motions it affects and which it does not:

Button Description

Monitor Switches to the variable overview.

 (>>> 4.17.8 "Displaying the variable overview 
and modifying variables" Page 84)

Insert Displays additional buttons:

 Row above: Inserts a new row above the one 
currently selected.

 Row below: Inserts a new row below the one 
currently selected.

 Group before: Inserts a new group to the left 
of the one currently selected.

 Group after: Inserts a new group to the right 
of the one currently selected.

Delete Displays additional buttons:

 Line: The selected row is deleted.

 Group: The current group is deleted.

Motion Effect?

PTP Yes

LIN No

CIRC No

CP spline motions (block and individual motion)

With higher motion profile

Yes

CP spline motions (block and individual motion)

Without higher motion profile

No

PTP spline motions (block and individual motion) Yes
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If a program is reset or deselected, energy saving mode is automatically de-
activated.

Energy saving mode is inactive in the following cases, even if it has been ac-
tivated:

 In the case of a BCO run

 In a constant velocity range with spline

 In a time block with spline

If low values have already been programmed for acceleration and velocity, 
$ECO_LEVEL has little or no effect.

Depending on the robot type, the savings may be the same, or virtually the 
same, for both “Middle” and “High” (e.g. with a payload under 30% of the de-
fault payload).

Precondition  $ADAP_ACC <> #NONE

 $OPT_MOVE <> #NONE

The default setting for both system variables is <> #NONE.

Syntax $ECO_LEVEL=Level

Explanation of 

the syntax

6.11 Configuring workspaces

Workspaces can be configured for a robot. These serve to protect the system.

A maximum of 8 Cartesian (=cubic) and 8 axis-specific workspaces can be 
configured at any one time. The workspaces can overlap.

 (>>> 6.11.1 "Configuring Cartesian workspaces" Page 171)

 (>>> 6.11.2 "Configuring axis-specific workspaces" Page 174)

There are 2 types of workspace:

 Non-permitted spaces. The robot may only move outside such a space.

 Permitted spaces. The robot must not move outside such a space.

Exactly what reactions occur when the robot violates a workspace depends on 
the configuration.

6.11.1 Configuring Cartesian workspaces

Description The following parameters define the position and size of a Cartesian work-
space:

 Origin of the workspace relative to the WORLD coordinate system

 Dimensions of the workspace, starting from the origin

Element Description

Stage Type: ENUM

 #OFF: Energy saving mode is deactivated.

 #LOW: Low saving

 #MIDDLE: Medium saving

 #HIGH: High saving
171 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



172 / 491

KUKA System Software 8.3
Precondition  User group "Expert".

 Operating mode T1 or T2.

Procedure 1. In the main menu, select Configuration > Miscellaneous > Workspace 
monitoring > Configuration.

The Cartesian workspaces window is opened.

2. Enter values and press Save.

3. Press Signal. The Signals window is opened.

4. In the Cartesian group: next to the number of the workspace, enter the 
output that is to be set if the workspace is violated.

5. Press Save.

6. Close the window.

Fig. 6-8: Cartesian workspace, origin U

Fig. 6-9: Cartesian workspace, dimensions
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If no output is to be set when the workspace is violated, the value FALSE must 
be entered.

Fig. 6-10: Configuring a Cartesian workspace

Item Description

1 Number of the workspace (max. 8)

2 Designation of the workspace

3 Origin and orientation of the workspace relative to the WORLD co-
ordinate system

4 Dimensions of the workspace in mm

5 Mode  (>>> 6.11.3 "Mode for workspaces" Page 176)

Fig. 6-11: Workspace signals

Item Description

1 Outputs for the monitoring of the Cartesian workspaces

2 Outputs for the monitoring of the axis-specific workspaces
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6.11.2 Configuring axis-specific workspaces

Description Axis-specific workspaces can be used to restricted yet further the areas de-
fined by the software limit switches in order to protect the robot, tool or work-
piece.

Precondition  User group "Expert".

 Operating mode T1 or T2.

Procedure 1. In the main menu, select Configuration > Miscellaneous > Workspace 
monitoring > Configuration.

The Cartesian workspaces window is opened.

2. Press Axis-spec. to switch to the window Axis-specific workspaces.

3. Enter values and press Save.

4. Press Signal. The Signals window is opened.

5. In the Axis-specific group: next to the number of the workspace, enter the 
output that is to be set if the workspace is violated.

6. Press Save.

7. Close the window.

Fig. 6-12: Example of axis-specific workspaces for A1
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If the value 0 is entered for an axis under Item 3 and Item 4, the axis is not 
monitored, irrespective of the mode.

Fig. 6-13: Configuring an axis-specific workspace

Item Description

1 Number of the workspace (max. 8)

2 Designation of the workspace

3 Lower limit for axis angle

4 Upper limit for axis angle

5 Mode  (>>> 6.11.3 "Mode for workspaces" Page 176)

Fig. 6-14: Workspace signals
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If no output is to be set when the workspace is violated, the value FALSE must 
be entered.

6.11.3 Mode for workspaces

6.12 Defining limits for reteaching

Description If this function is active, existing points may only be re-taught within the de-
fined limits in the user groups “User” and “Operator”. If the limits are exceeded, 
a message is displayed, indicating that the change is not possible. Global po-
sitions, e.g. the HOME position, can no longer be re-taught at all in these user 
groups.

In the user group “Expert”, points can still be re-taught without restrictions. 

The limits only apply to changes made using the buttons Change and Touch 
Up or Cmd OK. Changes made using different functions, e.g. calibration or 
variable correction, remain possible for the user groups “User” and “Operator”. 

Precondition  “Expert” user group

Item Description

1 Outputs for the monitoring of the Cartesian workspaces

2 Outputs for the monitoring of the axis-specific workspaces

Mode Description

#OFF Workspace monitoring is deactivated.

#INSIDE  Cartesian workspace: The defined output is set if 
the TCP or flange is located inside the workspace.

 Axis-specific workspace: The defined output is set if 
the axis is located inside the workspace.

#OUTSIDE  Cartesian workspace: The defined output is set if 
the TCP or flange is located outside the workspace.

 Axis-specific workspace: The defined output is set if 
the axis is located outside the workspace.

#INSIDE_STOP  Cartesian workspace: The defined output is set if 
the TCP, flange or wrist root point is located inside 
the workspace. (Wrist root point = center point of 
axis A5)

 Axis-specific workspace: The defined output is set if 
the axis is located inside the workspace.

The robot is also stopped and messages are displayed. 
The robot cannot be moved again until the workspace 
monitoring is deactivated or bypassed.

 (>>> 4.16 "Bypassing workspace monitoring" 
Page 76)

#OUTSIDE_ST
OP

 Cartesian workspace: The defined output is set if 
the TCP or flange is located outside the workspace.

 Axis-specific workspace: The defined output is set if 
the axis is located outside the workspace.

The robot is also stopped and messages are displayed. 
The robot cannot be moved again until the workspace 
monitoring is deactivated or bypassed.

 (>>> 4.16 "Bypassing workspace monitoring" 
Page 76)
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Procedure 1. In the main menu, select Configuration > Miscellaneous > Point coor-
dinate correction limit. The Point coordinate correction limit window 
opens.

2. Enter the desired values and activate the check box Correction limit ac-
tive.

3. Touch the Close icon. A request for confirmation is displayed, asking if the 
changes are to be saved.

4. Answer the query with Yes. The entries are saved and the window is 
closed.

6.13 Warm-up

Description If a robot is started in low ambient temperatures, this results in increased fric-
tion in the gear unit. This can cause the motor current of an axis (or of more 
than one axis) to reach its maximum value. This stops the robot and the robot 
controller generates the error message Regulator limit exceeded <axis number>.

Fig. 6-15: Option window “Point coordinate correction limit”

Item Description

1 Check box active: The limits are active.

Check box not active: The limits are not active.

2 Maximum permissible change for the X, Y and Z values

 1.00 … 100.00 mm

The value represents the radius of an imagined sphere about the 
original point. 

3 Maximum permissible change for the A, B and C values

 0.00 … 20.00 deg

Value 0.00 means: no change allowed.

4 This box is only displayed if at least one external axis is present.

Maximum permissible change for the displayed external axis.

 0.00 … 100.00 mm

Button Description

External axes The button is only available if more than one ex-
ternal axis is present.

Displays the next external axis.
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To avoid this, the motor current can be monitored during the warm-up phase. 
If a defined value is reached, the robot controller reduces the motion velocity. 
This, in turn, reduces the motor current.

6.13.1 Configuring warm-up

Precondition  “Expert” user group

Procedure 1. Open the file R1\Mada\$machine.dat.

2. Set the corresponding system variables to the desired values.

 (>>> 6.13.3 "System variables for warm-up" Page 179)

3. Close the file. Respond to the request for confirmation asking whether the 
changes should be saved by pressing Yes.

6.13.2 Warm-up sequence

Precondition  $WARMUP_RED_VEL =TRUE

 Operating mode AUT or AUT EXT

 The robot is considered to be cold. This applies in the following cases:

 Cold start

 Or $COOLDOWN_TIME has expired.

 Or $WARMUP_RED_VEL has been set from FALSE to TRUE.

Example Sequence on the basis of the following example values in $machine.dat:

1. The cold robot starts. The motor currents are monitored for 30 minutes 
($WARMUP_TIME).

2. If the motor current of an axis exceeds 95% ($WARMUP_CURR_LIMIT) 
of the maximum permissible motor current, the monitoring is triggered. 
The robot controller then generates the message Warm-up active and re-
duces the internal override. The robot slows down and the motor current 
drops. The program override on the KCP remains unchanged!

The internal override is reduced to a maximum of 60% 
($WARMUP_MIN_FAC) of the programmed override. There is no way of 
influencing how quickly the internal override is reduced.

3. Once the monitoring is no longer triggered, the robot controller increases 
the internal override again. This is generally the case before the minimum 
$WARMUP_MIN_FAC has been reached! The robot accelerates again.

Once a second, the robot controller edges back up towards the pro-
grammed override. $WARMUP_SLEW_RATE determines the rate of in-
crease. In the example, the internal override is increased by 5% per 
second.

4. It is possible that the robot is still not warm enough and that the motor cur-
rent thus exceeds the maximum $WARMUP_CURR_LIMIT once again. 

The monitoring refers to PTP motions and PTP-CP approximate po-
sitioning blocks. 
Other motions are not monitored and their velocity is not reduced. 

These include LIN, CIRC and all spline motions (CP and PTP).

BOOL $WARMUP_RED_VEL = TRUE

REAL $WARMUP_TIME = 30.0

REAL $COOLDOWN_TIME = 120.0

INT $WARMUP_CURR_LIMIT = 95

INT $WARMUP_MIN_FAC = 60

REAL $WARMUP_SLEW_RATE = 5.0
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The robot controller reacts (within $WARMUP_TIME) the same way as the 
first time.

5. If the robot is warm enough for the robot controller to increase the internal 
override all the way back up to the programmed override, the robot con-
troller deactivates the message Warm-up active.

6. After 30 minutes ($WARMUP_TIME), the robot is deemed to be warmed 
up and the motor currents are no longer monitored.

LOG file The following events are logged in the file “Warmup.LOG” (path “KRC:\Robot-
er\Log\”):

Example:

6.13.3 System variables for warm-up

The system variables for the warm-up can only be modified in the file $Ma-
chine.dat (path KRC:\R1\MADA).

Entry Meaning

Monitoring active The motor currents are monitored.

Monitoring inactive The motor currents are not monitored.

Controlling active The velocity is reduced.

Controlling inactive The velocity corresponds to the programmed 
override once again.

...

Date: 21.08.08 Time: 14:46:57 State: Monitoring active

Date: 21.08.08 Time: 14:54:06 State: Controlling active

Date: 21.08.08 Time: 14:54:07 State: Controlling inactive

Date: 21.08.08 Time: 18:23:43 State: Monitoring inactive

...

If one of the values is outside the permissible range, the warm-up 
function is not active and the velocity is not reduced.

System variable Description

$WARMUP_RED_VEL  TRUE: Warm-up functionality is activated.

 FALSE: Warm-up functionality is deactivated (default).

If $WARMUP_RED_VEL is set from FALSE to TRUE, this sets the 
runtime of the robot to zero. The robot is deemed to be cold, irre-
spective of how long it was previously under servo control.

$WARMUP_TIME Time during which the motor currents are monitored by the warm-
up function.

If the cold robot is started, a runtime value is incremented. If the 
robot is not under servo control, the value is decremented. If the 
runtime is greater than $WARMUP_TIME, the robot is deemed to 
be warmed up and the motor currents are no longer monitored.

 > 0.0 min
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6.14 Collision detection

Description If the robot collides with an object, the robot controller increases the axis 
torques in order to overcome the resistance. This can result in damage to the 
robot, tool or other objects.

Collision detection reduces the risk of such damage. It monitors the axis 
torques. If these deviate from a specified tolerance range, the following reac-
tions are triggered:

 The robot stops with a STOP 1.

 The robot controller calls the program tm_useraction. This is located in 
the Program folder and contains the HALT statement. Alternatively, the 
user can program other reactions in the program tm_useraction.

 (>>> 6.14.4 "Editing the program tm_useraction" Page 185)

The robot controller automatically calculates the tolerance range. (Exception: 
no values are calculated in T1 mode.) A program must generally be executed 
2 or 3 times before the robot controller has calculated a practicable tolerance 

$COOLDOWN_TIME If the warm robot is not under servo control, a standstill value is 
incremented. If the robot is under servo control, the value is dec-
remented. If the standstill time is greater than 
$COOLDOWN_TIME, the robot is deemed to be cold and the 
motor currents are monitored. (Precondition: 
$WARMUP_RED_VEL = TRUE.)

If the controller of a warm robot is shut down and restarted with a 
warm restart, the time the controller was switched off is counted 
as standstill time.

 > 0.0 min

$WARMUP_CURR_LIMIT Maximum permissible motor current during warm-up (relative to 
the regular maximum permissible motor current)

Regular maximum permissible motor current = 

($CURR_LIM * $CURR_MAX) / 100

 0 … 100%

$WARMUP_MIN_FAC Minimum for the override reduction due to the warm-up function

The internal override is reduced at most to the factor of the pro-
grammed override defined here.

 0 … 100%

$WARMUP_SLEW_RATE Rate of increase for the increase in velocity

Once the monitoring is no longer triggered, the robot controller 
increases the internal override again. The rate of increase is 
defined here.

 > 0.0%/s

System variable Description

Collision detection is an extension and improvement of the torque 
monitoring function.
The torque monitoring function remains available. Programs in which 

torque monitoring is already defined can still be executed as before.
Alternatively, the lines with the torque monitoring in such programs can be 
deleted and collision detection can be used instead. Collision detection must 
not be used together with torque monitoring in a program.
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range. The user can define an offset via the user interface for the tolerance 
range calculated by the robot controller.

If the robot is not operated for a longer period (e.g. over the weekend), the mo-
tors, gear units, etc., cool down. Different axis torques are required in the first 
few runs after such a break than in the case of a robot that is already at oper-
ating temperature. The robot controller automatically adapts the collision de-
tection to the changed temperature.

Precondition  In order to be able to use the collision detection function, acceleration ad-
aptation must be activated. 

Acceleration adaptation is activated when system variable $ADAP_ACC 
is not equal to #NONE. (This is the default setting.) The system variable 
can be found in the file C:\KRC\Roboter\KRC\R1\MaDa\$ROBCOR.DAT.

 The tolerance range is only calculated for motion blocks that have been 
executed completely.

 To activate collision detection for a motion, the parameter Collision de-
tection must be set to TRUE during programming. This can be seen from 
the addition CD in the program code:

Limitations  Collision detection is not possible for HOME positions and other global po-
sitions.

 Collision detection is not possible for external axes.

 Collision detection is not possible during backward motion.

 Collision detection is not possible in T1 mode.

 High axis torques arise when the stationary robot starts to move. For this 
reason, the axis torques are not monitored in the starting phase (approx. 
700 ms).

 The collision detection function reacts much less sensitively for the first 2 
or 3 program executions after the program override value has been mod-
ified. Thereafter, the robot controller has adapted the tolerance range to 
the new program override.

System variables

PTP P2  Vel= 100 % PDAT1 Tool[1] Base[1] CD

The parameter Collision detection is only available if the motion is 
programmed via an inline form.
Information about collision detection for motions programmed without 

inline forms can be found in the documentation “KUKA.ExpertTech”.

System variable Description

$TORQ_DIFF The values of $TORQ_DIFF (torque) and $TORQ_DIFF2 
(impact) are automatically calculated during program execution. 
These values are compared with the values from the previous 
program execution or with the default values. The highest value 
is saved. The values are always calculated, even when collision 
detection is deactivated.

If collision detection is active, the system compares the values 
of $TORQ_DIFF and $TORQ_DIFF2 with the saved values dur-
ing the motion.

$TORQ_DIFF2

$TORQMON_DEF[1] … 
$TORQMON_DEF[6]

Values for the tolerance range in program mode (per axis)*

File KRC:\STEU\Mada\$custom.dat

$TORQMON_COM_DEF[1] 
… 
$TORQMON_COM_DEF[6]

Values for the tolerance range in jog mode (per axis)*

File KRC:\STEU\Mada\$custom.dat
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*The width of the tolerance range is equal to the maximum torque [Nm] multi-
plied by the value in $TORQMON_... . The default value is 200. Unit: percent.

6.14.1 Calculating the tolerance range and activating collision detection

Precondition  The acceleration adaptation is switched on.

 The load data have been entered correctly.

 In the program, the parameter Collision detection is set to TRUE for all 
motions that are to be monitored.

 If required: the desired collision response has been programmed in the 
program tm_useraction.

Procedure 1. In the main menu, select Configuration > Miscellaneous > Collision de-
tection.

 (>>> 6.14.3 "Option window “Collision detection”" Page 183)

2. The box KCP must contain the entry MonOff. If this is not the case, press 
Deactivate.

3. Start the program and execute it several times. After 2 or 3 program exe-
cutions, the robot controller has calculated a practicable tolerance range.

4. Press Activate. The box KCP in the Collision detection window now 
contains the entry MonOn.

Save the configuration by pressing Close.

If required, the user can define an offset for the tolerance range.  
(>>> 6.14.2 "Defining an offset for the tolerance range" Page 182)

6.14.2 Defining an offset for the tolerance range

Description An offset for the torque and for the impact can be defined for the tolerance 
range. The lower the offset, the more sensitive the reaction of the collision de-
tection. The higher the offset, the less sensitive the reaction of the collision de-
tection.

Torque: The torque is effective if the robot meets a continuous resistance. Ex-
amples:

 The robot collides with a wall and pushes against the wall.

 The robot collides with a container. The robot pushes against the container 
and moves it.

$COLL_ENABLE Signal declaration. This output is set if the value of one of the 
$TORQMON_DEF[…] variables is less than 200.

File: KRC:\STEU\Mada\$machine.dat

$COLL_ALARM Signal declaration. This output is set if message 117 “Collision 
Detection axis <axis number>” is generated. The output 
remains set as long as $STOPMESS is active.

File: KRC:\STEU\Mada\$machine.dat

$TORQMON_TIME Response time for the collision detection. Unit: milliseconds. 
Default value: 0.0

 File: C:\KRC\Roboter\KRC\Steu\MaDa\$CUSTOM.DAT.

System variable Description

The tolerance range must be recalculated in the following cases:

The velocity has been modified.

Points have been changed, added or removed.
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Impact: The impact is effective if the robot meets a brief resistance. Example:

 The robot collides with a panel which is sent flying by the impact.

Procedure 1. Select program.

2. In the main menu, select Configuration > Miscellaneous > Collision de-
tection.

 (>>> 6.14.3 "Option window “Collision detection”" Page 183)

3. The offset for a motion can be modified while a program is running: 

If the desired motion is displayed in the Collision detection window, 
press an arrow key in the Torque or Impact box. The window remains fo-
cused on the motion and the offset can be modified. 

Alternatively, a block selection to the desired motion can be carried out.

4. Save the change by pressing Save.

5. Save the configuration by pressing Close.

6. Set the original operating mode and program run mode.

6.14.3 Option window “Collision detection”

If the collision detection reacts too sensitively, do not immediately in-
crease the offset. Instead, recalculate the tolerance range first and 
test whether the collision detection now reacts as desired.

 (>>> 6.14.1 "Calculating the tolerance range and activating collision detec-
tion" Page 182)

Fig. 6-16: Option window “Collision detection”

The values in the option window Collision detection do not always 
refer to the current motion. Deviations are particularly possible in the 
case of points which are close together and approximated motions.
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Item Description

1 Indicates the status of the current motion:

 Red: the current motion is not monitored.

 Green: the current motion is monitored.

 Orange: an arrow key has been pressed in the Torque or Im-
pact box. The window remains focused on the motion and the 
offset can be modified. The change can then be applied by 
pressing Save.

 Pixelated: A program must generally be executed 2 or 3 times 
before the robot controller has calculated a practicable toler-
ance range. This display is pixelated during this learning 
phase.

2 Number of the TMx variable

The robot controller creates a TMx variable for each motion block 
in which the parameter Collision detection is set to TRUE. TMx 
contains all the values for the tolerance range of this motion block. 
If 2 motion blocks refer to the same point Px, the robot controller 
creates 2 TMx variables.

3 Path and name of the selected program

4 Point name

5 This box is only active in “Automatic External” mode. It appears 
gray in all other modes.

MonOn: collision detection has been activated by the PLC.

If collision detection is activated by the PLC, the PLC sends the 
input signal sTQM_SPSACTIVE to the robot controller. The robot 
controller responds with the output signal sTQM_SPSSTATUS. 
The signals are defined in the file $config.dat.

Note: Collision detection is only active in Automatic External 
mode if both the PLC box and the KCP box show the entry 
MonOn.

6 MonOn: collision detection has been activated from the smart-
PAD.

Note: Collision detection is only active in Automatic External 
mode if both the PLC box and the KCP box show the entry 
MonOn.

7 Offset for the torque. The lower the offset, the more sensitive the 
reaction of the collision detection. Default value: 20.

If an arrow key is pressed, the window remains focused on the 
motion and the offset can be modified. The change can then be 
applied by pressing Save.

 N.A.: the option Collision detection in the inline form is set to 
FALSE for this motion.

8 Offset for the impact. The lower the offset, the more sensitive the 
reaction of the collision detection. Default value: 30.

If an arrow key is pressed, the window remains focused on the 
motion and the offset can be modified. The change can then be 
applied by pressing Save.

 N.A.: the option Collision detection in the inline form is set to 
FALSE for this motion.
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6.14.4 Editing the program tm_useraction

Description By default, the program tm_useraction contains the HALT statement. If re-
quired, the user can program other statements. 

Preparation  In the attributes of the program tm_useraction, activate the attribute Vis-
ible:

To do so, activate the check box Visible on the Module info tab.

 (>>> 7.4.2 "Displaying or modifying properties of files and folders" 
Page 233)

Precondition  “Expert” user group

 T1, T2 or AUT mode

 Submit interpreter is deselected.

Procedure 1. Select tm_useraction.src in the file list (= right-hand area of the Naviga-
tor).

2. Press the Open button. The program is displayed in the editor.

3. Make the desired changes.

4. Close the program.

To accept the changes, answer the request for confirmation with Yes.

5. Recommendation: Deactivate the attribute Visible again.

Reason:

 Visible activated: when the robot controller calls tm_useraction, the 
block pointer indicates this program.

 Visible deactivated: when the robot controller calls tm_useraction, 
the block pointer indicates the point at which the main program was in-
terrupted. This is generally more useful during troubleshooting.

Button Description

Activate Activates collision detection.

This button is not displayed if the torque or impact 
has been changed, but the changes have not yet 
been saved.

Deactivate Deactivates collision detection.

This button is not displayed if the torque or impact 
has been changed, but the changes have not yet 
been saved.

Save Saves changes to the torque and/or impact.

Cancel Rejects changes to the torque and/or impact.

tm_useraction.src is called by the robot controller by means of an 
interrupt. The restrictions that apply to interrupt programs must there-
fore be observed during programming.
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6.14.5 Torque monitoring

Description Differences between torque monitoring and collision detection:

 The tolerance range is not automatically calculated by the robot controller, 
but must be defined by the user.

 The tolerance range only refers to the torque. No values can be defined 
for the impact.

 The robot controller cannot automatically adapt the tolerance range to 
changed temperatures.

 If a collision is detected, the robot stops with a STOP 1. It is not possible 
to call a user-defined program.

Overview

6.14.5.1 Determining values for torque monitoring

Description The maximum torque deviation that has occurred can be determined as a per-
centage by means of the system variable $TORQ_DIFF[...].

Procedure 1. In the main menu, select Display > Variable > Single.

2. Set the value of the variable $TORQ_DIFF[…] to 0.

3. Execute the motion block and read the variable again. The value corre-
sponds to the maximum torque deviation.

4. Set the variable for the monitoring of the axis to this value plus a safety 
margin of 5 - 10%.

Only the value 0 can be assigned to the variables $TORQ_DIFF[...].

6.14.5.2 Programming torque monitoring

Precondition  In order to be able to use the collision detection function, acceleration ad-
aptation must be activated. Acceleration adaptation is activated when sys-
tem variable $ADAP_ACC is not equal to #NONE. (This is the default 
setting.) The system variable can be found in the file C:\KRC\Robot-
er\KRC\R1\MaDa\$ROBCOR.DAT.

 A program is selected.

Procedure 1. Position the cursor in the line before the motion for which the torque mon-
itoring is to be programmed.

2. Select the menu sequence Commands > Motion parameters > Torque 
monitoring. An inline form is opened.

Collision detection is an extension and improvement of the torque 
monitoring function.
The torque monitoring function remains available. Programs in which 

torque monitoring is already defined can still be executed as before.
Alternatively, the lines with the torque monitoring in such programs can be 
deleted and collision detection can be used instead. Collision detection must 
not be used together with torque monitoring in a program.

Step Description

1 Determine suitable values for torque monitoring.

 (>>> 6.14.5.1 "Determining values for torque monitoring" 
Page 186)

2 Program torque monitoring.

 (>>> 6.14.5.2 "Programming torque monitoring" 
Page 186)
Issued: 14.01.2015 Version: KSS 8.3 SI V4



6 Configuration
3. In the TORQMON box, select the entry SetLimits.

4. For each axis, enter the amount by which the command torque may devi-
ate from the actual torque.

5. Press Cmd OK.

6. If a response time for the torque monitoring is to be defined:

Set the variable $TORQMON_TIME to the desired value. Unit: millisec-
onds. Default value: 0.

The values are automatically reset to the default value 200 in the following 
cases:

 Reset

 Block selection

 Program deselection

6.15 Defining calibration tolerances

Precondition  “Expert” user group

Procedure  In the main menu, select Start-up > Calibrate > Tolerances.

Description

Fig. 6-17

Fig. 6-18

Only modify the default values in exceptional cases. Otherwise, in-
creased error messages and inaccuracy may result.

Fig. 6-19: Default error tolerances
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The following buttons are available:

6.16 Configuring backward motion

Description The configuration options described below apply to backward motion using the 
Start backwards key. They do not apply to other backward motion functional-
ities, e.g. backward motion as part of fault strategies in technology packages.

The following default settings are valid for backward motion using the Start 
backwards key: 

 Backward motion is active.

 A maximum of 30 motions can be saved in the buffer.

 When backward motion is started, the robot controller does not indicate 
this by means of a message.

If other settings are desired, these must be entered in KrcConfig.XML.

Precondition  “Expert” user group

 T1, T2 or AUT mode

Procedure 1. Open the file KrcConfig.XML in the directory C:\KRC\ROBOTER\Con-
fig\User\Common.

2. Before the last line, i.e. before </KrcConfig>, insert the entry 
BACKWARD_STEP.

3. Set the parameters to the desired values.

4. Close KrcConfig.XML. Respond to the request for confirmation asking 
whether the changes should be saved by pressing Yes. 

5. Reboot the robot controller with the settings Cold start and Reload files. 

Item Description

1 The minimum distance for tool calibration.

 0 … 200 mm

2 The minimum distance for base calibration.

 0 … 200 mm

3 The minimum angle between the straight lines through the 3 cali-
bration points in base calibration.

 0 … 360°

4 Maximum error in calculation.

 0 … 200 mm

Button Description

Default Restores the default settings. The data must then 
be saved by pressing OK.

Further information about backward motion can be found in this doc-
umentation.
 (>>> 8.12 "Backward motion using the Start backwards key" 

Page 270)
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BACKWARD_

STEP

The contents of the line before BACKWARD_STEP are not relevant for back-
ward motion and may differ from this example.

If not all parameters of BACKWARD_STEP are listed, the default values are 
valid for those that are not listed.

If BACKWARD_STEP is removed from KrcConfig.XML again, the default val-
ues are valid for all parameters again.

6.17 Configuring Automatic External

Description If robot processes are to be controlled centrally by a higher-level controller 
(e.g. a PLC), this is carried out using the Automatic External interface.

The higher-level controller transmits the signals for the robot processes (e.g. 
motion enable, fault acknowledgement, program start, etc.) to the robot con-
troller via the Automatic External interface. The robot controller transmits in-
formation about operating states and fault states to the higher-level controller.

Overview To enable use of the Automatic External interface, the following configurations 
must be carried out:

Fig. 6-20: Example: BACKWARD_STEP

Parameter Description/default

ENABLE Type: BOOL

 TRUE (= default): activated, i.e. backward motion using 
the Start backwards key is possible.

 FALSE: deactivated, i.e. backward motion using the 
Start backwards key is not possible.

MOVE-
MENTS

Type: INT

Maximum number of motions recorded for backward 
motion

 0 … 60 (default = 30)

BACKWARD
_WARNING

Type: BOOL

 TRUE: The robot controller generates the following 
message when the Start backwards key is pressed for 
the first time after forward motion: Caution! Robot is 
moving backwards.. The user must acknowledge the 
message and press the Start backwards key again.

 FALSE (= default): No message
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6.17.1 Configuring CELL.SRC

Description In Automatic External mode, programs are called using the program 
CELL.SRC.

Program

Step Description

1 Configuration of the CELL.SRC program.

 (>>> 6.17.1 "Configuring CELL.SRC" Page 190)

2 Configuration of the inputs/outputs of the Automatic Exter-
nal interface.

 (>>> 6.17.2 "Configuring Automatic External inputs/out-
puts" Page 191)

3 Only if error numbers are to be transmitted to the higher-lev-
el controller: configuration of the P00.DAT file.

 (>>> 6.17.3 "Transmitting error numbers to the higher-level 
controller" Page 197)

1  DEF  CELL ( )

     …

6    INIT

7    BASISTECH INI

8    CHECK HOME

9    PTP HOME  Vel= 100 % DEFAULT

10    AUTOEXT INI

11    LOOP

12      P00 (#EXT_PGNO,#PGNO_GET,DMY[],0 )

13      SWITCH  PGNO ; Select with Programnumber

14  

15      CASE 1

16        P00 (#EXT_PGNO,#PGNO_ACKN,DMY[],0 )

17        ;EXAMPLE1 ( ) ; Call User-Program

18  

19      CASE 2

20        P00 (#EXT_PGNO,#PGNO_ACKN,DMY[],0 )

21        ;EXAMPLE2 ( ) ; Call User-Program

22  

23      CASE 3

24        P00 (#EXT_PGNO,#PGNO_ACKN,DMY[],0 )

25        ;EXAMPLE3 ( ) ; Call User-Program

26  

27      DEFAULT

28        P00 (#EXT_PGNO,#PGNO_FAULT,DMY[],0 )

29      ENDSWITCH

30    ENDLOOP

31  END

Line Description

12 The robot controller calls the program number from the 
higher-level controller.

15 CASE branch for program number = 1

16 Receipt of program number 1 is communicated to the higher-
level controller.

17 The user-defined program EXAMPLE1 is called.

27 DEFAULT = the program number is invalid.

28 Error treatment in the case of an invalid program number
Issued: 14.01.2015 Version: KSS 8.3 SI V4



6 Configuration
Precondition  “Expert” user group

Procedure 1. Open the program CELL.SRC in the Navigator. (This program is located 
in the folder "R1".)

2. In the section CASE 1, replace the name EXAMPLE1 with the name of the 
program that is to be called via program number 1. Delete the semicolon 
in front of the name.

3. For all further programs, proceed as described in step 2. If required, add 
additional CASE branches.

4. Close the program CELL.SRC. Respond to the request for confirmation 
asking whether the changes should be saved with Yes.

6.17.2 Configuring Automatic External inputs/outputs

Procedure 1. In the main menu, select Configuration > Inputs/outputs > Automatic 
External.

2. In the Value column, select the cell to be edited and press Edit.

3. Enter the desired value and save it by pressing OK.

4. Repeat steps 2 and 3 for all values to be edited.

5. Close the window. The changes are saved.

Description

   …

  15      CASE 1

  16        P00 (#EXT_PGNO,#PGNO_ACKN,DMY[],0 )

  17        MY_PROGRAM ( ) ; Call User-Program

  …

Fig. 6-21: Configuring Automatic External inputs
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6.17.2.1 Automatic External inputs

PGNO_TYPE Type: Variable

This variable defines the format in which the program number sent by the high-
er-level controller is read.

Fig. 6-22:  Configuring Automatic External outputs

Item Description

1 Number

2 Long text name of the input/output

3 Type

 Green: Input/output

 Yellow: variable or system variable ($...)

4 Name of the signal or variable

5 Input/output number or channel number

6 The outputs are thematically assigned to tabs.

Val-
ue

Description Example

1 Read as binary number.

The program number is transmitted by the 
higher-level controller as a binary coded 
integer.

0 0 1 0 0 1 1 1

=> PGNO = 39
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* When using this transmission format, the values of PGNO_REQ, 
PGNO_PARITY and PGNO_VALID are not evaluated and are thus of no sig-
nificance.

REFLECT_PROG

_NR

Type: Variable

This variable defines whether the program number is to be mirrored to an out-
put range. The output of the signal starts with the output defined using 
PGNO_FBIT_REFL. 

PGNO_LENGTH Type: Variable

This variable determines the number of bits in the program number sent by the 
higher-level controller. Range of values: 1 … 16. 

Example: PGNO_LENGTH = 4 => the external program number is 4 bits long.

If PGNO_TYPE has the value 2, only 4, 8, 12 and 16 are permissible values 
for the number of bits.

PGNO_FBIT Input representing the first bit of the program number. Range of values: 
1 … 8192.

Example: PGNO_FBIT = 5 => the external program number begins with the 
input $IN[5].

PGNO_PARITY Input to which the parity bit is transferred from the higher-level controller.

 (>>> 6.17.2.2 "Odd / even parity" Page 195)

If PGNO_TYPE has the value 3, PGNO_PARITY is not evaluated.

PGNO_VALID Input to which the command to read the program number is transferred from 
the higher-level controller. 

2 Read as BCD value.

The program number is transmitted by the 
higher-level controller as a binary coded 
decimal.

0 0 1 0 0 1 1 1

=> PGNO = 27

3 Read as “1 of n”*.

The program number is transmitted by the 
higher-level controller or the periphery as a 
"1 of n" coded value.

0 0 0 0 0 0 0 1

=> PGNO = 1

0 0 0 0 1 0 0 0

=> PGNO = 4

Val-
ue

Description Example

Val-
ue

Description

0 Function deactivated

1 Function activated

Input Function

Negative value Odd parity

0 No evaluation

Positive value Even parity

Input Function

Negative value Number is transferred at the falling edge of the signal.
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If PGNO_TYPE has the value 3, PGNO_VALID is not evaluated.

$EXT_START If the I/O interface is active, this input can be set to start or continue a program.

$MOVE_ENABLE This input is used by the higher-level controller to check the robot drives.

If the drives have been switched off by the higher-level controller, the message 
“GENERAL MOTION ENABLE” is displayed. It is only possible to move the ro-
bot again once this message has been reset and another external start signal 
has been given.

During commissioning, the variable $MOVE_ENABLE is often configured with 
the value $IN[1025]. If a different input is not subsequently configured, no ex-
ternal start is possible.

$CHCK_MOVENA Type: Variable

If the variable $CHCK_MOVENA has the value FALSE, $MOVE_ENABLE 
can be bypassed. The value of the variable can only be changed in the file 
C:\KRC\ROBOTER\KRC\STEU\Mada\$OPTION.DAT.

$CONF_MESS Setting this input enables the higher-level controller to acknowledge error 
messages automatically as soon as the cause of the error has been eliminat-
ed.

$DRIVES_OFF If there is a low-level pulse of at least 20 ms duration at this input, the higher-
level controller switches off the robot drives.

$DRIVES_ON If there is a high-level pulse of at least 20 ms duration at this input, the higher-
level controller switches on the robot drives.

0 Number is transferred at the rising edge of the signal on 
the EXT_START line.

Positive value Number is transferred at the rising edge of the signal.

Input Function

Only the rising edge of the signal is evaluated.

There is no BCO run in Automatic External mode. This 
means that the robot moves to the first programmed po-

sition after the start at the programmed (not reduced) velocity and does not 
stop there.

Signal Function

TRUE Jogging and program execution are possible.

FALSE All drives are stopped and all active commands inhibit-
ed.

Signal Function

TRUE MOVE_ENABLE monitoring is activated.

FALSE MOVE_ENABLE monitoring is deactivated.

In order to be able to use MOVE_ENABLE monitoring, 
$MOVE_ENABLE must have been configured with the input 
$IN[1025]. Otherwise, $CHCK_MOVENA has no effect.

Only the rising edge of the signal is evaluated.
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$I_O_ACT If this input is TRUE, the Automatic External interface is active. Default setting: 
$IN[1025].

6.17.2.2 Odd / even parity

Description A parity bit is a bit which is added to a bit sequence and has a checking func-
tion. It indicates whether the bit sequence contains an even or odd sum of 
ones.

The meaning of the relevant bit value (“even” or “odd”) depends on the appli-
cable parity protocol: “even parity” or “odd parity”.

If the entire data block – consisting of the bit sequence and the parity bit – is 
transferred and the parity bit then no longer matches the sequence, this 
means that an error has occurred during transfer.

Even parity Even parity

The sum of the ones in the entire data block (bit sequence + parity bit) must 
be even.

Example:

Odd parity Odd parity

The sum of the ones in the entire data block (bit sequence + parity bit) must 
be odd.

Example:

6.17.2.3 Automatic External outputs

$RC_RDY1 Ready for program start.

$ALARM_STOP This output is reset in the following EMERGENCY STOP situations:

 The EMERGENCY STOP device on the smartPAD is pressed.

 External E-STOP

Sum of ones in the bit sequence Parity bit

Even 0

Odd 1

Bit sequence Parity bit

0011.1010 0

1010.0100 1

Sum of ones in the bit sequence Parity bit

Even 1

Odd 0

Bit sequence Parity bit

0011.1010 1

1010.0100 0
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$USER_SAF This output is reset if the safety fence monitoring switch is opened (AUT mode) 
or an enabling switch is released (T1 or T2 mode).

$PERI_RDY By setting this output, the robot controller communicates to the higher-level 
controller the fact that the robot drives are switched on.

$ROB_CAL The signal is FALSE as soon as a robot axis has been unmastered

$I_O_ACTCONF This output is TRUE if Automatic External mode is selected and the input 
$I_O_ACT is TRUE.

$STOPMESS This output is set by the robot controller in order to communicate to the higher-
level controller any message occurring which requires the robot to be stopped. 
(Examples: EMERGENCY STOP, Motion enable or Operator safety)

PGNO_FBIT_REF

L

Output representing the first bit of the program number. Precondition: The in-
put REFLECT_PROG_NR has the value 1. 

The size of the output area depends on the number of bits defining the pro-
gram number (PGNO_LENGTH).

If a program selected by the PLC is deselected by the user, the output area 
starting with PGNO_FBIT_REFL is set to FALSE. In this way, the PLC can 
prevent a program from being restarted manually.

PGNO_FBIT_REFL is also set to FALSE if the interpreter is situated in the 
CELL program.

$ALARM_STOP_I

NTERN

Previous name: Int. NotAus

This output is set to FALSE if the EMERGENCY STOP device on the smart-
PAD is pressed.

$PRO_ACT This output is set whenever a process is active at robot level. The process is 
therefore active as long as a program or an interrupt is being processed. Pro-
gram processing is set to the inactive state at the end of the program only after 
all pulse outputs and all triggers have been processed.

In the event of an error stop, a distinction must be made between the following 
possibilities:

 If interrupts have been activated but not processed at the time of the error 
stop, the process is regarded as inactive ($PRO_ACT=FALSE).

 If interrupts have been activated and processed at the time of the error 
stop, the process is regarded as active ($PRO_ACT=TRUE) until the in-

In the case of an EMERGENCY STOP, the nature of the EMERGEN-
CY STOP can be recognized from the states of the outputs 
$ALARM_STOP and $ALARM_STOP_INTERN:

 Both outputs are FALSE: the EMERGENCY STOP was triggered on the 
smartPAD.

 $ALARM_STOP is FALSE, $ALARM_STOP_INTERN is TRUE: exter-
nal EMERGENCY STOP.

In the case of an EMERGENCY STOP, the nature of the EMERGEN-
CY STOP can be recognized from the states of the outputs 
$ALARM_STOP and $ALARM_STOP_INTERN:

 Both outputs are FALSE: the EMERGENCY STOP was triggered on the 
smartPAD.

 $ALARM_STOP is FALSE, $ALARM_STOP_INTERN is TRUE: exter-
nal EMERGENCY STOP.
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terrupt program is completed or a STOP occurs in it 
($PRO_ACT=FALSE).

 If interrupts have been activated and a STOP occurs in the program, the 
process is regarded as inactive ($PRO_ACT=FALSE). If, after this, an in-
terrupt condition is met, the process is regarded as active 
($PRO_ACT=TRUE) until the interrupt program is completed or a STOP 
occurs in it ($PRO_ACT=FALSE).

PGNO_REQ A change of signal at this output requests the higher-level controller to send a 
program number.

If PGNO_TYPE has the value 3, PGNO_REQ is not evaluated.

APPL_RUN By setting this output, the robot controller communicates to the higher-level 
controller the fact that a program is currently being executed.

$PRO_MOVE Means that a synchronous axis is moving, including in jog mode. The signal is 
thus the inverse of $ROB_STOPPED.

$IN_HOME This output communicates to the higher-level controller whether or not the ro-
bot is in its HOME position.

$ON_PATH This output remains set as long as the robot stays on its programmed path. 
The output ON_PATH is set after the BCO run. This output remains set until 
the robot leaves the path, the program is reset or block selection is carried out. 
The ON_PATH signal has no tolerance window, however; as soon as the robot 
leaves the path the signal is reset.

$NEAR_POSRET This signal allows the higher-level controller to determine whether or not the 
robot is situated within a sphere about the position saved in $POS_RET. The 
higher-level controller can use this information to decide whether or not the 
program may be restarted.

The user can define the radius of the sphere in the file $CUSTOM.DAT using 
the system variable $NEARPATHTOL.

$ROB_STOPPED The signal is set when the robot is at a standstill. In the event of a WAIT state-
ment, this output is set during the wait.

The signal is thus the inverse of $PRO_MOVE.

$T1, $T2, $AUT, 

$EXT

These outputs are set when the corresponding operating mode is selected.

6.17.3 Transmitting error numbers to the higher-level controller

Error numbers of the robot controller in the range 1 to 255 can be transmitted 
to the higher-level controller. To transmit the error numbers, the file P00.DAT, 
in the directory C:\KRC\ROBOTER\KRC\R1\TP, must be configured as fol-
lows:

   1  DEFDAT  P00

   2  

   3  BOOL PLC_ENABLE=TRUE ; Enable error-code transmission to plc

   4  INT I

   5  INT F_NO=1

   6  INT MAXERR_C=1 ; maximum messages for $STOPMESS

   7  INT MAXERR_A=1 ; maximum messages for APPLICATION

   8  DECL STOPMESS MLD

   9  SIGNAL ERR $OUT[25]  TO $OUT[32]

  10  BOOL FOUND

  11  

  12  STRUC PRESET INT OUT,CHAR PKG[3],INT ERR
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  13  DECL PRESET P[255]

      …

  26  P[1]={OUT 2,PKG[] "P00",ERR 10}

      …

  30  P[128]={OUT 128,PKG[] "CTL",ERR 1}

      …

  35  STRUC ERR_MESS CHAR P[3],INT E

  36  DECL ERR_MESS ERR_FILE[64]

  37  ERR_FILE[1]={P[] "XXX",E 0}

      …

  96  ERR_FILE[64]={P[] "XXX",E 0}

  97  ENDDAT

Line Description

3 PLC_ENABLE must be TRUE.

6 Enter the number of controller errors for the transmission of 
which parameters are to be defined.

7 Enter the number of application errors for the transmission of 
which parameters are to be defined.

9 Specify which robot controller outputs the higher-level control-
ler should use to read the error numbers. There must be 8 
outputs.

13 In the following section, enter the parameters of the errors.

P[1]  … P[127]: range for application errors

P[128]  … P[255]: range for controller errors

26 Example of parameters for application errors:

 OUT 2 = error number 2

 PKG[] "P00" = technology package

 ERR 10 = error number in the selected technology pack-
age

30 Example of parameters for controller errors:

 OUT 128 = error number 128

 PKG[] "CTL" = technology package

 ERR 1 = error number in the selected technology package

37 … 96 The last 64 errors that have occurred are stored in the 
ERR_FILE memory.
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6.17.4 Signal diagrams

Fig. 6-23: Automatic system start and normal operation with program number acknowledge-
ment by means of PGNO_VALID
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Fig. 6-24: Automatic system start and normal operation with program number acknowledge-
ment by means of $EXT_START
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Fig. 6-25: Restart after dynamic braking (operator safety and restart)
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Fig. 6-26: Restart after path-maintaining EMERGENCY STOP
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Fig. 6-27: Restart after motion enable
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Fig. 6-28: Restart after user STOP
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6.18 Torque mode

6.18.1 Overview of torque mode

Description The “torque mode” function consists of the sub-functionalities “torque limita-
tion” and “deactivation of monitoring functions”.

Torque limitation:

The torques, i.e. the motor current, can be limited for individual axes or multi-
ple axes. Torque limitation enables the following applications:

 The axis can push or pull with a defined torque against a resistance.

Example: 

application of a defined pressure on the workpiece by an electric motor-
driven spot welding gun.

 The axis can be set to “soft”. It can then be moved by application of an ex-
ternal force. It can be pushed away, for example.

Examples: 

The robot must grip a workpiece in a press that is then ejected by the 
press. In order for the robot to be able to yield and absorb the ejector 
stroke, the affected axis is set to “soft”.

The robot must set a workpiece down at a point from which it can be pulled 
into exactly the right position by means of clamps. The robot must be com-
pliant for this.

Deactivation of monitoring functions:

The torque limitation generally results in a relatively large deviation between 
the command position and the actual position. Certain monitoring functions 
are triggered by this deviation, although this is undesirable with torque limita-
tion. These regular monitoring functions can thus be deactivated. 

Restriction The following restriction must be taken into consideration if axes are to absorb 
ejector motions:

A diagonal ejector motion cannot generally be absorbed by switching a single 
axis to “soft”. Remedy:

 In the case of slightly diagonal ejector motions, a possible remedy is to in-
stall the robot with a slight inclination.

 Or contact KUKA Roboter GmbH.

6.18.1.1 Using torque mode

Torque mode is only possible in program mode, not in manual mode.

Inclined installation of the robot is only permissible up to a certain an-
gle of inclination. Further information is contained in the robot operat-
ing or assembly instructions.
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Procedure 1. Set the torque limits for the desired axis and/or deactivate the regular mon-
itoring functions.

 (>>> 6.18.2 "Activating torque mode: SET_TORQUE_LIMITS()" 
Page 208)

If the regular monitoring functions are deactivated, other monitoring func-
tions specially adapted to torque mode are automatically activated. 

 (>>>  "Monitoring functions" Page 207)

2. If the axis is to be set to “soft”: move the axis so that the torque limit be-
comes active. At the end of the motion, the brakes of this axis remain 
open.

Alternatively, a “motion” to the current position can be executed. The robot 
does not move, but the brakes are released.

3. Optionally: generate a signal indicating that the axis is stationary (e.g. sig-
nal to an injection molding machine).

4. Perform the desired action, e.g. move to workpiece and build up pressure 
or push the axis away.

5. Optionally: wait for a signal to end torque mode.

6. Deactivate torque mode again.

 (>>> 6.18.3 "Deactivating torque mode: RESET_TORQUE_LIMITS()" 
Page 211)

The torque limits are canceled and the regular monitoring functions are re-
activated. Furthermore, the command position is adjusted to the actual po-
sition.

Activated/deacti-

vated

Torque mode is considered to be activated in the following case:

 If the upper torque limit is less than or equal to the upper value of the 
$TORQUE_AXIS_MAX interval.

 (>>> 6.18.5.3 "$TORQUE_AXIS_MAX" Page 213)

 And/or: If the lower torque limit is greater than or equal to the lower value 
of the $TORQUE_AXIS_MAX interval.

 And/or: If the regular monitoring functions are deactivated.

Torque mode is considered to be deactivated in the following case:

 If no limits are set or if the limits are invalid. A limit is invalid if it is outside 
the $TORQUE_AXIS_MAX interval.

By default, the robot controller is configured so that only 
limits that exceed the holding torque of the axis 

($HOLDING_TORQUE) can be set. It is nonetheless possible that the axis 
with limited torque is no longer able to achieve the necessary torque for brak-
ing, holding or moving the axis. This can be the case, for example, if the de-
fault configuration of the robot controller has been changed or incorrect load 
data are used.
Incorrectly set values can result in unexpected behavior of the robot control-
ler, e.g. motion in a different direction or with different acceleration.
For this reason:

 Only ever limit the torque in small steps, gradually approaching the re-
quired limit. 

 Do not limit the torque further than necessary.

Failure to take this precaution into consideration may result in death, injuries 
or damage to property.

If an application requires torque limits that no longer exceed the hold-
ing torque of the axis, KUKA Roboter GmbH must be contacted. 
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 And: If the regular monitoring functions are deactivated.

Automatic deacti-

vation

Torque mode is automatically deactivated in the following cases:

 End of program

 Program reset

 Program deselection

 Block selection (but no deactivation if the target of the block selection is in 
an interrupt program)

 RESUME (but no deactivation if the RESUME statement returns to an in-
terrupt program)

 Manual mode is activated. Planning is carried out from the current actual 
position and motion is resumed with full torque.

Monitoring 

functions

Torque mode generally results in a relatively large deviation between the com-
mand position and the actual position. Certain monitoring functions are trig-
gered by this deviation, although this is undesirable in torque mode. These 
regular monitoring functions can thus be deactivated using 
SET_TORQUE_LIMITS(). 

If the regular monitoring functions are deactivated, other monitoring functions 
specially adapted to torque mode are automatically activated for the actual ve-
locity and following error. If required, user-defined values can be set for these 
special monitoring functions using SET_TORQUE_LIMITS().

The following messages belong to the regular monitoring functions. They are 
no longer displayed if the regular monitoring functions are deactivated.

It is also possible, however, to retain the regular monitoring functions in torque 
mode. This may be useful, for example, if torque mode is used to avoid dam-
age in the case of collisions.

 (>>> 6.18.6.2 "Robot program: avoiding damage in the event of collisions" 
Page 216)

6.18.1.2 Robot program example: setting A1 to “soft” in both directions

Description This simple example illustrates the basic principle of torque mode.

In this example, A1 is to be set to “soft” in both directions. For this purpose, 
both the positive and negative current limits are set to 0 Nm. This allows A1 to 
be moved by application of an external force.

Program

Monitoring Message no. / message

Following error monitoring 26024: Ackn. Max. following error 
exceeded ({Drive}).

Standstill monitoring 1100: Stopped {(Axis number)}

Positioning monitoring 1105: Positioning monitoring {(Axis num-
ber)}

Monitoring whether motor 
blocked

26009: Motor blocked ({Drive}).

    ...

 1  PTP {A1 10}

 2  SET_TORQUE_LIMITS(1, {lower 0, upper 0, monitor #off})

 3  PTP {A1 11}

    ...

 4  RESET_TORQUE_LIMITS(1)

 5  PTP {A1 -20}

    ... 
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It is only for A1 that the holding torque is 0 Nm. The limits can therefore not 
generally be set to 0 for setting an axis to “soft”.

This documentation contains a more detailed example of setting axes to “soft” 
that can also be applied to other axes. 

 (>>> 6.18.6.1 "Robot program: setting axis to “soft” in both directions" 
Page 215)

6.18.2 Activating torque mode: SET_TORQUE_LIMITS()

Description This function can be used to perform the following actions for a specific axis:

 Limit the torques in the positive and/or negative direction.

 Deactivate the regular monitoring functions that would be triggered by a 
higher following error.

 If the regular monitoring functions are deactivated: modify the values for 
the special monitoring functions.

Function SET_TORQUE_LIMITS (axis: in, values: in)

TorqLimitParam STRUC TorqLimitParam REAL lower, upper, SW_ONOFF monitor, 
REAL max_vel, max_lag

Line Description

2 Negative and positive current limits of A1 are set to 0; the reg-
ular monitoring functions are deactivated.

(The actual velocity and the following error are now monitored 
with special monitoring functions.)

3 A “motion” is executed to activate torque limitation. (Since both 
current limits are set to 0, the robot will not actually move.)

A1 can now be moved by application of an external force.

4 Deactivate torque mode again for A1.

Torque limitation is canceled and the regular monitoring func-
tions are reactivated. Furthermore, the command position is 
automatically adjusted to the actual position.

5 The robot moves to the next position.

(The motion from line 4 is not belatedly executed now, as the 
command/actual adjustment has been carried out in line 5.)

Element Description

axis Type: INT

Axis to which the statement applies

values Type: TorqLimitParam

Values set for the axis

Element Description

lower Lower torque limit

Unit: Nm (for linear axes: N)

Default value: -1E10 (i.e. unlimited)

upper Upper torque limit

Unit: Nm (for linear axes: N)

Default value: 1E10 (i.e. unlimited)
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lower/upper When must the upper torque be limited and when must the lower torque be 
limited? 

General: The direction in which the following error is building up must always 
be limited.

Example: The robot is to be moved up against an obstacle and then stop there. 
The torque that is thus built up is to be limited.

 If the obstacle appears in the positive direction, upper must be set.

 If the obstacle appears in the negative direction, lower must be set.

Characteristics  SET_TORQUE_LIMITS() can be used in robot programs and in submit 
programs.

 Advance run stop: In the robot program, the statement triggers an ad-
vance run stop.

 Values may remain partially non-initialized. The non-initialized components 
mean that the existing values are to remain unchanged.

 If both limits are set, upper must be >= lower.

 If one limit (or both) is already set and the other limit is then set, and if the 
new limit would result in an empty interval, the new limit value becomes 
the value for both limits. Example:

 Already set: {lower 1, upper 2}

 Newly set: {lower 3}

 This results in: {lower 3, upper 3}

 It is permissible to set a positive lower or a negative upper limit. 

 The limits set must be greater than the current holding torque 
$HOLDING_TORQUE. If they are set differently, the robot controller gen-
erates an error message that must be acknowledged by the user.

monitor  #ON (Default): activates the regular monitoring func-
tions. 

 #OFF: deactivates the regular monitoring functions. In-
stead, the monitoring functions max_vel and max_lag 
are activated.

max_vel Maximum permissible actual velocity in torque mode (only 
relevant if the regular monitoring functions are deactivated)

Only a positive value may be programmed.

Unit: Degrees (for linear axes: mm)

Default value (valid for all operating modes): T1 jog velocity 
* internal safety factor

In T1, the maximum velocity with which jogging can be car-
ried out is the default value, even if a higher value is pro-
grammed.

Note: Only set a higher value than the default value if 
absolutely necessary.

max_lag Maximum permissible following error in torque mode (only 
relevant if the regular monitoring functions are deactivated)

Only a positive value may be programmed.

Unit: Degrees (for linear axes: mm)

Default value: 5 degrees (for linear axes: 100 mm)

Note: Only set a higher value than the default value if 
absolutely necessary.

Element Description
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 lower must be less than or equal to the upper value of the 
$TORQUE_AXIS_MAX_0 interval.

upper must be greater than or equal to the lower value of the 
$TORQUE_AXIS_MAX_0 interval.

If the limits are set differently, the robot controller generates an error mes-
sage that must be acknowledged by the user.

Examples Example 1:

For A1, the permissible torque range is limited to the interval 800 … 1,400 Nm.

Example 2:

For A3, the upper torque limit is set to 1,200 Nm.

Example 3:

For A1, the regular monitoring functions are (re)activated.

Example 4:

For A1, the permissible torque range is limited to the interval -1,000 … 
1,000 Nm. Furthermore, the regular monitoring functions are deactivated and 
the special monitoring functions are set to user-defined values.

Example 5:

For A1, the permissible torque range is set to -1E10 … 1E10, i.e. the range is 
unlimited. The regular monitoring functions are (re)activated.

This all corresponds to RESET_TORQUE_LIMITS(1), with the difference that 
in example 5, the command position is not to adapted to the actual position.

Example 6:

For A1, the lower torque limit is set to a calculated value.

The value has been calculated with the function myCalc() and transferred with 
the variable myLimits. (In the concrete application, the user must write his own 
function for this.)

In order for the other components to be non-initialized, the value is pre-initial-
ized with a partially initialized aggregate.

Example 7:

In this case, the limits are also set to a value that has been calculated with a 
function. (In the concrete application, the user must write his own function for 
this.)

If an application requires torque limits that no longer exceed the hold-
ing torque of the axis, KUKA Roboter GmbH must be contacted. 

SET_TORQUE_LIMITS(1, {lower 800, upper 1400} )

SET_TORQUE_LIMITS(3, {upper 1200} )

SET_TORQUE_LIMITS(1, {monitor #on} )

SET_TORQUE_LIMITS(1, {lower -1000, upper 1000, monitor #off, max_vel 
10, max_lag 20} )

SET_TORQUE_LIMITS(1, {lower -1E10, upper 1E10, monitor #on} )

DECL TorqLimitParam myParams

...

myParams = {lower 0}

myParams.lower = myCalc()

SET_TORQUE_LIMITS(1, myParams)
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The return value of the function is transferred directly, however. 

6.18.3 Deactivating torque mode: RESET_TORQUE_LIMITS()

Description This function has the following effect on the selected axis:

 It cancels the limitation of the torques insofar as they were limited. 

 It reactivates the regular monitoring functions insofar as they were deacti-
vated.

 It adapts the command position to the actual position.

Function RESET_TORQUE_LIMITS (axis: in)

Characteristics  The statement can be used in robot programs and in submit programs.

 Advance run stop: In the robot program, the statement triggers an ad-
vance run stop. This cannot be masked with CONTINUE!

Alternative If no command/actual value adjustment is required, torque mode can also be 
deactivated with SET_TORQUE_LIMITS instead of 
RESET_TORQUE_LIMITS:

 Advantage: Can be used during a motion (“on the fly”).

 Disadvantage: If the torque limitation has resulted in a relatively large fol-
lowing error, the robot accelerates very fast. This can trigger monitoring 
functions and stop the program.

6.18.4 Interpreter specifics

Description  SET_TORQUE_LIMITS() and RESET_TORQUE_LIMITS() can be used 
in robot programs and in submit programs.

 The statements are interpreter-specific, i.e. they only work in the interpret-
er in which they have been used.

 SET_TORQUE_LIMITS() first takes effect when the axis is moved for the 
interpreter that generates the statement. Example: 

a. Torque mode is activated in the robot program for an external axis.

b. The external axis is moved by a submit program. Torque mode has no 
effect.

c. The external axis is moved by a robot program. Torque mode takes ef-
fect.

DEFFCT TorqLimitParam myCalcLimits()

DECL TorqLimitParam myLimits

...

RETURN myLimits

ENDFCT

...

SET_TORQUE_LIMITS(1, myCalcLimits())

Element Description

axis Type: INT

Axis to which the statement applies

SET_TORQUE_LIMITS(1, {lower -1E10, upper 1E10, monitor #on} )

Deactivation by means of SET_TORQUE_LIMITS is not suitable in 
most cases.
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 If torque mode is already active, SET_TORQUE_LIMITS() takes effect im-
mediately.

 SET_TORQUE_LIMITS() works immediately if a motion is active. For this 
reason, the torque limits can be set at any time in robot programs, both in-
side and outside an interrupt, and the monitoring functions can be activat-
ed and deactivated. 

It is also possible to use torque mode inside an interrupt program only. (If 
RESET_TORQUE_LIMITS() is used, it may subsequently be necessary to 
return to the interrupt position with PTP $AXIS_RET.)

 (>>> 6.18.6.3 "Robot program: torque mode in the interrupt" Page 217)

 When a torque-driven axis “changes owner”, the command position is ad-
justed to the actual position.

“Change of owner” means: an interpreter has moved the axis in torque 
mode (and thus “owns” it). While torque mode is active, the axis is moved 
by a different interpreter.

The main application here is: jogging after a program has been interrupted 
in torque mode.

Example The following example shows when SET_TORQUE_LIMITS() is effective, de-
pending on whether torque mode is already active or not.

Initial situation (default): the monitoring functions are activated.

6.18.5 Diagnostic variables for torque mode

All these variables and constants are write-protected. 

Their value is not dependent on the interpreter.

6.18.5.1 $TORQUE_AXIS_ACT

Variable $TORQUE_AXIS_ACT[axis number]

Data type: REAL

Description Current motor torque for axis [axis number]

Unit: Nm (for linear axes: N)

 1 SET_TORQUE_LIMITS(1, {monitor #off})

 2 HALT

 3 PTP_REL {A1 10}

 4 HALT

 5 SET_TORQUE_LIMITS(1, {monitor #on})

 6 HALT

 7 PTP_REL {A1 15}

Line Description

1 The monitoring functions for A1 are deactivated.

2 Here the monitoring functions are still activated.

3 The axis is moved. From here on, the statement 
SET_TORQUE_LIMITS is effective.

4 The monitoring functions are deactivated. 

5 The monitoring functions are activated.

6 Here the monitoring functions are already activated. Because 
torque limitation was already active, the statement took effect 
immediately and not just after the next motion of this axis.
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The value is only relevant if the brakes are released. If the brakes are applied, 
it is virtually zero. 

Advance run stop: In the robot program, the variable triggers an advance run 
stop.

 (>>> 6.18.5.6 "Comparison: $TORQUE_AXIS_ACT and 
$HOLDING_TORQUE " Page 214)

$BRAKE_SIG The state of the brakes can be displayed by means of the system variable 
$BRAKE_SIG. The value of $BRAKE_SIG is a bit array: bit 0 corresponds to 
A1, bit 6 corresponds to E1. 

 Bit n = 0: Brake is closed. 

 Bit n = 1: Brake is open.

6.18.5.2 $TORQUE_AXIS_MAX_0

Constant $TORQUE_AXIS_MAX_0[axis number]

Data type: REAL

Description Maximum permanent motor torque for axis [axis number] at velocity 0

The value specifies an interval: from -value to +value.

Unit: Nm (for linear axes: N)

Advance run stop:  does not trigger an advance run stop. 

6.18.5.3 $TORQUE_AXIS_MAX

Constant $TORQUE_AXIS_MAX[axis number]

Data type: REAL

Description Absolute maximum motor torque for axis [axis number]

The value specifies an interval: from -value to +value.

Unit: Nm (for linear axes: N)

Advance run stop:  does not trigger an advance run stop.

6.18.5.4 $TORQUE_AXIS_LIMITS

Variable $TORQUE_AXIS_LIMITS[axis number]

Data type: TorqLimitParam

Description Currently active motor torque limitation for axis [axis number]

Unit: Nm (for linear axes: N)

The variable is primarily intended for diagnosis via the variable correction func-
tion or variable overview. 

Characteristics:

lower must be less than or equal to the upper value of the 
$TORQUE_AXIS_MAX_0 interval.
upper must be greater than or equal to the lower value of the 

$TORQUE_AXIS_MAX_0 interval.
If the limits are set differently, the robot controller generates an error mes-
sage that must be acknowledged by the user.
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 If there are currently no limits active, upper and lower remain non-initial-
ized. 

 The component monitor is always initialized unless the axis does not ex-
ist. 

This is relevant, for example, in the case of 4-axis and 5-axis robots: if the 
entire array is displayed, the non-existent axes can be easily identified.

Non-existent external axes are simply not displayed when the entire array 
is displayed.

 Max_vel and max_lag are non-initialized if monitor = #ON, as the reg-
ular monitoring functions are active in this case. 

If monitor = #OFF, the values of max_vel and max_lag are displayed, ir-
respective of whether they have been set explicitly in the current program 
or whether the default values are being used.

Advance run stop: In the robot program, the variable triggers an advance run 
stop.

6.18.5.5 $HOLDING_TORQUE

Variable $HOLDING_TORQUE[axis number]

Data type: REAL

Description Holding torque for the robot axis [axis number]

Unit: Nm

The holding torque refers to the current actual position of the axis and the cur-
rent load.

(For external axes, the value 0 N is always returned.)

Advance run stop: In the robot program, the variable triggers an advance run 
stop.

 (>>> 6.18.5.6 "Comparison: $TORQUE_AXIS_ACT and 
$HOLDING_TORQUE " Page 214)

6.18.5.6 Comparison: $TORQUE_AXIS_ACT and $HOLDING_TORQUE 

In the case of a robot that is stationary with the brakes released, 
$TORQUE_AXIS_ACT is not equal to $HOLDING_TORQUE, although this 
might be assumed.

Characteristics of $HOLDING_TORQUE:

 A calculated value that does not take friction into consideration. Control ef-
fects have no influence on the value.

 Is only dependent on the current position of the axis. Thus remains un-
changed if the position remains constant.

Characteristics of $TORQUE_AXIS_ACT:

The fact that certain components may remain non-initialized simpli-
fies diagnosis for the user. 
If the variable is accessed via KRL, however, the robot controller may 

regard the access as “invalid”. Recommendation: Check the state of the vari-
able with VARSTATE() prior to access.

If the upper and lower torque limits are set to $HOLDING_TORQUE 
for all axes, the robot must remain stationary when the brakes are re-
leased. 

If this is not the case, i.e. if the robot drifts, the load is not correctly configured.
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 Calculated from the actual currents. Friction and control effects thus affect 
the value.

 Can change if the position remains constant.

The discrepancy between $HOLDING_TORQUE and $TORQUE_AXIS_ACT 
is less than or equal to the current friction if the robot remains stationary for at 
least 1 second. A precondition is that the load data are correct.

6.18.6 Other examples

6.18.6.1 Robot program: setting axis to “soft” in both directions

Description The robot must grip a workpiece in a press that is then ejected by the press. 
In order for the robot to be able to yield and absorb the ejector stroke, the axis 
is set to “soft”.

For this, the torque limits must be set to a very small interval around the hold-
ing torque. (It is only for A1 that the holding torque = 0 Nm. The limits can 
therefore not generally be set to 0 for setting an axis to “soft”.)

Assumption for this example: a rotation about the axis [ideal_axis] moves the 
gripper almost exactly in the ejector direction.

Program  1 DECL TorqLimitParam myLimits

 2 DECL INT ideal_axis

   ...

 3 myLimits.monitor = #off

 4 myLimits.lower = $holding_torque[ideal_axis] - 10

 5 myLimits.upper = $holding_torque[ideal_axis] + 10

 6 SET_TORQUE_LIMITS(ideal_axis, myLimits)

 7 PTP $AXIS_ACT

 8 OUT_SIGNAL_SOFT = TRUE

 9 WAIT FOR IN_SIGNAL_EJECTED

10 RESET_TORQUE_LIMITS(ideal_axis)

11 OUT_SIGNAL_SOFT = FALSE

12 WAIT FOR IN_SIGNAL_NEXTMOVE

   ... 

Line Description

3 …6 For the axis [ideal_axis], the regular monitoring functions are 
deactivated and the torques are limited to a very small interval 
around the holding torque.

7 Execute a “motion” to the current position to activate reduction 
of the current limits. The axis [ideal_axis] can now be moved 
by the ejector of the press.

8 Signal to the press controller that the axis is ready for the ejec-
tion.

9 Wait for signal from press controller that the workpiece has 
been ejected.

10 Cancels torque limitation and reactivates the regular monitor-
ing functions. Furthermore, adjusts the command position to 
the actual position.

11 Signal to the press controller that the axis is no longer ready 
for an ejection.

12 If required:

Wait for a signal that motion away from the position is allowed.
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6.18.6.2 Robot program: avoiding damage in the event of collisions

Description Torque limitation can be used to avoid damage in the event of collisions. 

 Advantage: It is assured that the robot only presses against the obstacle 
with a defined, limited force.

 Disadvantage: The robot becomes sluggish. High accelerations are no 
longer possible.

Program The robot fetches workpieces from a box. During the motion to points P7, P8 
and P9, the possibility cannot be ruled out of the robot with the workpiece col-
liding with the box. It must be ensured that the robot does not press so hard 
that damage can result. For this, the forces are limited before the critical 
points.

The regular monitoring functions are deactivated. This is not because they 
would otherwise be triggered unnecessarily; on the contrary, they are not strict 
enough for this example. Instead, one of the special monitoring functions is set 
to a very low value. (Depending on the specific application, it may also be use-
ful to use the regular monitoring functions.)

   ...

 1 DECL TorqLimitParam myParams

   ...

 2 FOR i = 1 to 6

 3   myParams.lower = $holding_torque[i] - 500

 4   myParams.upper = $holding_torque[i] + 500

 5   myParams.monitor = #off

 6   myParams.max_lag = 0.1

 7 SET_TORQUE_LIMITS(i, myParams)

 8 ENDFOR

 9 $acc.cp = my_low_acceleration

10 $vel.cp = my_low_velocity

11 LIN P7

12 LIN P8

13 LIN P9

14 FOR i = 1 to 6

15   myParams.lower = -1E10

16   myParams.upper = 1E10

17   myParams.monitor = #on

18 SET_TORQUE_LIMITS(i, myParams)

19 ENDFOR

20 $acc.cp = my_high_acceleration

21 $vel.cp = my_high_velocity

22 LIN P10

   ...

Line Description

2 … 7 The torques for A1 ... A6 are limited.

3, 4 The limits are set to a relatively small interval centered on the 
holding torque.

5, 6 The regular monitoring functions are deactivated. Max_lag = 
0.1 has the effect of triggering a stop in the case of a following 
error as low as 0.1°.

9, 10 Acceleration and velocity are reduced so that the robot ap-
proaches the critical point slowly.

11 …13 Points at which a collision could occur.

If a collision occurs, the monitoring function max_lag is trig-
gered and the system operator can intervene.

After the critical section:
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6.18.6.3 Robot program: torque mode in the interrupt

Description This demonstrates that torque mode can be used completely inside an inter-
rupt program. The example is not primarily a practical one, but is intended to 
show that this use is generally possible.

Program The robot is to determine the position of a workpiece whose possible location 
is known, but not its exact position. First, a proximity sensor signals to the ro-
bot controller when the robot is in the vicinity of the workpiece. On the basis of 
this sensor signal, an interrupt program is then called.

The actual search is carried out in the interrupt program: A1 moves towards 
the workpiece. Torque mode is activated for A1 beforehand. The robot comes 
to a standstill where it makes contact with the workpiece due to the reduced 
torques: the workpiece has been “found”. This position can now be saved as 
the position of the workpiece.

14 …19 Torque mode is deactivated. 

SET_TORQUE_LIMITS can be used here: the robot only 
reaches this point if it has passed the critical points without col-
lision. In this case, no following error has built up and com-
mand/actual value adjustment is not required.

20, 21 Acceleration and velocity are reset to the previous higher val-
ues.

22 Uncritical point

Line Description

   ...

 1 LIN P1

 2 INTERRUPT DECL 1 WHEN sensor_signal==true DO search()

 3 INTERRUPT ON 1

 4 LIN P2

 5 INTERRUPT OFF 1

   ...

-------------------------

 6 DEF search()

 7 ...

 8 BRAKE

 9 SET_TORQUE_LIMITS(1,{lower 1000, upper 1000, monitor #off})

10 PTP_REL {A1 10}

11 RESET_TORQ_LIMITS(1)

12 piece_found = $POS_ACT_MES

13 PTP $AXIS_RET

14 END

Line Description

1 … 4 On the way to P2, the sensor is to signal when the robot is in 
the vicinity of the workpiece.

2 When the sensor signal is received, the subprogram search() 
is called.

In the subprogram:

8 The current motion is stopped as soon as search() is execut-
ed. 

9 Sets torque limits for A1, deactivates regular monitoring func-
tions.
217 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



218 / 491

KUKA System Software 8.3
6.18.6.4 Robot program: servo gun builds up pressure

Description This program shows how torque mode can be activated by means of a trigger. 
(Comparable programs are used in the background in the KUKA.ServoGun 
technology packages. They thus do not need to be programmed by the user.)

Program Main program:

Weld program:

10 A1 moves. The robot comes to a standstill where it makes con-
tact with the workpiece due to the reduced torques. 

Once the robot has reached its command position {A1 10}, the 
next program line is executed. (The fact that the actual position 
deviates from the command position has no effect, as the reg-
ular monitoring functions have been deactivated.)

11 Cancels torque limitation and reactivates the regular monitor-
ing functions. Furthermore, adjusts the command position the 
actual position.

12 The current position of the robot now indicates the position of 
the workpiece. This is saved here in a variable.

13 Returns to the position at which the robot left the path in the 
main program.

Line Description

 1 DEF SPOT()

 2 DECL BOOL error_occurred

   ...

 3 Interrupt DECL 1 WHEN $stopmess DO resume_subprog()

 4 Interrupt ON 1 

 5 REPEAT

 6  error_occurred = false

 7  SPOT_MOVE()

 8 UNTIL error_occurred == false

   ...

Line Description

3 If an error occurs, resume_subprog() is to be called.

7 The weld program SPOT_MOVE() is called.

5 … 8 If an error has occurred (i.e. if error_occurred == true), 
SPOT_MOVE() is repeated.

 1 DEF SPOT_MOVE()

   ...

 2 TorqLimWeld = {lower -1000, upper 1000 , monitor #off}

 3 i = 6+EG_EXTAX_ACTIVE

   ...

 4 LIN P_APPROX C_DIS

 5 $VEL_EXTAX[EG_EXTAX_ACTIVE]=EG_MAX_CONST_VEL[EG_EXTAX_ACTIVE]

 6 LIN P_APPROX C_DIS 

 7 TRIGGER WHEN DISTANCE=0 DELAY=50 DO SET_TORQUE_LIMITS(i, 
TorqLimWeld) PRIO = -1

 8 LIN P_PART C_DIS

 9 TRIGGER WHEN DISTANCE=0 DELAY=50 DO START_TIMER_SPOT() PRIO=82

10 LIN P_PRESSURE C_DIS 

11 LIN P_WELD 

12 WAIT FOR EG_TRIGGER_END

13 RESET_TORQUE_LIMITS(i)

14 Interrupt OFF 1
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Interrupt program in the event of an error:

6.18.6.5 Submit program: servo gun builds up pressure

Precondition  E1 is already asynchronous with ASYPTP {E1 10}.

 Or: $ASYNC_MODE is configured in such a way (bit 0 = 1) that the axis is 
implicitly set to synchronous mode in the case of ASYPTP in the submit 
program.

Program

15 LIN P_PART C_DIS 

16 END

Line Description

7 Shortly before the gun touches the workpiece, the torques are 
reduced.

9 … 11 Build up pressure and then weld.

12 The weld timer signals the end of welding.

13 Cancels torque limitation and reactivates the regular monitor-
ing functions. Furthermore, adjusts the command position the 
actual position.

 1 DEF resume_subprog()

 2 BRAKE 

 3 Suppress_repositioning()

 4 HALT

 5 error_occurred = true

 6 RESUME

 7 END

Line Description

3 Normally, in the case of a restart after HALT, the robot is repo-
sitioned to the position at which the interrupt was triggered. 
(This is because of $STOPMESS.) Suppress_repositioning() 
prevents this repositioning. 

Suppress_repositioning() may be useful, depending on the ap-
plication, but not necessarily.

5 Set error_occurred to TRUE so that the REPEAT loop in the 
main program is repeated.

6 RESUME deactivates torque mode. Jump back to line 8 in the 
main program.

   ...

 1 IF $PRO_STATE1==#P_FREE

 2   SET_TORQUE_LIMITS(7,{upper 1000, monitor #off })

 3   ASYPTP {E1 10}

   ...

 4   RESET_TORQUE_LIMITS(7)

 5   ASYPTP {E1 -10}

 6 ENDIF

   ...

Line Description

1 Ensure that no robot program is selected.

2 Limit the positive torque and deactivate the regular monitoring 
functions.

3 Motion towards end point {E1 10} behind the workpiece. The 
pressure on the workpiece builds up.
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6.19 Event planner

This function can be used for time-related or action-related control of the data 
comparison between the kernel system and the hard drive. During data com-
parison, the kernel system data are written to the hard drive.

6.19.1 Configuring a data comparison

Precondition  “Expert” user group

Procedure 1. In the main menu, select Configuration > Miscellaneous > Event plan-
ner.

2. Open the tree structure in the left-hand part of the window.

3. Select the desired action:

 T1 and T2 consistency: Compare data in operating modes T1 and T2 
at regular intervals.

 AUT and EXT consistency: Compare data in operating mode Auto-
matic External at regular intervals.

 Logic consistency: Compare data after a change of operating mode 
or after online optimizing.

Online optimizing is the modification of the parameters of a program 
during operation.

4. Make the desired settings in the right-hand part of the window.

 (>>> 6.19.2 "Configuring T1 and T2 Consistency, AUT and EXT Consis-
tency" Page 220)

 (>>> 6.19.3 "Configuring Logic Consistency" Page 221)

5. Press Save.

6.19.2 Configuring T1 and T2 Consistency, AUT and EXT Consistency

The following settings are possible here:

 Definition of the date and time that a comparison will first be made be-
tween the data in the kernel system and those on the hard drive.

 Definition of the interval at which this operation is to be repeated.

4 Cancels torque limitation and reactivates the regular monitor-
ing functions. Furthermore, adjusts the command position the 
actual position.

The interpreter waits in RESET_TORQUE_LIMITS(7) until the 
asynchronous motion has been completed. Only then does it 
perform the command/actual value adjustment. It is therefore 
not necessary to program WAIT FOR $ASYNC_STATE == 
#IDLE before “RESET…”.

5 Reopen the gun.

Line Description
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Description

6.19.3 Configuring Logic Consistency

Description The following settings are possible here:

Fig. 6-29: Configuring T1 and T2 Consistency

Item Description

1  Check box active: data comparison is activated.

 Check box not active: data comparison is deactivated.

2 Enter date and time in the format indicated.

3  Check box active: interval is activated.

 Check box not active: interval is deactivated.

If the intervals selected are too small, this can result in 
damage to the hard drive. An interval of several minutes 

is recommended.
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6.20 Brake test

6.20.1 Overview of the brake test

Description Each robot axis has a holding brake integrated into the motor. The brake test 
checks every axis at low speed and at the current temperature to see if the 
braking torque is sufficiently high, i.e. whether it exceeds a certain minimum 
value. The minimum value for the individual axes is stored in the machine da-
ta. (The brake test does not calculate the absolute value of the braking torque.) 

Request If the brake test is active, the following events cause a brake test to be request-
ed:

Fig. 6-30: Configuring Logic Consistency

Item Description

1  Check box active: data comparison is activated.

 Check box not active: data comparison is deactivated.

2  Check box active: data are compared when operating mode 
is switched to T1.

 Check box not active: data comparison is deactivated.

3  Check box activated: data are compared when operating mode 
is switched to T2.

 Check box not active: data comparison is deactivated.

4  Check box active: data are compared when operating mode 
is switched to Automatic.

 Check box not active: data comparison is deactivated.

5  Check box active: data are compared when operating mode 
is switched to Automatic External.

 Check box not active: data comparison is deactivated.

6  Check box active: data are compared after online optimizing.

 Check box not active: data comparison is deactivated.
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 Input $BRAKETEST_REQ_EX is set externally, e.g. by a PLC (external 
request)

 Robot controller boots with a cold start (internal request)

 Function test of the brake test (internal request)

 Brake test cycle time has elapsed (internal request)

Cycle time The cycle time is 46 h. It is deemed to have elapsed when the drives have 
been under servo-control for a total of 46 h. The robot controller then requests 
a brake test and generates the following message: Brake test required. The 
robot can be moved for another 2 hours. It then stops and the robot controller 
generates the following acknowledgement message: Cyclical check for brake 
test request not made. Once the message has been acknowledged, the robot 
can be moved for another 2 hours.

Execution A precondition for the brake test is that the robot is at operating temperature. 
This is the case after approx. 1 h in normal operation.

The brake test is carried out using the program BrakeTestReq.SRC. It can be 
started in the following ways:

 Automatically

Integrate BrakeTestReq.SRC into the application program in such a way 
that it is cyclically called as a subprogram. If a brake test is requested, the 
robot detects this and starts the brake test.

 Manually

Start the program BrakeTestReq.SRC manually.

Sequence The brake test checks all brakes one after the other.

1. The robot accelerates to a defined velocity. (The velocity cannot be influ-
enced by the user.)

2. Once the robot has reached the velocity, the brake is applied and the re-
sult for this braking operation is displayed in the message window.

3. If a brake has been identified as being defective, the brake test can be re-
peated for confirmation or the robot can be moved to the parking position.

If a brake has reached the wear limit, the robot controller indicates this by 
means of a message. A worn brake will soon be identified as defective. 
Until then, the robot can be moved without restrictions.

Overview

If a brake has been identified as being defective, the drives remain 
under servo-control for 2 hours following the start of the brake test (= 
monitoring time). The robot controller then switches the drives off.

Step Description

In WorkVisual:

1 If required: Activate the brake test in WorkVisual.

 (>>> 6.20.2 "Activating the brake test" Page 224)

On the robot controller:

2 Configure input and output signals for the brake test.

 (>>> 6.20.4 "Configuring input and output signals for the 
brake test" Page 225)

3 Teach positions for the brake test.

The parking position must be taught. The start position and 
end position can be taught.

 (>>> 6.20.5 "Teaching positions for the brake test" 
Page 227)
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6.20.2 Activating the brake test

 If a safety option is installed and the safe monitoring is active, the brake 
test is automatically active. 

 If the brake test is not automatically active, the user has the option of man-
ually activating it. This must be carried out in WorkVisual.

6.20.3 Programs for the brake test

The programs are located in the directory C:\KRC\ROBOT-
ER\KRC\R1\TP\BrakeTest.

4 If the brake test is to be carried out automatically:

Integrate BrakeTestReq.SRC into the application program 
in such a way that it is cyclically called as a subprogram.

5 If the brake test is to be carried out manually:

Start the program BrakeTestReq.SRC manually.

 (>>> 6.20.6 "Performing a manual brake test" Page 228)

6 If required: Test the function of the brake test.

 (>>> 6.20.7 "Checking that the brake test is functioning 
correctly" Page 229)

Step Description

If the brake test is not automatically active, the user must carry out a 
risk assessment to determine whether it is necessary to activate the 
brake test for the specific application.

Further information about activating the brake test is contained in the 
WorkVisual documentation.

Program Description

BrakeTestReq.SRC This program performs the brake test.

It can be performed in the following ways:

 Integrate the program into the application program in such a way that 
it is cyclically called as a subprogram. If a brake test is requested, the 
robot detects this and performs the brake test immediately.

 Execute the program manually.

 Test the function of the brake test. The robot controller executes Bra-
keTestReq.SRC with special parameterization.

BrakeTestPark.SRC The parking position of the robot must be taught in this program. 

The robot can be moved to the parking position if a brake has been 
identified as being defective.  Alternatively, the brake test can be 
repeated for confirmation.

BrakeTestStart.SRC The start position of the brake test can be taught in this program. The 
robot starts the brake test from this position.

If the start position is not taught, the robot performs the brake test at the 
actual position.
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6.20.4 Configuring input and output signals for the brake test

Description All signals for the brake test are declared in the file $machine.dat in the direc-
tory KRC:\STEU\MADA.

Precondition  “Expert” user group

Procedure 1. Open the file $machine.dat in the directory KRC:\STEU\MADA in the Nav-
igator.

2. Assign inputs and outputs.

3. Save and close the file.

$machine.dat Extract from the file $machine.dat (with default settings, without comments):

Signals There is 1 input signal. By default, it is routed to $IN[1026].

The output signals are preset to FALSE. There is no compelling need to assign 
output numbers to them. It is only necessary to assign numbers if there is a 
need to be able to read the signals (e.g. via the variable correction function or 
program execution.)

BrakeTestBack.SRC The end position of the brake test can be taught in this program. The 
robot moves to this position after the brake test.

If the end position is not taught, the robot remains at the actual position 
after the brake test.

BrakeTestSelfT-
est.SRC

The program checks whether the brake test has correctly detected a 
defective brake. For this purpose, the robot controller executes BrakeT-
estReq.SRC with special parameterization.

Program Description

These signals are not redundant in design and can sup-
ply incorrect information. Do not use these signals for 

safety-relevant applications.

...

SIGNAL $BRAKETEST_REQ_EX $IN[1026]

SIGNAL $BRAKETEST_MONTIME FALSE

...

SIGNAL $BRAKETEST_REQ_INT FALSE

SIGNAL $BRAKETEST_WORK FALSE

SIGNAL $BRAKES_OK FALSE

SIGNAL $BRAKETEST_WARN FALSE

...

Signal Description

$BRAKETEST_REQ_EX Input

 TRUE = brake test is being requested externally (e.g. by PLC). 
The robot controller confirms the signal with 
$BRAKETEST_REQ_INT = TRUE and generates message 
27004.

 FALSE = brake test is not being requested externally.

$BRAKETEST_MONTIME Output

 TRUE = robot was stopped due to elapsed monitoring time. 
Acknowledgement message 27002 is generated.

 FALSE = acknowledgement message 27002 is not active. (Not 
generated, or has been acknowledged.)
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Messages

6.20.4.1 Signal diagram of the brake test – examples

Example 1 The signal diagram for the brake test applies in the following case:

 No brake has reached the wear limit.

 No brake is defective.

$BRAKETEST_REQ_INT Output

 TRUE = message 27004 is active.

The signal is not set to FALSE again until a brake test is carried 
out with a positive result, i.e. with message 27012.

 FALSE = brake test is not requested (either internally or exter-
nally).

$BRAKETEST_WORK Output

 TRUE = brake test is currently being performed.

 FALSE = brake test is not being performed.

If no defective brakes have been detected, message 27012 is 
generated.

Edge TRUE → FALSE:

 Test was successfully completed. No brake is defective. Mes-
sage 27012 is generated.

 Or at least 1 defective brake was detected and the robot has 
moved to the parking position.

 Or the program was canceled during execution of the brake 
test.

$BRAKES_OK Output

 Edge FALSE → TRUE: Output was set to FALSE by the pre-
vious brake test. The brake test was carried out again and no 
defective brake was detected.

 Edge TRUE → FALSE: A brake has just been detected as de-
fective. Message 27007 is generated.

$BRAKETEST_WARN Output

 Edge FALSE → TRUE: At least 1 brake has been detected as 
having reached the wear limit. Message 27001 is generated at 
the same time.

 Edge TRUE → FALSE: Output was set to TRUE by the previ-
ous brake test. The brake test was carried out again and no 
worn brake was detected.

Signal Description

No. Message

27001 Brake {Brake no.}{Axis no.} has reached the wear limit

27002 Cyclical check for brake test request not made

27004 Brake test required

27007 Insufficient holding torque of brake {Brake no.}{Axis no.}

27012 Brake test successful
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Example 2 The signal diagram for the brake test applies in the following case:

 Brake A2 is worn.

 Brake A4 is defective.

6.20.5 Teaching positions for the brake test

Description The parking position must be taught.

Fig. 6-31: Signal diagram: brakes OK

Item Description

1 The brake test is requested.

2 Automatic call of the program BrakeTestReq.SRC

Start of the brake test

3 The brake test is completed.

Fig. 6-32: Signal diagram: brakes not OK

Item Description

1 The brake test is requested.

$BRAKETEST_REQ_INT is not set to FALSE again until a brake 
test is carried out with a positive result.

2 Automatic call of the program BrakeTestReq.SRC

Start of the brake test

3 Brake A2 is tested: brake is worn.

4 Brake A4 is tested: brake is defective.

5 The robot has been moved to the parking position or the program 
has been canceled.
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The start position and end position can be taught.

 If the start position is not taught, the robot performs the brake test at the 
actual position.

 If the end position is not taught, the robot remains at the actual position af-
ter the brake test.

Parking position If a brake is identified as being defective, the robot can be moved to the park-
ing position. Alternatively, the brake test can be repeated for confirmation.

Precondition  All output signals are assigned to outputs.

 “Expert” user group

 Operating mode T1

Procedure 1. Open the program BrakeTestStart.SRC in the directory R1\TP\BrakeTest.

2. Teach the motions to the start position of the brake test.

 The motions must be taught in such a way that the robot cannot cause 
a collision on the way to the start position.

 In the start position, every robot axis must have an available motion 
range of ±10°.

3. Save and close the program.

4. Open the program BrakeTestBack.SRC in the directory R1\TP\BrakeTest.

5. Teach the motions from the start position to the end position of the brake 
test.

The start and end position may be identical.

6. Save and close the program.

7. Open the program BrakeTestPark.SRC in the directory R1\TP\BrakeTest.

8. Program the motions from the end position to the parking position of the 
robot.

9. Save and close the program.

6.20.6 Performing a manual brake test

Precondition  No persons or objects are present within the motion range of the robot.

The parking position must be selected in a position 
where no persons are endangered if the robot sags be-

cause of the defective brake. The transport position, for example, can be se-
lected as the parking position.
Further information about the transport position is contained in the robot op-
erating or assembly instructions.

If a brake is identified as being defective and the drives 
are deactivated, the robot may sag. For this reason, no 

stop may be triggered during the motion to the parking position. The monitor-
ing functions that can trigger a stop in this range (e.g. monitoring spaces) 
must be deactivated beforehand. No safety functions may be executed that 
would trigger a stop (e.g. E-STOP, opening the safety gate, change of oper-
ating mode, etc.).
If a brake has been identified as being defective, the parking position must 
be approached no faster than at 10% of maximum velocity.

Program override for the test is automatically set to 
100%. The robot moves at high velocity. Make sure that 

the robot cannot collide and that no persons are in the motion range of the 
robot.
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 In the start position, every robot axis has an available motion range of 
±10°. (Or, if no start position has been taught, in the actual position.)

 The parking position has been taught in the program BrakeTestPark.SRC.

 “Expert” user group

 Program run mode GO

 AUT mode

 The robot is at operating temperature (= after approx. 1 h in normal oper-
ation).

Procedure 1. Select the program BrakeTestReq.SRC in the directory R1\TP\BrakeTest 
and press the Start key.

2. The following message is displayed: Performing manual brake test - 
please acknowledge. Acknowledge the message.

3. Press the Start key. The message Programmed path reached (BCO) is 
displayed.

4. Press the Start key. The brakes are tested, starting with A1.

5. Possible results:

 If a brake is OK, this is indicated by the following message: Brake 
{Brake no.}{Axis no.} OK.

If all brakes are OK, this is indicated after the brake test by the follow-
ing message: Brake test successful. (It is possible that one or more 
brakes may have reached the wear limit. This is also indicated by a 
message.)

Deselect the program BrakeTestReq.SRC.

 If a brake is defective, this is indicated by the following message: In-
sufficient holding torque of brake {Brake no.}{Axis no.}.

Once all brakes have been tested, either press Repeat to repeat the 
brake test for checking purposes

or press Park pos. to move the robot to the parking position.

6.20.7 Checking that the brake test is functioning correctly

Description It is possible to check whether the brake test has correctly detected a defective 
brake: the program BrakeTestSelfTest.SRC simulates a fault in the brakes 
and triggers a brake test. If the brake test detects the simulated fault, it is func-
tioning correctly.

Precondition  No persons or objects are present within the motion range of the robot.

 In the start position, every robot axis has an available motion range of 
±10°. (Or, if no start position has been taught, in the actual position.)

 The parking position has been taught in the program BrakeTestPark.SRC.

 “Expert” user group

 Program run mode GO

 AUT mode

If a brake has been identified as being defective, the drives remain 
under servo-control for 2 hours following the start of the brake test (= 
monitoring time). The robot controller then switches the drives off.

Program override for the test is automatically set to 
100%. The robot moves at high velocity. Make sure that 

the robot cannot collide and that no persons are in the motion range of the 
robot.
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 The robot is at operating temperature (= after approx. 1 h in normal oper-
ation).

Procedure 1. Select the program BrakeTestSelfTest.SRC in the directory R1\TP\Bra-
keTest and press the Start key.

2. The following message is displayed: Performing self-test for brake test - please 
acknowledge. Confirm the message by pressing Ackn..

3. Press the Start key.

4. Result of the function test:

 Message Insufficient holding torque of brake 3: The brake test has correct-
ly detected the simulated fault. The brake test is functioning correctly.

Deselect the program BrakeTestSelfTest.SRC. 

Perform a manual brake test. This ensures that the simulated fault 
does not remain active.

 Any other message, or no message, means: The brake test has not 
detected the simulated fault. The brake test is not functioning correctly.

If the function test establishes that the brake test is not 
functioning correctly:

 The robot must no longer be moved.

 KUKA Roboter GmbH must be contacted.
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7 Program and project management

7.1 Creating a new program

Description It is not possible to select a template in the user group “User”. By default, a 
program of type “Module” is created.

Precondition  The Navigator is displayed.

Procedure 1. In the directory structure, select the folder in which the program is to be 
created, e.g. the folder Program. (Not all folders allow the creation of pro-
grams within them.)

2. Press New. 

3. Only in the user group “Expert”:

The Template selection window is opened. Select the desired template 
and confirm with OK.

4. Enter a name for the program and confirm it with OK.

7.2 Creating a new folder

Precondition  The Navigator is displayed.

Procedure 1. In the directory structure, select the folder in which the new folder is to be 
created, e.g. the folder R1. 

Not all folders allow the creation of new folders within them. In the user 
groups “Operator” and “User”, new folders can only be created in the folder 
R1.

2. Press New. 

3. Enter a name for the folder and confirm it with OK.

7.3 Renaming a file or folder

Precondition  The Navigator is displayed.

Procedure 1. In the directory structure, select the folder in which the file or folder to be 
renamed is located.

2. Select the file or folder in the file list.

3. Select Edit > Rename.

4. Overwrite the name with the new name and confirm with OK.

 

 

 

231 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



232 / 491

KUKA System Software 8.3
7.4 Navigator file manager

Overview

Description In the Navigator, the user manages programs and system-specific files.

Header

 Left-hand area: the selected filter is displayed.

 (>>> 7.4.1 "Selecting filters" Page 233)

 Right-hand area: the directory or drive selected in the directory structure 
is displayed.

Directory structure

Overview of directories and drives. Exactly which directories and drives are 
displayed depends on the user group and configuration.

File list

The contents of the directory or drive selected in the directory structure are dis-
played. The manner in which programs are displayed depends on the selected 
filter.

The file list has the following columns:

Fig. 7-1: Navigator

1 Header 3 File list

2 Directory structure 4 Status bar

Column Description

Name Directory or file name

Extension File extension

This column is not displayed in the user group “User”.
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Status bar

The status bar can display the following information:

 Selected objects

 Action in progress

 User dialogs

 User entry prompts

 Requests for confirmation

7.4.1 Selecting filters

Description This function is not available in the user group “User”.

The filter defines how programs are displayed in the file list. The following fil-
ters are available:

 Detail

Programs are displayed as SRC and DAT files. (Default setting)

 Modules

Programs are displayed as modules.

Precondition  “Expert” user group

Procedure 1. Select the menu sequence Edit > Filter.

2. Select the desired filter in the left-hand section of the Navigator.

3. Confirm with OK.

7.4.2 Displaying or modifying properties of files and folders

Precondition  To change properties: user group “Expert”.

Procedure 1. Select the object in the directory structure or in the file list.

2. Select the menu sequence Edit > Properties.

A window opens. Depending on the specific object selected, the number 
of tabs in the window may vary.

3. If required: Change the properties and save the changes with OK.

Comment Comment

Attributes Attributes of the operating system and kernel system

This column is not displayed in the user group “User”.

Size File size in kilobytes

This column is not displayed in the user group “User”.

# Number of changes made to the file

Changed Date and time of the last change

Created Date and time of file creation

This column is not displayed in the user group “User”.

Column Description
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General

Module info The Module info tab is only displayed if the selected object is a file.

Fig. 7-2: “General” tab

Item Description

1 Name of the selected object

2 Object type, path and size. Object types:

 Module: module

 Dir: folder

 Archiv: archive file

 Bin: binary file

 Text: text file

 VirtualDir: virtual folder

 Unknown: all other file types

3 Windows object properties

4 Windows object properties. The properties can be modified in the 
user group “Expert”.

5 Free: the file is not selected in the smart.HMI and is not open.

Full: the file is open in the smart.HMI.

ProKor: the file is selected in the smart.HMI.
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Parameters The Parameters tab is only displayed if the selected object is a file.

Fig. 7-3: “Module info” tab

Item Description

1 Version: internal version number of the file. After creation, the file 
does not yet have a number. After the first change, the file 
receives the number 1. The number is incremented after every 
change.

Size SRC:: size of the SRC file

Size DAT:: size of the DAT file

Source type:: file type

 SRC: SRC file

 SubmitSub: SUB file

 None: all other file types, e.g. DAT file

2 Status of the module in the submit interpreter and in the robot 
interpreter

Free: program is not selected.

selected: program is selected.

Active: only relevant for the Submit box. This program is cur-
rently being used by the submit interpreter.

3 Check box active: if this program is called as a subprogram, it is 
displayed in the Editor.

Check box not active: if this program is called as a subprogram, it 
is not displayed in the Editor. This program cannot be selected 
manually.

4 The user can enter his or her name here.

5 The user can enter a comment for the module here. The comment 
is displayed in the Comment column in the Navigator.
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Any desired information can be stored in KRL modules.

Program in the 

editor

If an SRC or DAT file is opened in an editor (e.g. WordPad) in Windows, a 
number of the file properties are displayed above the DEF line.

Fig. 7-4: “Parameters” tab

Item Description

1 The existing information is shown here.

A piece of information can be deleted by selecting the line and 
deleting the contents in the box Parameter value. Then confirm 
with OK.

2 The user can enter a name here for a new piece of information.

3 The user can enter information here.

 1  &ACCESS RV

 2  &REL 2

 3  &COMMENT test comment

 4  &USER kuka

 5  &PARAM test name = test param

 6  &PARAM TEMPLATE = C:\KRC\Roboter\Template\vorgabe

 7  &PARAM EDITMASK = *

 8  DEF test( )

    ...

Line Description

1 Tab Module info, check box Visible

 &ACCESS RV = check box active

 &ACCESS R = check box inactive

2 Tab Module info, box Version

3 Tab Module info, box Comment

4 Tab Module info, box User

5 Tab Parameters, boxes Name and Parameter value
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7.5 Selecting or opening a program

Overview A program can be selected or opened. Instead of the Navigator, an editor is 
then displayed with the program.

 (>>> 7.5.1 "Selecting and deselecting a program" Page 237)

 (>>> 7.5.2 "Opening a program" Page 238)

It is possible to toggle backwards and forwards between the program display 
and the Navigator.

 (>>> 7.5.3 "Toggling between the Navigator and the program" Page 239)

Differences Program is selected:

 The block pointer is displayed.

 The program can be started.

 The program can be edited to a certain extent.

Selected programs are particularly suitable for editing in the user group 
“User”.

Example: KRL instructions covering several lines (e.g. LOOP … END-
LOOP) are not permissible.

 When the program is deselected, modifications are accepted without a re-
quest for confirmation. If impermissible modifications are programmed, an 
error message is displayed.

Program is opened:

 The program cannot be started.

 The program can be edited.

Opened programs are particularly suitable for editing in the user group 
“Expert”.

 A request for confirmation is generated when the program is closed. Mod-
ifications can be accepted or rejected.

7.5.1 Selecting and deselecting a program

Precondition  T1, T2 or AUT mode

Procedure 1. Select the program in the Navigator and press Select. 

The program is displayed in the editor. It is irrelevant whether a module, 
an SRC file or a DAT file is selected. It is always the SRC file that is dis-
played in the editor.

2. Start or edit the program.

3. Deselect the program again: 

Select Edit > Cancel program.

Or: In the status bar, touch the Robot interpreter status indicator. A win-
dow opens. Select Cancel program.

If a selected program is edited in the user group “Expert”, the cursor 
must then be removed from the edited line and positioned in any other 
line! 

Only in this way is it certain that the editing will be applied when the program 
is deselected again.

When the program is deselected, modifications are accepted without 
a request for confirmation!
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If the program is running, it must be stopped before it can be deselected.

Description If a program is selected, this is indicated by the Robot interpreter status indi-
cator.

 (>>> 8.6 "Robot interpreter status indicator" Page 267)

7.5.2 Opening a program

Precondition  T1, T2 or AUT mode

A program can be opened in AUT EXT mode, but not edited.

Procedure 1. Select the program in the Navigator and press Open. The program is dis-
played in the editor.

If a module has been selected, the SRC file is displayed in the editor. If an 
SRC file or DAT file has been selected, the corresponding file is displayed 
in the editor.

2. Edit the program.

3. Close the program.

4. To accept the changes, answer the request for confirmation with Yes.

Fig. 7-5: Program is selected

1 Block pointer

2 Cursor

3 Program path and file name

4 Position of the cursor in the program

5 The icon indicates that the program is selected.
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Description

7.5.3 Toggling between the Navigator and the program

Description If a program is selected or open, it is possible to display the Navigator again 
without having to deselect or close the program. The user can then return to 
the program.

Procedure Program is selected:

 Toggling from the program to the Navigator: select the menu sequence 
Edit > Navigator.

 Toggling from the Navigator to the program: press PROGRAM.

Program is open:

 Toggling from the program to the Navigator: select the menu sequence 
Edit > Navigator.

 Toggling from the Navigator to the program: press EDITOR.

7.6 Structure of a KRL program

Fig. 7-6: Program is open

1 Cursor

2 Program path and file name

3 Position of the cursor in the program

Programs that are running or have been interrupted must first be 
stopped before the menu sequences and buttons referred to above 
are available.

1  DEF my_program( )

2  INI

3

4  PTP HOME  Vel= 100 % DEFAULT

   ...

8  LIN point_5 CONT Vel= 2 m/s CPDAT1 Tool[3] Base[4]
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The first motion instruction in a KRL program must define an unambiguous 
starting position. The HOME position, which is stored by default in the robot 
controller, ensures that this is the case.

If the first motion instruction is not the default HOME position, or if this position 
has been changed, one of the following statements must be used:

 Complete PTP instruction of type POS or E6POS

 Complete PTP instruction of type AXIS or E6AXIS

“Complete” means that all components of the end point must be specified.

In programs that are used exclusively as subprograms, different statements 
can be used as the first motion instruction.

7.6.1 HOME position

The HOME position is not program-specific. It is generally used as the first and 
last position in the program as it is uniquely defined and uncritical.

The HOME position is stored by default with the following values in the robot 
controller:

   ...

14 PTP point_1 CONT Vel= 100 % PDAT1 Tool[3] Base[4]

   ...

20 PTP HOME  Vel= 100 % DEFAULT

21

22 END

Line Description

1 The DEF line indicates the name of the program. If the pro-
gram is a function, the DEF line begins with “DEFFCT” and 
contains additional information. The DEF line can be dis-
played or hidden.

 (>>> 7.7.1 "Displaying/hiding the DEF line" Page 241)

2 The INI line contains initializations for internal variables and 
parameters.

4 HOME position

 (>>> 7.6.1 "HOME position" Page 240)

8 LIN motion

 (>>> 10.2.3 "Programming a LIN motion" Page 308)

14 PTP motion

 (>>> 10.2.1 "Programming a PTP motion" Page 307)

20 HOME position

22 The END line is the last line in any program. If the program is 
a function, the wording of the END line is “ENDFCT”. The 
END line must not be deleted!

If the HOME position is modified, this affects all pro-
grams in which it is used. Injuries or damage to property 

may result.

Axis A1 A2 A3 A4 A5 A6

Pos. 0° - 90° + 90° 0° 0° 0°
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Additional HOME positions can be taught. A HOME position must meet the fol-
lowing conditions:

 Good starting position for program execution

 Good standstill position. For example, the stationary robot must not be an 
obstacle.

7.7 Displaying/hiding program sections

7.7.1 Displaying/hiding the DEF line

Description By default, the DEF line is hidden. Declarations can only be made in a program 
if the DEF line is visible.

The DEF line is displayed and hidden separately for opened and selected pro-
grams. If detail view (ASCII mode) is activated, the DEF line is visible and does 
not need to be activated separately.

Precondition  User group “Expert”

 Program is selected or open.

Procedure 1. Select the menu sequence Edit > View. The subitem DEF line displays 
the current status:

 Check box not active: The DEF line is hidden.

 Check box active: The DEF line is displayed.

2. To change the status, touch the menu item DEF line.

The menu then closes automatically.

7.7.2 Activating detail view

Description Detail view (ASCII mode) is deactivated by default to keep the program trans-
parent. If detail view is activated, hidden program lines, such as the FOLD and 
ENDFOLD lines and the DEF line, are displayed.

Detail view is activated and deactivated separately for opened and selected 
programs.

Precondition  “Expert” user group

Procedure 1. Select the menu sequence Edit > View. The subitem Detail view (ASCII) 
displays the current status:

 Check box not active: Detail view is deactivated.

 Check box active: Detail view is activated.

2. To change the status, touch the menu item Detail view (ASCII). 

The menu then closes automatically.

If the HOME position is modified, this affects all pro-
grams in which it is used. Injuries or damage to property 

may result.
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7.7.3 Activating/deactivating the line break function

Description If a line is wider than the program window, the line is broken by default. The 
part of the line after the break has no line number and is marked with a black, 
L-shaped arrow. 

The line break function can be deactivated. If a line is wider than the program 
window, the line is no longer visible in its entirety. A scroll bar is displayed un-
derneath the program window. 

The line break function is activated and deactivated separately for opened and 
selected programs.

Precondition  User group “Expert”

 Program is selected or open.

Procedure 1. Select the menu sequence Edit > View. The subitem Line break displays 
the current status:

 Check box not active: Line break function is deactivated.

 Check box active: Line break function is activated.

2. To change the status, touch the menu item Line break.

The menu then closes automatically.

7.7.4 Displaying Folds

Description Folds are used to hide sections of the program. In this way, Folds make pro-
grams more transparent. The hidden program sections are processed during 
program execution in exactly the same way as normal program sections.

 In the user group “User”, Folds are always closed. In other words, the con-
tents of the Folds are not visible and cannot be edited.

 In the user group “Expert”, Folds are closed by default. They can be 
opened and edited. New Folds can be created.

 (>>> 7.8.3 "Creating folds" Page 245)

If a program is deselected, all Folds are automatically closed.

Fig. 7-7: Line break

Fig. 7-8: Example of a closed Fold
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Color coding of Folds:

Precondition  User group “Expert”

 Program is selected or open.

Procedure 1. Select the line containing the Fold.

2. Press Open/close fold. The Fold then opens.

3. To close the fold, press Open/close fold again.

Alternatively, use the menu sequence Edit > FOLD > Open all FOLDs or 
Close all FOLDs to open or close all the Folds in a program at once.

7.8 Editing programs

Overview  A running program cannot be edited.

 Programs cannot be edited in AUT EXT mode.

Fig. 7-9: Example of an open Fold

Color Description

Dark red Closed fold

Light red Opened fold

Dark blue Closed sub-Fold

Light blue Opened sub-Fold

Green Contents of the Fold

If a selected program is edited in the user group “Expert”, the cursor 
must then be removed from the edited line and positioned in any other 
line! 

Only in this way is it certain that the editing will be applied when the program 
is deselected again.
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7.8.1 Inserting a comment or stamp

Precondition  Program is selected or open.

 Operating mode T1

Procedure 1. Select the line after which the comment or stamp is to be inserted.

2. Select the menu sequence Commands > Comment > Normal or Stamp.

3. Enter the desired data. If a comment or stamp has already been entered 
previously, the inline form still contains the same entries.

 In the case of a comment, the box can be cleared using New text 
ready for entry of a new text.

 In the case of a stamp, the system time can also be updated using 
New time and the NAME box can be cleared using New name.

4. Save with Cmd Ok.

Action Possible in user group …?

Insert comment or 
stamp

User: Yes

Expert: Yes

Delete lines User: Yes

Expert: Yes

Create folds User: No

Expert: Yes

Copy User: No

Expert: Yes

Paste User: No

Expert: Yes

Insert blank lines 
(press the Enter key)

User: No

Expert: Yes

Cut User: No

Expert: Yes

Find User: Yes

Expert: Yes

Possible for all user groups in an open program, 
even in AUT EXT mode.

Replace User: No

Expert: Yes (program is open, not selected)

Programming with 
inline forms

User: Yes

Expert: Yes

KRL programming User: Possible to a certain extent. KRL instruc-
tions covering several lines (e.g. LOOP … END-
LOOP) are not permissible.

Expert: Yes
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Description 

Comment

Description 

Stamp

A stamp is a comment that is extended to include the system date and time 
and the user ID.

7.8.2 Deleting program lines

Description If a program line containing a motion instruction is deleted, the point name and 
coordinates remain saved in the DAT file. The point can be used in other mo-
tion instructions and does not need to be taught again.

Precondition  Program is selected or open.

 Operating mode T1

Procedure 1. Select the line to be deleted. (The line need not have a colored back-
ground. It is sufficient for the cursor to be in the line.)

If several consecutive lines are to be deleted: drag a finger or stylus across 
the desired area. (The area must now have a colored background.)

2. Select the menu sequence Edit > Delete.

3. Confirm the request for confirmation with Yes.

7.8.3 Creating folds

Syntax ;FOLD Name

Statements

;ENDFOLD <Name>

The ENDFOLD lines can be assigned more easily if the name of the Fold is 
entered here as well. Folds can be nested.

Precondition  “Expert” user group

Fig. 7-10: Inline form “Comment”

Item Description

1 Any text

Fig. 7-11: Inline form “Stamp”

Item Description

1 System date (cannot be edited)

2 System time

3 Name or ID of the user

4 Any text

Lines cannot be restored once they have been deleted!
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 Program is selected or open.

 Operating mode T1

Procedure 1. Enter Fold in program. A double semicolon prevents the Fold from closing 
when edited.

2. Delete the second semicolon.

3. Position the cursor in a line outside the Fold. The Fold closes.

7.8.4 Additional editing functions

The following additional program editing functions can be called using Edit:

Copy

Precondition:

 Program is selected or open.

 “Expert” user group

 Operating mode T1

Paste

Precondition:

 Program is selected or open.

 “Expert” user group

 Operating mode T1

Cut

Precondition:

 Program is selected or open.

 “Expert” user group

 Operating mode T1

Fig. 7-12: Creating a sample Fold, step 1

Fig. 7-13: Creating a sample Fold, step 2

Fig. 7-14: Creating a sample Fold, step 3
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Find

Precondition:

 Program is selected or open.

Replace

Precondition:

 Program has been opened.

 “Expert” user group

 Operating mode T1

Marked region

 (>>> 10.5.4 "Transforming blocks of coordinates" Page 339)

7.9 Printing a program

Procedure 1. Select the program in the Navigator. Multiple program selection is also 
possible.

2. Select the menu sequence Edit > Print.

7.10 Archiving and restoring data

7.10.1 Archiving overview

Target locations Archiving can be performed to the following target destinations:

 USB stick in smartPAD or robot controller

 Network

Menu items The following menu items are available:

("*.*" means all files and subdirectories.)

Menu item Archives the directories/files

All  KRC:\*.*

 C:\KRC\Roboter\Config\User\*.*

 C:\KRC\Roboter\Config\System\Common\Mada\*.*

 C:\KRC\Roboter\Init\*.*

 C:\KRC\Roboter\lr_Spec\*.*

 C:\KRC\Roboter\Template\*.*

 C:\KRC\Roboter\Rdc\*.*

 C:\KRC\User\*.*

 C:\KRC\Roboter\log\Mastery.log

 Some additional log data

Applications  KRC:\R1\Program\*.*

 KRC:\R1\System\*.*

 KRC:\R1\cell*.*

 KRC:\Steu\$config*.*
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If archiving is carried out using the menu item All and there is an existing ar-
chive present, this will be overwritten.

If archiving is carried out using a menu item other than All or KrcDiag and an 
archive is already available, the robot controller compares its robot name with 
that in the archive. If the names are different, a request for confirmation is gen-
erated.

If archiving is carried out repeatedly via KrcDiag, a maximum of 10 archives 
can be created. Further archives will overwrite the oldest existing archive.

The logbook can also be activated.  (>>> 7.10.4 "Archiving the logbook" 
Page 249)

7.10.2 Archiving to a USB stick

Description This procedure generates a ZIP file on the stick. By default, this file has the 
same name as the robot. A different name can be defined for the file, however, 
under Robot data.

 (>>> 4.17.15 "Displaying/editing robot data" Page 90)

The archive is displayed in the ARCHIVE:\ directory in the Navigator. Archiving 
is also carried out automatically to D:\ as well as to the stick. The file IN-
TERN.ZIP is generated here. 

System data  KRC:\R1\Mada\*.*

 KRC:\R1\System\*.*

 KRC:\R1\TP\*.*

 KRC:\Steu\Mada\*.*

 C:\KRC\Roboter\Config\User\*.*

 C:\KRC\Roboter\Config\System\Common\Mada\*.*

 C:\KRC\Roboter\Init\*.*

 C:\KRC\Roboter\lr_Spec\*.*

 C:\KRC\Roboter\Template\*.*

 C:\KRC\Roboter\Rdc\*.*

 C:\KRC\User\*.*

Log data  C:\KRC\Roboter\log\*.*

Except: Poslog.xsl and files with the extension DMP

 Some additional log data

KrcDiag If it is necessary for an error to be analyzed by KUKA 
Roboter GmbH, this menu item can be used to com-
press the data for sending to KUKA.

A screenshot of the current view of the smartHMI is 
automatically generated for the data packet. For this 
reason, display error-relevant information on the 
smartHMI before starting the operation, e.g. expand 
the message window or display the logbook. What 
information is useful here depends on the specific cir-
cumstances.

In addition to the menu sequence File > Archive, there 
are other methods available for compressing these 
data.

 (>>> 13.5 "Automatically compressing data for error 
analysis (KrcDiag)" Page 466)

Menu item Archives the directories/files
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Special case KrcDiag: 

This menu item generates the folder KRCDiag on the stick. This contains a 
ZIP file. The ZIP file is also automatically archived in C:\KUKA\KRCDiag.

Procedure 1. Connect the USB stick (to smartPAD or cabinet).

2. In the main menu, select File > Archive > USB (KCP) or USB (cabinet) 
and then the desired menu item.

3. Confirm the request for confirmation with Yes. The archive is created. 

Once the archiving is completed, this is indicated in the message window.

Special case KrcDiag: If archiving is carried out using this menu item, a 
separate window indicates when archiving has been completed. The win-
dow is then automatically hidden again.

4. The stick can now be removed.

7.10.3 Archiving on the network

Description This procedure generates a ZIP file on the network path. By default, this file 
has the same name as the robot. A different name can be defined for the file, 
however, under Start-up > Robot data.

The network path to which archiving is to be carried out must be configured in 
the Robot data window. If a user name and password are required for ar-
chiving to this path, these can also be entered here. 

 (>>> 4.17.15 "Displaying/editing robot data" Page 90)

The archive is displayed in the ARCHIVE:\ directory in the Navigator. Archiving 
is also carried out automatically to D:\ as well as to the network path. The file 
INTERN.ZIP is generated here. 

Special case KrcDiag: 

This menu item generates the folder KRCDiag on the network path. This con-
tains a ZIP file. The ZIP file is also automatically archived in C:\KUKA\KRCDi-
ag.

Precondition  The network path to which the data are to be archived is configured.

Procedure 1. In the main menu, select File > Archive > Network and then the desired 
menu item.

2. Confirm the request for confirmation with Yes. The archive is created. 

Once the archiving is completed, this is indicated in the message window. 
Special case KrcDiag: If archiving is carried out using this menu item, a 
separate window indicates when archiving has been completed. The win-
dow is then automatically hidden again.

7.10.4 Archiving the logbook

Description The file “Logbuch.txt” is generated as an archive in the directory C:\KRC\RO-
BOTER\LOG.

Procedure  In the main menu, select File > Archive > Logbook.

The archive is created. Once the archiving is completed, this is indicated 
in the message window. 

A non-bootable USB stick must be used.
We recommend using a non-bootable KUKA stick. Data 

may be lost if a stick from a different manufacturer is used.
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7.10.5 Restoring data

Description

The following menu items are available for restoring data:

 All

 Applications

 System data

If the archived files are not the same version as the files present in the system, 
an error message is generated during restoration.

Similarly, if the version of the archived technology packages does not match 
the installed version, an error message is generated.

Precondition  If data are to be restored from the USB stick: A USB stick with the archive 
is connected.

The stick can be connected to the smartPAD or robot controller.

Procedure 1. In the main menu, select File > Restore and then the desired subitems.

2. Confirm the request for confirmation with Yes. Archived files are restored 
to the robot controller. A message indicates completion of the restoration 
process.

3. If data have been restored from a USB stick: the stick can now be re-
moved.

4. Reboot the robot controller.

7.11 Project management

7.11.1 Pinning a project on the robot controller

Description Projects that are present on the robot controller can be pinned. A project can 
be pinned directly on the robot controller or in WorkVisual.

Pinned projects cannot be changed, activated or deleted. They can be copied 
or unpinned, however. A project can thus be pinned e.g. to prevent it from be-
ing accidentally deleted.

Precondition  “Expert” user group

Procedure 1. Touch the WorkVisual icon on the smartHMI, then go to Open. The Proj-
ect management window opens.

2. Select the desired project and press the Pin button. The project is pinned 
and labeled with a pin symbol in the project list.

 (>>> 7.11.3 "Project management window" Page 252)

Only KSS 8.3 archives may be loaded into KSS 8.3. If 
other archives are loaded, the following may occur:

 Error messages

 Robot controller is not operable.

 Personal injury and damage to property.

A non-bootable USB stick must be used.
We recommend using a non-bootable KUKA stick. Data 

may be lost if a stick from a different manufacturer is used.

Information about how projects can be pinned via WorkVisual can be 
found in the WorkVisual documentation. 
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3. The project can be unpinned again by pressing the Unpin button.

7.11.2 Activating a project

Precondition  User group “Expert” or higher

If the activation would cause changes in the area Safety-relevant com-
munication parameters, the user group “Safety recovery” or higher must 
be selected.

 In AUT or AUT EXT mode:

The project can only be activated if this affects only KRL programs. If the 
project contains settings that would cause other changes, it cannot be ac-
tivated. 

Preparation There are 2 ways of reaching the first step of the procedure below. 

 Project activation is the direct continuation of another sequence, e.g. the 
restoration of a project.

In this case, the preparation described as follows is not necessary. 

 Or: Project activation is executed as a stand-alone sequence. 

In this case, the preparation described as follows is required in order to ar-
rive at the procedure. 

Preparation:

1. Touch the WorkVisual icon on the smartHMI, then go to Open. The Proj-
ect management window opens.

2. Select the desired project and activate it using the Activate button.

Procedure 1. The KUKA smartHMI displays the request for confirmation Do you want to 
activate the project […]?. In addition, a message is displayed as to whether 
the activation would overwrite a project, and if so, which.

If no relevant project will be overwritten: Confirm with Yes within 30 min-
utes.

2. An overview is displayed of the changes which will be made in comparison 
to the project that is still active on the robot controller. The check box De-
tails can be used to display details about the changes.

3.  The overview displays the request for confirmation Do you want to conti-
nue?. Confirm with Yes. The project is activated on the robot controller.

If one of the options KUKA.SafeOperation or KUKA.SafeRangeMon-
itoring is installed on the robot controller, different user groups may 
apply. Information can be found in the documentation for these op-

tions.

If changes are listed in the overview under the heading 
Safety-relevant communication parameters, this 

means that the behavior of the Emergency Stop and “Operator safety” signal 
may have changed compared with the previous project. 
After activation of the project, the Emergency Stop and the “Operator safety” 
signal must be checked for safe functioning. If the project is activated on sev-
eral robot controllers, this check must be carried out for every robot control-
ler. Failure to carry out this check may result in death, injuries or damage to 
property.
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7.11.3 Project management window

Overview The Project management window is opened using the WorkVisual icon on 
the smartHMI.

In addition to the regular projects, the Project management window contains 
the following special projects:

After activation of a project on the robot controller, the 
safety configuration must be checked there! If this is not 

done, the robot will possibly be operated with incorrect data. Death, injuries 
or damage to property may result.
 (>>> 6.5 "Checking the safety configuration of the robot controller" 
Page 166)

If the activation of a project fails, an error message is dis-
played. In this case, one of the following measures must 

be carried out:

 Either: Activate a project again (the same one or a different one).

 Or: Reboot the robot controller with a cold restart.

In the case of a KSS/VSS update, the initial project and base project 
are overwritten by copies of the active project.

Project Description

Initial project The initial project is always present. It cannot be 
changed by the user. It contains the initial state of the 
robot controller as shipped.

Base project The user can save the active project as the base proj-
ect. This functionality is generally used to save a func-
tional, tried-and-tested project state.

The base project cannot be activated, but copied. The 
base project can no longer be changed by the user. It 
can, however, be overwritten by saving a new base 
project (after a request for confirmation).

If a project is activated which does not contain all the 
configuration files, the missing information is inserted 
from the base project. This is the case e.g. if a project 
is activated from an earlier version of WorkVisual. (The 
configuration files include machine data files, safety 
configuration files and many others.)

In the case of a KSS/VSS update, the initial project and base project 
are overwritten by copies of the active project.
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Description

With all copying operations, a window opens in which a name and a descrip-
tion can be entered for the copy.

Buttons The following buttons are available:

Fig. 7-15: “Projects management” window

Item Description

1 The initial project is displayed.

2 Restores the factory settings of the robot controller.

Only available to the user group “Expert” or higher.

3 The base project is displayed.

4 Creates a copy of the base project.

Only available to the user group “Expert” or higher.

5 The active project is displayed.

6 Saves the active project as the base project. The active project re-
mains active.

Only available to the user group “Expert” or higher.

7 Creates a pinned copy of the active project.

Only available to the user group “Expert” or higher.

8 List of inactive projects (except base and initial project)
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7.12 Backup Manager

7.12.1 Overview of Backup Manager

Overview The Backup Manager makes it possible to back up and restore projects, option 
packages and RDC data.

The default settings for the Backup Manager are defined in the Backup con-
figuration window. The settings can be changed. 

 (>>> 7.12.5 "Configuring Backup Manager" Page 258)

Start types There are several ways of starting a backup or restoration:

When a backup/restoration is running, no further backup/restoration can be 
started. However, the start types are not mutually exclusive. If, for example, 
an automatic backup is configured, a manual backup can still be executed. 

Button Description

Activate Activates the selected project.

If the selected project is pinned: Creates a copy of the 
selected project. (A pinned project cannot be activated 
itself, only a copy of it.) The user can then decide 
whether to activate this copy or whether the current 
project should remain active.

Only available to the user group “Expert” or higher.

Pin  (>>> 7.11.1 "Pinning a project on the robot controller" 
Page 250)

Only available if an unpinned project is selected. Only 
available to the user group “Expert” or higher.

Unpin Unpins the project.

Only available if a pinned project is selected. Only 
available to the user group “Expert” or higher.

Copy Copies the selected project.

Only available to the user group “Expert” or higher.

Delete Deletes the selected project.

Only available if a non-activated, unpinned project is 
selected. Only available to the user group “Expert” or 
higher.

Edit Opens a window in which the name and/or description 
of the selected project can be changed.

Only available if an unpinned project is selected. Only 
available to the user group “Expert” or higher.

Update Refreshes the project list. This enables e.g. projects to 
be displayed which have been transferred to the robot 
controller since the display was opened.

Backup Restoration

Manual Yes Yes

Automatic, in inter-
vals

Yes No

Via inputs

(only possible in AUT 
or AUT EXT mode)

Yes

Yes

(only projects and option pack-
ages, no RDC data)
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7.12.2 Manual backup of projects, option packages and RDC data

Description Projects

The following projects are backed up by default:

 Active project

 Initial project

 Base project

Option packages

Option packages will be backed up under the following conditions:

 The option package has a KOP file.

 The option package was originally added to the project in WorkVisual. The 
project is now active on the robot controller.

Or: 

The option package has been installed in the active project via Start-up > 
Additional software. The option package was available during installa-
tion as a single KOP file (not as a directory structure!).

RDC data

Every time a backup is made, a file with the name [Robot_serial_number].RDC 
is created. It contains the CAL, MAM and PID files. Not all files are present in 
all cases (dependent on the robot).

Procedure  In the main menu, select File > Backup Manager, and then one of the fol-
lowing menu items:

 Back up

The target directory is D:\ProjectBackup as long as no other directory 
has been configured. The path is automatically created if it does not 
already exist.

 Or Save as...

A target directory can be selected here. It only applies to this backup.

The backup is carried out. The robot controller displays a message when the 
backup has been successfully completed. It generates one message per proj-
ect or option package and one message relating to the RDC data.

However, option packages will not be backed up if the same package version 
already exists in the target directory.

Execution

Manual  (>>> 7.12.2 "Manual backup of projects, option 
packages and RDC data" Page 255)

 (>>> 7.12.3 "Manually restoring projects and op-
tion packages" Page 256)

 (>>> 7.12.4 "Restoring RDC data manually" 
Page 257)

Automatic, in inter-
vals

If backups are to be started automatically, this 
must be configured in the Backup configuration 
window.

Via inputs If backups/restorations are to be started via in-
puts, this must be configured in the Backup con-
figuration window.
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7.12.3 Manually restoring projects and option packages

Description Projects

The following projects are restored by default:

 Active project (i.e. the project which was active during the backup)

 Initial project

 Base project

After manual restoration of the project, the robot controller reactivates the pre-
viously active project if certain preconditions are met. If not, the project re-
mains inactive. This can be activated by the user at the desired point in time.

After restoration of the project via inputs, the previously active project also re-
mains inactive.

Option packages

The option packages for which there are KOP files in the source directory are 
not necessarily all restored. An option package will be restored under the fol-
lowing conditions:

 At the time of backup, the option package was present in the active proj-
ect.

 At the time of restoration, this version of the option package is not installed 
on the robot controller.

Following restoration, some option packages automatically install themselves 
when the corresponding project is activated.

Option packages that do not automatically install themselves are available for 
installation under Start-up > Additional software. A message on the robot 
controller indicates that the option package must still be installed. 

Menu items There are 2 menu items available for restoration. They differ with regard to the 
source directory that is accessed.

 Restore > 

The source directory is D:\ProjectBackup as long as no other directory has 
been configured.

 Or Restore from ... > 

A source directory can be selected here. It only applies to this restoration.

Precondition

 User group “Expert” or higher

If the activation would cause changes in the area Safety-relevant com-
munication parameters, the user group “Safety recovery” or higher must 
be selected.

 In AUT or AUT EXT mode:

The project can only be activated if this affects only KRL programs. If the 
project contains settings that would cause other changes, it cannot be ac-
tivated. 

No special preconditions are required for the restoration as such. If a 
project is to be activated, the following preconditions must be met.

If one of the options KUKA.SafeOperation or KUKA.SafeRangeMon-
itoring is installed on the robot controller, different user groups may 
apply. Information can be found in the documentation for these op-

tions.
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Procedure in 

AUT / AUT EXT 

mode

1. In the main menu, select File > Backup Manager > Restore > Projects 
and options.

Or: 

Select File > Backup Manager > Restore from ... > Projects and op-
tions and then select the source directory.

2. The robot controller displays a message for each project and option pack-
age when the restoration has been successfully completed.

 When an option package has been restored, the package must first be 
installed before the project can be activated. This is indicated by a 
message on the robot controller.

 If no option package has been restored, the robot controller begins to 
activate the project without a request for confirmation.

3. For the further activation steps, see:  (>>> 7.11.2 "Activating a project" 
Page 251)

Procedure in 

T1 / T2 mode

1. In the main menu, select File > Backup Manager > Restore > Projects 
and options.

Or: 

Select File > Backup Manager > Restore from ... > Projects and op-
tions and then select the source directory.

2. The robot controller displays a message for each project and option pack-
age when the restoration has been successfully completed.

 When an option package has been restored, the package must first be 
installed before the project can be activated. This is indicated by a 
message on the robot controller.

 If no option package has been restored, the robot controller displays 
the following request for confirmation: 

Do you want to activate the project […]? In addition, a message is dis-
played as to whether the activation would overwrite a project, and if so, 
which.

If no relevant project will be overwritten: Confirm with Yes within 
30 minutes.

3. For the further activation steps, see:  (>>> 7.11.2 "Activating a project" 
Page 251)

7.12.4 Restoring RDC data manually

Menu items There are 2 menu items available for restoration. They differ with regard to the 
source directory that is accessed.

 Restore > 

The source directory is D:\ProjectBackup as long as no other directory has 
been configured.

 Or Restore from ... > 

A source directory can be selected here. It only applies to this restoration.

Precondition  “Expert” user group

Procedure 1. In the main menu, select File > Backup Manager > Restore > RDC data.

Observe the safety instructions relating to project activation!

Observe the safety instructions relating to project activation!
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Or: 

Select File > Backup Manager > Restore from ... > RDC data and then 
select the source directory.

2. A window opens. Activate the check boxes next to the data that are to be 
restored:

 PID file, MAM file and/or CAL file

If an entry is grayed out and the check box is not activated, this means that 
this file is not available in the backup.

3. Confirm the selection with Restore. 

Once the restoration has been completed, the following message is dis-
played: RDC data successfully restored from {0}.

7.12.5 Configuring Backup Manager

Precondition  “Expert” user group

 For changes to the Signal interface tab additionally:

T1 or T2 mode

Procedure 1. In the main menu, select File > Backup Manager > Backup configura-
tion.

The Backup configuration window is opened.

2. Carry out the desired changes in the tabs.

 Backup configuration contains the general settings. 

Automatic saving can also be configured here if required.

 I/O control can also be configured under Signal interface if required.

3. Close the window.

4. Respond to the request for confirmation asking whether the changes 
should be saved by pressing Yes.
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7.12.5.1 “Backup configuration” tab

Backup configu-

ration

Fig. 7-16: “Backup configuration” tab

Item Description

1 Maximum number of subfolders for older backups

A backup does not overwrite existing backup files. Instead, a sub-
folder is automatically created and the files are transferred there. 
When the maximum number of subfolders has been reached, the 
oldest subfolder will be deleted during the next backup and a new 
one will be created.

 0 … 50

Default: 5

2  Activated: The active project is backed up during backup.

During restoration, only the project which was active during the 
backup will be restored.

 Deactivated (default): The following projects are backed up 
during the backup: Active project, base project, initial project

These projects are restored during restoration.
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3  Activated (default): During backup, the robot controller stores 
the projects and RDC data in the directory [Target path for 
project backup]\[Robot name]\.

The robot controller accesses this directory during restoration.

Note: Select this setting if more than one robot controller uses 
the same target path.

 Deactivated: During backup, the robot controller stores the 
projects and RDC data in the directory [Target path for proj-
ect backup]\.

The robot controller accesses this directory during restoration.

Note: Option packages are always stored under [Target path for 
KOP backup]\OptionPackages\ irrespective of this setting.

4  Activated: The robot controller automatically carries out back-
ups. The following parameters determine the point in time:

Interval, Day, Time hh:mm

Note: After an automatic backup, the robot controller does not 
display a message of successful completion. 

If the robot controller was switched off at the configured time, it 
carries out a backup as soon as it is switched on again. It only 
carries out one backup, even if the time was missed more than 
once.

 Deactivated (default): No automatic backup.

5  Activated (default): The target directory for backups and the 
source directory for restorations is D:\ProjectBackup.

 Deactivated: The following parameters determine the target 
directory for backups and the source directory for restorations:

Target path for project backup, Target path for KOP back-
up

The following parameters can only be edited if the option Back up and 
restore locally (D:\ProjectBackup) is deactivated.

6 If during backup and/or restoration the robot controller must ac-
cess the network and an authentication is required, the data saved 
here are used. If no authentication is required, the data have no ef-
fect.

 User: User name

Default: user

 Password: Password. On entry, only the number of characters 
is displayed and not the characters themselves.

Default: kuka

7 For projects and RDC data: Target directory for backups and 
source directory for restorations

It is possible to navigate to the desired directory or to enter it direct-
ly. In the latter case, the path is automatically created if it does not 
already exist.

8 For KOP files: Target directory for backups and source directory for 
restorations

It is possible to navigate to the desired directory or to enter it direct-
ly. In the latter case, the path is automatically created if it does not 
already exist.

Item Description
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7.12.5.2 “Signal interface” tab

Signal interface

When a restoration is started via inputs, the robot controller – in con-
trast to manual restoration – does not activate the previously active 
project. This can be activated by the user at the desired point in time. 

Fig. 7-17: “Signal interface” tab

Item Description

1  Activated: Backups and restorations can be started via the in-
put signal configured under Start address.

 Deactivated (default): Start is not possible via input signal.

The following parameters can only be edited if the option Activate 
Remote Backup/Restore is activated.

2  Activated: The signals defined under Start address are as-
signed the following long text names:

BM input signal, BM output signal

If the signals already have long text names, these are not over-
written. 

 Deactivated (default): No long text names

If Activated was previously selected, Deactivated removes 
the long text names.

3 Displays when the input signal starts a backup or restoration. (Dis-
play during the length of a signal)

 (>>>  "Input signals" Page 262)

4  Left-hand lamp: Status of the input Start address.

 Right-hand lamp: Status of the input Start address + 1.

Status (cannot be edited): Green = 1; Gray = 0
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Input signals

A continuously active input signal does not cause the action to repeat.

When a backup/restoration is running, no further backup/restoration can be 
started. 

Output signals The signals 01 and 11 are present during the time configured in Pulse dura-
tion [ms], after which point the signal switches to 00.

5 Input signal consisting of the following inputs:

Start address and Start address + 1.

Default: 1 026

6 Displays the action being executed or the result.

 (>>>  "Output signals" Page 262)

7  Left-hand lamp: Status of the output Start address.

 Right-hand lamp: Status of the output Start address + 1.

Status (cannot be edited): Green = 1; Gray = 0

8 Output signal consisting of the following outputs:

Start address and Start address + 1.

Default: 4 095

9 Duration for which output signal 01 or 11 is present before the ro-
bot controller sets 00 again

Unit: ms

Default: 5,000 ms

Item Description

Signal → Created actions / display in the Status box

00 No action / Idle

01 Starts a backup / Backup

10 Starts a restoration / Restore

11 Undefined state

Action / Result → Created signal / display in the Status box

No action running 00 / Idle

Backup running 10 / Backup

Restoration running 10 / Restore

Backup successful 01 / BackupSuccess

Restoration successful 01 / RestoreSuccess

Backup unsuccessful 11 / BackupError

Restoration unsuc-
cessful

11 / RestoreError
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8 Program execution

8.1 Selecting the program run mode

Procedure 1. Touch the Program run mode status indicator. The Program run mode 
window is opened.

2. Select the desired program run mode.

 (>>> 8.2 "Program run modes" Page 263)

The window closes and the selected program run mode is applied.

8.2 Program run modes

The following additional program run modes are available for systems integra-
tors.

These program run modes can only be selected via the variable correction 
function. System variable for the program run mode: $PRO_MODE.

 

 

x

Designation
Status 

indicator
Description

Go

#GO

The program is executed through to 
the end without stopping.

Motion

#MSTEP

The program is executed with a stop at 
each point, including auxiliary points 
and spline segment points. The Start 
key must be pressed again for each 
point. The program is executed without 
advance processing.

Single Step

#ISTEP

The program is executed with a stop 
after each program line. The motion is 
also stopped after program lines that 
cannot be seen and after blank lines. 
The Start key must be pressed again 
for each line. The program is executed 
without advance processing.

Single Step is only available to the 
user group “Expert”.

Backward

#BSTEP

This program run mode is automati-
cally selected if the Start backwards 
key is pressed. It is not possible to 
select a different mode.

This mode works in the same way as 
Motion, but with the following excep-
tion: CIRC motions are executed back-
wards in the same way as they were 
last executed forwards, i.e. if the for-
ward motion was not stopped at the 
auxiliary point, nor will the backward 
motion be stopped there.

This exception does not apply in the 
case of SCIRC motions. Here, the 
backward motion is always stopped at 
the auxiliary point.
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8.3 Advance run

The advance run is the maximum number of motion blocks that the robot con-
troller calculates and plans in advance during program execution. The actual 
number is dependent on the capacity of the computer.

The advance run refers to the current position of the block pointer. It is set via 
the system variable $ADVANCE:

 Default value: 3

 Maximum value: 5

The advance run is required, for example, in order to be able to calculate ap-
proximate positioning motions. If $ADVANCE = 0 is set, approximate position-
ing is not possible.

Certain statements trigger an advance run stop. These include statements 
that influence the periphery, e.g. OUT statements.

8.4 Block pointer

Overview During program execution, the block pointer indicates various items of infor-
mation:

 Which motion the robot is currently executing or has completed

 Whether an auxiliary point or end point is currently being approached

 The direction in which the robot is executing the program

Designation
Status 

indicator
Description

Program Step

#PSTEP

The program is executed step by step 
without advance processing. Subpro-
grams are executed completely.

Continuous Step

#CSTEP

Approximate positioning points are 
executed with advance processing, i.e. 
they are approximated.

Exact positioning points are executed 
without advance processing and with a 
stop after the motion instruction.

Pointer Direction Description

Forwards The end point is being approached.

Backwards

Forwards The end point has been reached with exact 
positioning.

Backwards

Forwards The auxiliary point is being approached.

Backwards

Forwards The auxiliary point has been reached with 
exact positioning.

Backwards
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Examples for 

forward motion

Fig. 8-1: The robot is moving from P3 to P4

Fig. 8-2: The robot has reached P4 with exact positioning

Fig. 8-3: The robot is moving from P5 to auxiliary point P6

Fig. 8-4: The robot has reached auxiliary point P6 with exact positioning

Fig. 8-5: The robot is moving from auxiliary point P6 to P7

Fig. 8-6: The robot has reached P7 with exact positioning
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Examples for 

backward motion

Double upward/

downward arrow

If the program window shows a section in which the block pointer is not cur-
rently located, a double arrow indicates the direction in which it is to be found.

Fig. 8-7: The robot is moving from P8 to P7

Fig. 8-8: The robot has reached P7 with exact positioning

Fig. 8-9: The robot is moving from P7 to auxiliary point P6

Fig. 8-10: The robot has reached auxiliary point P6 with exact position-
ing

Fig. 8-11: The block pointer is located higher up in the program

Fig. 8-12: The block pointer is located lower down in the program
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8.5 Setting the program override (POV)

Description Program override is the velocity of the robot during program execution. The 
program override is specified as a percentage of the programmed velocity.

In T1 mode, the maximum velocity is 250 mm/s, irrespective of the value that 
is set.

Procedure 1. Touch the POV/HOV status indicator. The Overrides window is opened.

2. Set the desired program override. It can be set using either the plus/minus 
keys or by means of the slide controller.

 Plus/minus keys: The value can be set to 100%, 75%, 50%, 30%, 
10%, 3%, 1%

 Slide controller: The override can be adjusted in 1% steps.

3. Touch the POV/HOV status indicator again. (Or touch the area outside the 
window.) 

The window closes and the selected override value is applied.

Alternative 

procedure

Alternatively, the override can be set using the plus/minus key on the right of 
the smartPAD.

The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%.

8.6 Robot interpreter status indicator

8.7 Starting a program forwards (manual)

Precondition  A program is selected.

 Operating mode T1 or T2

Procedure 1. Select the program run mode.

2. Hold the enabling switch down and wait until the status bar indicates 
“Drives ready”:

The Jog options window can be opened via Options in the Over-
rides window.

Icon Color Description

Gray No program is selected.

Yellow The block pointer is situated on the first line 
of the selected program.

Green The program is selected and is being exe-
cuted.

Red The selected and started program has been 
stopped.

Black The block pointer is situated at the end of 
the selected program.
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3. Carry out a BCO run: Press Start key and hold it down until the message 
“Programmed path reached (BCO)” is displayed in the message window. The 
robot stops.

4. Press Start key and hold it down.

The program is executed with or without stops, depending on the program 
run mode.

To stop a program that has been started manually, release the Start key.

8.8 Starting a program forwards (automatic)

Precondition  A program is selected.

 Operating mode Automatic (not Automatic External)

Procedure 1. Select the program run mode Go.

2. Switch on the drives.

3. Carry out a BCO run: 

Press Start key and hold it down until the message “Programmed path 
reached (BCO)” is displayed in the message window. The robot stops.

4. Press the Start key. The program is executed.

To stop a program that has been started in Automatic mode, press the STOP 
key.

8.9 Carrying out a block selection

Description A program can be started at any point by means of a block selection.

Precondition  A program is selected.

 Operating mode T1 or T2

Procedure 1. Select the program run mode.

2. Select the motion block at which the program is to be started.

3. Press Block selection. The block pointer indicates the motion block.

4. Hold the enabling switch down and wait until the status bar indicates 
“Drives ready”:

Fig. 8-13

The BCO run is executed as a LIN or PTP motion from 
the actual position to the target position. The velocity is 

automatically reduced. The path of the motion cannot be predicted reliably. 
Observe the motion during the BCO run so that the robot can be stopped in 
time if a collision becomes imminent.

The BCO run is executed as a LIN or PTP motion from 
the actual position to the target position. The velocity is 

automatically reduced. The path of the motion cannot be predicted reliably. 
Observe the motion during the BCO run so that the robot can be stopped in 
time if a collision becomes imminent.
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5. Carry out a BCO run: Press Start key and hold it down until the message 
“Programmed path reached (BCO)” is displayed in the message window. The 
robot stops.

6. The program can now be started manually or automatically. It is not nec-
essary to carry out a BCO run again.

8.10 Resetting a program

Description In order to restart an interrupted program from the beginning, it must be reset. 
This returns the program to the initial state.

Precondition  Program is selected.

Procedure  Select the menu sequence Edit > Reset program.

Alternative 

procedure

 In the status bar, touch the Robot interpreter status indicator. A window 
opens.

Select Reset program.

8.11 Starting Automatic External mode

Precondition  Operating mode T1 or T2

 Inputs/outputs for Automatic External are configured.

 The program CELL.SRC is configured.

Procedure 1. Select the program CELL.SRC in the Navigator. (This program is located 
in the folder “R1”.)

2. Set program override to 100%. (This is the recommended setting. A differ-
ent value can be set if required.)

3. Carry out a BCO run: 

Hold down the enabling switch. Then press the Start key and hold it down 
until the message “Programmed path reached (BCO)” is displayed in the 
message window.

4. Select “Automatic External” mode.

5. Start the program from a higher-level controller (PLC).

To stop a program that has been started in Automatic mode, press the STOP 
key.

The BCO run is executed as a LIN or PTP motion from 
the actual position to the target position. The velocity is 

automatically reduced. The path of the motion cannot be predicted reliably. 
Observe the motion during the BCO run so that the robot can be stopped in 
time if a collision becomes imminent.

There is no BCO run in Automatic External mode. This 
means that the robot moves to the first programmed po-

sition after the start at the programmed (not reduced) velocity and does not 
stop there.

The BCO run is executed as a LIN or PTP motion from 
the actual position to the target position. The velocity is 

automatically reduced. The path of the motion cannot be predicted reliably. 
Observe the motion during the BCO run so that the robot can be stopped in 
time if a collision becomes imminent.
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8.12 Backward motion using the Start backwards key

The following applies to backward motion using the Start backwards key. It 
does not apply to other backward motion functionalities, e.g. backward motion 
as part of fault strategies in technology packages.

8.12.1 Executing motions backwards

Description Backward motion is often used if a sequence of motions is to be optimized and 
individual points are to be re-taught for this purpose. The user executes the 
path backwards until the point that is to be corrected has been reached. Once 
the point has been re-taught, backward motion is continued if required in order 
to correct further points.

The program run mode #BSTEP is automatically applied for backward motion. 

Approximate positioning and weaving are not possible during backward mo-
tion. If approximate positioning or weaving were carried out for points during 
forward execution, the backward path will thus differ from the forward path. It 
is thus possible that the robot may have to perform a BCO run after starting 
backward motion, even though it did not leave the path during forward motion.

Precondition  A program is selected.

 The motions that are to be executed backwards have been executed for-
wards.

 T1 or T2 mode

Procedure 1. Hold the enabling switch down and wait until the status bar indicates 
“Drives ready”:

2. Press and hold down the Start backwards key.

 If the robot is already on the backward path, it now moves backwards.

 If the robot is not on the backward path, it now moves to it. When 
“Programmed path reached (BCO)” is displayed in the message window, 
it has reached the path. The robot stops.

Press the Start backwards key again. The robot now moves back-
wards.

3. Press the Start backwards key again for each motion block.

8.12.2 Functional principle and characteristics of backward motion

Functional 

principle

During forward motion, the robot controller saves the executed motions in a 
ring buffer. During backward motion, the motions are executed on the basis of 
the saved information.

No backward motion possible once the buffer has been deleted:

The contents of the buffer are deleted in the following cases. Backward motion 
is not possible again until motions have been executed in the forward direction 
again.

The BCO run is executed as a LIN or PTP motion from 
the actual position to the target position. The velocity is 

automatically reduced. The path of the motion cannot be predicted reliably. 
Observe the motion during the BCO run so that the robot can be stopped in 
time if a collision becomes imminent.
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 Program is reset.

 Program is deselected.

 Lines are inserted into the program or deleted.

 KRL instruction RESUME

 Block selection to a motion other than the current one.

What is possible without restriction, however, is a block selection to any 
segment point within the current spline block. This counts as block selec-
tion to the current motion, as the robot controller plans and executes the 
spline block as one motion.

The robot controller deletes the buffer without generating a corresponding 
message.

Characteristics  Backward motion is only possible in modes T1 and T2.

 Only motions are executed during backward motion, and no control struc-
tures or control instructions.

 Outputs, flags and cyclical flags are not recorded during forward motion. 
For this reason, their previous states are not restored during backward 
motion.

 The velocity is the same as for forward motion. 

In T2, it is possible that monitoring functions may be triggered during back-
ward motion that are not triggered during forward motion. In this case, the 
program override must be reduced.

Backward motion can be deactivated. Further configuration options are also 
available.

 (>>> 6.16 "Configuring backward motion" Page 188)

DELETE_BACKWARD_BUFFER() can be used to prevent backward motion for 
specific motions.

 (>>> 11.14.1 "DELETE_BACKWARD_BUFFER()" Page 441)

Torque/force 

mode, 

VectorMove

The following applies to motions with torque or force mode or VectorMove:

 Backward motion is possible for conventional motions, but force/torque 
mode or VectorMove is automatically deactivated.

 Spline motions cannot be executed backwards.

8.12.2.1 Response in the case of subprograms

 Motions executed forwards in an interrupt program are not recorded. They 
cannot, therefore, be executed backwards.

 If a subprogram has been completely executed during forward motion, it 
cannot be executed with backward motion. 

 If the forward motion was stopped in a subprogram, the response depends 
on the position of the advance run pointer:

In the case of more complex applications with torque 
mode (e.g. press ejection) and/or VectorMove, backward 

motion is generally not recommended, as the underlying processes are not 
usually reversible.
In such cases, it is advisable to prevent backward motion using 
DELETE_BACKWARD_BUFFER(). Damage to property may otherwise re-
sult.
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8.12.2.2 Approximate positioning response

Description Approximate positioning is not possible during backward motion. If approxi-
mate positioning was carried out for points during forward execution, the back-
ward path will thus differ from the forward path. It is thus possible that the robot 
may have to perform a BCO run for the backward path after starting backward 
motion, even though it did not leave the path during forward motion.

Example 1 Backward start outside an approximate positioning range:

The Start backwards key is pressed while the robot is on the path, but not in 
an approximate positioning range. The robot now moves backwards on the 
path to the end point of the previous motion.

PBACK = position of the robot at the moment at which the Start backwards key 
is pressed

If the end point of the previous motion is approximated, it is nonetheless ad-
dressed with exact positioning.

Position of the advance run 
pointer

Response

Advance run pointer is in the sub-
program.

Backward motion is possible.

Advance run pointer has already 
left the subprogram.

Backward motion is not possible.

Prevention:

Trigger an advance run stop before 
the END of the subprogram, e.g. 
with WAIT SEC 0. However, it is 
then no longer possible to carry out 
approximate positioning at this 
point.

Or set $ADVANCE to "1". This does 
not always prevent the error mes-
sage, but it reduces the probability. 
Approximate positioning is still pos-
sible.

Fig. 8-14: Case 1: Backward start outside an approximate positioning 
range
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Example 2 Backward start in the approximate positioning range:

The Start backwards key is pressed while the robot is in an approximate posi-
tioning range. The robot now performs a BCO run to the start of the approxi-
mate positioning range and stops there. If the Start backwards key is now 
pressed again, the actual backward motion begins, i.e. the robot moves back-
wards along the path to the end point of the previous motion.

8.12.2.3 Response in the case of weave motions

Description Weaving is not possible during backward motion. If weaving was carried out 
during forward execution, the backward path will thus differ from the forward 
path. The robot must therefore perform a BCO run for the backward path after 
starting backward motion, even though it did not leave the path during forward 
motion.

Example Backward start on weave path:

The Start backwards key is pressed while the robot is weaving. The robot now 
performs a BCO run to the taught path and stops there. If the Start backwards 
key is now pressed again, the actual backward motion begins, i.e. the robot 
moves backwards along the path to the end point of the previous motion.

PBACK = position of the robot at the moment at which the Start backwards key 
is pressed

Fig. 8-15: Case 2: Backward start outside an approximate positioning 
range

Fig. 8-16: Backward start in the approximate positioning range
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8.12.2.4 Switching from backwards to forwards

Precondition It is only possible to resume forward motion following backward motion if the 
following preconditions are met:

 Block selection is possible to the program line on which the backward 
block pointer is currently located.

 If the first motion to be executed forwards again is a conventional motion, 
it must be completely programmed. 

It is thus not possible, for example, to switch from backward motion to for-
ward motion if the first motion is a PTP_REL motion.

With few exceptions, this restriction does not apply in the case of spline 
motions.

Response When the Start forward key is pressed for the first time following backward mo-
tion, the response is as follows:

 If BCO exists, the program run mode most recently used in the forward di-
rection is automatically restored and the robot moves forwards on the 
path.

 If BCO does not exist, a BCO run is carried out. The program run mode 
meanwhile remains set to #BSTEP. After the BCO run, the robot stops. 
The Start forwards key must now be pressed again. The program run 
mode most recently used in the forward direction is automatically restored 
and the robot now moves forwards on the path.

If the switch from backwards to forwards occurs in a control structure, the robot 
first moves forwards to the end of the control structure. It then stops with the 
message Control structure next block {Block number}. The block number 
specifies the first block after the control structure.

8.12.3 System variables with changed meaning

The meaning of certain system variables relating to backward motion has 
changed with effect from V8.3.6. In some cases, they no longer have any ef-
fect, but still exist for reasons of compatibility with older versions.

The system variables that start with “$VW_…” exist not only in the VSS, but 
also in the KSS.

Fig. 8-17: Backward start on weave path
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Designation Meaning in V8.3.6 and higher

$BWD_INFO Contains the current configuration for back-
ward motion as a bitmap. Numerous technol-
ogy packages read this variable.

The variable can only be read.

$BWDSTART This variable only still exists for reasons of 
compatibility. It can be set to TRUE or 
FALSE, but this has no effect.

$VW_BACKWARD Corresponds to the attribute ENABLE of the 
configuration element BACKWARD_STEP.

The variable can only be read.

$VW_CYCFLAG Always supplies the value 0.

This variable only still exists for reasons of 
compatibility and can only be read.

$VW_MOVEMENT Corresponds to the attribute MOVEMENTS 
of the configuration element 
BACKWARD_STEP.

The variable can only be read.

$VW_RETRACE_AMF Always supplies the value FALSE.

This variable only still exists for reasons of 
compatibility and can only be read.

$LOAD_BWINI Always supplies the value FALSE.

This variable only still exists for reasons of 
compatibility and can only be read.
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9 Basic principles of motion programmi...
9 Basic principles of motion programming

9.1 Overview of motion types

The following motion types can be programmed:

 Point-to-point motions (PTP)

 (>>> 9.2 "Motion type PTP" Page 277)

 Linear motions (LIN)

 (>>> 9.3 "Motion type LIN" Page 278)

 Circular motions (CIRC)

 (>>> 9.4 "Motion type CIRC" Page 278)

 Spline motions

Spline motions have a number of advantages over conventional PTP, LIN 
and CIRC motions.

 (>>> 9.7 "Spline motion type" Page 283)

The following motions are known as CP (“Continuous Path”) motions.

 LIN, CIRC, CP spline blocks, SLIN, SCIRC

9.2 Motion type PTP

The robot guides the TCP along the fastest path to the end point. The fastest 
path is generally not the shortest path and is thus not a straight line. As the 
motions of the robot axes are rotational, curved paths can be executed faster 
than straight paths.

The exact path of the motion cannot be predicted.

 

s

 

The start point of a motion is always the end point of the previous mo-
tion.

Fig. 9-1: PTP motion
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9.3 Motion type LIN

The robot guides the TCP at a defined velocity along a straight path to the end 
point.

9.4 Motion type CIRC

The robot guides the TCP at a defined velocity along a circular path to the end 
point. The circular path is defined by a start point, auxiliary point and end point.

Fig. 9-2: LIN motion

Fig. 9-3: CIRC motion
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9.5 Approximate positioning

Approximate positioning means that the motion does not stop exactly at the 
programmed point. Approximate positioning is an option that can be selected 
during motion programming.

Approximate positioning is not possible if the motion instruction is followed by 
an instruction that triggers an advance run stop.

Approximate positioning with a PTP motion

The TCP leaves the path that would lead directly to the end point and moves 
along a faster path. During programming of the motion, the maximum distance 
from the end point at which the TCP may deviate from its original path is de-
fined.

The path of an approximated PTP motion cannot be predicted. It is also not 
possible to predict on which side of the approximated point the path will run.

Approximate positioning with a LIN motion

The TCP leaves the path that would lead directly to the end point and moves 
along a shorter path. During programming of the motion, the maximum dis-
tance from the end point at which the TCP may deviate from its original path 
is defined.

Approximate positioning with a CIRC motion

The TCP leaves the path that would lead directly to the end point and moves 
along a shorter path. During programming of the motion, the maximum dis-
tance from the end point at which the TCP may deviate from its original path 
is defined.

The motion passes exactly through the auxiliary point.

Fig. 9-4: PTP motion, P2 is approximated

Fig. 9-5: LIN motion, P2 is approximated
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9.6 Orientation control LIN, CIRC

Description The orientation of the TCP can be different at the start point and end point of 
a motion. There are several different types of transition from the start orienta-
tion to the end orientation. A type must be selected when a CP motion is pro-
grammed.

The orientation control for LIN and CIRC motions is defined as follows:

 In the option window Motion parameters

 (>>> 10.2.8 "Option window “Motion parameters” (LIN, CIRC, PTP)" 
Page 311)

 Or via the system variable $ORI_TYPE

LIN motion

Fig. 9-6: CIRC motion, PEND is approximated

Orientation control Description

 Option window: 
Constant orientation

 $ORI_TYPE = #CON-
STANT

The orientation of the TCP remains con-
stant during the motion.

The programmed orientation is disregarded 
for the end point and that of the start point 
is retained.

 Option window: 
Standard

 $ORI_TYPE = #VAR

The orientation of the TCP changes contin-
uously during the motion.

Note: If, with Standard, the robot passes 
through a wrist axis singularity, use Wrist 
PTP instead.

 Option window: 
Wrist PTP

 $ORI_TYPE = #JOINT

The orientation of the TCP changes contin-
uously during the motion. This is done by 
linear transformation (axis-specific motion) 
of the wrist axis angles.

Note: Use Wrist PTP if, with Standard, the 
robot passes through a wrist axis singular-
ity. 
The orientation of the TCP changes contin-
uously during the motion, but not uniformly. 
Wrist PTP is thus not suitable if a specific 
orientation must be maintained exactly, e.g. 
in the case of laser welding.
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CIRC motion During CIRC motions, the robot controller only takes the programmed orienta-
tion of the end point into consideration. The programmed orientation of the 
auxiliary point is disregarded.

The same orientation control options are available for selection for CIRC mo-
tions as for LIN motions.

It is also possible to define for CIRC motions whether the orientation control is 
to be base-related or path-related. This is defined via the system variable 
$CIRC_TYPE.

 (>>> 9.6.1 "Combinations of $ORI_TYPE and $CIRC_TYPE" Page 281)

9.6.1 Combinations of $ORI_TYPE and $CIRC_TYPE

$ORI_TYPE = #CONSTANT, $CIRC_TYPE = #PATH:

Fig. 9-7: Constant orientation

Fig. 9-8: Standard or Wrist PTP

Orientation control Description

$CIRC_TYPE = #BASE Base-related orientation control during the 
circular motion

$CIRC_TYPE = #PATH Path-related orientation control during the 
circular motion

$CIRC_TYPE is meaningless if $ORI_TYPE = #JOINT.
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$ORI_TYPE = #VAR, $CIRC_TYPE = #PATH:

$ORI_TYPE = #CONSTANT, $CIRC_TYPE = #BASE:

Fig. 9-9: Constant orientation, path-related

Fig. 9-10: Variable orientation, path-related

Fig. 9-11: Constant orientation, base-related
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$ORI_TYPE = #VAR, $CIRC_TYPE = #BASE:

9.7 Spline motion type

Spline is a motion type that is particularly suitable for complex, curved paths. 
Such paths can also be generated using approximated LIN and CIRC motions, 
but splines have advantages, however.

The most versatile spline motion is the spline block. A spline block is used to 
group together several motions as an overall motion. The spline block is 
planned and executed by the robot controller as a single motion block. 

The motions that may be included in a spline block are called spline segments. 
They are taught separately. 

 A CP spline block can contain SPL, SLIN and SCIRC segments.

 A PTP spline block can contain SPTP segments.

In addition to spline blocks, individual spline motions can also be programmed: 
SLIN, SCIRC and SPTP.

Fig. 9-12: Variable orientation, base-related
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Advantages of 

spline blocks

 The path is defined by means of points that are located on the path. The 
desired path can be generated easily.

 The programmed velocity is maintained better than with conventional mo-
tion types. There are few cases in which the velocity is reduced.

 (>>> 9.7.1 "Velocity profile for spline motions" Page 285)

Furthermore, special constant velocity ranges can be defined in CP spline 
blocks.

 The path always remains the same, irrespective of the override setting, ve-
locity or acceleration.

 Circles and tight radii are executed with great precision.

Disadvantages of 

LIN/CIRC

 The path is defined by means of approximated points that are not located 
on the path. The approximate positioning ranges are difficult to predict. 
Generating the desired path is complicated and time-consuming.

Fig. 9-13: Curved path with spline block

Fig. 9-14: Curved path with approximated LIN motions
Issued: 14.01.2015 Version: KSS 8.3 SI V4



9 Basic principles of motion programmi...
 In many cases, the velocity may be reduced in a manner that is difficult to 
predict, e.g. in the approximate positioning ranges and near points that are 
situated close together.

 The path changes if approximate positioning is not possible, e.g. for time 
reasons.

 The path changes in accordance with the override setting, velocity or ac-
celeration.

9.7.1 Velocity profile for spline motions

The path always remains the same, irrespective of the override setting, veloc-
ity or acceleration.

The robot controller already takes the physical limits of the robot into consid-
eration during planning. The robot moves as fast as possible within the con-
straints of the programmed velocity, i.e. as fast as its physical limits will allow. 
This is an advantage over conventional LIN and CIRC motions for which the 
physical limits are not taken into consideration during planning. It is only during 
motion execution that these limits have any effect and can cause stops to be 
triggered.

Reduction of the velocity

Prime examples of cases in which the velocity has to fall below the pro-
grammed velocity include:

 Tight corners

 Major reorientation

 Large motions of the external axes

 Motion in the vicinity of singularities

Reduction of the velocity due to major reorientation can be avoided with spline 
segments by selecting the orientation control option Ignore orientation.

Reduction of the velocity due to major external axis motions can be avoided 
for spline segments with $EX_AX_IGNORE.

Reduction of the velocity to 0

This is the case for:

 Successive points with the same coordinates.

 Successive SLIN and/or SCIRC segments. Cause: inconstant velocity di-
rection. 

In the case of SLIN-SCIRC transitions, the velocity is also reduced to 0 if 
the straight line is a tangent of the circle, as the circle, unlike the straight 
line, is curved.

Fig. 9-15: Exact positioning at P2
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Exceptions:

 In the case of successive SLIN segments that result in a straight line and 
in which the orientations change uniformly, the velocity is not reduced.

 In the case of a SCIRC-SCIRC transition, the velocity is not reduced if both 
circles have the same center point and the same radius and if the orienta-
tions change uniformly. (This is difficult to teach, so calculate and program 
points.)

9.7.2 Block selection with spline motions

Spline block Block selection can be made to the segments of a spline block. 

 CP spline block: 

The BCO run is executed as a conventional LIN motion. This is indicated 
by means of a message that must be acknowledged.

 PTP spline block: 

The BCO run is executed as a conventional PTP motion. This is not indi-
cated by a message.

Following a block selection, the path is generally the same as if the spline were 
to be executed during normal program execution. 

Exceptions are possible if the spline has never yet been executed prior to the 
block selection and the block selection is made here to the start of the spline 
block: 

The start point of the spline motion is the last point before the spline block, i.e. 
the start point is outside the block. The robot controller saves the start point 
during normal execution of a spline. In this way, it is already known in the case 
of a block selection being carried out subsequently. If the spline block has nev-
er yet been executed, however, the start point is unknown. 

If the Start key is pressed after the BCO run, the modified path is indicated by 
means of a message that must be acknowledged.

Example: modified path in the case of block selection to P1

Fig. 9-16: Exact positioning at P2

Fig. 9-17: P2 is executed without exact positioning.

Circles with the same center point and the same radius are some-
times programmed to obtain circles ≥ 360°. A simpler method is to 
program a circular angle.
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SCIRC In the case of block selection to a SCIRC segment for which a circular angle 
has been programmed, the motion is executed to the end point, taking into 
consideration the circular angle, provided that the robot controller knows the 
start point. 

If the robot controller does not know the start point, the motion is executed to 
the programmed end point. In this case, a message is generated, indicating 
that the circular angle is not being taken into consideration.

In the case of a block selection to an individual SCIRC motion, the circular an-
gle is never taken into consideration.

9.7.3 Modifications to spline blocks

Description  Modification of the position of the point:

If a point within a spline block is offset, the path is modified, at most, in the 
2 segments before this point and the 2 segments after it.

Small point offsets generally result in small modifications to the path. If, 
however, very long segments are followed by very short segments or vice 
versa, small modifications can have a very great effect.

 Modification of the segment type:

If an SPL segment is changed into an SLIN segment or vice versa, the 
path changes in the previous segment and the next segment.

Fig. 9-18: Example: modified path in the case of block selection to P1

1  PTP P0

2  SPLINE

3   SPL P1

4   SPL P2

5   SPL P3

6   SPL P4

7   SCIRC P5, P6

8   SPL P7

9   SLIN P8

10 ENDSPLINE

Line Description

2 Header/start of the CP spline block

3 … 9 Spline segments

10 End of the CP spline block
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Example 1 Original path:

A point is offset relative to the original path:

P3 is offset. This causes the path to change in segments P1 - P2, P2 - P3 and 
P3 - P4. Segment P4 - P5 is not changed in this case, as it belongs to an 
SCIRC and a circular path is thus defined.

The type of a segment is changed relative to the original path:

In the original path, the segment type of P2 - P3 is changed from SPL to SLIN. 
The path changes in segments P1 - P2, P2 - P3 and P3 - P4.

PTP P0

SPLINE

 SPL P1

 SPL P2

 SPL P3

 SPL P4

 SCIRC P5, P6

 SPL P7

 SLIN P8

ENDSPLINE

Fig. 9-19: Original path

Fig. 9-20: Point has been offset

PTP P0

SPLINE

 SPL P1

 SPL P2
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Example 2 Original path:

A point is offset relative to the original path:

P3 is offset. This causes the path to change in all the segments illustrated. 
Since P2 - P3 and P3 - P4 are very short segments and P1 - P2 and P4 - P5 
are long segments, the slight offset causes the path to change greatly.

 SLIN P3

 SPL P4

 SCIRC P5, P6

 SPL P7

 SLIN P8

ENDSPLINE

Fig. 9-21: Segment type has been changed

...

SPLINE

 SPL {X 100, Y 0, ...}

 SPL {X 102, Y 0}

 SPL {X 104, Y 0}

 SPL {X 204, Y 0}

ENDSPLINE

Fig. 9-22: Original path

...

SPLINE

 SPL {X 100, Y 0, ...}

 SPL {X 102, Y 1}

 SPL {X 104, Y 0}

 SPL {X 204, Y 0}

ENDSPLINE
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Remedy:

 Distribute the points more evenly

 Program straight lines (except very short ones) as SLIN segments

9.7.4 Approximation of spline motions

All spline blocks and all individual spline motions can be approximated with 
one another. It makes no difference whether they are CP or PTP spline blocks, 
nor is the motion type of the individual motion relevant.

The motion type of the approximate positioning arc always corresponds to the 
second motion. In the case of SPTP-SLIN approximation, for example, the ap-
proximate positioning arc is of type CP.

Spline motions cannot be approximated with conventional motions (LIN, 
CIRC, PTP).

Approximation not possible due to time or advance run stops:

If approximation is not possible for reasons of time or due to an advance run 
stop, the robot waits at the start of the approximate positioning arc.

 In the case of time reasons: the robot moves again as soon as it has been 
possible to plan the next block.

 In the case of an advance run stop: the end of the current block is reached 
at the start of the approximate positioning arc. This means that the ad-
vance run stop is canceled and the robot controller can plan the next block. 
Robot motion is resumed.

In both cases, the robot now moves along the approximate positioning arc. Ap-
proximate positioning is thus technically possible; it is merely delayed.

This response differs from that for LIN, CIRC or PTP motions. If approximate 
positioning is not possible for the reasons specified, the motion is executed to 
the end point with exact positioning.

No approximate positioning in MSTEP and ISTEP:

In the program run modes MSTEP and ISTEP, the robot stops exactly at the 
end point, even in the case of approximated motions.

In the case of approximate positioning from one spline block to another spline 
block, the result of this exact positioning is that the path is different in the last 
segment of the first block and in the first segment of the second block from the 
path in program run mode GO.

In all other segments of both spline blocks, the path is identical in MSTEP, 
ISTEP and GO.

9.7.5 Replacing an approximated CP motion with a spline block

Description In order to replace approximated conventional CP motions with spline blocks, 
the program must be modified as follows:

 Replace LIN - LIN with SLIN - SPL - SLIN.

Fig. 9-23: Point has been offset
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 Replace LIN - CIRC with SLIN - SPL - SCIRC.

Recommendation: Allow the SPL to project a certain way into the original 
circle. The SCIRC thus starts later than the original CIRC.

In approximated motions, the corner point is programmed. In the spline block, 
the points at the start and end of the approximation are programmed instead.

The following approximated motion is to be reproduced:

Spline motion:

P1A = start of approximation, P1B = end of approximation

Ways of determining P1A and P1B:

 Execute the approximated path and save the positions at the desired point 
by means of Trigger.

 Calculate the points in the program with KRL.

 The start of the approximation can be determined from the approximate 
positioning criterion. Example: If C_DIS is specified as the approximate 
positioning criterion, the distance from the start of the approximation to the 
corner point corresponds to the value of $APO.CDIS.

The end of the approximation is dependent on the programmed velocity.

The SPL path does not correspond exactly to the approximate positioning arc, 
even if P1A and P1B are exactly at the start/end of the approximation. In order 
to recreate the exact approximate positioning arc, additional points must be in-
serted into the spline. Generally, one point is sufficient.

Example The following approximated motion is to be reproduced:

LIN P1 C_DIS

LIN P2

SPLINE

 SLIN P1A

 SPL P1B

 SLIN P2

ENDSPLINE

Fig. 9-24: Approximated motion - spline motion

$APO.CDIS=20

$VEL.CP=0.5
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Spline motion:

The start of the approximate positioning arc has been calculated from the ap-
proximate positioning criterion.

The SPL path does not yet correspond exactly to the approximate positioning 
arc. For this reason, an additional SPL segment is inserted into the spline.

LIN {Z 10} C_DIS

LIN {Y 60}

SPLINE WITH $VEL.CP=0.5

 SLIN {Z 30}

 SPL {Y 30, Z 10}

 SLIN {Y 60}

ENDSPLINE

Fig. 9-25: Example: Approximated motion - spline motion 1

SPLINE WITH $VEL.CP=0.5

 SLIN {Z 30}

 SPL {Y 15, Z 15}

 SPL {Y 30, Z 10}

 SLIN {Y 60}

ENDSPLINE
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With the additional point, the path now corresponds to the approximate posi-
tioning arc.

9.7.5.1 SLIN-SPL-SLIN transition

In the case of a SLIN-SPL-SLIN segment sequence, it is usually desirable for 
the SPL segment to be located within the smaller angle between the two 
straight lines. Depending on the start and end point of the SPL segment, the 
path may also move outside this area.

The path remains inside if the following conditions are met:

 The extensions of the two SLIN segments intersect.

Fig. 9-26: Example: Approximated motion - spline motion 2

Fig. 9-27: SLIN-SPL-SLIN
293 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



294 / 491

KUKA System Software 8.3
 2/3 ≤ a/b ≤ 3/2

a = distance from start point of the SPL segment to intersection of the SLIN 
segments

b = distance from intersection of the SLIN segments to end point of the 
SPL segment

9.8 Orientation control for CP spline motions

Description The orientation of the TCP can be different at the start point and end point of 
a motion. When a CP spline motion is programmed, it is necessary to select 
how to deal with the different orientations.

The orientation control type is defined as follows:

 If programming with KRL syntax: by means of the system variable 
$ORI_TYPE

 If programming with inline forms: in the option window Motion parameters

Orientation control Description

 Option window: 
Constant orientation

 $ORI_TYPE = #CON-
STANT

The orientation of the TCP remains constant during the motion.

The orientation of the start point is retained. The programmed ori-
entation of the end point is not taken into consideration.

 Option window: 
Default

 $ORI_TYPE = #VAR

The orientation of the TCP changes continuously during the 
motion. At the end point, the TCP has the programmed orienta-
tion.

 Option window: 
Wrist PTP

 $ORI_TYPE = #JOINT

The orientation of the TCP changes continuously during the 
motion. This is done by linear transformation (axis-specific 
motion) of the wrist axis angles.

Note: Use Wrist PTP if, with Default, the robot passes through a 
wrist axis singularity. 
The orientation of the TCP changes continuously during the 
motion, but not uniformly. Wrist PTP is thus not suitable if a spe-
cific orientation must be maintained exactly, e.g. in the case of 
laser welding.

 Option window: 
Ignore orientation

 $ORI_TYPE = #IG-
NORE

This option is only available for CP spline segments (not for the 
spline block or for individual spline motions).

This option is used if no specific orientation is required at a spe-
cific point.

 (>>>  "#IGNORE" Page 295)

Fig. 9-28: Constant orientation
Issued: 14.01.2015 Version: KSS 8.3 SI V4



9 Basic principles of motion programmi...
#IGNORE $ORI_TYPE = #IGNORE is used if no specific orientation is required at a point. 
If this option is selected, the robot controller ignores the taught or programmed 
orientation of the point. Instead, it calculates the optimal orientation for this 
point on the basis of the orientations of the surrounding points. This reduces 
the cycle time.

Example:

The taught or programmed orientation of XP3 and XP4 is ignored.

Characteristics of $ORI_TYPE = #IGNORE:

 In the program run modes MSTEP and ISTEP, the robot stops with the ori-
entations calculated by the robot controller.

 In the case of a block selection to a point with #IGNORE, the robot adopts 
the orientation calculated by the robot controller.

$ORI_TYPE = #IGNORE is not allowed for the following segments:

 The last segment in a spline block

 SCIRC segments with $CIRC_TYPE=#PATH

 Segments followed by a SCIRC segment with $CIRC_TYPE=#PATH

 Segments followed by a segment with $ORI_TYPE=#CONSTANT

SCIRC It is possible to define for SCIRC motions whether the orientation control is to 
be space-related or path-related.

 (>>> 9.8.1 "SCIRC: reference system for the orientation control" Page 296)

It is possible to define for SCIRC motions whether, and to what extent, the ori-
entation of the auxiliary point is to be taken into consideration. The orientation 
behavior at the end point can also be defined.

 (>>> 9.8.2 "SCIRC: orientation behavior" Page 296)

$SPL_ORI_JOINT

_AUTO

$SPL_ORI_JOINT_AUTO is used to optimize the motion characteristics in the 
vicinity of wrist axis singularities.

Functional principle of $SPL_ORI_JOINT_AUTO = #ON: 

Fig. 9-29: Default orientation control

SPLINE

  SPL XP1 

  SPL XP2 

  SPL XP3 WITH $ORI_TYPE=#IGNORE

  SPL XP4 WITH $ORI_TYPE=#IGNORE

  SPL XP5

  SPL XP6

ENDSPLINE
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 For CP spline motions with $ORI_TYPE = #VAR, the robot controller au-
tomatically decides for each motion (i.e. for each segment) whether to ex-
ecute it as #VAR or #JOINT.

$SPL_ORI_JOINT_AUTO = #ON is an alternative to using $ORI_TYPE = 
#JOINT. While $ORI_TYPE = #JOINT can be used for specific individual mo-
tions, $SPL_ORI_JOINT_AUTO = #ON enables automatic optimization over 
program sequences of any size with minimal effort for modification.

$SPL_ORI_JOINT_AUTO can only be modified using a robot program. 
$SPL_ORI_JOINT_AUTO cannot be used in spline segments.

Default: $SPL_ORI_JOINT_AUTO = #OFF

9.8.1 SCIRC: reference system for the orientation control

It is possible to define for SCIRC motions whether the orientation control is to 
be space-related or path-related. This can be defined as follows:

 If programming with inline forms: in the option window Motion parameters

 If programming with KRL syntax: by means of the system variable 
$CIRC_TYPE

$CIRC_TYPE = #PATH is not allowed for the following motions:

 SCIRC segments for which $ORI_TYPE = #IGNORE

 SCIRC motions preceded by a spline segment for which $ORI_TYPE = 
#IGNORE

 (>>> 9.6.1 "Combinations of $ORI_TYPE and $CIRC_TYPE" Page 281)

9.8.2 SCIRC: orientation behavior

Description During SCIRC motions, the robot controller can take the programmed orienta-
tion of the auxiliary point into consideration. The operator can define whether 
and to what extent it is actually taken into consideration: 

 If programming with KRL syntax: by means of the system variable 
$CIRC_MODE

 If programming with inline forms: in the option window Motion parame-
ters, tab Circle configuration

In the case of SCIRC statements with circular angles, the same procedure can 
also be used to define whether the end point is to have the programmed ori-
entation or whether the orientation is to be scaled according to the circular an-
gle.

$CIRC_MODE can only be written to by means of a SCIRC statement. 
$CIRC_MODE cannot be read.

Syntax For auxiliary points:

$CIRC_MODE.AUX_PT.ORI = BehaviorAUX

For end points:

Orientation control Description

 Option window: 
base-related

 $CIRC_TYPE = #BASE

Base-related orientation control during the 
circular motion

 Option window: 
path-oriented

 $CIRC_TYPE = #PATH

Path-related orientation control during the 
circular motion
Issued: 14.01.2015 Version: KSS 8.3 SI V4



9 Basic principles of motion programmi...
$CIRC_MODE.TARGET_PT.ORI = BehaviorEND

Explanation of 

the syntax

Limitations  If $ORI_TYPE = #IGNORE for a SCIRC segment, $CIRC_MODE is not 
evaluated.

 If a SCIRC segment is preceded by a SCIRC or SLIN segment with 
$ORI_TYPE = #IGNORE, #CONSIDER cannot be used in this SCIRC 
segment.

For SCIRC with circular angle:

 #INTERPOLATE must not be set for the auxiliary point.

 If $ORI_TYPE = #IGNORE, #EXTRAPOLATE must not be set for the end 
point.

 If it is preceded by a spline segment with $ORI_TYPE = #IGNORE, #EX-
TRAPOLATE must not be set for the end point.

9.8.2.1 SCIRC: Orientation behavior – example: auxiliary point

Description The following orientations have been programmed for the TCP:

 Start point: 0°

 Auxiliary point: 98°

Element Description

BehaviorAUX Data type: ENUM

 #INTERPOLATE: At the auxiliary point, the TCP adopts 
the programmed orientation.

 #IGNORE: The robot controller ignores the pro-
grammed orientation of the auxiliary point. The transi-
tion from the start orientation of the TCP to the end 
orientation is carried out over the shortest possible dis-
tance. 

 #CONSIDER (default): 

There are essentially 2 paths for the transition from the 
start orientation to the end orientation by means of a ro-
tation: a shorter one and a longer one. With #CONSID-
ER, the robot controller selects the path that comes 
closest to the programmed orientation of the auxiliary 
point. It is possible for the TCP to adopt the pro-
grammed orientation of the auxiliary point at some point 
along the path. This is not necessarily the case, howev-
er.

BehaviorEND Data type: ENUM

 #INTERPOLATE: The programmed orientation of the 
end point is accepted at the actual end point.

(Only possibility for SCIRC without specification of cir-
cular angle. If #EXTRAPOLATE is set, #INTERPO-
LATE is nonetheless executed.)

 #EXTRAPOLATE: The orientation is adapted to the cir-
cular angle:

If the circular angle makes the motion longer, the pro-
grammed orientation is accepted at the programmed 
end point. The orientation is continued accordingly to 
the actual end point.

If the circular angle makes the motion shorter, the pro-
grammed orientation is not reached.

(Default for SCIRC with specification of circular angle.)
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 End point: 197°

The re-orientation is thus 197°. If the auxiliary point is ignored, the end orien-
tation can also be achieved by means of the shorter re-orientation of 360° -
 197° = 163°.

 The dotted orange arrows show the programmed orientation.

 The gray arrows indicate schematically what the actual orientation would 
be where this differs from the programmed orientation.

#INTERPOLATE At the auxiliary point, the TCP adopts the programmed orientation of 98°. The 
re-orientation is 197°.

#IGNORE The short re-orientation through 163° is used. The programmed orientation of 
the auxiliary point is disregarded.

#CONSIDER

The programmed orientation of the auxiliary point is 98° and is thus on the lon-
ger path. The robot controller thus selects the longer path for the re-orienta-
tion. 

Fig. 9-30: #INTERPOLATE

SP Start point

AuxP Auxiliary point

TP End point

Fig. 9-31: #IGNORE

#CONSIDER is suitable if the user wants to specify the re-orientation 
direction of the TCP without the need for a specific orientation at the 
auxiliary point. The user can specify the direction using the auxiliary 

point.
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Additional example for #CONSIDER:

If the auxiliary point were to be programmed with 262°, it would be on the 
shorter path. The robot controller would therefore select the shorter path for 
the re-orientation. The gray arrows indicate that it does not necessarily adopt 
the programmed orientation of the auxiliary point. 

9.8.2.2 SCIRC: Orientation behavior – example: end point

Description  The dotted orange arrows show the programmed orientation.

 The gray arrows show the actual orientation where this differs from the 
programmed orientation.

#INTERPOLATE At TP, which is situated before TP_CA, the programmed orientation has not 
yet been reached. The programmed orientation is accepted at TP_CA.

Fig. 9-32: #CONSIDER

Fig. 9-33: #CONSIDER, additional example
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#EXTRAPOLATE The programmed orientation is accepted at TP. For TP_CA, this orientation is 
continued in accordance with the circular angle.

9.9 Circular angle

A circular angle can be programmed for most circular motions. 

The circular angle specifies the overall angle of the motion. This makes it pos-
sible to extend the motion beyond the programmed end point or to shorten it. 
The actual end point thus no longer corresponds to the programmed end point.

Unit: degrees. Circular angles greater than +360° and less than -360° can be 
programmed. 

Fig. 9-34: #INTERPOLATE

SP Start point

AuxP Auxiliary point

TP Programmed end point

TP_CA Actual end point. Determined by the circular angle.

Fig. 9-35: #EXTRAPOLATE

Information about whether this is possible for a specific circular mo-
tion can be found in the description of the motion in the programming 
section of this documentation.
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The preceding sign determines the direction in which the circular path is exe-
cuted:

 Positive: direction Start point › Auxiliary point › End point

 Negative: direction Start point › End point › Auxiliary point

9.10 Status and Turn

Overview The position (X, Y, Z) and orientation (A, B, C) values of the TCP are not suf-
ficient to define the robot position unambiguously, as different axis positions 
are possible for the same TCP. Status and Turn serve to define an unambig-
uous position that can be achieved with different axis positions.

Status (S) and Turn (T) are integral parts of the data types POS and E6POS:

KRL program The robot controller only takes the programmed Status and Turn values into 
consideration for PTP motions. They are ignored for CP motions. 

The first motion instruction in a KRL program must therefore be one of the fol-
lowing instructions so that an unambiguous starting position is defined for the 
robot:

 A complete PTP instruction of type POS or E6POS

 Or a complete PTP instruction of type AXIS or E6AXIS

“Complete” means that all components of the end point must be specified. The 
default HOME position is always a complete PTP instruction. 

Status and Turn can be omitted in the subsequent instructions:

 The robot controller retains the previous Status value.

 The Turn value is determined by the path in CP motions. In the case of 
PTP motions, the robot controller selects the Turn value that results in the 
shortest possible path.

9.10.1 Status

The Status specification prevents ambiguous axis positions.

Fig. 9-36: Example: Same TCP position, different axis position

STRUC POS REAL X, Y, Z, A, B, C, INT S, T

STRUC E6POS REAL X, Y, Z, A, B, C, E1, E2, E3, E4, E5, E6, INT S, T
301 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



302 / 491

KUKA System Software 8.3
Bit 0 Bit 0 specifies the position of the intersection of the wrist axes (A4, A5, A6).

The A1 coordinate system is identical to the $ROBROOT coordinate system if 
axis 1 is at 0°. For values not equal to 0°, it moves with axis 1.

Bit 1 Bit 1 specifies the position of axis 3. The angle at which the value of bit 1 
changes depends on the robot type.

For robots whose axes 3 and 4 intersect, the following applies: 

Position Value

Overhead area

If the x-value of the intersection of the wrist axes, rela-
tive to the A1 coordinate system, is negative, the robot 
is in the overhead area.

Bit 0 = 1

Basic area

If the x-value of the intersection of the wrist axes, rela-
tive to the A1 coordinate system, is positive, the robot 
is in the basic area.

Bit 0 = 0

Fig. 9-37: Example: The intersection of the wrist axes (red dot) is in the 
basic area.

Position Value

A3 ≥ 0° Bit 1 = 1

A3 < 0° Bit 1 = 0
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For robots with an offset between axis 3 and axis 4, the angle at which the val-
ue of bit 1 changes depends on the size of this offset.

Bit 2 Bit 2 specifies the position of axis 5.

The sign preceding the angle of A5 is irrelevant! What counts is the direction 
in which A5 is tilted, i.e. upwards or downwards. The direction is specified with 
reference to the zero position of A4.

Bit 3 Bit 3 is not used and is always 0.

Bit 4 Bit 4 specifies whether or not the point was taught using an absolutely accu-
rate robot.

Fig. 9-38: Offset between A3 and A4 – example: KR 30

Position (reference: A4 = 0°) Value

A5 is tilted upwards. Bit 2 = 1

A5 = 0° Bit 2 = 0

A5 is tilted downwards.

Fig. 9-39: Bit 2
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Depending on the value of the bit, the point can be executed by both absolute-
ly accurate robots and non-absolutely-accurate robots. Bit 4 is for information 
purposes only and has no influence on how the robot calculates the point. This 
means, therefore, that when a robot is programmed offline, bit 4 can be ig-
nored.

9.10.2 Turn

Description The Turn specification makes it possible to move axes through angles greater 
than +180° or less than -180° without the need for special motion strategies 
(e.g. auxiliary points). With rotational axes, the individual bits determine the 
sign before the axis value in the following way:

Bit = 0: angle ≥ 0°

Bit = 1: angle < 0°

Example

T 19 corresponds to T 'B010011'. This means:

9.11 Singularities

KUKA robots with 6 degrees of freedom have 3 different singularity positions.

 Overhead singularity

 Extended position singularity

 Wrist axis singularity

A singularity position is characterized by the fact that unambiguous reverse 
transformation (conversion of Cartesian coordinates to axis-specific values) is 
not possible, even though Status and Turn are specified. In this case, or if very 
slight Cartesian changes cause very large changes to the axis angles, one 
speaks of singularity positions.

Overhead In the overhead singularity, the wrist root point (intersection of axes A4, A5 and 
A6) is located vertically above axis 1.

The position of axis A1 cannot be determined unambiguously by means of re-
verse transformation and can thus take any value.

Description Value

The point was not taught with an absolutely accurate 
robot.

Bit 4 = 0

The point was taught with an absolutely accurate robot. Bit 4 = 1

Value Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

0 A6 ≥ 0° A5 ≥ 0° A4 ≥ 0° A3 ≥ 0° A2 ≥ 0° A1 ≥ 0°

1 A6 < 0° A5 < 0° A4 < 0° A3 < 0° A2 < 0° A1 < 0°

DECL POS XP1 = {X 900, Y 0, Z 800, A 0, B 0, C 0, S 6, T 19}

Axis Angle

A1 negative

A2 negative

A3 positive

A4 positive

A5 negative

A6 positive
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If the end point of a PTP motion is situated in this overhead singularity position, 
the robot controller may react as follows by means of the system variable 
$SINGUL_POS[1]:

 0: The angle for axis A1 is defined as 0 degrees (default setting).

 1: The angle for axis A1 remains the same from the start point to the end 
point.

Extended 

position

In the extended position singularity, the wrist root point (intersection of axes 
A4, A5 and A6) is located in the extension of axes A2 and A3 of the robot.

The robot is at the limit of its work envelope.

Although reverse transformation does provide unambiguous axis angles, low 
Cartesian velocities result in high axis velocities for axes A2 and A3.

If the end point of a PTP motion is situated in this extended position singularity, 
the robot controller may react as follows by means of the system variable 
$SINGUL_POS[2]:

 0: The angle for axis A2 is defined as 0 degrees (default setting).

 1: The angle for axis A2 remains the same from the start point to the end 
point.

Wrist axes In the wrist axis singularity position, the axes A4 and A6 are parallel to one an-
other and axis A5 is within the range ±0.01812°.

The position of the two axes cannot be determined unambiguously by reverse 
transformation. There is an infinite number of possible axis positions for axes 
A4 and A6 with identical axis angle sums.

If the end point of a PTP motion is situated in this wrist axis singularity, the ro-
bot controller may react as follows by means of the system variable 
$SINGUL_POS[3]:

 0: The angle for axis A4 is defined as 0 degrees (default setting).

 1: The angle for axis A4 remains the same from the start point to the end 
point.
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10 Programming for user group “User” (inline forms)

10.1 Names in inline forms

Names for data sets can be entered in inline forms. These include, for exam-
ple, point names, names for motion data sets, etc.

The following restrictions apply to names:

 Maximum length 23 characters

 No special characters are permissible, with the exception of $.

 The first character must not be a number.

The restrictions do not apply to output names.

Other restrictions may apply in the case of inline forms in technology packag-
es.

10.2 Programming PTP, LIN and CIRC motions

10.2.1 Programming a PTP motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the position that is to be taught as the end point.

2. Position the cursor in the line after which the motion instruction is to be in-
serted.

3. Select the menu sequence Commands > Motion > PTP.

4. Set the parameters in the inline form.

 (>>> 10.2.2 "Inline form “PTP”" Page 308)

5. Save instruction with Cmd Ok.

 

 

In the case of programs with the following axis motions 
or positions, the film of lubricant on the gear units of the 

axes may break down:

 Motions <3°

 Oscillating motions

 Areas of gear units permanently facing upwards

It must be ensured that the gear units have a sufficient supply of oil. For this, 
in the case of oscillating motions or short motions (<3°), programming must 
be carried out in such a way that the affected axes regularly move more than 
40° (e.g. once per cycle).
In the case of areas of gear units permanently facing upwards, sufficient oil 
supply must be achieved by programming re-orientations of the in-line wrist. 
In this way, the oil can reach all areas of the gear units by means of gravity. 
Required frequency of re-orientations:

 With low loads (gear unit temperature <+35 °C): daily

 With medium loads (gear unit temperature +35 °C to 55 °C): hourly

 With heavy loads (gear unit temperature >+55 °C): every 10 minutes

Failure to observe this precaution may result in damage to the gear units.

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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10.2.2 Inline form “PTP”

10.2.3 Programming a LIN motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the position that is to be taught as the end point.

2. Position the cursor in the line after which the motion instruction is to be in-
serted.

3. Select the menu sequence Commands > Motion > LIN.

4. Set the parameters in the inline form.

 (>>> 10.2.4 "Inline form “LIN”" Page 309)

5. Save instruction with Cmd Ok.

Fig. 10-1: Inline form for PTP motions

Item Description

1 Motion type PTP

2 Name of the end point

The system automatically generates a name. The name can be 
overwritten.

 (>>> 10.1 "Names in inline forms" Page 307)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.7 "Option window “Frames”" Page 310)

3  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

4 Velocity

 1 … 100%

5 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.8 "Option window “Motion parameters” (LIN, CIRC, 
PTP)" Page 311)

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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10.2.4 Inline form “LIN”

10.2.5 Programming a CIRC motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the position that is to be taught as the auxiliary point.

2. Position the cursor in the line after which the motion instruction is to be in-
serted.

3. Select the menu sequence Commands > Motion > CIRC.

4. Set the parameters in the inline form.

 (>>> 10.2.6 "Inline form “CIRC”" Page 310)

5. Press Teach Aux. 

6. Move the TCP to the position that is to be taught as the end point.

7. Save instruction with Cmd Ok.

Fig. 10-2: Inline form for LIN motions

Item Description

1 Motion type LIN

2 Name of the end point

The system automatically generates a name. The name can be 
overwritten.

 (>>> 10.1 "Names in inline forms" Page 307)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.7 "Option window “Frames”" Page 310)

3  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

4 Velocity

 0.001 … 2 m/s

5 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.8 "Option window “Motion parameters” (LIN, CIRC, 
PTP)" Page 311)

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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10.2.6 Inline form “CIRC”

10.2.7 Option window “Frames”

Fig. 10-3: Inline form for CIRC motions

Item Description

1 Motion type CIRC

2 Name of the auxiliary point

The system automatically generates a name. The name can be 
overwritten.

 (>>> 10.1 "Names in inline forms" Page 307)

3 Name of the end point

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.7 "Option window “Frames”" Page 310)

4  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

5 Velocity

 0.001 … 2 m/s

6 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.8 "Option window “Motion parameters” (LIN, CIRC, 
PTP)" Page 311)

Fig. 10-4: Option window: Frames
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10.2.8 Option window “Motion parameters” (LIN, CIRC, PTP)

Item Description

1 Tool selection.

If True in the box External TCP: workpiece selection.

Range of values: [1] … [16]

2 Base selection.

If True in the box External TCP: fixed tool selection.

Range of values: [1] … [32]

3 Interpolation mode

 False: The tool is mounted on the mounting flange.

 True: The tool is a fixed tool.

4  True: For this motion, the robot controller calculates the axis 
torques. These are required for collision detection.

 False: For this motion, the robot controller does not calculate 
the axis torques. Collision detection is thus not possible for this 
motion.

Fig. 10-5: Option window “Motion parameters” (LIN, CIRC, PTP)

Item Description

1 Acceleration

Refers to the maximum value specified in the machine data. The 
maximum value depends on the robot type and the selected oper-
ating mode.
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10.3 Programming spline motions

10.3.1 Programming tips for spline motions

 It is only possible to exploit the advantages of the spline motion type to the 
full if spline blocks are used. 

 Interrupt programs must not contain any spline motions.

 A spline block should cover only one process (e.g. an adhesive seam). 
More than one process in a spline block leads to a loss of structural clarity 
within the program and makes changes more difficult.

 Use SLIN and SCIRC segments in cases where the workpiece necessi-
tates straight lines and arcs. (Exception: use SPL segments for very short 
straight lines.) Otherwise, use SPL segments, particularly if the points are 
close together.

 Procedure for defining the path:

a. First teach or calculate a few characteristic points. Example: points at 
which the curve changes direction.

b. Test the path. At points where the accuracy is still insufficient, add 
more SPL points.

 Avoid successive SLIN and/or SCIRC segments, as this often reduces the 
velocity to 0. 

Program SPL segments between SLIN and SCIRC segments. The length 
of the SPL segments must be at least > 0.5 mm. Depending on the actual 
path, significantly larger SPL segments may be required.

 Avoid successive points with identical Cartesian coordinates, as this re-
duces the velocity to 0.

 The parameters (tool, base, velocity, etc.) assigned to the spline block 
have the same effect as assignments before the spline block. The assign-
ment to the spline block has the advantage, however, that the correct pa-
rameters are read in the case of a block selection.

 Use the option Ignore orientation if no specific orientation is required for 
a SLIN, SCIRC or SPL segment. The robot controller calculates the opti-
mal orientation for this point on the basis of the orientations of the sur-
rounding points. This improves the cycle time.

 If there are external axes present and no specific position of the external 
axis is required for a spline segment, set $EX_AX_IGNORE to “1” for that 
external axis. The robot controller then calculates the optimal position for 

2 This box is only displayed if it is specified in the inline form that the 
point is to be approximated.

Furthest distance before the end point at which approximate posi-
tioning can begin

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used.

3 This box is only displayed for LIN and CIRC motions.

Orientation control selection.

 Standard

 Wrist PTP

 Constant orientation

 (>>> 9.6 "Orientation control LIN, CIRC" Page 280)

Item Description
Issued: 14.01.2015 Version: KSS 8.3 SI V4



10 Programming for user group “User” (...
this point on the basis of the surrounding external axis positions. This im-
proves the cycle time.

 The jerk can be modified The jerk is the change in acceleration. Proce-
dure:

a. Use the default values initially.

b. If vibrations occur at tight corners: reduce values.

If the velocity drops or the desired velocity cannot be reached: in-
crease values or increase acceleration.

 If the robot executes points which lie on a work surface, a collision with the 
work surface is possible when approaching the first point.

In order to avoid a collision, observe the recommendations for the SLIN-
SPL-SLIN transition.

 (>>> 9.7.5.1 "SLIN-SPL-SLIN transition" Page 293)

 In the case of PTP spline blocks with multiple SPTP segments, it is possi-
ble that the software limit switches may be violated even though the points 
are within the limits! 

In this case, the points must be re-taught, i.e. they must be moved further 
away from the software limit switches. Alternatively, the software limit 
switches can be modified, provided that the required machine protection 
is still assured.

10.3.2 Programming a spline block

Description A spline block can be used to group together several motions as an overall 
motion. The motions that may be included in a spline block are called spline 
segments. They are taught separately. 

A spline block is planned and executed by the robot controller as a single mo-
tion block. 

 A CP spline block may contain SPL, SLIN and SCIRC segments.

 A PTP spline block may contain SPTP segments.

A spline block that contains no segments is not a motion statement. The num-
ber of segments in the block is only limited by the memory capacity. Apart from 
the segments, a spline block may also contain the following elements:

 Inline commands from technology packages that support the spline func-
tionality

Fig. 10-6: Collision with work surface

Fig. 10-7: Avoiding a collision with the work surface
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 Comments and blank lines

A spline block must not include any other instructions, e.g. variable assign-
ments or logic statements. 

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the spline block is to be inserted.

2. Select the menu sequence Commands > Motion.

 Then select SPLINE block for a CP spline block.

 Or select PTP SPLINE block for a PTP spline block.

3. Set the parameters in the inline form.

 (>>> 10.3.2.1 "Inline form for CP spline block" Page 314)

 (>>> 10.3.2.2 "Inline form “PTP SPLINE block”" Page 315)

4. Press Cmd OK.

5. Press Open/close fold. Spline segments can now be inserted into the 
block.

10.3.2.1 Inline form for CP spline block

The start point of a spline block is the last point before the spline 
block.
The end point of a spline block is the last point in the spline block.

A spline block does not trigger an advance run stop.

Fig. 10-8: Inline form for CP spline block

Item Description

1 Name of the spline block. The system automatically generates a 
name. The name can be overwritten.

 (>>> 10.1 "Names in inline forms" Page 307)

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

 (>>> 10.3.2.3 "Option window “Frames” (CP and PTP spline 
block)" Page 315)

2  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

3 Cartesian velocity

 0.001 … 2 m/s

4 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

 (>>> 10.3.2.4 "Option window “Motion parameters” (CP spline 
block)" Page 316)
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10.3.2.2 Inline form “PTP SPLINE block”

10.3.2.3 Option window “Frames” (CP and PTP spline block)

Fig. 10-9: Inline form “PTP SPLINE block”

Item Description

1 Name of the spline block. The system automatically generates a 
name. The name can be overwritten.

 (>>> 10.1 "Names in inline forms" Page 307)

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

 (>>> 10.3.2.3 "Option window “Frames” (CP and PTP spline 
block)" Page 315)

2  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

3 Axis velocity

 1 … 100%

4 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

 (>>> 10.3.2.5 "Option window “Motion parameters” (PTP spline 
block)" Page 317)

Fig. 10-10: Option window “Frames” (CP and PTP spline block)
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10.3.2.4 Option window “Motion parameters” (CP spline block)

Item Description

1 Tool selection.

Or: If True in the box External TCP: workpiece selection.

 [1] … [16]

2 Base selection.

Or: If True in the box External TCP: fixed tool selection.

 [1] … [32]

3 Interpolation mode

 False: The tool is mounted on the mounting flange.

 True: The tool is a fixed tool.

Fig. 10-11: Option window “Motion parameters” (CP spline block)

Item Description

1 Axis velocity. The value refers to the maximum value specified in 
the machine data.

 1 … 100%

2 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

4 Orientation control selection.

5 Orientation control reference system selection.

This parameter only affects SCIRC segments (if present).

6 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum distance is that of the last segment in the spline. If 
there is only one segment present, the maximum distance is half 
the segment length. If a higher value is entered, this is ignored 
and the maximum value is used.
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10.3.2.5 Option window “Motion parameters” (PTP spline block)

10.3.3 Programming segments for a spline block

10.3.3.1 Programming an SPL or SLIN segment

Precondition  A program is selected.

 Operating mode T1

 The CP spline block fold is open.

Procedure 1. Move the TCP to the end point.

2. Position the cursor in the line after which the segment is to be inserted in 
the spline block.

3. Select the menu sequence Commands > Motion > SPL or SLIN.

4. Set the parameters in the inline form.

 (>>> 10.3.3.3 "Inline form for CP spline segment" Page 318)

5. Press Cmd OK.

Fig. 10-12: Option window “Motion parameters” (PTP spline block)

Item Description

1 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

2 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum distance is that of the last segment in the spline. If 
there is only one segment present, the maximum distance is half 
the segment length. If a higher value is entered, this is ignored 
and the maximum value is used.

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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10.3.3.2 Programming an SCIRC segment

Precondition  A program is selected.

 Operating mode T1

 The CP spline block fold is open.

Procedure 1. Move the TCP to the auxiliary point.

2. Position the cursor in the line after which the segment is to be inserted in 
the spline block.

3. Select the menu sequence Commands > Motion > SCIRC.

4. Set the parameters in the inline form.

 (>>> 10.3.3.3 "Inline form for CP spline segment" Page 318)

5. Press Teach Aux.

6. Move the TCP to the end point.

7. Press Cmd OK.

10.3.3.3 Inline form for CP spline segment

By default, not all boxes of the inline form are displayed. The boxes can be dis-
played or hidden using the Switch parameter button.

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.

Fig. 10-13: Inline form for CP spline segment

Item Description

1 Motion type

 SPL, SLIN or SCIRC

2 Only for SCIRC: Point name for the auxiliary point.

The system automatically generates a name. The name can be 
overwritten. 

 (>>> 10.1 "Names in inline forms" Page 307)

3 Point name for the end point. The system automatically generates 
a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.3.3.6 "Option window “Frames” (CP and PTP spline seg-
ments)" Page 321)
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10.3.3.4 Programming an SPTP segment

Precondition  A program is selected.

 Operating mode T1

 The PTP spline block fold is open.

Procedure 1. Move the TCP to the end point.

2. Position the cursor in the line after which the segment is to be inserted in 
the spline block.

3. Select the menu sequence Commands > Motion > SPTP.

4. Set the parameters in the inline form.

 (>>> 10.3.3.5 "Inline form for SPTP segment" Page 320)

5. Press Cmd OK.

4 Cartesian velocity

By default, the value that is valid for the spline block is also valid 
for the segment. A separate value can be assigned here for the 
segment if required. The value applies only for this segment. 

 0.001 … 2 m/s

5 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

By default, the values that are valid for the spline block are also 
valid for the segment. Separate values can be assigned here for 
the segment if required. The values apply only for this segment. 

Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 10.3.3.7 "Option window “Motion parameters” (CP spline 
segment)" Page 321)

6 Circular angle

Only available if the motion type SCIRC has been selected.

 - 9 999° … + 9 999°

If a value less than -400° or greater than +400° is entered, a 
request for confirmation is generated when the inline form is 
saved asking whether entry is to be confirmed or rejected.

7 Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten.

Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 10.3.3.9 "Option window “Logic parameters”" Page 323)

Item Description

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
319 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



320 / 491

KUKA System Software 8.3
10.3.3.5 Inline form for SPTP segment

By default, not all boxes of the inline form are displayed. The boxes can be dis-
played or hidden using the Switch parameter button.

Fig. 10-14: Inline form for SPTP segment

Item Description

1 Motion type SPTP

2 Point name for end point. The system automatically generates a 
name. The name can be overwritten. 

 (>>> 10.1 "Names in inline forms" Page 307)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.3.3.6 "Option window “Frames” (CP and PTP spline seg-
ments)" Page 321)

3 Axis velocity

By default, the value that is valid for the spline block is also valid 
for the segment. A separate value can be assigned here for the 
segment if required. The value applies only for this segment. 

 1 … 100%

4 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

By default, the values that are valid for the spline block are also 
valid for the segment. Separate values can be assigned here for 
the segment if required. The values apply only for this segment. 

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.3.3.8 "Option window “Motion parameters” (SPTP)" 
Page 322)

5 Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten.

Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 10.3.3.9 "Option window “Logic parameters”" Page 323)
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10.3.3.6 Option window “Frames” (CP and PTP spline segments)

10.3.3.7 Option window “Motion parameters” (CP spline segment)

Motion param-

eters

Fig. 10-15: Option window “Frames” (CP and PTP spline segments)

Item Description

1  True: For this motion, the robot controller calculates the axis 
torques. These are required for collision detection.

 False: For this motion, the robot controller does not calculate 
the axis torques. Collision detection is thus not possible for this 
motion.

Fig. 10-16: Option window “Motion parameters” (CP spline segment)

Item Description

1 Axis velocity. The value refers to the maximum value specified in 
the machine data.

 1 … 100%

2 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

4 Orientation control selection

5 Only in the case of SCIRC segments: Orientation control refer-
ence system selection
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Circle configu-

ration

10.3.3.8 Option window “Motion parameters” (SPTP)

Fig. 10-17: Circle configuration (SCIRC segment)

Item Description

6 Only in the case of SCIRC segments: Selection of orientation 
behavior at auxiliary point

7 Only in the case of SCIRC segments: This box is only displayed if 
ANGLE was selected in the inline form.

Selection of orientation behavior at end point

Fig. 10-18: Option window “Motion parameters” (SPTP)

Item Description

1 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%
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10.3.3.9 Option window “Logic parameters”

Trigger Trigger

2 This box is not available for SPTP segments. In the case of indi-
vidual SPTP motions, this box is only displayed if CONT was 
selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used. 

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

Item Description

Fig. 10-19: Trigger

Item Description

1 A (further) trigger can be assigned to the motion by means of the 
button Select action > Add trigger. If it is the first trigger for this 
motion, this command also causes the Trigger box to be dis-
played.

A maximum of 8 triggers per motion are possible. 

(A trigger can be removed again by means of Select action > Re-
move trigger.)

2 Reference point of the trigger

 TRUE: Start point 

 FALSE: End point

 (>>> 11.11.2.1 "Reference point for approximate positioning – 
overview" Page 428)
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Conditional stop Conditional stop

3 Spatial offset relative to the end or start point

 Negative value: Offset towards the start of the motion

 Positive value: Offset towards the end of the motion

 (>>>  "Max. offset" Page 426)

The shift in space can also be taught. In this case, the box Start 
point is reference point is automatically set to FALSE.

 (>>> 10.3.3.10 "Teaching the shift in space for logic parameters" 
Page 326)

4 Shift in time relative to Offset

 Negative value: Shift towards the start of the motion.

 Positive value: Trigger is switched after Time has elapsed.

 (>>>  "Max. offset" Page 426)

5 Statement that is to be initiated by the trigger. The following are 
possible:

 Assignment of a value to a variable

Note: There must be no runtime variable on the left-hand side 
of the assignment.

 OUT statement; PULSE statement; CYCFLAG statement

 Subprogram call. In this case, the priority must be specified.

Example: my_subprogram() PRIO = 81

Priorities 1, 2, 4 to 39 and 81 to 128 are available. Priorities 40 
to 80 are reserved for cases in which the priority is automati-
cally assigned by the system. If the priority is to be assigned 
automatically by the system, the following is programmed: 
PRIO = -1.

If several triggers call subprograms at the same time, the trig-
ger with the highest priority is processed first, then the triggers 
of lower priority. 1 = highest priority. 

Item Description

Further information about the conditional stop can be found in this 
documentation.
 (>>> 10.3.5 "Conditional stop" Page 332)

Fig. 10-20: Conditional stop
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Constant velocity 

range

Constant velocity range

Item Description

1 Stop condition. The following are permitted:

 a global Boolean variable

 a signal name

 a comparison

 a simple logic operation: NOT, OR, AND or EXOR

2 The conditional stop can refer to either the start point or the end 
point of the motion. 

 TRUE: Start point 

 FALSE: End point

If the reference point is approximated, the same rules apply as for 
the PATH trigger. 

 (>>> 11.11.2.1 "Reference point for approximate positioning – 
overview" Page 428)

3 The stop point can be shifted in space. For this, the desired dis-
tance from the start or end point must be specified. If no shift in 
space is desired, enter “0”.

 Positive value: Offset towards the end of the motion

 Negative value: Offset towards the start of the motion

There are limits to the distance the stop point can be offset. The 
same limits apply as for the PATH trigger.  (>>>  "Max. offset" 
Page 426)

The shift in space can also be taught. In this case, the box Start 
point is reference point is automatically set to FALSE.

 (>>> 10.3.3.10 "Teaching the shift in space for logic parameters" 
Page 326)

Constant velocity range is only available for CP spline segments.

Further information about the constant velocity ranges can be found 
in this documentation.
 (>>> 10.3.6 "Constant velocity range in the CP spline block" 

Page 335)

Fig. 10-21: Constant velocity range
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10.3.3.10Teaching the shift in space for logic parameters

Description Shifts in space can be specified in the option window Logic parameters for 
trigger, conditional stop and constant velocity range. Instead of entering these 
offsets numerically, they can also be taught.

Precondition  A program is selected.

 Operating mode T1

 The point for which the offset is to apply has already been taught.

Procedure 1. Move the TCP to the desired position.

2. Position the cursor in the line containing the motion instruction for which 
the offset is to be taught.

3. Press Change. The inline form for this instruction is opened.

4. Open the option window Logic parameters and select the required tab.

5. Press Select action then one of the following buttons depending on what 
the offset is to be taught for: 

 Teach trigger path

 Teach conditional stop path

 Teach constant velocity range path

The distance from the end point of the current motion statement is now ap-
plied as the value for the offset.

6. Save the change by pressing Cmd OK.

Item Description

1  Start: Defines the start of the constant velocity range.

 End: Defines the end of the constant velocity range.

2 Start and End can refer to either the start point or the end point of 
the motion. 

 TRUE: Start or End refers to the start point. 

If the start point is approximated, the reference point is gener-
ated in the same way as for homogenous approximate posi-
tioning with the PATH trigger. 

 (>>> 11.11.2.2 "Reference point for homogenous approxi-
mate positioning" Page 429)

 FALSE: Start or End refers to the end point.

If the end point is approximated, Start or End refers to the start 
of the approximate positioning arc.

3 The start or end of the constant velocity range can be shifted in 
space. For this, the desired distance must be specified. If no shift 
in space is desired, enter “0”.

 Positive value: Offset towards the end of the motion

 Negative value: Offset towards the start of the motion

 (>>> 10.3.6.2 "Maximum limits" Page 337)

The shift in space can also be taught. In this case, the box Start 
point is reference point is automatically set to FALSE.

 (>>> 10.3.3.10 "Teaching the shift in space for logic parameters" 
Page 326)

If an offset is taught, the box Start point is reference point in the cor-
responding tab is automatically set to FALSE, as the taught distance 
refers to the end point of the motion.
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10.3.4 Programming individual spline motions

10.3.4.1 Programming an individual SLIN motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the end point.

2. Position the cursor in the line after which the motion is to be inserted.

3. Select Commands > Motion > SLIN.

4. Set the parameters in the inline form.

 (>>> 10.3.4.2 "Inline form “SLIN”" Page 327)

5. Press Cmd OK.

10.3.4.2 Inline form “SLIN”

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.

Fig. 10-22: Inline form “SLIN” (individual motion)

Item Description

1 Motion type SLIN

2 Point name for end point. The system automatically generates a 
name. The name can be overwritten. 

 (>>> 10.1 "Names in inline forms" Page 307)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.7 "Option window “Frames”" Page 310)

3  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

4 Velocity

 0.001 … 2 m/s
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10.3.4.3 Option window “Motion parameters” (SLIN)

5 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.3.4.3 "Option window “Motion parameters” (SLIN)" 
Page 328)

6 This box can be displayed or hidden by means of Switch param-
eter.

Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten. 
Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 10.3.3.9 "Option window “Logic parameters”" Page 323)

Item Description

Fig. 10-23: Option window “Motion parameters” (SLIN)

Item Description

1 Axis velocity. The value refers to the maximum value specified in 
the machine data.

 1 … 100%

2 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

4 Orientation control selection.

5 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used. 
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10.3.4.4 Programming an individual SCIRC motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the auxiliary point.

2. Position the cursor in the line after which the motion is to be inserted.

3. Select the menu sequence Commands > Motion > SCIRC.

4. Set the parameters in the inline form.

 (>>> 10.3.4.5 "Inline form “SCIRC”" Page 329)

5. Press Teach Aux.

6. Move the TCP to the end point.

7. Press Cmd OK.

10.3.4.5 Inline form “SCIRC”

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.

Fig. 10-24: Inline form “SCIRC” (individual motion)

Item Description

1 Motion type SCIRC

2 Point name for the auxiliary point.

The system automatically generates a name. The name can be 
overwritten.

 (>>> 10.1 "Names in inline forms" Page 307)

3 Point name for the end point.

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.7 "Option window “Frames”" Page 310)

4  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

5 Velocity

 0.001 … 2 m/s
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10.3.4.6 Option window “Motion parameters” (SCIRC)

Motion param-

eters

6 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.3.4.6 "Option window “Motion parameters” (SCIRC)" 
Page 330)

7 Circular angle

 - 9 999° … + 9 999°

If a circular angle less than -400° or greater than +400° is entered, 
a request for confirmation is generated when the inline form is 
saved asking whether entry is to be confirmed or rejected.

8 This box can be displayed or hidden by means of Switch param-
eter.

Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten. 
Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 10.3.3.9 "Option window “Logic parameters”" Page 323)

Item Description

Fig. 10-25: Motion parameters (SCIRC)

Item Description

1 Axis velocity. The value refers to the maximum value specified in 
the machine data.

 1 … 100%

2 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

4 Orientation control selection
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Circle configu-

ration

10.3.4.7 Programming an individual SPTP motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the end point.

2. Position the cursor in the line after which the motion is to be inserted.

3. Select Commands > Motion > SPTP.

4. Set the parameters in the inline form.

 (>>> 10.3.4.8 "Inline form “SPTP”" Page 332)

5. Press Cmd OK.

5 Orientation control reference system selection

6 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used. 

Item Description

Fig. 10-26: Circle configuration (SCIRC)

Item Description

7 Selection of orientation behavior at auxiliary point

8 This box is only displayed if ANGLE was selected in the inline 
form.

Selection of orientation behavior at end point

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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10.3.4.8 Inline form “SPTP”

10.3.5 Conditional stop

Description The “conditional stop” enables the user to define a point on the path at which 
the robot stops if a certain condition is met. This point is called the “stop point”. 
As soon as the condition is no longer met, the robot resumes its motion.

During the runtime, the robot controller calculates the latest point at which the 
robot must brake in order to be able to stop at the stop point. From this point 
(braking point) onwards, it monitors whether or not the condition is met. 

 If the condition is met at the braking point, the robot brakes in order to stop 
at the stop point.

If, however, the condition then switches back to “not met” before the stop 
point is reached, the robot accelerates again and does not stop.

 If the condition is not met at the braking point, the robot motion is continued 
without braking. 

Essentially, any number of conditional stops can be programmed. A maximum 
of 10 “braking point → stop point” paths may overlap, however.

Fig. 10-27: Inline form “SPTP” (individual motion)

Item Description

1 Motion type SPTP

2 Point name for end point. The system automatically generates a 
name. The name can be overwritten. 

 (>>> 10.1 "Names in inline forms" Page 307)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.2.7 "Option window “Frames”" Page 310)

3  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

4 Velocity

 1 … 100%

5 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 10.3.3.8 "Option window “Motion parameters” (SPTP)" 
Page 322)

6 This box can be displayed or hidden by means of Switch param-
eter.

Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten. 
Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 10.3.3.9 "Option window “Logic parameters”" Page 323)
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While the robot is braking, the robot controller displays the following message 
in T1/T2 mode: Conditional stop active (line {Line number}).

 (>>> 10.3.5.2 "Stop condition: example and braking characteristics" 
Page 334)

Programming Programming with KRL syntax:

 using the statement STOP WHEN PATH

Programming with inline forms:

 In the spline block (CP and PTP) or in the individual spline block: 

in the option window “Logic parameters”

 Before a spline block (CP and PTP): 

via the inline form Spline Stop Condition

10.3.5.1 Inline form “Spline Stop Condition”

This inline form may only be used before a spline block. There may be other 
statements between the inline form and the spline block, but no motion instruc-
tions.

Fig. 10-28: Inline form “Spline Stop Condition”

Item Description

1 Point to which the conditional stop refers

 With ONSTART: last point before the spline block

 Without ONSTART: last point in the spline block

If the spline is approximated, the same rules apply as for the 
PATH trigger. 

Note: Information about approximate positioning with the PATH 
trigger is contained in the Operating and Programming Instruc-
tions for System Integrators.

ONSTART can be set or removed using the Toggle OnStart but-
ton.

2 The stop point can be shifted in space. For this, the desired dis-
tance from the reference point must be specified. If no shift in 
space is desired, enter “0”.

 Positive value: Offset towards the end of the motion

 Negative value: Offset towards the start of the motion

There are limits to the distance the stop point can be offset. The 
same limits apply as for the PATH trigger. 

The shift in space can also be taught. 

 (>>>  "Teach path" Page 334)

3 Stop condition. The following are permitted:

 a global Boolean variable

 a signal name

 a comparison

 a simple logic operation: NOT, OR, AND or EXOR
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Teach path

10.3.5.2 Stop condition: example and braking characteristics

Example The indentations are not present by default and have been inserted here for 
greater clarity.

Button Description

Teach path If an offset is desired, it is not necessary to enter 
the value into the inline form numerically; the off-
set can also be taught. This is done via Teach 
path.

If an offset is taught, ONSTART is automatically 
removed, if set in the inline form, as the taught 
distance always refers to the end point of the mo-
tion.

The teaching sequence is the same as that for 
the option window Logic parameters.  
(>>> 10.3.3.10 "Teaching the shift in space for 
logic parameters" Page 326)

Fig. 10-29: Inline programming example (folds expanded)

Line Description

4 If the input $IN[77] is FALSE, the robot stops 50 mm after P2 
and waits until $IN[77] is TRUE.

Fig. 10-30: Example of STOP WHEN PATH
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Braking charac-

teristics

If the stop condition is not met until the robot has already passed BP, it is too 
late to stop at SP with a normal braking ramp. In this case, the robot stops with 
a path-maintaining EMERGENCY STOP and comes to a standstill at an un-
predictable point. 

 If the EMERGENCY STOP causes the robot to stop after SP, the program 
cannot be resumed until the stop condition is no longer met.

 If the path-maintaining EMERGENCY STOP causes the robot to stop be-
fore SP, the following occurs when the program is resumed:

 If the stop condition is no longer met, the robot resumes its motion.

 If the stop condition is still met, the robot moves as far as SP and stops 
there.

10.3.6 Constant velocity range in the CP spline block

Description In a CP spline block, a range can be defined in which the robot maintains the 
programmed velocity constant where possible. This range is called the “con-
stant velocity range”.

 1 constant velocity range can be defined per CP spline block.

 A constant velocity range is defined by a start statement and an end state-
ment.

 The range cannot extend beyond the spline block.

 There is no lower limit to the size of the range. 

If it is not possible to maintain the programmed velocity constant, the robot 
controller indicates this by means of a message during program execution. 

Constant velocity range over several segments:

Point Description

BP Braking Point: The robot must start braking here in order to 
stop at the stop point.

From this point onwards, the robot controller monitors 
whether or not the stop condition is met.

The position of BP depends on the velocity and the override 
setting and cannot be identified by the operator.

SP Stop Point

The distance P2 → SP is 50 mm long.

Situation at BP Behavior of the robot

$IN[77] == FALSE The robot brakes and stops at SP.

$IN[77] == TRUE The robot does not brake and does 
not stop at SP. The program is exe-
cuted as if the STOP WHEN PATH 
statement were not present.

1. $IN[77] == FALSE at BP.

2. The input switches to TRUE be-
tween BP and SP.

1. The robot brakes at BP. 

2. If the input is TRUE, the robot 
accelerates again and does not 
stop at SP.

1. $IN[77] == TRUE at BP.

2. The input switches to FALSE 
between BP and SP.

1. The robot does not brake at BP.

2. If the input is FALSE, the robot 
stops with a path-maintaining 
EMERGENCY STOP and 
comes to a standstill at an un-
predictable point. 
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A constant velocity range can extend over several segments with different pro-
grammed velocities. In this case, the lowest of the velocities is valid for the 
whole range. 

Even in the segments with a higher programmed velocity, the motion is exe-
cuted with the lowest velocity in this case. No message is generated indicating 
that the velocity has not been maintained. This only occurs if the lowest veloc-
ity cannot be maintained. 

Programming A constant velocity range can be programmed in the following ways:

 If programming with KRL syntax: by means of the statement CONST_VEL

 If programming with inline forms: 

The start or end of the range is stored in the corresponding CP segment 
in the option window Logic parameters.

10.3.6.1 Block selection to the constant velocity range

Description If a block selection to a constant velocity range is carried out, the robot con-
troller ignores it and generates a corresponding message. The motions are ex-
ecuted as if no constant velocity range were programmed.

A block selection to the path section defined by the offset values is considered 
as a block selection to the constant velocity range. The motion blocks in which 
the start and end of the range are programmed, however, are irrelevant.

Example

The folds in the program are expanded. The indentations are not present by 
default and have been inserted here for greater clarity.

The start of the constant velocity range is at P1 in the program. The end is at 
P4. What counts, however, when deciding what constitutes a block selection 
to the constant velocity range is where the range is located on the path:

Fig. 10-31: Constant velocity range example (inline programming)
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What is considered as a block selection to the constant velocity range?

10.3.6.2 Maximum limits

If the start or end point of the spline block is an exact positioning point:

 The constant velocity range starts at the start point at the earliest.

 The constant velocity range ends at the end point at the latest.

If the offset value is such that these limits would be exceeded, the robot con-
troller automatically reduces the offset and generates the following message: 
CONST_VEL {Start/End} = {Offset} cannot be implemented; {New offset} will 
be used.

The robot controller reduces the offset far enough to create a range in which 
the constant programmed velocity can be maintained. In other words, it does 
not necessarily shift the limit exactly to the start or end point of the spline block, 
but possibly further inwards.

The same message is generated if the range is already in the spline block be-
forehand, but the defined velocity cannot be maintained due to the offset. In 
this case, once again, the robot controller reduces the offset.

If the start or end point of the spline block is approximated:

 The constant velocity range starts at the start of the approximate position-
ing arc of the start point at the earliest.

 The constant velocity range ends at the start of the approximate position-
ing arc of the end point at the latest.

If the offset is such that these limits would be exceeded, the robot controller 
automatically sets the limit to the start of the corresponding approximate posi-
tioning arc. It does not generate a message.

Fig. 10-32: Constant velocity range example (path)

Block selection to point ... P1 P2 P3 P4

= in constant velocity range? No No Yes No

Fig. 10-33: Maximum limits for approximated SPLINE/ENDSPLINE
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10.4 Displaying the distance between points

Precondition  Program is selected or open.

 T1 or T2 operating mode

 “Expert” user group

Procedure 1. Select the points (= the motion blocks) for which the distance is to be dis-
played. Multiple consecutive blocks can also be selected.

2. Select the menu sequence Edit > Marked region > Cart. distance.

A window opens. It displays the following information:

 The Cartesian coordinates of the first selected point

 The Cartesian coordinates of the last selected point

 The distance between the coordinates in millimeters and degrees

 The distance between the TCP position at the first and last point in mil-
limeters and degrees

3. Select other points if required.

4. Press Refresh to update the display.

10.5 Modifying programmed motions

10.5.1 Modifying motion parameters

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line containing the instruction that is to be 
changed.

2. Press Change. The inline form for this instruction is opened.

3. Modify parameters.

4. Save changes by pressing Cmd Ok.

10.5.2 Modifying blocks of motion parameters

Precondition  “Expert” user group

 A program is selected.

 Operating mode T1

Procedure 1. Select the motion instructions to be modified. (Only consecutive motion in-
structions can be modified as a block.)

2. Press Change. The inline form of the first selected motion block opens.

3. Modify parameters.

4. Press Cmd OK. The changes will be applied to the selected motion blocks 
where possible.

Some changes will not be applied in every motion block, e.g. it is not pos-
sible to apply the PTP parameter Velocity in a LIN motion block.

10.5.3 Re-teaching a point

Description The coordinates of a taught point can be modified. This is done by moving to 
the new position and overwriting the old point with the new position.

Precondition  A program is selected.

 Operating mode T1
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Procedure 1. Move the TCP to the desired position.

2. Position the cursor in the line containing the motion instruction that is to be 
changed.

3. Press Change. The inline form for this instruction is opened.

4. For PTP and LIN motions: Press Touch Up to accept the current position 
of the TCP as the new end point.

For CIRC motions:

 Press Teach Aux to accept the current position of the TCP as the new 
auxiliary point.

 Or press Teach End to accept the current position of the TCP as the 
new end point.

5. Confirm the request for confirmation with Yes.

6. Save change by pressing Cmd Ok.

10.5.4 Transforming blocks of coordinates

Precondition  “Expert” user group

 A program is selected.

 Operating mode T1

Procedure 1. Select the motion instructions to be modified. (Only consecutive motion in-
structions can be modified as a block.)

2. Select the menu sequence Edit > Marked region. Select transformation 
type.

The corresponding window is opened.

 (>>> 10.5.4.1 "“Axis mirroring” window" Page 342)

 (>>> 10.5.4.2 "“Transform - Axis Specific” window" Page 343)

 (>>> 10.5.4.3 "“Transform - Cartesian Base” window" Page 344)

3. Enter values for the transformation and press Calculate.

Overview The following transformation types are available:

 Transform - Cartesian base

 Transform - Cartesian tool

 Transform - Cartesian World

 Transform - Axis-specific

 Axis mirroring

Transform - Base Transform - Cartesian Base:

The transformation refers to the current BASE coordinate system.
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Point P is offset by ∆ X and ∆ Y in the negative direction. The new position of 
the point is P*.

Transform - TCP Transform - Cartesian TCP:

The transformation refers to the current TOOL coordinate system.

Point P is offset by ∆ Z and ∆ Y in the negative direction. The new position of 
the point is P*.

Transform - 

World

Transform - Cartesian World:

The transformation is relative to the WORLD coordinate system.

Fig. 10-34: Transform - Cartesian Base

Fig. 10-35: Transform - Cartesian TCP
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Point P is offset by ∆ X and ∆ Y in the negative direction. The new position of 
the point is P*.

Transform - Axis 

Specific

Transform - Axis Specific:

The transformation is axis-specific.

Axis A5 is rotated by the angle ∆α. The new position of point P is P*.

Mirroring Mirroring:

Mirroring in the XY plane of the ROBROOT coordinate system.

Fig. 10-36: Transform - Cartesian World

Fig. 10-37: Transform - Axis Specific
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Points P1, P2 and P3 are mirrored in the XY plane (1). The new positions of 
the points are P1*, P2* and P3*.

10.5.4.1 “Axis mirroring” window

No values need to be entered in this window. Pressing the Calculate button 
mirrors the point coordinates in the XZ plane of the ROBROOT coordinate sys-
tem.

Fig. 10-38: Mirroring

Fig. 10-39: Mirroring
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The following buttons are available:

Only selected points with a complete E6POS definition are copied. This in-
cludes, for example, all those that were generated via inline forms during pro-
gramming. Points without a complete E6POS definition are ignored during the 
point offset.

10.5.4.2 “Transform - Axis Specific” window

The following buttons are available:

Following mirroring of the coordinates, the tool used must also be mir-
rored in the XZ plane.

Button Description

Calculate Mirrors the coordinates of the selected motion 
points in the XZ plane, converts the coordinates 
to axis angles and applies the new values.

Undo Undoes the mirroring and restores the old point 
data.

Fig. 10-40: Point transformation - axis-specific

Item Description

1 Selection of the transformation type

2 Rotation group: input boxes for the position offset of axes A1 
... A6

 Range of values: Dependent on the configuration of the 
axis-specific workspaces

E1 .. E6 switches to the External axes group: input boxes for 
the position offset of axes E1 ... E6

Note: Values can only be entered for configured axes.

Button Description

E1 .. E6/A1 .. A6 Toggles between the Rotation and External 
axes groups.
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Only selected points with a complete E6POS definition are copied. This in-
cludes, for example, all those that were generated via inline forms during pro-
gramming. Points without a complete E6POS definition are ignored during the 
point offset.

10.5.4.3 “Transform - Cartesian Base” window

The following buttons are available:

Undo Undoes the transformation and restores the old 
point data.

Calculate Calculates the point transformation and applies it 
to all selected motion points.

If the transformation would cause a point to be 
situated outside the configured workspace, the 
point is not transformed.

Button Description

Fig. 10-41: Point transformation - Cartesian

Item Description

1 Selection of the transformation type

2 Position group: input boxes for the point transformation in the X, 
Y, Z direction

 Range of values: Dependent on the configuration of the Carte-
sian workspaces

3 Orientation group: input boxes for the transformation of the A, B, 
C orientation

 Range of values: Dependent on the configuration of the Carte-
sian workspaces

Button Description

Undo Undoes the transformation and restores the old 
point data.

Calculate Calculates the point transformation and applies it 
to all selected motion points.

If the transformation would cause a point to be 
situated outside the configured workspace, the 
point is not transformed.
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Only selected points with a complete E6POS definition are copied. This in-
cludes, for example, all those that were generated via inline forms during pro-
gramming. Points without a complete E6POS definition are ignored during the 
point offset.

10.6 Programming logic instructions

10.6.1 Inputs/outputs

Digital inputs/outputs

The robot controller can manage up to 8192 digital inputs and 8192 digital out-
puts. 4096 inputs/outputs are available by default.

Analog inputs/outputs

The robot controller can manage 32 analog inputs and 32 analog outputs. 

The inputs/outputs are managed via the following system variables:

$ANIN[…] indicates the input voltage, adapted to the range between -1.0 and 
+1.0. The actual voltage depends on the settings of the analog module.

$ANOUT[…] can be used to set an analog voltage. $ANOUT[…] can have val-
ues from -1.0 to +1.0 written to it. The voltage actually generated depends on 
the settings of the analog module. If an attempt is made to set voltages outside 
the range of values, the robot controller displays the following message: Limit 
{Signal name}

10.6.2 Setting a digital output - OUT

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > OUT.

3. Set the parameters in the inline form.

 (>>> 10.6.3 "Inline form “OUT”" Page 345)

4. Save instruction with Cmd Ok.

10.6.3 Inline form “OUT”

The instruction sets a digital output.

Inputs Outputs

Digital $IN[1] … $IN[8192] $OUT[1] … $OUT[8192]

Analog $ANIN[1] … $ANIN[32] $ANOUT[1] … $ANOUT[32]

Fig. 10-42: Inline form “OUT”
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10.6.4 Setting a pulse output - PULSE

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > PULSE.

3. Set the parameters in the inline form.

 (>>> 10.6.5 "Inline form “PULSE”" Page 346)

4. Save instruction with Cmd Ok.

10.6.5 Inline form “PULSE”

The instruction sets a pulse of a defined length.

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE

 FALSE

4  CONT: Execution in the advance run

 [Empty box]: Execution with advance run stop

Fig. 10-43: Inline form “PULSE”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE: “High” level

 FALSE: “Low” level

4  CONT: Execution in the advance run

 [Empty box]: Execution with advance run stop

5 Length of the pulse

 0.10 … 3.00 s
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10.6.6 Setting an analog output - ANOUT

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the instruction is to be inserted.

2. Select Commands > Analog output > Static or Dynamic.

3. Set the parameters in the inline form.

 (>>> 10.6.7 "Inline form “ANOUT” (static)" Page 347)

 (>>> 10.6.8 "Inline form “ANOUT” (dynamic)" Page 347)

4. Save instruction with Cmd Ok.

10.6.7 Inline form “ANOUT” (static)

This instruction sets a static analog output. The voltage is set to a fixed level 
by means of a factor. The actual voltage level depends on the analog module 
used. For example, a 10 V module with a factor of 0.5 provides a voltage of 
5 V.

ANOUT triggers an advance run stop.

10.6.8 Inline form “ANOUT” (dynamic)

This instruction activates or deactivates a dynamic analog output.

A maximum of 4 dynamic analog outputs can be activated at any one time. 
ANOUT triggers an advance run stop.

The voltage is determined by a factor. The actual voltage level depends on the 
following values:

 Velocity or function generator

For example, a velocity of 1 m/s with a factor of 0.5 results in a voltage of 
5 V. 

 Offset

For example, an offset of +0.15 for a voltage of 0.5 V results in a voltage 
of 6.5 V.

Fig. 10-44: Inline form “ANOUT” (static)

Item Description

1 Number of the analog output

 CHANNEL_1 … CHANNEL_32

2 Factor for the voltage

 0 … 1 (intervals: 0.01)

Fig. 10-45: Inline form “ANOUT” (dynamic)
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10.6.9 Programming a wait time - WAIT

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > WAIT.

3. Set the parameters in the inline form.

 (>>> 10.6.10 "Inline form “WAIT”" Page 348)

4. Save instruction with Cmd Ok.

10.6.10 Inline form “WAIT”

WAIT can be used to program a wait time. The robot motion is stopped for a 
programmed time. WAIT always triggers an advance run stop.

10.6.11 Programming a signal-dependent wait function - WAITFOR

Precondition  A program is selected.

 Operating mode T1

Item Description

1 Activation or deactivation of the analog output

 ON

 OFF

2 Number of the analog output

 CHANNEL_1 … CHANNEL_32

3 Factor for the voltage

 0 … 10 (intervals: 0.01)

4  VEL_ACT: The voltage is dependent on the velocity.

 TECHVAL[1] … TECHVAL[6]: The voltage is controlled by a 
function generator.

5 Value by which the voltage is increased or decreased

 -1 … +1 (intervals: 0.01)

6 Time by which the output signal is delayed (+) or brought forward 
(-)

 -0.2 … +0.5 s

Fig. 10-46: Inline form “WAIT”

Item Description

1 Wait time

 ≥ 0 s
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Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > WAITFOR.

3. Set the parameters in the inline form.

 (>>> 10.6.12 "Inline form “WAITFOR”" Page 349)

4. Save instruction with Cmd Ok.

10.6.12 Inline form “WAITFOR”

The instruction sets a signal-dependent wait function.

If required, several signals (maximum 12) can be linked. If a logic operation is 
added, boxes are displayed in the inline form for the additional signals and 
links.

Fig. 10-47: Inline form “WAITFOR”

Item Description

1 Add external logic operation. The operator is situated between the 
bracketed expressions.

 AND

 OR

 EXOR

Add NOT.

 NOT

 [Empty box]

Enter the desired operator by means of the corresponding button.

2 Add internal logic operation. The operator is situated inside a 
bracketed expression.

 AND

 OR

 EXOR

Add NOT.

 NOT

 [Empty box]

Enter the desired operator by means of the corresponding button.

3 Signal for which the system is waiting

 IN

 OUT

 CYCFLAG

 TIMER

 FLAG

4 Number of the signal
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10.6.13 Switching on the path - SYN OUT

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > SYN OUT.

3. Set the parameters in the inline form.

 (>>> 10.6.14 "Inline form “SYN OUT”, option “START/END”" Page 350)

 (>>> 10.6.15 "Inline form “SYN OUT”, option “PATH”" Page 353)

4. Save instruction with Cmd Ok.

10.6.14 Inline form “SYN OUT”, option “START/END”

The switching action can be triggered relative to the start or end point of the 
motion. The switching action can be delayed or brought forward. The motion 
can be a LIN, CIRC or PTP motion.

Possible applications include:

 Closing or opening the weld gun during spot welding

 Switching the welding current on/off during arc welding

 Starting or stopping the flow of adhesive in bonding or sealing applica-
tions.

5 If a name exists for the signal, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

6  CONT: Execution in the advance run

 [Empty box]: Execution with advance run stop

Item Description

Fig. 10-48: Inline form “SYN OUT”, option “START/END”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE

 FALSE
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Example 1 Start point and end point are exact positioning points.

OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits.

Switching limits:

 START: The switching point can be delayed, at most, as far as exact po-
sitioning point P3 (+ ms).

 END: The switching point can be brought forward, at most, as far as exact 
positioning point P2 (- ms).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.

Example 2 Start point is exact positioning point, end point is approximated.

4 Point to which SYN OUT refers:

 START: Start point of the motion

 END: End point of the motion

5 Switching action delay

 -1,000 … +1,000 ms

Note: The time specification is absolute, i.e. the switching point 
varies according to the velocity of the robot.

Item Description

LIN P1 VEL=0.3m/s CPDAT1

LIN P2 VEL=0.3m/s CPDAT2

SYN OUT 1 '' State= TRUE at START Delay=20ms

SYN OUT 2 '' State= TRUE at END Delay=-20ms

LIN P3 VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4

Fig. 10-49

LIN P1 VEL=0.3m/s CPDAT1

LIN P2 VEL=0.3m/s CPDAT2

SYN OUT 1 '' State= TRUE at START Delay=20ms

SYN OUT 2 '' State= TRUE at END Delay=-20ms

LIN P3 CONT VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4
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OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits. M = middle of the approxi-
mate positioning range.

Switching limits:

 START: The switching point can be delayed, at most, as far as the start of 
the approximate positioning range of P3 (+ ms).

 END: The switching point can be brought forward, at most, as far as the 
start of the approximate positioning range of P3 (-).

The switching point can be delayed, at most, as far as the end of the ap-
proximate positioning range of P3 (+).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.

Example 3 Start point and end point are approximated

OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits. M = middle of the approxi-
mate positioning range.

Fig. 10-50

LIN P1 VEL=0.3m/s CPDAT1

LIN P2 CONT VEL=0.3m/s CPDAT2

SYN OUT 1 '' State= TRUE at START Delay=20ms

SYN OUT 2 '' State= TRUE at END Delay=-20ms

LIN P3 CONT VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4

Fig. 10-51
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Switching limits:

 START: The switching point can be situated, at the earliest, at the end of 
the approximate positioning range of P2.

The switching point can be delayed, at most, as far as the start of the ap-
proximate positioning range of P3 (+ ms).

 END: The switching point can be brought forward, at most, as far as the 
start of the approximate positioning range of P3 (-).

The switching point can be delayed, at most, as far as the end of the ap-
proximate positioning range of P3 (+).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.

10.6.15 Inline form “SYN OUT”, option “PATH”

The switching action refers to the end point of the motion. The switching action 
can be shifted in space and delayed or brought forward. The motion can be a 
LIN or CIRC motion. It must not be a PTP motion.

Example 1 Start point is exact positioning point, end point is approximated.

Fig. 10-52: Inline form “SYN OUT”, option “PATH”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE

 FALSE

4  PATH: SYN OUT refers to the end point of the motion.

5 This box is only displayed if PATH has been selected.

Distance from the switching point to the end point

 -2,000 … +2,000 mm

6 Switching action delay

 -1,000 … +1,000 ms

Note: The time specification is absolute, i.e. the switching point 
varies according to the velocity of the robot.

LIN P1 VEL=0.3m/s CPDAT1

SYN OUT 1 '' State= TRUE at START PATH=20mm Delay=-5ms

LIN P2 CONT VEL=0.3m/s CPDAT2

LIN P3 CONT VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4
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OUT 1 specifies the approximate position at which switching is to occur. The 
dotted lines indicate the switching limits. M = middle of the approximate posi-
tioning range.

Switching limits:

 The switching point can be brought forward, at most, as far as exact posi-
tioning point P1.

 The switching point can be delayed, at most, as far as the next exact po-
sitioning point P4. If P3 was an exact positioning point, the switching point 
could be delayed, at most, as far as P3.

If greater values are specified for the shift in space or time, the controller au-
tomatically switches at the switching limit.

Example 2 Start point and end point are approximated

OUT 1 specifies the approximate position at which switching is to occur. The 
dotted lines indicate the switching limits. M = middle of the approximate posi-
tioning range.

Fig. 10-53

LIN P1 CONT VEL=0.3m/s CPDAT1

SYN OUT 1 '' State= TRUE at START PATH=20mm Delay=-5ms

LIN P2 CONT VEL=0.3m/s CPDAT2

LIN P3 CONT VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4

Fig. 10-54
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Switching limits:

 The switching point can be brought forward, at most, as far as the start of 
the approximate positioning range of P1.

 The switching point can be delayed, at most, as far as the next exact po-
sitioning point P4. If P3 was an exact positioning point, the switching point 
could be delayed, at most, as far as P3.

If greater values are specified for the shift in space or time, the controller au-
tomatically switches at the switching limit.

10.6.16 Setting a pulse on the path - SYN PULSE

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > SYN PULSE.

3. Set the parameters in the inline form.

 (>>> 10.6.17 "Inline form “SYN PULSE”" Page 355)

4. Save instruction with Cmd Ok.

10.6.17 Inline form “SYN PULSE”

SYN PULSE can be used to trigger a pulse at the start or end point of the mo-
tion. The pulse can be shifted in time and/or space, i.e. it does not have to be 
triggered exactly at the point, but can also be triggered before or after it.

Fig. 10-55: Inline form “SYN PULSE”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE

 FALSE

4 Duration of the pulse

 0.1 … 3 s
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10.6.18 Modifying a logic instruction

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line containing the instruction that is to be 
changed.

2. Press Change. The inline form for this instruction is opened.

3. Change the parameters.

4. Save changes by pressing Cmd Ok.

5 Point to which SYN PULSE refers:

 START: Start point of the motion

 END: End point of the motion

See SYN OUT for examples and switching limits.  
(>>> 10.6.14 "Inline form “SYN OUT”, option “START/END”" 
Page 350)

 PATH: SYN PULSE refers to the end point. An offset in space 
is also possible.

See SYN OUT for examples and switching limits.  
(>>> 10.6.15 "Inline form “SYN OUT”, option “PATH”" Page 353)

6 Distance from the switching point to the end point

 -2,000 … +2,000 mm

This box is only displayed if PATH has been selected.

7 Switching action delay

 -1,000 … +1,000 ms

Note: The time specification is absolute. The switching point var-
ies according to the velocity of the robot.

Item Description
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11 Programming for user group “Expert” (KRL syntax)

11.1 Overview of KRL syntax

 

 

In the case of programs with the following axis motions 
or positions, the film of lubricant on the gear units of the 

axes may break down:

 Motions <3°

 Oscillating motions

 Areas of gear units permanently facing upwards

It must be ensured that the gear units have a sufficient supply of oil. For this, 
in the case of oscillating motions or short motions (<3°), programming must 
be carried out in such a way that the affected axes regularly move more than 
40° (e.g. once per cycle).
In the case of areas of gear units permanently facing upwards, sufficient oil 
supply must be achieved by programming re-orientations of the in-line wrist. 
In this way, the oil can reach all areas of the gear units by means of gravity. 
Required frequency of re-orientations:

 With low loads (gear unit temperature <+35 °C): daily

 With medium loads (gear unit temperature +35 °C to 55 °C): hourly

 With heavy loads (gear unit temperature >+55 °C): every 10 minutes

Failure to observe this precaution may result in damage to the gear units.

If a selected program is edited in the user group “Expert”, the cursor 
must then be removed from the edited line and positioned in any other 
line! 

Only in this way is it certain that the editing will be applied when the program 
is deselected again.

Variables and declarations

DECL  (>>> 11.4.1 "DECL" Page 364)

ENUM  (>>> 11.4.2 "ENUM" Page 365)

STRUC  (>>> 11.4.3 "STRUC" Page 366)

Motion programming

PTP  (>>> 11.5.1 "PTP" Page 368)

LIN, CIRC  (>>> 11.5.3 "LIN, CIRC" Page 369)

PTP_REL  (>>> 11.5.2 "PTP_REL" Page 368)

LIN_REL, CIRC_REL  (>>> 11.5.4 "LIN_REL, CIRC_REL" Page 370)

SPLINE … ENDSPLINE  (>>> 11.6.1 "SPLINE ... ENDSPLINE" Page 375)

PTP_SPLINE … ENDSPLINE  (>>> 11.6.2 "PTP_SPLINE ... ENDSPLINE" Page 376)

SLIN, SCIRC, SPL  (>>> 11.6.3 "SLIN, SCIRC, SPL" Page 377)

SLIN_REL, SCIRC_REL, SPL_REL  (>>> 11.6.4 "SLIN_REL, SCIRC_REL, SPL_REL" 
Page 378)

SPTP  (>>> 11.6.5 "SPTP" Page 380)

SPTP_REL  (>>> 11.6.6 "SPTP_REL" Page 381)

TIME_BLOCK  (>>> 11.6.8 "TIME_BLOCK" Page 383)

CONST_VEL  (>>> 11.6.9 "CONST_VEL" Page 386)

STOP WHEN PATH  (>>> 11.6.10 "STOP WHEN PATH" Page 389)
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Program execution control

CONTINUE  (>>> 11.7.1 "CONTINUE" Page 391)

EXIT  (>>> 11.7.2 "EXIT" Page 391)

FOR … TO … ENDFOR  (>>> 11.7.3 "FOR ... TO ... ENDFOR" Page 392)

GOTO  (>>> 11.7.4 "GOTO" Page 392)

HALT  (>>> 11.7.5 "HALT" Page 393)

IF … THEN … ENDIF  (>>> 11.7.6 "IF ... THEN ... ENDIF" Page 393)

LOOP … ENDLOOP  (>>> 11.7.7 "LOOP ... ENDLOOP" Page 394)

ON_ERROR_PROCEED  (>>> 11.7.8 "ON_ERROR_PROCEED" Page 394)

REPEAT … UNTIL  (>>> 11.7.9 "REPEAT ... UNTIL" Page 399)

SWITCH … CASE … ENDSWITCH  (>>> 11.7.10 "SWITCH ... CASE ... ENDSWITCH" 
Page 400)

WAIT FOR …  (>>> 11.7.11 "WAIT FOR …" Page 401)

WAIT SEC …  (>>> 11.7.12 "WAIT SEC …" Page 402)

WHILE … ENDWHILE  (>>> 11.7.13 "WHILE ... ENDWHILE" Page 402)

Inputs/outputs

ANIN  (>>> 11.8.1 "ANIN" Page 403)

ANOUT  (>>> 11.8.2 "ANOUT" Page 404)

PULSE  (>>> 11.8.3 "PULSE" Page 405)

SIGNAL  (>>> 11.8.4 "SIGNAL" Page 409)

Subprograms and functions

DEFFCT … ENDFCT  (>>> 11.9.3 "DEFFCT ... ENDFCT" Page 411)

RETURN  (>>> 11.9.4 "RETURN" Page 411)

Interrupt programming

BRAKE  (>>> 11.10.1 "BRAKE" Page 416)

INTERRUPT  (>>> 11.10.3 "INTERRUPT" Page 418)

INTER-
RUPT … DECL … WHEN … DO

 (>>> 11.10.2 "INTERRUPT ... DECL ... WHEN ... DO" 
Page 417)

RESUME  (>>> 11.10.4 "RESUME" Page 420)

Path-related switching actions (=Trigger)

TRIGGER WHEN DISTANCE  (>>> 11.11.1 "TRIGGER WHEN DISTANCE" Page 421)

TRIGGER WHEN PATH  (>>> 11.11.2 "TRIGGER WHEN PATH" Page 424)

Communication

 (>>> 11.12 "Communication" Page 432)

Operators

Arithmetic operators  (>>> 11.13.1 "Arithmetic operators" Page 433)

Geometric operator  (>>> 11.13.2 "Geometric operator" Page 434)

Relational operators  (>>> 11.13.3 "Relational operators" Page 437)

Logic operators  (>>> 11.13.4 "Logic operators" Page 438)

Bit operators  (>>> 11.13.5 "Bit operators" Page 438)

Priority of the operators  (>>> 11.13.6 "Priority of the operators" Page 440)
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11.2 Symbols and fonts

The following symbols and fonts are used in the syntax descriptions:

11.3 Important KRL terms

11.3.1 SRC files and DAT files

A KRL program generally consists of an SRC file and a DAT file of the same 
name.

 SRC file: contains the program code.

 DAT file: contains permanent data and point coordinates. The DAT file is 
also called a data list.

The SRC file and associated DAT file together are called a module.

Depending on the user group, programs in the Navigator are displayed as 
modules or individual files:

 User group "User"

A program is displayed as a module. The SRC file and the DAT file exist 
in the background. They are not visible for the user and cannot be edited 
individually.

 User group "Expert"

By default, the SRC file and the DAT file are displayed individually. They 
can be edited individually.

System functions

DELETE_BACKWARD_BUFFER()  (>>> 11.14.1 "DELETE_BACKWARD_BUFFER()" 
Page 441)

ROB_STOP()  (>>> 11.14.2 "ROB_STOP() and 
ROB_STOP_RELEASE()" Page 442)

SET_BRAKE_DELAY()  (>>> 11.14.3 "SET_BRAKE_DELAY()" Page 443)

VARSTATE()  (>>> 11.14.4 "VARSTATE()" Page 446)

Manipulating string variables

 (>>> 11.15 "Editing string variables" Page 447)

Syntax element Representation

KRL code  Courier font

 Upper-case letters

Examples: GLOBAL; ANIN ON; OFFSET

Elements that must be 
replaced by program-spe-
cific entries

 Italics

 Upper/lower-case letters

Examples: Distance; Time; Format

Optional elements  In angle brackets

Example: <STEP Increment>

Elements that are mutually 
exclusive

 Separated by the "|" symbol

Example: IN |OUT
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11.3.2 Naming conventions and keywords

Names Examples of names in KRL: variable names, program names, point names

 Names in KRL can have a maximum length of 24 characters.

In some cases, less than 24 characters are allowed, e.g. a maximum of 
23 characters in inline forms.

 Names in KRL can consist of letters (A-Z), numbers (0-9) and the signs “_” 
and “$”.

 Names in KRL must not begin with a number.

 Names in KRL must not be keywords.

Other restrictions may apply in the case of inline forms in technology packag-
es.

Keywords Keywords are sequences of letters having a fixed meaning. They must not be 
used in programs in any way other than with this meaning. No distinction is 
made between uppercase and lowercase letters. A keyword remains valid ir-
respective of the way in which it is written.

Example: The sequence of letters CASE is an integral part of the KRL syntax 
SWITCH … CASE … ENDSWITCH. For this reason, CASE must not be used 
in any other way, e.g. as a variable name.

The system distinguishes between reserved and non-reserved keywords:

 Reserved keywords

These may only be used with their defined meaning.

 Non-reserved keywords

With non-reserved keywords, the meaning is restricted to a particular con-
text. Outside of this context, a non-reserved keyword is interpreted by the 
compiler as a name.

Overview of important keywords:

All elements of the KRL syntax described in this documentation that are not 
program-specific are keywords. 

The following important keywords are worth a particular mention:

The names of all system variables begin with the “$” sign. To avoid 
confusion, do not begin the names of user-defined variables with this 
sign.

In practice, it is not helpful to distinguish between reserved and non-
reserved keywords. To avoid error messages or compiler problems, 
keywords are thus never used other than with their defined meaning.

AXIS ENDFCT

BOOL ENDFOR

CHAR ENDIF

CAST_FROM ENDLOOP

CAST_TO ENDSWITCH

CCLOSE ENDWHILE

CHANNEL EXT

CIOCTL EXTFCT

CONFIRM FALSE

CONST FRAME

COPEN GLOBAL

CREAD INT
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11.3.3 Data types

Overview There are 2 kinds of data types:

 User-defined data types

User-defined data types are always derived from the data types ENUM or 
STRUC.

 Predefined data types, e.g.:

 Simple data types

 Data types for motion programming

The following simple data types are predefined:

The following data types for motion programming are predefined:

Structure type AXIS

A1 to A6 are angle values (rotational axes) or translation values (translational 
axes) for the axis-specific movement of robot axes 1 to 6.

Structure type E6AXIS

E1 to E6 are angle values or translation values of the external axes 7 to 12.

Structure type FRAME

X, Y and Z are space coordinates, while A, B and C are the orientation of the 
coordinate system.

CWRITE MAXIMUM

DEF MINIMUM

DEFAULT POS

DEFDAT PRIO

DEFFCT PUBLIC

E6AXIS SREAD

E6POS SWRITE

END REAL

ENDDAT TRUE

Data type Keyword Description

Integer INT Integer

 -2³¹-1 … 2³¹-1

Examples: 1; 32; 345

Real REAL Floating-point number

 +1.1E-38 … +3.4E+38

Examples: 1.43; 38.50; 300.25

Boolean BOOL Logic state

 TRUE

 FALSE

Character CHAR 1 character

 ASCII character

Examples: "A"; "1"; "q"

STRUC AXIS REAL A1, A2, A3, A4, A5, A6

STRUC E6AXIS REAL A1, A2, A3, A4, A5, A6, E1, E2, E3, E4, E5, E6
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Structure types POS and E6POS

S (Status) and T (Turn) define axis positions unambiguously.

11.3.4 Areas of validity

Local

Global Always globally valid:

 The first program in an SRC file. By default, it bears the name of the SRC 
file.

 Predefined data types

 KRL system variables

 Variables and signals defined in $CONFIG.DAT

The data objects named under “local” can be made available globally.

  (>>> 11.3.4.1 "Making subprograms, functions and interrupts available 
globally" Page 362)

  (>>> 11.3.4.2 "Making variables, constants, signals and user data types 
available globally" Page 363)

If there are local and global objects with the same name, the compiler uses the 
local object within its area of validity.

11.3.4.1 Making subprograms, functions and interrupts available globally

Use the keyword GLOBAL in the declaration.

Example of subprogram:

STRUC FRAME REAL X, Y, Z, A, B, C

STRUC POS REAL X, Y, Z, A, B, C, INT S, T

STRUC E6POS REAL X, Y, Z, A, B, C, E1, E2, E3, E4, E5, E6, INT S, T

Data object Area of validity

Variable

Signal

 If the object was defined in an SRC file:

It is valid in the program routine in which it was defined, i.e. between DEF 
and END (main program OR local subprogram).

Variables defined in an SRC file are called “runtime variables”. 

 If the object was defined in a DAT file:

It is valid in the SRC file that belongs to the DAT file.

Constant Valid in the module to which the data list in which the constant was declared 
belongs.

User-defined 
data type

 If the data type was defined in an SRC file: it is valid at, or below, the pro-
gram level in which it was declared.

 If the data type was defined in a DAT file: it is valid in the SRC file that be-
longs to the DAT file.

Subprogram Valid in the main program of the shared SRC file.

Function Valid in the main program of the shared SRC file.

Interrupt Valid at, or below, the programming level in which it was declared.

...

END

-------------------------------

GLOBAL DEF MY_SUBPROG

...
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Example of function:

Example of interrupt:

11.3.4.2 Making variables, constants, signals and user data types available globally

Variables, signals and user-defined data types can be made available globally 
via a data list or $CONFIG.DAT.

Constants must always be declared and, at the same time, initialized in a data 
list. For this reason, they can only be made available globally via a data list.

Data list Making the object available globally via a data list:

1. Insert the keyword PUBLIC into the program header of the data list:

2. Use the keyword GLOBAL in the declaration.

Example (declaration of a variable):

GLOBAL can only be used for variables, signals and user-defined data types 
if they have been declared in a data list.

PUBLIC is used exclusively for the purpose described here, i.e. together with 
GLOBAL in data lists for making specific data objects available globally. PUB-
LIC on its own has no effect.

$CONFIG.DAT  Declare the object in the USER GLOBALS section in $CONFIG.DAT.

The keyword GLOBAL is not required here, nor can it be used here.

Restriction Data types defined in a data list using the keyword GLOBAL must not be used 
in $CONFIG.DAT.

Example:

In DEFDAT PROG(), the enumeration type SWITCH_TYP has been defined 
with the keyword GLOBAL:

If this data type is used in $CONFIG.DAT, the compiler signals the error “Type 
unknown: *** DECL SWITCH_TYP MY_VAR”.

...

END

-------------------------------

GLOBAL DEFFCT INT MY_FCT(my_var:IN)

...

GLOBAL INTERRUPT DECL 23 WHEN $IN[12]==TRUE DO UP1(20,VALUE)

DEFDAT MY_PROG PUBLIC

DEFDAT MY_PROG PUBLIC

EXTERNAL DECLARATIONS

DECL GLOBAL INT counter

...

ENDDAT

DEFDAT PROG()

GLOBAL ENUM SWITCH_TYP ON, OFF 

...

DEFDAT $CONFIG

DECL SWITCH_TYP MY_VAR

...
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11.3.5 Constants

The value of a constant can no longer be modified during program execution 
after initialization. Constants can be used to prevent a value from being 
changed accidentally during program execution.

Constants must be declared and, at the same time, initialized in a data list. The 
data type must be preceded by the keyword CONST.

DECL <GLOBAL> CONST Data type Variable name = Value

11.4 Variables and declarations

11.4.1 DECL

Description Declaration of variables, arrays and constants

Syntax Declaration of variables

Declaration of variables in programs:

<DECL> Data type Name1 <, ..., NameN>

Declaration of variables in data lists:

<DECL> <GLOBAL> Data type Name1 <, ..., NameN>

Declaration of variables in data lists with simultaneous initialization:

<DECL> <GLOBAL> Data type Name = Value

In the case of declaration with simultaneous initialization, a separate DECL 
declaration is required for each variable. It is not possible to declare and ini-
tialize several variables with a single DECL declaration.

Declaration of arrays

Declaration of arrays in programs:

<DECL> Data type Name1 [Dimension1 <, ..., Dimension3> ] <, ..., NameN 
[DimensionN1 <,..., DimensionN3>] >

Declaration of arrays in data lists:

<DECL> <GLOBAL> Data type Name1 [Dimension1 <, ..., Dimension3> ] <, ..., 
NameN [DimensionN1 <,..., DimensionN3>] >

For the declaration of arrays or constant arrays in data lists with simultaneous 
initialization:

 It is not permissible to declare and initialize in a single line. The initializa-
tion must, however, follow directly after the line containing the declaration. 
There must be no lines, including blank lines, in between.

 If several elements of an array are initialized, the elements must be spec-
ified in ascending sequence of the array index (starting from the right-hand 
array index).

 If the same character string is to be assigned to all of the elements of an 
array of type CHAR as a default setting, it is not necessary to initialize each 
array element individually. The right-hand array index is omitted. (No index 
is written for a one-dimensional array index.)

Declaration of arrays in data lists with simultaneous initialization:

<DECL> <GLOBAL> Data type Name [Dimension1 <,..., Dimension3> ] 
Name [1 <, 1, 1> ] = Value1
<Name [1 <, 1, 2> ] = Value2>
...
Name [Dimension1 <, Dimension2, Dimension3> ] = ValueN
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Declaration of constant arrays in data lists with simultaneous initialization:

DECL <GLOBAL> CONST Data type Name [Dimension1 <,..., Dimension3> ] 
Name [1 <, 1, 1> ] = Value1
<Name [1 <, 1, 2> ] = Value2>
...
Name [Dimension1 <, Dimension2, Dimension3> ] = ValueN

Explanation of 

the syntax

Example 1 Declarations with predefined data types. The keyword DECL can also be omit-
ted.

Example 2 Declarations of arrays with simultaneous initialization (only possible in data 
lists).

11.4.2 ENUM

Description Definition of an enumeration type (= ENUM data type)

Syntax <GLOBAL> ENUM NameEnumType Constant1<, ..., ConstantN>

Element Description

DECL DECL can be omitted if Data type is a predefined data type. 
If Data type is a user-defined data type, then DECL is oblig-
atory.

GLOBAL  (>>> 11.3.4 "Areas of validity" Page 362)

CONST The keyword CONST must only be used in data lists.

Data type Specification of the desired data type

Name Name of the object (variable, array or constant) that is 
being declared.

Dimension Type: INT

Dimension defines the number of array elements for the 
dimension in question. Arrays have a minimum of 1 and a 
maximum of 3 dimensions.

Value The data type of Value must be compatible with Data type, 
but not necessarily identical. If the data types are compati-
ble, the system automatically matches them.

DECL INT X 

DECL INT X1, X2 

DECL REAL ARRAY_A[7], ARRAY_B[5], A

INT A[7] 

A[1]=27 

A[2]=313 

A[6]=11 

CHAR TEXT1[80] 

TEXT1[]="message" 

CHAR TEXT2[2,80]

TEXT2[1,]="first message" 

TEXT2[2,]="second message"
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Explanation of 

the syntax

Example 1 Definition of an enumeration type with the name COUNTRY_TYPE.

Declaration of a variable of type COUNTRY_TYPE:

Initialization of the variable of type COUNTRY_TYPE:

Example 2 An enumeration type with the name SWITCH_TYPE and the constants ON 
and OFF is defined.

Restriction Data types defined in a data list using the keyword GLOBAL must not be used 
in $CONFIG.DAT.

Example:

In DEFDAT PROG(), the enumeration type SWITCH_TYP has been defined 
with the keyword GLOBAL:

If this data type is used in $CONFIG.DAT, the compiler signals the error “Type 
unknown: *** DECL SWITCH_TYP MY_VAR”.

11.4.3 STRUC

Description Definition of a structure type (= STRUC data type). Several data types are 
combined to form a new data type.

Element Description

GLOBAL  (>>> 11.3.4 "Areas of validity" Page 362)

Note: Data types defined using the keyword GLOBAL must 
not be used in $CONFIG.DAT.

NameEnum-
Type

Name of the new enumeration type.

Recommendation: For user-defined data types, assign 
names ending in _TYPE, to distinguish them from variable 
names.

Constant The constants are the values that a variable of the enumer-
ation type can take. Each constant may only occur once in 
the definition of the enumeration type.

ENUM COUNTRY_TYP SWITZERLAND, AUSTRIA, ITALY, FRANCE

DECL COUNTRY_TYP MYCOUNTRY

MYCOUNTRY = #AUSTRIA

DEF PROG()

ENUM SWITCH_TYP ON, OFF 

DECL SWITCH_TYP GLUE

   IF A>10 THEN

      GLUE=#ON

   ELSE

      GLUE=#OFF

   ENDIF 

END

DEFDAT PROG()

GLOBAL ENUM SWITCH_TYP ON, OFF 

...

DEFDAT $CONFIG

DECL SWITCH_TYP MY_VAR

...
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Syntax <GLOBAL> STRUC Name structure type Data type1 Component1A<, 
Component1B, ...> < , Data type2 Component2A<, Component2B, ...>>

Explanation of 

the syntax

Value assignment There are 2 ways of assigning values to variables based on a STRUC data 
type:

 Assignment of values to several components of a variable: with an aggre-
gate

 Assignment of a value to a single component of a variable: with the point 
separator

Information regarding the aggregate:

 The values of an aggregate can be simple constants or themselves aggre-
gates; they may not, however, be variables (see also Example 3).

 Not all components of the structure have to be specified in an aggregate.

 The components do not need to be specified in the order in which they 
have been defined.

 Each component may only be contained once in an aggregate.

 The name of the structure type can be specified at the beginning of an ag-
gregate, separated by a colon.

Example 1 Definition of a structure type CAR_TYPE with the components AIR_COND, 
YEAR and PRICE.

Declaration of a variable of type CAR_TYPE:

Initialization of the variable MYCAR of type CAR_TYPE with an aggregate:

A variable based on a structure type does not have to be initialized with an ag-
gregate. It is also possible to initialize the components individually with the 
point separator.

Modification of an individual component using the point separator:

Example 2 Definition of a structure type S_TYPE with the component NUMBER of data 
type REAL and of the array component TEXT[80] of data type CHAR.

Element Description

GLOBAL  (>>> 11.3.4 "Areas of validity" Page 362)

Note: Data types defined using the keyword GLOBAL must 
not be used in $CONFIG.DAT.

Name 
structure type

Name of the new structure type. The names of user-
defined data types should end in _TYPE, to distinguish 
them from variable names.

Data type TYPE: Any data type

Structure types are also permissible as data types.

Component Name of the component. It may only be used once in the 
structure type.

Arrays can only be used as components of a structure type 
if they have the type CHAR and are one-dimensional. In 
this case, the array limit follows the name of the array in 
square brackets in the definition of the structure type.

STRUC CAR_TYP BOOL AIR_COND, INT YEAR, REAL PRICE

DECL CAR_TYP MYCAR

MYCAR = {CAR_TYP: PRICE 15000, AIR_COND TRUE, YEAR 2003}

MYCAR.AIR_COND = FALSE
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Example 3 Example of aggregates as values of an aggregate:

11.5 Motion programming: PTP, LIN, CIRC

11.5.1 PTP

Description Executes a point-to-point motion to the end point. The coordinates of the end 
point are absolute.

Syntax PTP End point <Approximation>

Explanation of 

the syntax

Example 1 End point specified in Cartesian coordinates.

Example 2 End point specified in axis-specific coordinates. The end point is approximat-
ed.

Example 3 End point specified with only 2 components. For the rest of the components, 
the controller takes the values of the previous position.

11.5.2 PTP_REL

Description Executes a point-to-point motion to the end point. The coordinates of the end 
point are relative to the current position.

STRUC S_TYP REAL NUMBER, CHAR TEXT[80]

STRUC INNER_TYP INT A, B, C 

STRUC OUTER_TYP INNER_TYP Q, R

DECL OUTER_TYP MYVAR

...

MYVAR = {Q {A 1, B 4}, R {A 3, C 2}}

Element Description

End point Type: POS, E6POS, AXIS, E6AXIS, FRAME

The end point can be specified in Cartesian or axis-specific 
coordinates. Cartesian coordinates refer to the BASE coor-
dinate system.

If not all components of the end point are specified, the 
controller takes the values of the previous position for the 
missing components.

Approxima-
tion

Approximation causes the end point to be approximated. At 
the same time, this parameter defines the earliest point at 
which the approximate positioning can begin.

 (>>> 11.5.5 "Approximation parameters for PTP, LIN CIRC 
and …_REL" Page 372)

PTP {X 12.3,Y 100.0,Z 50,A 9.2,B 50,C 0,S ’B010’,T ’B1010’}

PTP {A1 10,A2 -80.6,A3 -50,A4 0,A5 14.2, A6 0} C_DIS

PTP {Z 500,X 123.6}

A REL statement always refers to the current position of the robot. For 
this reason, if a REL motion is interrupted, the robot executes the en-
tire REL motion again, starting from the position at which it was inter-

rupted.
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For information about the response of the robot controller in the case of infi-
nitely rotating axes:  (>>> 11.5.6 "REL motions for infinitely rotating axes" 
Page 374)

Syntax PTP_REL End point <Approximation> <#BASE|#TOOL>

Explanation of 

the syntax

Example 1 Axis 2 is moved 30 degrees in a negative direction. None of the other axes 
moves.

Example 2 The robot moves 100 mm in the X direction and 200 mm in the negative Z di-
rection from the current position. Y, A, B, C and S remain constant. T is calcu-
lated in relation to the shortest path.

11.5.3 LIN, CIRC

Description LIN:

LIN executes a linear motion to the end point. The coordinates of the end point 
are absolute.

CIRC:

CIRC executes a circular motion. An auxiliary point and an end point must be 
specified in order for the controller to be able to calculate the circular motion.

The coordinates of the auxiliary point and end point are absolute.

Syntax LIN:

LIN End point <Approximation>

Element Description

End point Type: POS, E6POS, AXIS, E6AXIS

The end point can be specified in Cartesian or axis-specific 
coordinates. The controller interprets the coordinates as 
relative to the current position. Cartesian coordinates refer 
to the BASE coordinate system.

If not all components of the end point are specified, the 
controller sets the value of the missing components to 0. In 
other words, the absolute values of these components 
remain unchanged.

Approxima-
tion

Approximation causes the end point to be approximated. At 
the same time, this parameter defines the earliest point at 
which the approximate positioning can begin.

 (>>> 11.5.5 "Approximation parameters for PTP, LIN CIRC 
and …_REL" Page 372)

#BASE, 
#TOOL

Only permissible if the end point was specified in Cartesian 
coordinates.

 #BASE (default): The coordinates of this end point refer 
to the coordinate system that belongs to the physical 
base.

 #TOOL: The coordinates of this end point refer to the 
coordinate system that belongs to the physical tool.

$IPO_MODE has no influence on the meaning of #BASE 
and #TOOL.

PTP_REL {A2 -30}

PTP_REL {X 100,Z -200}
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CIRC:

CIRC Auxiliary point, End point<, CA Circular angle> <Approximation>

Explanation of 

the syntax

Examples End point with two components. For the rest of the components, the controller 
takes the values of the previous position.

The end point of the circular motion is defined by a circular angle of 260°. The 
end point is approximated.

11.5.4 LIN_REL, CIRC_REL

Description LIN_REL:

LIN_REL executes a linear motion to the end point. The coordinates of the end 
point are relative to the current position.

CIRC_REL:

CIRC_REL executes a circular motion. An auxiliary point and an end point 
must be specified in order for the controller to be able to calculate the circular 
motion. The coordinates of the auxiliary point and end point are relative to the 
current position.

Element Description

Auxiliary point Type: POS, E6POS, FRAME

If not all components of the auxiliary point are specified, the 
controller takes the values of the previous position for the 
missing components.

The orientation angles and the Status and Turn specifica-
tions for an auxiliary point are always disregarded.

The auxiliary point cannot be approximated. The motion 
always stops exactly at this point.

The coordinates refer to the BASE coordinate system.

End point Type: POS, E6POS, FRAME

If not all components of the end point are specified, the 
controller takes the values of the previous position for the 
missing components.

The Status and Turn specifications for an end point of type 
POS or E6POS are disregarded.

The coordinates refer to the BASE coordinate system.

Circular angle Unit: Degrees; without restriction

 (>>> 9.9 "Circular angle" Page 300)

Approxima-
tion

Approximation causes the end point to be approximated. At 
the same time, this parameter defines the earliest point at 
which the approximate positioning can begin.

 (>>> 11.5.5 "Approximation parameters for PTP, LIN CIRC 
and …_REL" Page 372)

LIN {Z 500,X 123.6}

CIRC {X 5,Y 0, Z 9.2},{X 12.3,Y 0,Z -5.3,A 9.2,B -5,C 20}, CA 260 
C_ORI
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For information about the response of the robot controller in the case of infi-
nitely rotating axes:  (>>> 11.5.6 "REL motions for infinitely rotating axes" 
Page 374)

Syntax LIN_REL:

LIN_REL End point <Approximation> <#BASE|#TOOL>

CIRC_REL:

CIRC_REL Auxiliary point, End point<, CA Circular angle> <Approximation> 
<#BASE|#TOOL>

Explanation of 

the syntax

A REL statement always refers to the current position of the robot. For 
this reason, if a REL motion is interrupted, the robot executes the en-
tire REL motion again, starting from the position at which it was inter-

rupted.

Element Description

Auxiliary point Type: POS, E6POS, FRAME

The auxiliary point must be specified in Cartesian coordi-
nates. The controller interprets the coordinates as relative 
to the current position. The coordinates refer to the BASE 
coordinate system.

If $ORI_TYPE, Status and/or Turn are specified, these 
specifications are ignored.

If not all components of the auxiliary point are specified, the 
controller sets the value of the missing components to 0. In 
other words, the absolute values of these components 
remain unchanged.

The orientation angles and the Status and Turn specifica-
tions for an auxiliary point are disregarded.

The auxiliary point cannot be approximated. The motion 
always stops exactly at this point.

End point Type: POS, E6POS, FRAME

The end point must be specified in Cartesian coordinates. 
The controller interprets the coordinates as relative to the 
current position. 

CIRC_REL: The coordinates refer to the BASE coordinate 
system.

LIN_REL: The coordinates can refer to the BASE or TOOL 
coordinate system.

If not all components of the end point are specified, the 
controller sets the value of the missing components to 0. In 
other words, the absolute values of these components 
remain unchanged.

The Status and Turn specifications for an end point of type 
POS or E6POS are disregarded.

Circular angle Unit: Degrees; without restriction

 (>>> 9.9 "Circular angle" Page 300)
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Examples Example 1:

The TCP moves 100 mm in the X direction and 200 mm in the negative Z di-
rection from the current position in the BASE coordinate system. Y, A, B, C 
and S remain constant. T is determined by the motion.

Example 2:

The TCP moves 100 mm from the current position in the negative X direction 
in the TOOL coordinate system. Y, Z, A, B, C and S remain constant. T is de-
termined by the motion.

This example is suitable for moving the tool backwards against the tool direc-
tion. The precondition is that the tool direction has been calibrated along the 
X axis.

Example 3:

The end point of the circular motion is defined by a circular angle of 500°. The 
end point is approximated.

11.5.5 Approximation parameters for PTP, LIN CIRC and …_REL

Parameters Not every parameter can be used in every instruction.

Approxima-
tion

Approximation causes the end point to be approximated. At 
the same time, this parameter defines the earliest point at 
which the approximate positioning can begin.

 (>>> 11.5.5 "Approximation parameters for PTP, LIN CIRC 
and …_REL" Page 372)

#BASE, 
#TOOL

 #BASE (default): The coordinates of this end point refer 
to the coordinate system that belongs to the physical 
base.

 #TOOL: The coordinates of this end point refer to the 
coordinate system that belongs to the physical tool.

$IPO_MODE has no influence on the meaning of #BASE 
and #TOOL.

Information about $APO is contained in the System Variables docu-
mentation.

Element Description

LIN_REL {X 100,Z -200}

LIN_REL {X -100} #TOOL

CIRC_REL {X 100,Y 3.2,Z -20},{Y 50},CA 500 C_VEL

Parameter Description

C_PTP Approximation starts, at the earliest, when half the dis-
tance between the start point and end point relative to 
the contour of the motion without approximation has 
been covered. 

C_DIS Approximation starts, at the earliest, when the distance 
to the end point falls below the value of $APO.CDIS.
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PTP,

PTP_REL

The parameter must be C_PTP or C_DIS for PTP-PTP approximation. If a 
second parameter is specified, the robot controller ignores it.

Two parameters can be specified for PTP-CP approximation. Of the two pa-
rameters, the one resulting in the smaller approximate positioning radius in the 
given situation takes effect.

Possible combinations for PTP-CP approximation:

Example: PTP-CP approximation

The robot controller calculates the approximate positioning radius which would 
result from each of the two parameters C_PTP and C_DIS under the current 
conditions (velocity, etc.). Only the smaller of the two radii then actually has an 
effect. It is the earliest limit at which approximate positioning can begin. 

LIN, CIRC, 

LIN_REL, 

CIRC_REL

The parameter must be C_DIS, C_VEL or C_ORI for CP-CP approximation. If 
a second parameter is specified, the robot controller ignores it.

Two parameters can be specified for CP-PTP approximation. Of the two pa-
rameters, the one resulting in the smaller approximate positioning radius in the 
given situation takes effect.

Possible combinations for CP-PTP approximation:

C_ORI Approximation starts, at the earliest, when the dominant 
orientation angle falls below the value of $APO.CORI.

C_VEL Approximation starts, at the earliest, when the velocity 
in the deceleration phase to the end point falls below the 
value of $APO.CVEL.

Information about $APO is contained in the System Variables docu-
mentation.

Parameter Description

1st parameter → C_PTP C_DIS

2nd parameter ↓

(without) Possible Possible

C_DIS Possible Not possible!

C_VEL Possible Possible

C_ORI Possible Possible

PTP XP1 C_PTP C_DIS

LIN XP2

1st parameter → C_DIS C_VEL C_ORI

2nd parameter ↓

(without) Possible Possible Possible

C_PTP Possible Possible Possible

C_DIS Possible Possible Possible
373 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



374 / 491

KUKA System Software 8.3
11.5.6 REL motions for infinitely rotating axes

Description

Examples Let A6 and E1 be infinitely rotating axes with the start position 120°. 

Let the position at X be = 1500 mm.

Example 1:

Explanation of end position of PTP_REL:

The permissible interval is from -60° to 300°. The position 450° is outside this 
interval and is thus not addressed. 

The end position must be within the interval AND be calculated as follows:

 450° ± (x * 360°)

The end position that meets these criteria is 90°. 

450° - (1 * 360°) = 90°

Example 2:

Example 3:

The statements do not contain any specification of the robot position. This im-
plicitly corresponds to: {X 0, Y 0, Z 0, A 0, B 0, C 0}

The Cartesian robot position thus remains unchanged in both cases. 

Example 4:

Motion Description

SPTP_REL The end position is calculated directly by 
adding the start position to the value spec-
ified in the REL statement. The overall 
length of the resulting path is irrelevant.

For external axes only:

SLIN_REL, SCIRC_REL, 
SPL_REL

PTP_REL The axis only moves to positions with the 
following interval:

 From “Start position minus 180°”

 To “Start position plus 180°”

If the addition of the start position and the 
value specified in the REL statement 
gives a value outside this interval, the 
actual end position is calculated as the dif-
ference of the value from 360° or a multi-
ple of 360°.

For external axes only:

LIN_REL, CIRC_REL

Statement End position

SPTP_REL {A6 330} A6 = 450°

PTP_REL {A6 330} A6 = 90°

Statement End position

SPTP_REL {A6 550} A6 = 670°

PTP_REL {A6 550} A6 = -50°

Statement End position

SPTP_REL {E1 950} E1 = 1070°

PTP_REL {E1 950} E1 = -10°
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The robot position, if not specified, is implicitly Cartesian, as explained in ex-
ample 3. 

If, however, the axis-specific robot position and not the Cartesian position is to 
remain unchanged, a zero motion must be specified explicitly for at least one 
robot axis, as illustrated here in example 4. 

Example 5:

External axis motions are always axis-specific. They are thus specified in de-
grees, even in these statements that only allow Cartesian coordinates for robot 
positions.

11.6 Motion programming: spline

11.6.1 SPLINE ... ENDSPLINE

Description SPLINE … ENDSPLINE defines a CP spline block. A CP spline block may 
contain:

 SLIN, SCIRC and SPL segments (number limited only by the memory ca-
pacity)

 PATH trigger

 1 time block (TIME_BLOCK …)

or 1 constant velocity range (CONST_VEL …)

 STOP WHEN PATH

 Comments

 Blank lines

The block must not include any other instructions, e.g. variable assignments 
or logic statements. 

Syntax SPLINE < WITH SysVar1 = Value1 <, SysVar2 = Value2, … > >

Segment1

 …

 <SegmentN>

ENDSPLINE <C_SPL>

Statement End position

SPTP_REL {A6 0, E1 950} A6 = 120°, E1 = 1070°

PTP_REL {A6 0, E1 950} A6 = 120°, E1 = -10°

Statement End position

SLIN_REL {X 300, E1 880} X = 1800 mm, E1 = 1000°

LIN_REL {X 300, E1 880} X = 1800 mm, E1 = 280°

The start point of a spline block is the last point before the spline 
block.
The end point of a spline block is the last point in the spline block.

A spline block does not trigger an advance run stop.
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Explanation of 

the syntax

Example

11.6.2 PTP_SPLINE ... ENDSPLINE

Description PTP_SPLINE … ENDSPLINE defines a PTP spline block. A PTP spline block 
may contain:

 SPTP segments (number limited only by the memory capacity)

 PATH trigger

 1 time block (TIME_BLOCK …)

 STOP WHEN PATH

 Comments

 Blank lines

The block must not include any other instructions, e.g. variable assignments 
or logic statements. 

Syntax PTP_SPLINE < WITH SysVar1 = Value1 <, SysVar2 = Value2, … > >

Element Description

SysVar  (>>> 11.6.7 "System variables for WITH" Page 382)

Value Value assignment to the system variable. The value is not 
valid for segments which have their own value assigned. 
With this one exception, the value remains valid, in the 
usual way, until a new value is assigned to the system vari-
able.

The system variables can also be assigned values by 
means of a function call. The same restrictions apply to 
these functions as to functions in the trigger.

 (>>> 11.11.3 "Constraints for functions in the trigger" 
Page 431)

C_SPL  With C_SPL: the end point is approximated. $APO de-
fines the earliest point at which the approximate posi-
tioning can begin.

 Without C_SPL: the motion stops exactly at the end 
point.

In System Software 8.2 and earlier, the identifier for approximate po-
sitioning with spline was “C_DIS”. If programs based on 8.2 or older 
versions are used in higher versions of 8.x and contain C_DIS, this 

can be retained and does not have to be changed to C_SPL.

SPLINE

  SPL P1

  TRIGGER WHEN PATH=GET_PATH() ONSTART DELAY=0 DO <subprog> PRIO=-1

  SPL P2

  SLIN P3

  SPL P4

  SCIRC P5, P6 WITH $VEL.CP=0.2

  SPL P7 WITH $ACC={CP 2.0, ORI1 200, ORI2 200}

  SCIRC P8, P9

  SPL P10

ENDSPLINE

The start point of a spline block is the last point before the spline 
block.
The end point of a spline block is the last point in the spline block.

A spline block does not trigger an advance run stop.
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Segment1

 …

 <SegmentN>

ENDSPLINE <C_SPL>

Explanation of 

the syntax

Example

11.6.3 SLIN, SCIRC, SPL

Description SLIN, SCIRC: 

SLIN and SCIRC can be programmed as a segment in a CP spline block or as 
an individual motion. 

It is possible to copy an individual SLIN or SCIRC motion into a CP spline 
block, but only if it does not contain an assignment to system variables that are 
prohibited there.

SPL: 

SPL can be programmed as a segment in a CP spline block. 

Syntax SLIN:

SLIN End point <WITH SysVar1 = Value1 <, SysVar2 = Value2, …, >> <C_SPL>

SCIRC:

SCIRC Auxiliary point, End point <, CA Circular angle> <WITH SysVar1 = Value1 
<,SysVar2 = Value2 , … >> <C_SPL>

SPL:

SPL End point <WITH SysVar1 = Value1 <, SysVar2 = Value2 , …>>

Element Description

SysVar  (>>> 11.6.7 "System variables for WITH" Page 382)

Value Value assignment to the system variable. The value is not 
valid for segments which have their own value assigned. 
With this one exception, the value remains valid, in the 
usual way, until a new value is assigned to the system vari-
able.

The system variables can also be assigned values by 
means of a function call. The same restrictions apply to 
these functions as to functions in the trigger.

 (>>> 11.11.3 "Constraints for functions in the trigger" 
Page 431)

C_SPL  With C_SPL: the end point is approximated. $APO de-
fines the earliest point at which the approximate posi-
tioning can begin.

 Without C_SPL: the motion stops exactly at the end 
point.

PTP_SPLINE WITH $ACC_AXIS[1]={CP 20, ORI1 80, ORI2 80}

  SPTP P1

  TRIGGER WHEN PATH=GET_PATH() ONSTART DELAY=0 DO <subprog> PRIO=-1

  SPTP P2

  SPTP P3

  SPTP P4 WITH $ACC_AXIS[1]={CP 10}

ENDSPLINE C_SPL
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Explanation of 

the syntax

Examples

11.6.4 SLIN_REL, SCIRC_REL, SPL_REL

Description SLIN_REL, SCIRC_REL: 

SLIN_REL and SCIRC_REL can be programmed as a segment in a CP spline 
block or as an individual motion. 

It is possible to copy an individual SLIN_REL or SCIRC_REL motion into a CP 
spline block, but only if it does not contain an assignment to system variables 
that are prohibited there.

Element Description

Auxiliary 
point

End point

Type: POS, E6POS, FRAME

The coordinates refer to the BASE coordinate system.

If not all components of the end point are specified, the 
controller takes the values of the previous position for the 
missing components. If this previous position is the end 
point of a circle with a circular angle, the following distinc-
tion is made:

 If the previous position is outside a spline block, the val-
ues of the end point that is actually reached are applied, 
and not those of the programmed end point.

 If the previous position is inside a spline block, the val-
ues of the programmed end point are applied, and not 
those of the end point that is actually reached.

If no previous position is known to the robot controller, the 
missing components are taken from the current robot posi-
tion.

Circular 
angle

Unit: Degrees; without restriction

 (>>> 9.9 "Circular angle" Page 300)

SysVar  (>>> 11.6.7 "System variables for WITH" Page 382)

Value Value assignment to the system variable.

In the case of segments: The assignment applies only for 
this segment.

The system variables can also be assigned values by 
means of a function call. The same restrictions apply to 
these functions as to functions in the trigger.

 (>>> 11.11.3 "Constraints for functions in the trigger" 
Page 431)

C_SPL  With C_SPL: the end point is approximated. $APO de-
fines the earliest point at which the approximate posi-
tioning can begin.

Only possible for individual motions, not for segments.

 Without C_SPL: the motion stops exactly at the end 
point.

In System Software 8.2 and earlier, the identifier for approximate po-
sitioning with spline was “C_DIS”. If programs based on 8.2 or older 
versions are used in higher versions of 8.x and contain C_DIS, this 

can be retained and does not have to be changed to C_SPL.

SCIRC P2, P3 WITH $CIRC_TYPE=#PATH

SPL P4 WITH $ACC={CP 2.0, ORI1 200, ORI2 200}
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SPL_REL: 

SPL_REL can be programmed as a segment in a CP spline block. 

For information about the response of the robot controller in the case of infi-
nitely rotating axes:  (>>> 11.5.6 "REL motions for infinitely rotating axes" 
Page 374)

Syntax SLIN_REL:

SLIN_REL End point <WITH SysVar1 = Value1 <, SysVar2 = Value2, …, >> 
<C_SPL><#BASE|#TOOL>

SCIRC_REL:

SCIRC_REL Auxiliary point, End point <, CA Circular angle> <WITH SysVar1 = 
Value1 <,SysVar2 = Value2 , … >> <C_SPL><#BASE|#TOOL>

SPL_REL:

SPL_REL End point < WITH SysVar1 = Value1 <,SysVar2 = Value2 , …>><#BA-
SE|#TOOL>

Explanation of 

the syntax
Element Description

Auxiliary point

End point

Type: POS, E6POS, FRAME

The point must be specified in Cartesian coordinates. The 
controller interprets the coordinates as relative to the end 
point of the previous motion.

If not all components of the point are specified, the control-
ler sets the value of the missing components to 0. In other 
words, the absolute values of these components remain 
unchanged.

Specifications of Status and Turn, if present, are ignored by 
the controller. (This is in contrast to SPTP_REL where they 
are taken into consideration!)

At the auxiliary point, the orientation angles are also 
ignored.

The auxiliary point cannot be approximated. The motion 
always stops exactly at this point.

Circular angle Unit: Degrees; without restriction

 (>>> 9.9 "Circular angle" Page 300)

SysVar  (>>> 11.6.7 "System variables for WITH" Page 382)

Value Value assignment to the system variable.

In the case of segments: The assignment applies only for 
this segment.

The system variables can also be assigned values by 
means of a function call. The same restrictions apply to 
these functions as to functions in the trigger.

 (>>> 11.11.3 "Constraints for functions in the trigger" 
Page 431)
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Example

11.6.5 SPTP

Description SPTP can be programmed as a segment in a PTP spline block or as an indi-
vidual motion. 

It is possible to copy an individual SPTP motion into a PTP spline block, but 
only if it does not contain an assignment to system variables that are prohibit-
ed there.

Syntax SPTP  End point <WITH SysVar1 = Value1 <, SysVar2 = Value2 , …>> <C_SPL>

C_SPL  With C_SPL: the end point is approximated. $APO de-
fines the earliest point at which the approximate posi-
tioning can begin.

Only possible for individual motions, not for segments.

 Without C_SPL: the motion stops exactly at the end 
point.

#BASE, 
#TOOL

 #BASE (default): The coordinates of this end point refer 
to the coordinate system that belongs to the physical 
base.

 #TOOL: The coordinates of this end point refer to the 
coordinate system that belongs to the physical tool.

$IPO_MODE has no influence on the meaning of #BASE 
and #TOOL.

Element Description

DECL E6POS P1 = {X 1500, Y -200, Z 2000, A 0, B 0, C 0, S 6, T27}

SPTP HOME

SLIN P1

SLIN_REL{X 0, Y 500, Z 0, A 0, B 0, C 0} WITH $BASE=$NULLFRAME #BASE

SLIN_REL{X 400} WITH $TOOL=$NULLFRAME C_SPL #TOOL

SLIN_REL{A 20}

SPTP_REL{A3 90} C_SPL

SPTP_REL Z 50, B -30} WITH $VEL.AXIS[4]=90 C_SPL #TOOL

SPTP_REL{A1 100}

SPLINE

   SPL P1

   SPL_REL{Z -300, B50} #TOOL

ENDSPLINE

PTPSPLINE

   SPTP P1

   SPTP_REL{A1 -100, A5 -70}

ENDSPLINE
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Explanation of 

the syntax

11.6.6 SPTP_REL

Description SPTP_REL can be programmed as a segment in a PTP spline block or as an 
individual motion. 

It is possible to copy an individual SPTP_REL motion into a PTP spline block, 
but only if it does not contain an assignment to system variables that are pro-
hibited there.

For information about the response of the robot controller in the case of infi-
nitely rotating axes:  (>>> 11.5.6 "REL motions for infinitely rotating axes" 
Page 374)

Syntax SPTP_REL End point <WITH SysVar1 = Value1 <, SysVar2 = Value2, …>> 
<C_SPL><#BASE|#TOOL>

Element Description

End point Type: AXIS, E6AXIS, POS, E6POS, FRAME

The Cartesian coordinates refer to the BASE coordinate 
system.

If not all components of the end point are specified, the 
controller takes the values of the previous position for the 
missing components. If this previous position is the end 
point of a circle with a circular angle, the values of the end 
point that is actually reached are applied, and not those of 
the programmed end point.

If no previous position is known to the robot controller, the 
missing components are taken from the current robot posi-
tion.

SysVar  (>>> 11.6.7 "System variables for WITH" Page 382)

Value Value assignment to the system variable.

In the case of SPTP segments: The assignment applies 
only for this segment. 

The system variables can also be assigned values by 
means of a function call. The same restrictions apply to 
these functions as to functions in the trigger.

 (>>> 11.11.3 "Constraints for functions in the trigger" 
Page 431)

C_SPL  With C_SPL: the end point is approximated. $APO de-
fines the earliest point at which the approximate posi-
tioning can begin.

Only possible for individual motions, not for segments.

 Without C_SPL: the motion stops exactly at the end 
point.

In System Software 8.2 and earlier, the identifier for approximate po-
sitioning with spline was “C_DIS”. If programs based on 8.2 or older 
versions are used in higher versions of 8.x and contain C_DIS, this 

can be retained and does not have to be changed to C_SPL.
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Explanation of 

the syntax

Example  (>>>  "Example" Page 380)

11.6.7 System variables for WITH

Spline block, 

individual spline 

motion

For spline blocks and individual spline motions, it is possible to write to the fol-
lowing system variables using the WITH line:

$ACC

$ACC_AXIS

$ACC_EXTAX

$APO

$BASE

$CIRC_TYPE

Element Description

End point Type: AXIS, E6AXIS, POS, E6POS, FRAME

The end point can be specified in Cartesian or axis-specific 
coordinates. The controller interprets the coordinates as 
relative to the end point of the previous block.

If not all components of the end point are specified, the 
controller sets the value of the missing components to 0. In 
other words, the absolute values of these components 
remain unchanged.

Specifications of Status and Turn, if present, are taken into 
consideration by the controller. (This is in contrast to 
SLIN_REL, SCIRC_REL and SPL_REL where they are 
ignored!)

SysVar  (>>> 11.6.7 "System variables for WITH" Page 382)

Value Value assignment to the system variable.

In the case of SPTP segments: The assignment applies 
only for this segment. 

The system variables can also be assigned values by 
means of a function call. The same restrictions apply to 
these functions as to functions in the trigger.

 (>>> 11.11.3 "Constraints for functions in the trigger" 
Page 431)

C_SPL  With C_SPL: the end point is approximated. $APO de-
fines the earliest point at which the approximate posi-
tioning can begin.

Only possible for individual motions, not for segments.

 Without C_SPL: the motion stops exactly at the end 
point.

#BASE, 
#TOOL

Only permissible if the end point was specified in Cartesian 
coordinates.

 #BASE (default): The coordinates of this end point refer 
to the coordinate system that belongs to the physical 
base.

 #TOOL: The coordinates of this end point refer to the 
coordinate system that belongs to the physical tool.

$IPO_MODE has no influence on the meaning of #BASE 
and #TOOL.
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$ECO_LEVEL

$GEAR_JERK

$IPO_MODE

$JERK

$LOAD

$ORI_TYPE

$ROTSYS

$SPL_ORI_JOINT_AUTO

$SYNC_ID

$SYNC_LIST

$TOOL

$VEL

$VEL_AXIS

$VEL_EXTAX

Additionally for SCIRC and SLIN: $CIRC_MODE

Spline segment For spline segments, it is possible to write to the following system variables us-
ing the WITH line:

$ACC

$ACC_AXIS

$ACC_EXTAX

$CIRC_TYPE

$EX_AX_IGNORE

$GEAR_JERK

$JERK

$ORI_TYPE

$ROTSYS

$SYNC_ID

$VEL

$VEL_AXIS

$VEL_EXTAX

Additionally for SCIRC and SLIN: $CIRC_MODE

11.6.8 TIME_BLOCK

Description TIME_BLOCK can be used in CP and PTP spline blocks.

TIME_BLOCK can be used to execute the spline block or part of one in a de-
fined time. It is also possible to allocate time components to areas of 
TIME_BLOCK.

Points can be modified in, added to or removed from the spline block without 
changing the time specifications. This enables the user to correct the Carte-
sian path and retain the existing timing.

A spline block may include 1 time block, i.e. 1 statement of the type 
TIME_BLOCK START … TIME_BLOCK END. This, in turn, may contain any 
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number of TIME_BLOCK PART statements. The time block may only be used 
in spline blocks.

A CP spline block can contain either 1 time block or 1 constant velocity range, 
but not both.

Syntax SPLINE

<Spline segments…>

…

TIME_BLOCK START

Spline segment

<Spline segments…>

...

< <TIME_BLOCK PART = Component_1>

…

Spline segment

<Spline segments…>

...

TIME_BLOCK PART = Component_N>

TIME_BLOCK END = Overall time

<Spline segments…>

…

ENDSPLINE

Explanation of 

the syntax

It is not essential for there to be spline segments before TIME_BLOCK START 
and after TIME_BLOCK END. It is nonetheless advisable to program as fol-
lows:

 There is at least 1 spline segment between SPLINE and TIME_BLOCK 
START.

 There is at least 1 spline segment between TIME_BLOCK END and END-
SPLINE.

Advantages:

 The programmed overall time is maintained exactly even in the case of ap-
proximate positioning.

 Segments before TIME_BLOCK START make it possible to accelerate to 
the required velocity.
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Example

Element Description

Component Type: INT or REAL; constant, variable or function

Desired component of Overall time for the following dis-
tance:

 From the point before TIME_BLOCK 
PART=Previous_component

to the point before TIME_BLOCK PART=Component

 If Previous_component does not exist:

From the point before TIME_BLOCK START 

to the point before TIME_BLOCK PART=Component

“Desired component” means: the components are main-
tained as accurately as possible by the robot controller. 
Generally, however, they are not maintained exactly. 

The user can assign the components in such a way that 
they add up to 100. The components can then be consid-
ered as percentages of Overall time.

The components do not have to add up to 100, however, 
and can have any sum! The robot controller always 
equates the sum of the components to Overall time. This 
allows the components to be used very flexibly and also 
changed.

If components are assigned, there must always be a 
TIME_BLOCK PART directly before TIME_BLOCK END. 
There must be no segments in between.

Overall time Type: INT or REAL; constant, variable or function; unit: s

Time in which the following distance is traveled:

 From the point before TIME_BLOCK START 
to the point before TIME_BLOCK END

The value must be greater than 0. The overall time is main-
tained exactly. If this time cannot be maintained, e.g. 
because too short a time has been programmed, the robot 
executes the motion in the fastest possible time. In T1 and 
T2, a message is also displayed.

If the value for Component or Overall time is assigned via a function, the 
same restrictions apply as for the functions in the trigger.
 (>>> 11.11.3 "Constraints for functions in the trigger" Page 431)

SPLINE

  SLIN P1 

  SPL P2

  TIME_BLOCK START

    SLIN P3

  TIME_BLOCK PART = 12.7

    SPL P4

    SPL P5

    SPL P6

  TIME_BLOCK PART = 56.4

    SCIRC P7, P8

    SPL P9

  TIME_BLOCK PART = 27.8

  TIME_BLOCK END = 3.9

  SLIN P10

ENDSPLINE
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Points P2 to P9 are executed exactly in the programmed time of 3.9 s. The ro-
bot controller equates the overall time of 3.9 s to the sum of all components, 
i.e. 96.9.

Block selection Whether or not the robot controller plans the time block depends on the line to 
which a block selection is carried out.

If the robot controller does not plan the time block, it generates the following 
message: Time block ignored due to BCO run.

$PATHTIME The data of the time-based spline can be read via the system variable $PATH-
TIME. $PATHTIME is filled with the data as soon as the robot controller has 
completed the planning of the spline block. The data are retained until the next 
spline block has been planned.

$PATHTIME is a structure and consists of the following components:

11.6.9 CONST_VEL

Description CONST_VEL is used to define constant velocity ranges. CONST_VEL can 
only be used in CP spline blocks.

There must be at least 1 spline segment between CONST_VEL END and 
ENDSPLINE.

Distance Time assigned by the robot controller to the distance

P2 … P3 12.7 components of 3.9 s = 0.51 s

P3 … P6 56.4 components of 3.9 s = 2.27 s

P6 … P9 27.8 components of 3.9 s = 1.12 s

Block selection to the line ... Time block is planned?

in the spline block before 
TIME_BLOCK START

Yes

TIME_BLOCK START No

The spline block is executed as if 
there were no TIME_BLOCK state-
ments present.

in the time block

TIME_BLOCK END

in the spline block after 
TIME_BLOCK END

Component Description

REAL $PATHTIME.TOTAL Time actually required for the entire 
spline block (s)

REAL $PATHTIME.SCHEDULED Overall time planned for the time 
block (s)

REAL $PATHTIME.PRO-
GRAMMED

Overall time programmed for the 
time block (s)

INT $PATHTIME.N_SECTIONS Number N of TIME_BLOCK_PART 
lines

REAL $PATHTIME.MAX_DEV Maximum deviation of all 
TIME_BLOCK_PARTs between the 
programmed time and the planned 
time (%)

INT $PATH-
TIME.MAX_DEV_SECTION

Number of the 
TIME_BLOCK_PART with the 
greatest deviation between the pro-
grammed time and the planned 
time
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A CP spline block can contain either 1 CONST_VEL or 1 TIME_BLOCK, but 
not both.

Syntax CONST_VEL START = Offset <ONSTART>

<Spline segments…>

...

CONST_VEL END =  Offset <ONSTART>

Explanation of 

the syntax

Example Here, the constant velocity range extends over several segments with different 
programmed velocities. In this case, the lowest of the velocities, i.e. 0.2 m/s, 
is valid for the whole range. 

Further information about the constant velocity ranges can be found 
in this documentation.
 (>>> 10.3.6 "Constant velocity range in the CP spline block" 

Page 335)

Element Description

ONSTART Reference point of the statement

 With ONSTART: Start point

 Without ONSTART: End point

If the start or end point is approximated, the reference point 
is generated in the same way as for homogenous approxi-
mate positioning with the PATH trigger. 

 (>>> 11.11.2.2 "Reference point for homogenous approxi-
mate positioning" Page 429)

Offset Type: INT or REAL; constant, variable or function; unit: mm

The start of the range can be shifted in space by means of 
CONST_VEL START = Offset.

The end of the range can be shifted in space by means of 
CONST_VEL END = Offset.

 Positive value: Offset towards the end of the motion

 Negative value: Offset towards the start of the motion

The point to which the offset refers depends on whether 
ONSTART is set or not. If no offset is desired, Offset=0 
must be programmed.

 (>>> 10.3.6.2 "Maximum limits" Page 337)

The value for Offset can be assigned using a function. The same re-
strictions apply as for the functions in the trigger.
 (>>> 11.11.3 "Constraints for functions in the trigger" Page 431)

1  PTP P0

2  SPLINE WITH $VEL.CP = 2.5

3   SLIN P1

4   CONST_VEL START = +100

5   SPL P2 WITH $VEL.CP = 0.5

6   SLIN P3 WITH $VEL.CP = 0.2

7   SPL P4 WITH $VEL.CP = 0.4

8   CONST_VEL END = -50

9   SCIRC P5, P6

10  SLIN P7

11 ENDSPLINE
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11.6.9.1 System variables for CONST_VEL

$STOP_CONST_

VEL_RED

If the maximum possible constant velocity in a constant velocity range is below 
the programmed velocity, the robot controller generates one of the following 
messages:

 In the CONST_VEL END range, instead of $VEL.CP={Setpoint $VEL.CP} 
m/s only {Velocity reached} m/s because line {Line of the limiting segment} 
reached.

 In CONST_VEL START instead of $VEL.CP={Setpoint $VEL.CP} m/s 
only {Velocity reached} m/s because line {Line of the limiting segment} 
reached.

 In CONST_VEL END instead of $VEL.CP={Setpoint $VEL.CP} m/s only 
{Velocity reached} m/s because line {Line of the limiting segment} 
reached.

For operating modes T1/T2, it is possible to configure whether these are noti-
fication messages or acknowledgement messages. This is carried out using 
the system variable $STOP_CONST_VEL_RED.

$STOP_CONST_VEL_RED is initialized with FALSE in the case of a cold start 
or program selection, but not if a program is reset.

$STOP_CONST_VEL_RED can be modified via the variable correction func-
tion or KRL.

$CONST_VEL $CONST_VEL specifies the velocity (mm/s) in the constant velocity range for 
the CP spline block that is currently being planned. The value remains valid 
until a different spline block with constant velocity range is planned. 

$CONST_VEL is write-protected. $CONST_VEL is invalid if one of the follow-
ing motions is currently being planned:

 CP spline block without constant velocity range

 PTP spline block

 Individual spline motion

 PTP, LIN, CIRC

$CONST_VEL_C $CONST_VEL_C corresponds to $CONST_VEL, but with the difference that 
$CONST_VEL_C refers to the CP spline block that is currently being execut-
ed.

Possible practical use:

The value of $CONST_VEL can be written to a user-specific local variable for 
each constant velocity range. This provides an overview of the constant veloc-
ities that can be reached. The application can then be programmed according-
ly, e.g. the point in time at which a nozzle is to be opened, or similar.

Value Description

FALSE (default) Notification message

TRUE  Operating mode T1 or T2: 

Acknowledgement message

The robot stops. In the program, the block 
pointer indicates the spline segment that trig-
gered the stop. Program execution cannot be 
resumed until the operator has acknowl-
edged the message.

 Operating mode AUT or AUT EXT: 

Notification message
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11.6.10 STOP WHEN PATH

Description The operator can program a conditional stop with STOP WHEN PATH.

Positions The conditional stop can be used in the following positions:

 In the individual spline block

 In the spline block (CP and PTP)

There must be at least 1 segment between STOP WHEN PATH and END-
SPLINE.

 Before a spline block (CP and PTP)

STOP WHEN PATH refers to the spline block in this case. There may be 
statements between STOP WHEN PATH and the spline block, but no mo-
tion instructions. 

Syntax STOP WHEN PATH = Offset  <ONSTART> IF Condition

Explanation of 

the syntax

Further information about the conditional stop can be found in this 
documentation.
 (>>> 10.3.5 "Conditional stop" Page 332)

Element Description

ONSTART Reference point of the statement

 Without ONSTART: End point

 With ONSTART: Start point

If the reference point is approximated, the same rules 
apply as for the PATH trigger. 

 (>>> 11.11.2.1 "Reference point for approximate position-
ing – overview" Page 428)

Offset Type: INT or REAL; constant, variable or function; unit: mm

The stop point can be shifted in space by means of Offset.

 Positive value: Shift towards the end of the motion

 Negative value: Shift towards the start of the motion

The point to which the offset refers depends on whether 
ONSTART is set or not. If no offset is desired, Offset=0 
must be programmed.

There are limits to the distance the stop point can be offset. 
The same limits apply as for the PATH trigger.  (>>>  "Max. 
offset" Page 426)

Condition Type: BOOL

Stop condition. The following are permitted:

 a global Boolean variable

 a signal name

 a comparison

 a simple logic operation: NOT, OR, AND or EXOR

The value for Offset can be assigned using a function. The same re-
strictions apply as for the functions in the trigger.
 (>>> 11.11.3 "Constraints for functions in the trigger" Page 431)
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11.6.11 $EX_AX_IGNORE

Description $EX_AX_IGNORE can only be used in the WITH line of spline segments.

Each bit of $EX_AX_IGNORE corresponds to an external axis number. If a 
specific bit is set to 1, the robot controller ignores the taught or programmed 
position of this external axis at the end point of the segment. Instead, the robot 
controller calculates the optimal position for this point on the basis of the sur-
rounding external axis positions. 

In the program run modes MSTEP and ISTEP, the robot stops at the positions 
calculated by the robot controller.

In the case of a block selection to a point with “$EX_AX_IGNORE = Bit n = 1”, 
the robot adopts the position calculated by the robot controller.

“$EX_AX_IGNORE = Bit n = 1” is not allowed for the following segments:

 For the first segment in a spline block (only up to KUKA System Software 
8.2)

 For the last segment in a spline block

 In the case of successive segments with identical Cartesian end points, 
“$EX_AX_IGNORE = Bit n = 1” is not allowed for the first and last seg-
ments (only up to KUKA System Software 8.2).

From KUKA System Software 8.3 onwards: If $EX_AX_IGNORE is pro-
grammed for an SPTP segment and the affected external axis is mathemati-
cally coupled, the robot controller rejects $EX_AX_IGNORE, i.e. the taught or 
programmed position of that axis is taken into consideration. In T1/T2, the ro-
bot controller generates the following message: Reject $EX_AX_IGNORE in 
line {Block number} because {External axis number} is mathematically cou-
pled.

Syntax $EX_AX_IGNORE=Bit array

Explanation of 

the syntax

Example

For P3, the robot controller ignores the taught position of external axis E1.

Recommendation: Whenever no specific position of the external axis 
is required for a point, use $EX_AX_IGNORE and set the bit for that 
external axis to “1”. This reduces the cycle time.

Element Description

Bit array  Bit n = 1: Taught/programmed position of the external 
axis is ignored.

 Bit n = 0: Taught/programmed position of the external 
axis is taken into consideration.

Bit n 5 4 3 2 1 0

Axis E6 E5 E4 E3 E2 E1

SPLINE

  SPL P1

  SPL P2

  SLIN P3 WITH $EX_AX_IGNORE = 'B000001'

  SPL P4

ENDSPLINE
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11.7 Program execution control

11.7.1 CONTINUE

Description CONTINUE can be used to prevent an advance run stop that would otherwise 
occur in the following program line.

CONTINUE always applies to the following line, even if this is a blank line! Ex-
ception: If the following line contains the statement ON_ERROR_PROCEED, 
CONTINUE applies to the line after.

Syntax CONTINUE

Examples Preventing both advance run stops:

In this case, the outputs are set in the advance run. When exactly they are set 
cannot be foreseen.

ON_ERROR_PROCEED with CONTINUE:

The effect of both sequences of statements is identical. In both examples, 
ON_ERROR_PROCEED and CONTINUE act on $OUT[1]=TRUE.

11.7.2 EXIT

Description Exit from a loop. The program is then continued after the loop. EXIT may be 
used in any loop.

Syntax EXIT

Example The loop is exited when $IN[1] is set to TRUE. The program is then contin-
ued after ENDLOOP.

CONTINUE

$OUT[1]=TRUE

CONTINUE

$OUT[2]=FALSE

ON_ERROR_PROCEED

CONTINUE

$OUT[1]=TRUE

CONTINUE

ON_ERROR_PROCEED

$OUT[1]=TRUE

DEF EXIT_PROG() 

PTP HOME 

LOOP

   PTP POS_1

   PTP POS_2

   IF $IN[1] == TRUE THEN

      EXIT

   ENDIF 

   CIRC HELP_1, POS_3

   PTP POS_4

ENDLOOP

PTP HOME

END
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11.7.3 FOR ... TO ... ENDFOR

Description A statement block is repeated until a counter exceeds or falls below a defined 
value.

After the last execution of the statement block, the program is resumed with 
the first statement after ENDFOR. The loop execution can be exited prema-
turely with EXIT.

Loops can be nested. In the case of nested loops, the outer loop is executed 
completely first. The inner loop is then executed completely.

Syntax FOR Counter = Start TO End <STEP Increment>

<Statements>

ENDFOR

Explanation of 

the syntax

Example The variable B is incremented by 1 after each of 5 times the loop is executed.

11.7.4 GOTO

Description Unconditional jump to a specified position in the program. Program execution 
is resumed at this position.

The destination must be in the same subprogram or function as the GOTO 
statement.

The following jumps are not possible:

 Into an IF statement from outside.

Element Description

Counter Type: INT

Variable that counts the number of times the loop has been 
executed. The preset value is Start. The variable must first 
be declared. 

The value of Counter can be used in statements inside and 
outside of the loop. Once the loop has been exited, Counter 
retains its most recent value.

Start; End Type: INT

Counter must be preset to the value Start. Each time the 
loop is executed, the value of Counter is automatically 
increased by the increment. If the value exceeds or falls 
below the End value, the loop is terminated.

Increment Type: INT

Value by which Counter is changed every time the loop is 
executed The value may be negative. Default value: 1. 

 Positive value: the loop is ended if Counter is greater 
than End.

 Negative value: the loop is ended if Counter is less than 
End.

The value may not be either zero or a variable.

INT A

... 

FOR A=1 TO 10 STEP 2

   B=B+1 

ENDFOR
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 Into a loop from outside.

 From one CASE statement to another CASE statement.

Syntax GOTO Label

... 

Label:

Explanation of 

the syntax

Example 1 Unconditional jump to the program position GLUESTOP.

Example 2 Unconditional jump from an IF statement to the program position END.

11.7.5 HALT

Description Stops the program. The last motion instruction to be executed will, however, 
be completed.

Execution of the program can only be resumed using the Start key. The next 
instruction after HALT is then executed.

In an interrupt program, program execution is only stopped after the advance 
run has been completely executed.

Syntax HALT

11.7.6 IF ... THEN ... ENDIF

Description Conditional branch. Depending on a condition, either the first statement block 
(THEN block) or the second statement block (ELSE block) is executed. The 
program is then continued after ENDIF.

The ELSE block may be omitted. If the condition is not satisfied, the program 
is then continued at the position immediately after ENDIF.

There is no limit on the number of statements contained in the statement 
blocks. Several IF statements can be nested in each other.

Syntax IF Condition THEN

Statements

GOTO statements lead to a loss of structural clarity within a program. 
It is better to work with IF, SWITCH or a loop instead.

Element Description

Label Position to which a jump is made. At the destination posi-
tion, Label must be followed by a colon.

GOTO GLUESTOP

...

GLUESTOP:

IF X>100 THEN

   GOTO ENDE 

ELSE

   X=X+1 

ENDIF 

A=A*X 

... 

ENDE: 

END
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<ELSE

Statements>

ENDIF

Explanation of 

the syntax

Example 1 IF statement without ELSE

Example 2 IF statement with ELSE

11.7.7 LOOP ... ENDLOOP

Description Loop that endlessly repeats a statement block. The loop execution can be ex-
ited with EXIT.

Loops can be nested. In the case of nested loops, the outer loop is executed 
completely first. The inner loop is then executed completely.

Syntax LOOP

Statements

ENDLOOP

Example The loop is executed until input $IN[30] is set to true.

11.7.8 ON_ERROR_PROCEED

Description ON_ERROR_PROCEED can be used to suppress a runtime error message 
triggered by the following program line. The robot controller skips the state-
ment that triggers the error and fills the system variable $ERR with information 
about the error.

 (>>> 11.7.8.1 "$ERR" Page 395)

Messages about internal errors or system errors cannot be suppressed.

Element Description

Condition Type: BOOL

Possible:

 Variable of type BOOL

 Function of type BOOL

 Logic operation, e.g. a comparison, with a result of type 
BOOL

IF A==17 THEN

   B=1 

ENDIF

IF $IN[1]==TRUE THEN

   $OUT[17]=TRUE 

ELSE

   $OUT[17]=FALSE 

ENDIF

LOOP

   LIN P_1

   LIN P_2

   IF $IN[30]==TRUE THEN

      EXIT

   ENDIF 

ENDLOOP
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ON_ERROR_PROCEED always applies to the following line, even if this is a 
blank line! Exception: If the following line contains the statement CONTINUE, 
ON_ERROR_PROCEED applies to the line after.

If the line after ON_ERROR_PROCEED is a subprogram call, the statement 
then refers to the call itself, and not to the first line of the subprogram.

$ERR, 

ERR_RAISE()

$ERR and ERR_RAISE() are important tools when working with 
ON_ERROR_PROCEED.

The function ERR_RAISE() can subsequently generate a suppressed runtime 
error message. It can only process the system variable $ERR or a variable de-
rived from $ERR as an OUT parameter.

Limitations ON_ERROR_PROCEED has no effect on motion statements:

SPLINE/ENDPLINE; PTP_SPLINE/ENDSPLINE; PTP; LIN; CIRC; PTP_REL; 
LIN_REL; CIRC_REL; ASYPTP; ASYSTOP; ASYCONT; ASYCANCEL; 
MOVE_EMI

ON_ERROR_PROCEED has no effect on the following control structures:

FOR/ENDFOR; GOTO; IF/ELSE/ENDIF; LOOP/ENDLOOP; REPEAT/UNTIL; 
SKIP/ENDSKIP; SWITCH/CASE/DEFAULT/ENDSWITCH; WHILE/END-
WHILE

Syntax ON_ERROR_PROCEED

Examples  (>>> 11.7.8.2 "Examples of $ERR, ON_ERROR_PROCEED and 
ERR_RAISE()" Page 396)

ON_ERROR_PROCEED with CONTINUE:

The effect of both sequences of statements is identical. In both examples, 
ON_ERROR_PROCEED and CONTINUE act on $OUT[1]=TRUE.

11.7.8.1 $ERR

Description Structure with information about the current program

The variable can be used to evaluate the currently executed program relative 
to the advance run. For example, the variable can be used to evaluate errors 
in the program in order to be able to respond to them with a suitable fault ser-
vice function.

The variable is write-protected and can only be read.

$ERR exists separately for the robot and submit interpreters. Each interpreter 
can only access its own variable. $ERR does not exist for the command inter-
preter.

Each subprogram level has its own representation of $ERR. In this way, the 
information from one level does not overwrite the information from different 
levels and information can be read from different levels simultaneously. 

ON_ERROR_PROCEED implicitly deletes the information from $ERR in the 
current interpreter and at the current level.

 (>>> 11.7.8.2 "Examples of $ERR, ON_ERROR_PROCEED and 
ERR_RAISE()" Page 396)

ON_ERROR_PROCEED

CONTINUE

$OUT[1]=TRUE

CONTINUE

ON_ERROR_PROCEED

$OUT[1]=TRUE
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Syntax $ERR=Information

Explanation of 

the syntax

Error_T STRUC Error_T INT number, PROG_INT_E interpreter, 
INT_TYP_E int_type, INT int_prio, line_nr, CHAR mo-
dule[24], up_name[24], TRIGGER_UP_TYPE trigger_type

11.7.8.2 Examples of $ERR, ON_ERROR_PROCEED and ERR_RAISE()

Example 1 If you do not wish to suppress all possible runtime error messages, but only 
specific ones, this distinction can be made using SWITCH … ENDSWITCH. In 

Element Description

Information Type: Error_T

List with information about the program currently being 
executed

Element Description

number Only in the event of a runtime error: Message number

If no error has occurred, the value zero is displayed.

interpreter Current interpreter

 #R_INT: Robot interpreter

 #S_INT: Submit interpreter

int_type Current program type and interrupt state

 #I_NORMAL: The program is not an interrupt program.

 #I_INTERRUPT: The program is an interrupt program.

 #I_STOP_INTERRUPT: Interrupt by means of 
$STOPMESS (error stop)

int_prio Priority of the interrupt

line_nr Only in the event of a runtime error: Number of the line that 
triggered the error

Note: The number does not generally correspond to the 
line number in the smartHMI program editor! In order to 
understand the numbering, open the program with a simple 
editor and do not count lines that start with “&”.

If no error has occurred, the value zero is displayed.

module[] Name of the current program

up_name[] Name of the current subprogram

trigger_type Context in which the trigger belonging to a subprogram 
was triggered

 #TRG_NONE: The subprogram is not a trigger subpro-
gram.

 #TRG_REGULAR: The trigger subprogram was 
switched during forward motion.

 #TRG_BACKWARD: The trigger subprogram was 
switched during backward motion.

 #TRG_RESTART: The trigger subprogram was 
switched on switching back to forward motion.

 #TRG_REPLAY: The trigger subprogram was switched 
repeatedly after backward motion.

Note: This component is available in KUKA System Soft-
ware 8.3 or higher.
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this example, only message 1422 is suppressed. Any other runtime error mes-
sages would be displayed.

Example 2 This example illustrates that each program level has its own representation of 
$ERR. 

 1  DEF myProg ()

 2  DECL E6POS myPos

 3  INI

 4  ON_ERROR_PROCEED

 5  myPos = $POS_INT

 6  SWITCH ($ERR.NUMBER)

 7    CASE 0

 8    CASE 1422

 9       ;program fault service function if required

         ...

10    DEFAULT

11       ERR_RAISE ($ERR)

12  ENDSWITCH

    ...

13  END

Line Description

4, 5 Line 5 triggers the message 1422 {$variable} value invalid (un-
less the program is called by an interrupt). 

ON_ERROR_PROCEED in the preceding line suppresses the 
error message.

6 … 12 Differentiation dependent on $ERR.NUMBER

7 If no error occurred in line 5, $ERR.NUMBER==0. In this case, 
no action is required.

8, 9 If message 1422 has been triggered, $ERR.NUMBER==1422. 
If required, a fault service function can be programmed.

10, 11 If a message other than 1422 was triggered, this message is 
now (subsequently) generated via ERR_RAISE.

 1  DEF myMainProg ()

 2  INT myVar, myVar2

 3  INI

 4  ON_ERROR_PROCEED

 5  mySubProg (myVar)

 6  HALT

 7  myVar2 = 7

 8  mySubProg (myVar2)

 9  END

---------------------------------------

10  DEF mySubProg (myTest:IN)

11  INT myTest

12  HALT

13  END
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Example 3 This example also shows that each program level has its own representation 
of $ERR. It also shows how the $ERR information can be transferred to a dif-
ferent level. 

Line Description

4, 5 Line 5 triggers the message 1422 {$variable} value invalid be-
cause myVar is not initialized and can thus not be transferred 
to a subprogram. 

ON_ERROR_PROCEED in the preceding line suppresses the 
error message.

6 If $ERR is read here using the variable correction function, the 
following components have the following values:

$ERR.number == 1422

$ERR.line_nr == 15

$ERR.module[] == "MYMAINPROG"

$ERR.up_name[] == "MYMAINPROG"

12 If $ERR is read here in the subprogram using the variable cor-
rection function, the following components have the following 
values:

$ERR.number == 0

$ERR.line_nr == 0

$ERR.module[] == "MYMAINPROG"

$ERR.up_name[] == "MYSUBPROG"

This clearly indicates that $ERR always has the information 
from the current level, i.e. from the subprogram MySubProg in 
this case. The information from MyMainProg, on the other 
hand, is unknown.

 1  DEF myMainProg2 ()

 2  INI

 3  ON_ERROR_PROCEED

 4  $OUT[-10] = TRUE

 5  myHandleErr ($ERR, $ERR)

 6  END

---------------------------------------

 7  DEF myHandleErr (inErr:IN, outErr:OUT)

 8  DECL Error_T inErr, outErr

 9  ON_ERROR_PROCEED

10  $OV_PRO=100/0

11  ERR_RAISE($ERR)

12  ERR_RAISE(outErr)

13  ERR_RAISE(inErr)

    ...

14  END

Line Description

3, 4 Line 4 triggers the message 1444 Array index inadmissible.

ON_ERROR_PROCEED in the preceding line suppresses the 
error message.

5, 7 The contents of $ERR are transferred to a subprogram twice: 
once as an IN parameter and once as an OUT parameter.
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Example 4 $ERR can be used not only for error treatment, but also to determine the cur-
rent surroundings. 

In this example, a parameter is transferred to a subprogram from both a robot 
program and a submit program. In the subprogram, the system determines 
which interpreter the parameter came from. The action that is carried out de-
pends on the result.

Robot program:

Submit program:

Subprogram:

11.7.9 REPEAT ... UNTIL

Description Non-rejecting loop. Loop that is repeated until a certain condition is fulfilled.

9, 10 Line 10 triggers the message 1451 Division by 0.

ON_ERROR_PROCEED in the preceding line suppresses the 
error message.

11 ERR_RAISE($ERR) generates the message from line 10, and 
not that from line 4. 

$ERR always has the information from the current level, i.e. 
from the subprogram myHandleErr in this case.

12 ERR_RAISE(outErr) generates the message from line 4 of the 
main program, as outErr is a reference to $ERR in the main 
program.

13 ERR_RAISE(inErr) is not permissible and thus triggers the 
message 1451 {(Variable name)} invalid argument. 

ERR_RAISE can only process $ERR or an OUT variable de-
rived from $ERR.

Line Description

  DEF Main ()

  ...

  mySUB (55)

  ...

  END

  DEF SPS ()

  ...

  LOOP

     mySUB (33)

     ...

  ENDLOOP

  ...

  END

  GLOBAL DEF mySUB (par:IN)

  INT par

  INI

  IF ($ERR.INTERPRETER==#R_INT) THEN

     $OUT_C[par] = TRUE

     ELSE

     $OUT[par] = TRUE

  ENDIF

  ...

  END
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The statement block is executed at least once. The condition is checked after 
each loop execution. If the condition is met, program execution is resumed at 
the first statement after the UNTIL line.

Loops can be nested. In the case of nested loops, the outer loop is executed 
completely first. The inner loop is then executed completely.

Syntax REPEAT

Statements

UNTIL Termination condition

Explanation of 

the syntax

Example 1 The loop is to be executed until $IN[1] is true.

Example 2 The loop is executed once, even though the termination condition is already 
fulfilled before the loop execution, because the termination condition is not 
checked until the end of the loop. After execution of the loop, R has the value 
102.

11.7.10 SWITCH ... CASE ... ENDSWITCH

Description Selects one of several possible statement blocks, according to a selection cri-
terion. Every statement block has at least one identifier. The block whose iden-
tifier matches the selection criterion is selected.

Once the block has been executed, the program is resumed after END-
SWITCH.

If no identifier agrees with the selection criterion, the DEFAULT block is exe-
cuted. If there is no DEFAULT block, no block is executed and the program is 
resumed after ENDSWITCH.

The SWITCH statement cannot be prematurely exited using EXIT.

Syntax SWITCH Selection criterion

CASE Identifier1 <,Identifier2,...>

Statement block

<CASE IdentifierM <,IdentifierN,...> 

Statement block >

<DEFAULT 

Element Description

Termination 
condition

Type: BOOL

Possible:

  Variable of type BOOL

  Function of type BOOL

 Logic operation, e.g. a comparison, with a result of type 
BOOL

R=1

REPEAT

   R=R+1

UNTIL $IN[1]==TRUE

R=101 

REPEAT

   R=R+1 

UNTIL R>100
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Default statement block>

 ENDSWITCH

There must be no blank line or comment between the SWITCH line and the 
first CASE line. DEFAULT may only occur once in a SWITCH statement.

Explanation of 

the syntax

Example 1 Selection criterion and identifier are of type INT. 

Example 2 Selection criterion and identifier are of type CHAR. The statement SP_5() is 
never executed here because the identifier C has already been used.

11.7.11 WAIT FOR …

Description WAIT FOR stops the program until a specific condition is fulfilled. Program ex-
ecution is then resumed. 

WAIT FOR triggers an advance run stop.

Syntax WAIT FOR Condition

Element Description

Selection cri-
terion

Type: INT, CHAR, ENUM

This can be a variable, a function call or an expression of 
the specified data type.

Identifier Type: INT, CHAR, ENUM

The data type of the identifier must match the data type of 
the selection criterion.

A statement block can have any number of identifiers. Mul-
tiple block identifiers must be separated from each other by 
a comma.

INT VERSION 

... 

SWITCH VERSION

   CASE 1

      UP_1()

   CASE 2,3

      UP_2()

      UP_3()

      UP_3A()

   DEFAULT

      ERROR_UP() 

ENDSWITCH

SWITCH NAME

   CASE "A"

      UP_1()

   CASE "B","C"

      UP_2()

      UP_3()

   CASE "C"

      UP_5() 

ENDSWITCH

If, due to incorrect formulation, the expression can never take the val-
ue TRUE, the compiler does not recognize this. In this case, execu-
tion of the program will be permanently halted because the program 

is waiting for a condition that cannot be fulfilled.
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Explanation of 

the syntax

Examples Interruption of program execution until $IN[17] is TRUE:

Interruption of program execution until BIT1 is FALSE:

11.7.12 WAIT SEC …

Description Halts execution of the program and continues it after a wait time. The wait time 
is specified in seconds.

WAIT SEC triggers an advance run stop.

Syntax WAIT SEC Wait time

Explanation of 

the syntax

Example Interruption of program execution for 17.156 seconds:

Interruption of program execution in accordance with the variable value of 
V_WAIT in seconds:

11.7.13 WHILE ... ENDWHILE

Description Rejecting loop. Loop that is repeated as long as a certain condition is fulfilled.

If the condition is not met, program execution is resumed at the first statement 
after the ENDWHILE line. The condition is checked before each loop execu-
tion. If the condition is not already fulfilled beforehand, the statement block is 
not executed.

Loops can be nested. In the case of nested loops, the outer loop is executed 
completely first. The inner loop is then executed completely.

Syntax WHILE Repetition condition

Statement block

ENDWHILE

Element Description

Condition Type: BOOL

Condition, the fulfillment of which allows program execu-
tion to be resumed.

 If the condition is FALSE, program execution is stopped 
until the condition is TRUE.

 If the condition is already TRUE when WAIT is called, 
program execution is not halted.

WAIT FOR $IN[17]

WAIT FOR BIT1==FALSE

Element Description

Wait time Type: INT, REAL

Number of seconds for which program execution is to be 
interrupted. If the value is negative, the program does not 
wait. With small wait times, the accuracy is determined by 
a multiple of 12 ms.

WAIT SEC 17.156

WAIT SEC V_ZEIT
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Explanation of 

the syntax

Example 1 The loop is executed 99 times. After execution of the loop, W has the value 100.

Example 2 The loop is executed as long as $IN[1] is true.

11.8 Inputs/outputs

11.8.1 ANIN

Description Cyclical reading (every 12 ms) of an analog input. ANIN triggers an advance 
run stop.

The robot controller has 32 analog inputs ($ANIN[1] … $ANIN[32]).

 A maximum of three ANIN ON statements can be used at the same time.

 A maximum of two ANIN ON statements can use the same variable Value 
or access the same analog input.

 All of the variables used in an ANIN statement must be declared in data 
lists (locally or in $CONFIG.DAT).

$ANIN[…] indicates the input voltage, adapted to the range between -1.0 and 
+1.0. The actual voltage depends on the settings of the analog module.

Syntax Starting cyclical reading:

ANIN ON Value = Factor * Signal name * <±Offset>

Ending cyclical reading:

ANIN OFF Signal name

Explanation of 

the syntax

Element Description

Repetition 
condition

Type: BOOL

Possible:

 Variable of type BOOL

 Function of type BOOL

 Logic operation, e.g. a comparison, with a result of type 
BOOL

W=1 

WHILE W<100

   W=W+1 

ENDWHILE

WHILE $IN[1]==TRUE

   W=W+1 

ENDWHILE

Element Description

Value Type: REAL

The result of the cyclical reading is stored in Value. Value 
can be a variable or a signal name for an output.

Factor Type: REAL

Any factor. It can be a constant, variable or signal name.
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Example In this example, the program override (= system variable $OV_PRO) is de-
fined by means of the analog input $ANIN[1].

$ANIN[1] must first be linked to a freely selected signal name, in this case 
SIGNAL_1, in the declaration section.

The cyclical scanning of SIGNAL_1 is ended using the ANIN OFF statement. 

11.8.2 ANOUT

Description Cyclical writing (every 12 ms) to an analog output. ANOUT triggers an ad-
vance run stop.

The robot controller has 32 analog outputs ($ANOUT[1] … $ANOUT[32]).

 A maximum of four ANOUT ON statements can be used at the same time.

 All of the variables used in an ANOUT statement must be declared in data 
lists (locally or in $CONFIG.DAT).

$ANOUT[…] can have values from -1.0 to +1.0 written to it. The voltage actu-
ally generated depends on the settings of the analog module. If an attempt is 
made to set voltages outside the range of values, the robot controller displays 
the following message: Limit {Signal name}

Syntax Starting cyclical writing:

ANOUT ON Signal name = Factor * Control element <±Offset> <DELAY = 
±Time> <MINIMUM = Minimum value> <MAXIMUM = Maximum value>

Ending cyclical writing:

ANOUT OFF Signal name

Explanation of 

the syntax

Signal name Type: REAL

Specifies the analog input. Signal name must first have been 
declared with SIGNAL . It is not possible to specify the ana-
log input $ANIN[x] directly instead of the signal name.

Offset Type: REAL

It can be a constant, variable or signal name.

Element Description

SIGNAL SIGNAL_1 $ANIN[1]

... 

ANIN ON $OV_PRO = 1.0 * SIGNAL_1

ANIN OFF SIGNAL_1

Element Description

Signal name Type: REAL

Specifies the analog output. Signal name must first have 
been declared with SIGNAL . It is not possible to specify 
the analog output $ANOUT[x] directly instead of the signal 
name.

Factor Type: REAL

Any factor. It can be a constant, variable or signal name.

Control 
element

Type: REAL

It can be a constant, variable or signal name.

Offset Type: REAL

It can be a constant, variable or signal name.
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Example In this example, the output $ANOUT[5] controls the adhesive output.

A freely selected name, in this case GLUE, is assigned to the analog output in 
the declaration section. The amount of adhesive is to be dependent on the cur-
rent path velocity (= system variable $VEL_ACT). Furthermore, the output sig-
nal is to be generated 0.5 seconds early. The minimum voltage is to be 3 V. 
(The voltage of the module used ranges from +10 V to -10 V.)

The cyclical analog output is ended by using ANOUT OFF:

11.8.3 PULSE

Description Sets a pulse. The output is set to a defined level for a specified duration. The 
output is then reset automatically by the system. The output is set and reset 
irrespective of the previous level of the output.

At any one time, pulses may be set at a maximum of 16 outputs.

If PULSE is programmed before the first motion block, the pulse duration also 
elapses if the Start key is released again and the robot has not yet reached the 
BCO position.

The PULSE statement triggers an advance run stop. It is only executed con-
currently with robot motion if it is used in a TRIGGER statement.

Syntax PULSE (Signal, Level, Pulse duration)

Time Type: REAL

Unit: seconds. By using the keyword DELAY and entering a 
positive or negative amount of time, the output signal can 
be delayed (+) or set early (-).

Minimum 
value, 
Maximum 
value

Type: REAL

Minimum and/or maximum value to be present at the out-
put. The actual value does not fall below/exceed these val-
ues, even if the calculated values fall outside this range.

Permissible values: -1.0 to +1.0

It can be a constant, variable, structure component or array 
element. The minimum value must always be less than the 
maximum value. The sequence of the keywords MINIMUM 
and MAXIMUM must be observed.

Element Description

SIGNAL GLUE $ANOUT[5]

... 

ANOUT ON GLUE = 0.5 * $VEL_ACT DELAY=-0.5 MINIMUM=0.30

ANOUT OFF GLUE

The pulse is not terminated in the event of an EMERGENCY STOP, 
an operator stop or an error stop!
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Explanation of 

the syntax

$OUT+PULSE If an output is already set before the pulse, it will be reset by the falling edge 
of the pulse.

$OUT[50] = TRUE
PULSE($OUT[50],TRUE,0.5)

Actual pulse characteristic at output 50:

If a negative pulse is applied to an output that is set to Low, the output remains 
Low until the end of the pulse and is then set to High:

$OUT[50] = FALSE
PULSE($OUT[50],FALSE,0.5) 

Actual pulse characteristic at output 50:

PULSE+$OUT If the same output is set during the pulse duration, it will be reset by the falling 
edge of the pulse.

PULSE($OUT[50],TRUE,0.5) 
$OUT[50] = TRUE

Actual pulse characteristic at output 50:

Element Description

Signal Type: BOOL

Output to which the pulse is to be fed. The following are 
permitted:

 OUT[No]

 Signal variable 

Level Type: BOOL

Logic expression:

 TRUE represents a positive pulse (high).

 FALSE represents a negative pulse (low).

Pulse dura-
tion

Type: REAL

Range of values: 0.1 to 3.0 seconds. Pulse durations out-
side this range trigger a program stop.

Pulse interval: 0.1 seconds, i.e. the pulse duration is 
rounded up or down. The PULSE statement is executed in 
the controller at the low-priority clock rate. This results in a 
tolerance in the order of the pulse interval (0.1 seconds). 
The time deviation is about 1% - 2% on average. The devi-
ation is about 13% for very short pulses.

Fig. 11-1: $OUT+PULSE, example 1

Fig. 11-2: $OUT+PULSE, example 2
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If the output is reset during the pulse duration, the pulse duration is reduced 
accordingly:

PULSE($OUT[50],TRUE,0.5)
$OUT[50] = FALSE

Actual pulse characteristic at output 50:

If an output is set to FALSE during a pulse and then back to TRUE, the pulse 
is interrupted and then resumed when the output is set to TRUE. The overall 
duration from the first rising edge to the last falling edge (i.e. including the du-
ration of the interruption) corresponds to the duration specified in the PULSE 
statement.

PULSE($OUT[50],TRUE,0.8)
$OUT[50]=FALSE
$OUT[50]=TRUE

Actual pulse characteristic at output 50:

The actual pulse characteristic is only specified as above if $OUT[x]=TRUE is 
set during the pulse. If $OUT[x]=TRUE is not set until after the pulse (see line 
3), then the actual pulse characteristic is as follows (line 4):

PULSE+PULSE If several PULSE statements overlap, it is always the last PULSE statement 
that determines the end of the overall pulse duration.

Fig. 11-3: PULSE+$OUT, example 1

Fig. 11-4: PULSE+$OUT, example 2

Fig. 11-5: PULSE+$OUT, example 3

Fig. 11-6: PULSE+$OUT, example 4
407 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



408 / 491

KUKA System Software 8.3
If a pulse is activated again before the falling edge, the duration of the second 
pulse starts at this moment. The overall pulse duration is thus shorter than the 
sum of the values of the first and second pulses:

PULSE($OUT[50],TRUE,0.5)
PULSE($OUT[50],TRUE,0.5)

Actual pulse characteristic at output 50:

If, during the pulse duration of a positive pulse, a negative pulse is sent to the 
same output, only the second pulse is taken into consideration from this mo-
ment onwards:

PULSE($OUT[50],TRUE,0.5)
PULSE($OUT[50],FALSE,0.5)

Actual pulse characteristic at output 50:

PULSE($OUT[50],TRUE,3.0)
PULSE($OUT[50],FALSE,1.0)

Actual pulse characteristic at output 50:

PULSE+END If a pulse is programmed before the END statement, the duration of program 
execution is increased accordingly.

PULSE($OUT[50],TRUE,0.8)
END

Program active 

Actual pulse characteristic at output 50:

Fig. 11-7: PULSE+PULSE, example 1

Fig. 11-8: PULSE+PULSE, example 2

Fig. 11-9: PULSE+PULSE, example 3

Fig. 11-10:  PULSE+END, example
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PULSE+RESET/

CANCEL

If program execution is reset (RESET) or aborted (CANCEL) while a pulse is 
active, the pulse is immediately reset:

PULSE($OUT[50],TRUE,0.8)
RESET or CANCEL

Actual pulse characteristic at output 50:

11.8.4 SIGNAL

Description SIGNAL links predefined signal variables for inputs or outputs with a name. 

Such a link, i.e. a SIGNAL declaration, is required in order to be able to ad-
dress an analog input or output. An input or output may appear in several SIG-
NAL declarations. 

The user can declare signals in the following files:

 In DAT files, in the section EXTERNAL DECLARATIONS

 In SRC files, in the declaration section

 In $CONFIG.DAT, in the section USER GLOBALS

There are also SIGNAL declarations that are predefined in the system. They 
can be found in the file $machine.DAT in the directory KRC:\STEU\MADA. 
These declarations can be deactivated in $machine.DAT using the keyword 
FALSE.

Syntax Declaration of signal names for inputs and outputs:

<GLOBAL> SIGNAL Signal name Signal variable <TO Signal variable>

Deactivation of a predefined SIGNAL declaration:

SIGNAL System signal name FALSE

Explanation of 

the syntax

Fig. 11-11:  PULSE+RESET, example

Element Description

GLOBAL Only possible for signals defined in a DAT file.

 (>>> 11.3.4 "Areas of validity" Page 362)

Signal name Any name

Signal 
variable

Predefined signal variable. The following types are avail-
able:

 $IN[x]

 $OUT[x]

 $ANIN[x]

 $ANOUT[x]

TO Groups together several consecutive binary inputs or out-
puts (max. 32) to form a digital input or output. The com-
bined signals can be addressed with a decimal name, a 
hexadecimal name (prefix H) or with a bit pattern name 
(prefix B). They can also be processed with Boolean oper-
ators. 
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Example 1 The output $OUT[7] is assigned the name START_PROCESS. The output 
$OUT[7] is set.

Example 2 The outputs $OUT[1] to $OUT[8] are combined to form one digital output un-
der the name OUTWORT. The outputs $OUT[3], $OUT[4], $OUT[5] and 
$OUT[7] are set.

11.9 Subprograms and functions

11.9.1 Calling a subprogram

Description Subprograms are programs which are accessed by means of branches from 
the main program. Once the subprogram has been executed, the main pro-
gram is resumed from the line directly after the subprogram call.

 Local subprograms are contained in the same SRC file as the main pro-
gram. They can be made to be recognized globally using the keyword 
GLOBAL.

 Global subprograms are programs with a separate SRC file of their own, 
which is accessed from another program by means of a branch.

A subprogram is called in the main program by specifying the name of the sub-
program followed by round brackets. 

Example In the following example, the subprogram my_subprogram is called:

11.9.2 Calling a function

Description A function is a subprogram that returns a certain value to the main program. 
Functions have a data type. 

A function is called in a similar way to a subprogram: specify the name of the 
function in the main program followed by round brackets. A function call can 
never stand alone, however; instead, the value must constantly be assigned 
to a variable of the same data type.

Example Examples of calls from the main program:

System signal 
name

Signal name predefined in the system, e.g. $T1.

FALSE Deactivates a SIGNAL declaration predefined in the sys-
tem. The inputs or outputs to which the SIGNAL declara-
tion refers are thus available again for other purposes.

FALSE is not a Boolean value here, but a keyword. The 
option TRUE is not available. If the SIGNAL declaration 
that has been deactivated by means of FALSE is to be 
reactivated, the program line containing the entry FALSE 
must be deleted.

Element Description

SIGNAL START_PROCESS $OUT[7]

START_PROCESS = TRUE

SIGNAL OUTWORT $OUT[1] TO $OUT[8] 

OUTWORT = 'B01011100'

my_subprogram()

REALVAR = REALFUNCTION()
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11.9.3 DEFFCT ... ENDFCT

Description This syntax describes the structure of a function.

Syntax DEFFCT Data type Name(<Variable:IN |OUT>)

<Statements>

RETURN Function value

ENDFCT

Explanation of 

the syntax

Example  (>>> 11.9.4 "RETURN" Page 411)

11.9.4 RETURN

Description Jump from a subprogram or function back to the program from which the sub-
program or function was called.

Subprograms

RETURN can be used to return to the main program if a certain condition is 
met in the subprogram. No values from the subprogram can be transferred to 
the main program.

Functions

Functions must be ended by a RETURN statement containing the value that 
has been determined. The determined value is hereby transferred to the pro-
gram from which the function was called. 

Syntax For subprograms:

RETURN

For functions:

RETURN Function value

Explanation of 

the syntax

Example 1 Return from a subprogram to the program from which it was called, dependent 
on a condition.

INTVAR = 5 * INTFUNCTION() + 1

Element Description

Data type Data type of the function

Name Name of the function

Variable If a value is transferred in the function: name of the variable 
to which the value is transferred

 (>>> 11.9.5 "Transferring parameters to a subprogram or 
function" Page 412)

IN |OUT If a value is transferred in the function: type of transfer

Function 
value

 (>>> 11.9.4 "RETURN" Page 411)

Element Description

Function 
value

Type: The data type of Function value must match the data 
type of the function.

Function value is the value determined by the function. The 
value can be specified as a constant, a variable or an 
expression.
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Example 2 Return from a function to the program from which it was called. The value X is 
transferred.

11.9.5 Transferring parameters to a subprogram or function

Description Parameters can be transferred from a main program to local and global sub-
programs and functions.

There are 2 ways of transferring parameters:

 As IN parameters

The value of the variable remains unchanged in the main program.

This transfer type is also called “Call by Value”.

 As OUT parameters

The subprogram reads the value, modifies it and writes the new value 
back to the main program.

This transfer type is also called “Call by Reference”.

Example 1 Transferring parameters to a local subprogram:

DEF PROG_2()   

   ...

   IF $IN[5]==TRUE THEN

   RETURN 

   ...

END

DEFFCT INT CALCULATE(X:IN)

   INT X

   X=X*X

   RETURN X

ENDFCT

Recommendation: Always transfer a parameter to a variable of the 
same data type.
It is possible to transfer parameters to a different data type, but with 

certain restrictions.
 (>>> 11.9.6 "Transferring a parameter to a different data type" Page 416)

 1  DEF MY_PROG( )

 2  DECL REAL r,s

 3  ...

 4  CALC_1(r)

 5  ...

 6  CALC_2(s)

 7  ...

 8  END

_______________________________________

 9  DEF CALC_1(num1:IN)

10  DECL REAL num1

11  ...

12  END

_______________________________________

13  DEF CALC_2(num2:OUT)

14  DECL REAL num2

15  ...

16  END
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Example 2 Transferring parameters to a global function:

Main program MY_PROG( ):

What happens if the value is transferred as an IN parameter?

CALC() function with IN:

What happens if the value is transferred as an OUT parameter?

Line Description

4 The subprogram CALC_1 is called and the parameter “r” is 
transferred.

6 The subprogram CALC_2 is called and the parameter “s” is 
transferred.

9 num1: The name of the variable to which the value of “r” is 
transferred.

IN means: “r” is only transferred for reading.

10, 14 The variables to which values are transferred must be de-
clared.

13 num2: The name of the variable to which the value of “s” is 
transferred.

OUT means: “s” is transferred, modified and written back to the 
main program.

 1  DEF MY_PROG( )

 2  DECL REAL result, value

 3  value = 2.0

 4  result = CALC(value)

 5  ...

    ...

    END

Line Description

3 “value” is assigned the value “2.0”.

4 The function CALC is called and the value of “value” is trans-
ferred.

The return value of the function is assigned to the variable “re-
sult”.

 1  DEFFCT REAL CALC(num:IN)

 2  DECL REAL return_value, num

 3  num = num + 8.0

 4  return_value = num * 100.0

 5  RETURN(return_value)

 6  ENDFCT

Line Description

1 The value of “value” is transferred to “num” as an IN parame-
ter. The value is still 2.0.

3 The value of “num” is modified. The value is now 10.0.

4, 5 The value of “return_value” is calculated and returned to the 
variable “result” in the main program. The value is 1 000.0.

6 The function is terminated and execution of the main program 
is resumed from line 5.

Note: The value of “value” in the main program is unchanged: 
2.0.
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CALC() function with OUT:

Transferring 

multiple param-

eters

Transferring multiple parameters:

The sequence automatically determines which parameter is transferred to 
which parameter: The first parameter is transferred to the first parameter in the 
subprogram, the second to the second parameter in the subprogram, etc.

 1  DEFFCT REAL CALC(num:OUT)

 2  DECL REAL return_value, num

 3  num = num + 8.0

 4  return_value = num * 100.0

 5  RETURN(return_value)

 6  ENDFCT

Line Description

1 The value of “value” is transferred to “num” as an OUT param-
eter. The value is still 2.0.

3 The value of “num” is modified. The value is now 10.0.

4, 5 The value of “return_value” is calculated and returned to the 
variable “result” in the main program. The value is 1 000.0.

6 The function is terminated and execution of the main program 
is resumed from line 5.

Note: The value of “value” in the main program is now 10.0.

 1  DEF MY_PROG( )

 2  DECL REAL w

 3  DECL INT a, b

 4  ...

 5  CALC(w, b, a)

 6  ...

 7  CALC(w, 30, a)

 8  ...

 9  END

_______________________________________

10  DEF CALC(ww:OUT, bb:IN, oo:OUT)

11  DECL REAL ww

12  DECL INT oo, bb

13  ...

14  END

Line Description

5 “w” is transferred to “ww” as an OUT parameter.

“b” is transferred to “bb” as an IN parameter.

“a” is transferred to “oo” as an OUT parameter.

7 “w” is transferred to “ww” as an OUT parameter.

“30” is transferred to “bb” as an IN parameter.

“a” is transferred to “oo” as an OUT parameter.

It is also possible not to transfer a value to a receiving variable in the 
subprogram, provided that this value is not required in the subpro-
gram. This makes it easier to adapt the program to changing se-

quences.
Example: CALC (w, ,a)
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Transferring 

arrays

Transferring arrays:

 Arrays may only be transferred as OUT parameters.

 Only complete arrays can be transferred to another array.

 Always declare the array in the subprogram without an array size. The ar-
ray size adapts itself to the output array.

In the case of transferring multidimensional arrays, array sizes are again not 
specified. However, the dimension of the array must be specified by means of 
commas.

Examples: 

ARRAY_1D[] (1-dimensional)

ARRAY_2D[,] (2-dimensional)

ARRAY_3D[,,] (3-dimensional)

Transferring individual array elements:

An individual array element may only be transferred to a variable, not to an ar-
ray.

 1  DEF MY_PROG( )

 2  DECL CHAR name[10]

 3  ...

 4  name="OKAY"

 5  CALC(name[])

 6  ...

 7  END

_______________________________________

 8  DEF CALC(my_name[]:OUT)

 9  DECL CHAR my_name[]

10  ...

11  END

Line Description

5, 8 Only complete arrays can be transferred to another array.

8 Arrays may only be transferred as OUT parameters.

9 Always declare the array in the subprogram without an array 
size. The array size adapts itself to the original array.

 1  DEF MY_PROG( )

 2  DECL CHAR name[10]

 3  ...

 4  name="OKAY"

 5  CALC(name[1])

 6  ...

 7  END

_______________________________________

 8  DEF CALC(symbol:IN)

 9  DECL CHAR symbol

10  ...

11  END
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11.9.6 Transferring a parameter to a different data type

It is always possible to transfer a value to the same data type. The following 
applies for transfer to a different data type:

11.10 Interrupt programming

11.10.1 BRAKE

Description BRAKE stops the robot.

BRAKE may only be used in an interrupt program. The interrupt program is not 
continued until the robot has come to a stop. The robot motion is resumed as 
soon as the interrupt program has been completed.

Syntax BRAKE <F>

Explanation of 

the syntax

Example  (>>> 11.10.3 "INTERRUPT" Page 418)

Line Description

2 A CHAR array with 10 elements is declared.

4 Values are assigned to the first 4 elements of the array. This 
corresponds to:

name[1] = "O"

name[2] = "K"

name[3] = "A"

name[4] = "Y"

(A CHAR variable can only ever contain 1 ASCII character.)

5 The subprogram CALC is called and the value of the first ele-
ment is transferred, i.e. the value “O”.

8 Individual array elements can also be transferred as IN param-
eters.

9 The variable to which the value of the array element is trans-
ferred must be declared (a variable, not an array).

Type in the main 

program

Type in the 

subprogram
Effect

BOOL INT, REAL, CHAR Transfer not possible; error message

INT, REAL, CHAR BOOL

INT REAL INT value is used as REAL value.

INT CHAR Character from the ASCII table is used.

CHAR INT INT value from the ASCII table is used.

CHAR REAL REAL value from the ASCII table is used.

REAL INT REAL values are rounded.

REAL CHAR REAL values are rounded; character from the 
ASCII table is used.

Element Description

F F triggers a STOP 1.

In the case of a BRAKE statement without F, the robot 
brakes with a STOP 2.
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11.10.2 INTERRUPT ... DECL ... WHEN ... DO

Description In the case of a defined event, e.g. an input, the controller interrupts the cur-
rent program and executes a defined subprogram. The event and the subpro-
gram are defined by INTERRUPT ... DECL ... WHEN ... DO.

Once the subprogram has been executed, the interrupted program is resumed 
at the point at which it was interrupted. Exception: RESUME.

A subprogram called by an interrupt is called an interrupt program.

A maximum of 32 interrupts may be declared simultaneously. An interrupt dec-
laration may be overwritten by another at any time.

Syntax <GLOBAL> INTERRUPT DECL Prio WHEN Event DO Subprogram

Explanation of 

the syntax

The interrupt declaration is an instruction. It must be situated in the 
instruction section of the program and not in the declaration section!

When first declared, an interrupt is deactivated. The interrupt must be 
activated before the system can react to the defined event! 
(>>> 11.10.3 "INTERRUPT" Page 418)

Interrupt programs must not contain any spline motions.

Element Description

GLOBAL An interrupt is only recognized at, or below, the level in 
which it is declared. In other words, an interrupt declared in 
a subprogram is not recognized in the main program (and 
cannot be activated there). If an interrupt is also to be rec-
ognized at higher levels, the declaration must be preceded 
by the keyword GLOBAL.

Prio Type: INT

If several interrupts occur at the same time, the interrupt 
with the highest priority is processed first, then those of 
lower priority. 1 = highest priority. 

Priorities 1, 2, 4 to 39 and 81 to 128 are available.

Note: Priorities 3 and 40 to 80 are reserved for use by the 
system. They must not be used by the user because this 
would cause system-internal interrupts to be overwritten 
and result in errors.

Event Type: BOOL

Event that is to trigger the interrupt. Structure components 
are impermissible. The following are permitted:

 a global Boolean variable

 a signal name

 a comparison

 a simple logic operation: NOT, OR, AND or EXOR

Subprogram The name of the interrupt program to be executed. Run-
time variables may not be transferred to the interrupt pro-
gram as parameters, with the exception of variables 
declared in a data list.
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Example 1 Declaration of an interrupt with priority 23 that calls the subprogram SP1 if 
$IN[12] is true. The parameters 20 and VALUE are transferred to the subpro-
gram.

Example 2 Two objects, the positions of which are detected by two sensors connected to 
inputs 6 and 7, are located on a programmed path. The robot is to be moved 
subsequently to these two positions.

For this purpose, the two detected positions are saved as points P_1 and P_2. 
These points are then addressed in the second section of the main program.

If the robot controller detects an event defined by means of INTERRUPT ... 
DECL ... WHEN ... DO, it always saves the current robot position in the system 
variables $AXIS_INT (axis-specific) and $POS_INT (Cartesian).

Main program:

Local interrupt program 1:

Local interrupt program 2:

11.10.3 INTERRUPT

Description Executes one of the following actions:

 Activates an interrupt.

 Deactivates an interrupt.

 Disables an interrupt.

 Enables an interrupt.

The interrupt must previously have been declared.  (>>> 11.10.2 "INTER-
RUPT ... DECL ... WHEN ... DO" Page 417)

Syntax INTERRUPT Action <Number>

INTERRUPT DECL 23 WHEN $IN[12]==TRUE DO UP1(20,VALUE)

DEF PROG()

... 

INTERRUPT DECL 10 WHEN $IN[6]==TRUE DO UP1() 

INTERRUPT DECL 20 WHEN $IN[7]==TRUE DO UP2() 

... 

INTERRUPT ON

LIN START 

LIN END 

INTERRUPT OFF 

LIN P_1

LIN P_2 

... 

END

DEF UP1()

P_1=$POS_INT 

END

DEF UP2()

P_2=$POS_INT 

END
Issued: 14.01.2015 Version: KSS 8.3 SI V4



11 Programming for user group “Expert”...
Explanation of 

the syntax

If, in the interrupt declaration, a Boolean variable, e.g. an input, has been de-
fined as the Event: 

 In this case, the interrupt is triggered by a change of state, e.g. in the case 
of $IN[x]==TRUE by the change from FALSE to TRUE. The state must 
therefore not already be present at INTERRUPT ON, as the interrupt is not 
then triggered!

 Furthermore, the following must also be considered in this case: the 
change of state must not occur until at least one interpolation cycle after 
INTERRUPT ON.

(This can be achieved by programming a WAIT SEC 0.012 after INTER-
RUPT ON. If no advance run stop is desired, a CONTINUE command can 
also be programmed before the WAIT SEC.)

The reason for this is that INTERRUPT ON requires one interpolation cy-
cle (= 12 ms) before the interrupt is actually activated. If the state changes 
before this, the interrupt cannot detect the change.

Example 1 The interrupt with priority 2 is activated. (The interrupt must already be de-
clared.)

Example 2 A non-path-maintaining EMERGENCY STOP is executed via the hardware 
during application of adhesive. The application of adhesive is stopped by the 
program and the adhesive gun is repositioned onto the path after enabling (by 
input 10).

Element Description

Action  ON: Activates an interrupt.

 OFF: Deactivates an interrupt.

 DISABLE: Disables an activated interrupt.

 ENABLE: Enables a disabled interrupt.

Number Type: INT

Number (= priority) of the interrupt to which the Action is to 
refer.

Number can be omitted. In this case, ON or OFF refers to all 
declared interrupts, while DISABLE or ENABLE refers to all 
active interrupts.

Up to 16 interrupts may be active at any one time. In this regard, par-
ticular attention must be paid to the following:

If, in the case of INTERRUPT ON, the Number is omitted, all declared 
interrupts are activated. The maximum permissible total of 16 may not be 
exceeded, however.

 If a trigger calls a subprogram, it counts as an active interrupt until the 
subprogram has been executed.

INTERRUPT ON 2

DEF PROG()

... 

INTERRUPT DECL 1 WHEN $STOPMESS DO STOP_PROG()

LIN P_1

INTERRUPT ON

LIN P_2

INTERRUPT OFF

...

END
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11.10.4 RESUME

Description RESUME cancels all running interrupt programs and subprograms up to the 
level at which the current interrupt was declared.

RESUME may only occur in interrupt programs. (Not in interrupt programs, 
however, that are called by an interrupt that is declared as GLOBAL.) When 
the RESUME statement is activated, the advance run pointer must not be at 
the level where the interrupt was declared, but at least one level lower.

Changing the variable $BASE in the interrupt program only has an effect there. 
The computer advance run, i.e. the variable $ADVANCE, must not be modified 
in the interrupt program.

Please note the following regarding the behavior of the robot controller after a 
RESUME:

 If the first motion instruction after RESUME is a CIRC motion, this is exe-
cuted as LIN. 

 If the first motion instruction after RESUME is a SCIRC motion, this is ex-
ecuted as SLIN. 

Reason: Following a RESUME statement, the robot is not situated at the orig-
inal start point of the motion. The motion will thus differ from how it was origi-
nally planned; this can potentially be very dangerous, particularly in the case 
of CIRC/SCIRC motions.

All other motions following a RESUME statement are executed as the motion 
type they were programmed to be.

Syntax RESUME

Example The robot is to search for a part on a path. The part is detected by means of a 
sensor at input 15. Once the part has been found, the robot is not to continue 
to the end point of the path, but to return to the interrupt position and pick up 
the part. The main program is then to be resumed.

Main program PROG():

DEF STOP_PROG()

BRAKE F

GLUE=FALSE

WAIT FOR $IN[10]

LIN $POS_RET

GLUE=TRUE

END

If the first motion instruction after RESUME is a CIRC or 
SCIRC motion, the robot must be able to reach the end 

point of the motion safely, by means of a LIN or SLIN motion, from any posi-
tion in which it could find itself when the RESUME statement is executed. 
This must be taken into consideration when programming RESUME state-
ments.
Failure to take this precaution into consideration may result in death, injuries 
or damage to property.

DEF PROG()

INI

... 

INTERRUPT DECL 21 WHEN $IN[15] DO FOUND()

PTP HOME 

... 

SEARCH()
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Motions that are to be canceled by means of BRAKE and RESUME must be 
located in a subprogram. For this reason, the search path is not directly pro-
grammed in the main program, but rather in the subprogram SEARCH().

Subprogram SEARCH() with search path:

When the RESUME statement is activated, the advance run pointer must not 
be at the level where the current interrupt was declared. To prevent this, an 
advance run stop is triggered here via WAIT FOR TRUE.

Interrupt program FOUND():

The braking process causes the robot to move slightly away from the position 
at which the interrupt was triggered. LIN $POS_INT causes the robot to return 
to the position at which the interrupt was triggered. 

The motion type LIN was used here because interrupt programs must not con-
tain any spline motions.

After LIN $POS_INT, the robot grips the part. (Not programmed in this exam-
ple.) 

RESUME causes the main program to be resumed after the part has been 
gripped. Without the RESUME statement, the subprogram SEARCH() would 
be resumed after END.

11.11 Path-related switching actions (=Trigger)

11.11.1 TRIGGER WHEN DISTANCE

Description The Trigger triggers a user-defined statement. The robot controller executes 
the statement parallel to the robot motion.

The trigger can optionally refer to the start or end point of the motion. The 
statement can either be triggered directly at the reference point, or it can be 
shifted in time.

Syntax TRIGGER WHEN DISTANCE=Position DELAY=Time DO Statement <PRIO=Pri-
ority>

... 

END

DEF SEARCH()

INTERRUPT ON 21

SPLINE

  SPL START_SEARCH 

  SPL IN_BETWEEN

  SPL END_SEARCH 

ENDSPLINE

WAIT FOR TRUE

...

END

DEF FOUND() 

INTERRUPT OFF 21

BRAKE 

LIN $POS_INT 

... ;The robot grips the found part.

RESUME 

END
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Explanation of 

the syntax

Reference point 

for approximate 

positioning

Where is the reference point if the start or end point is approximated?

 DISTANCE = 0: 

If the start point is approximated, the reference point lies at the end of the 
approximate positioning arc.

 DISTANCE = 1: 

If the end point is approximated, the reference point lies in the middle of 
the approximate positioning arc.

Element Description

Position Type: INT; variable or constant

Reference point of the trigger

 0: Start point

 1: End point

 (>>>  "Reference point for approximate positioning" 
Page 422)

Time Type: REAL; variable, constant or function; unit: ms

Shift in time relative to Position. If no offset is desired, set 
Time = 0.

 Negative value: Offset towards the start of the motion

 Positive value: Offset towards the end of the motion

 (>>>  "Max. offset" Page 423)

If Time calls a function, the function is subject to con-
straints.  (>>> 11.11.3 "Constraints for functions in the trig-
ger" Page 431)

Statement Possible:

 Assignment of a value to a variable

Note: There must be no runtime variable on the left-
hand side of the assignment.

 OUT statement; PULSE statement; CYCFLAG state-
ment

 Subprogram call. In this case, Priority must be specified.

Priority Type: INT; variable or constant

Priority of the trigger. Only relevant if Statement calls a sub-
program, and then obligatory.

Priorities 1, 2, 4 to 39 and 81 to 128 are available. Priorities 
40 to 80 are reserved for cases in which the priority is auto-
matically assigned by the system. If the priority is to be 
assigned automatically by the system, the following is pro-
grammed: PRIO = -1.

If several triggers call subprograms at the same time, the 
trigger with the highest priority is processed first, then the 
triggers of lower priority. 1 = highest priority. 

If a trigger calls a subprogram, it counts as an active interrupt until the 
subprogram has been executed. Up to 16 interrupts may be active at 
any one time.
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Max. offset There are limits to the distance the reference point can be offset. The following 
table specifies the maximum possible offsets. If larger, and thus invalid, offsets 
are programmed, the robot controller switches the trigger at the permissible 
limit at the latest. In T1/T2, it generates a corresponding message.

Example 1 130 milliseconds after P_2, $OUT[8] is set to TRUE.

Example 2 In the middle of the approximate positioning arc of P_5, the subprogram 
MY_SUBPROG with priority 5 is called.

Example 3 Explanation of the diagram  (>>> Fig. 11-13 ):

In the diagram, the approximate positions in which the Triggers would be trig-
gered are indicated by arrows. Start, middle and end of each approximate po-
sitioning arc are marked (with *start, *middle and *end).

Fig. 11-12: TRIGGER WHEN DISTANCE reference point for approximate 
positioning

DISTANCE = …
Maximum negative 

offset …

Maximum positive 

offset …

DISTANCE = 0 - - -

(No negative offset possi-
ble.)

 Up to end point

 If the end point is ap-
proximated: up to the 
start of the approxi-
mate positioning arc

DISTANCE = 1

and

End point = 
exact position-
ing point

 Up to start point

 If the start point is ap-
proximated: up to the 
end of the approxi-
mate positioning arc

- - -

(No positive offset possi-
ble.)

DISTANCE = 1

and

End point = 
approximated

Up to the start of the 
approximate positioning 
arc of the end point

Up to the end of the 
approximate positioning 
arc of the end point

LIN P_2

TRIGGER WHEN DISTANCE=0 DELAY=130 DO $OUT[8]=TRUE 

LIN P_3 

PTP P_4

TRIGGER WHEN DISTANCE=1 DELAY=0 DO MY_SUBPROG() PRIO=5 

PTP P_5 C_DIS

PTP P_6
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11.11.2 TRIGGER WHEN PATH

Description The Trigger triggers a user-defined statement. The robot controller executes 
the statement parallel to the robot motion.

 1  DEF PROG()

 2  ... 

 3  PTP P_0 

 4  TRIGGER WHEN DISTANCE=0 DELAY=40 DO A=12

 5  TRIGGER WHEN DISTANCE=1 DELAY=-20 DO UP1() PRIO=10

 6  LIN P_1 

 7  ...

 8  TRIGGER WHEN DISTANCE=0 DELAY=10 DO UP2(A) PRIO=5

 9  TRIGGER WHEN DISTANCE=1 DELAY=15 DO B=1

10  LIN P_2 C_DIS

11  ...

12  TRIGGER WHEN DISTANCE=0 DELAY=10 DO UP2(B) PRIO=12

13  TRIGGER WHEN DISTANCE=1 DELAY=0 DO UP(A,B,C) PRIO=6

14  LIN P_3 C_DIS

15  ...

16  TRIGGER WHEN DISTANCE=0 DELAY=50 DO UP2(A) PRIO=4

17  TRIGGER WHEN DISTANCE=1 DELAY=-80 DO A=0

18  LIN P_4

19  ... 

20  END

Line Switching ranges of the triggers

4 Switching range: P_0 to P_1

5 Switching range: P_0 to P_1

8 Switching range: P_1 to P_2*start

9 Switching range: P_2*start to P_2*end

12 Switching range: P_2*end to P_3*start

13 Switching range: P_3*start to P_3*end

16 Switching range: P_3*end to P_4

17 Switching range: P_3*end to P_4

Fig. 11-13: Example of TRIGGER WHEN DISTANCE
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The trigger can optionally refer to the start or end point of the motion. The 
statement can either be triggered directly at the reference point, or it can be 
shifted in space and/or time.

Syntax TRIGGER WHEN PATH = Distance <ONSTART> DELAY = Time DO Statement 
<PRIO = Priority>

Functions PATH and DELAY can call functions. The functions are subject to constraints.

 (>>> 11.11.3 "Constraints for functions in the trigger" Page 431)

Explanation of 

the syntax

The trigger cannot be used for PTP motions.

If the trigger is used in a spline block, it must not be between the last 
segment and ENDSPLINE.

Element Description

ONSTART Reference point of the trigger

 With ONSTART: Start point

 Without ONSTART: End point

 (>>> 11.11.2.1 "Reference point for approximate position-
ing – overview" Page 428)

Distance Type: REAL; variable, constant or function; unit: mm 
(except in the case of PTP splines without unit)

Shift in space relative to the reference point. If no shift in 
space is desired, set Distance = 0.

 Negative value: Offset towards the start of the motion

 Positive value: Offset towards the end of the motion

 (>>>  "Max. offset" Page 426)

Time Type: REAL; variable, constant or function; unit: ms

Shift in time relative to Distance. If no shift in time is desired, 
set Time = 0.

 Negative value: Offset towards the start of the motion

 Positive value: Trigger is switched after Time has 
elapsed.

 (>>>  "Max. offset" Page 426)
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Max. offset The switching point can only be offset within certain limits. If larger, and thus 
invalid, offsets are programmed, the robot controller switches the trigger at the 
permissible limit at the latest. In T1/T2, it generates a corresponding message.

Maximum offset for Distance + negative Time value:

The limits apply to the entire offset, comprising shift in space and negative shift 
in time.

Statement Possible:

 Assignment of a value to a variable

Note: There must be no runtime variable on the left-
hand side of the assignment.

 OUT statement; PULSE statement; CYCFLAG state-
ment

 Subprogram call. In this case, Priority must be specified.

Priority Type: INT; variable or constant

Priority of the trigger. Only relevant if Statement calls a sub-
program, and then obligatory.

Priorities 1, 2, 4 to 39 and 81 to 128 are available. Priorities 
40 to 80 are reserved for cases in which the priority is auto-
matically assigned by the system. If the priority is to be 
assigned automatically by the system, the following is pro-
grammed: PRIO = -1.

If several triggers call subprograms at the same time, the 
trigger with the highest priority is processed first, then the 
triggers of lower priority. 1 = highest priority. 

If a trigger calls a subprogram, it counts as an active interrupt until the 
subprogram has been executed. Up to 16 interrupts may be active at 
any one time.

Element Description
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Maximum offset for positive Time value:

The maximum positive shift in time is 1,000 ms. Any shift in time between 0 
and 1,000 ms will be switched, even if the program has already been deselect-
ed in the meantime!

Example

In the diagram, the approximate position in which the $OUT[2]=TRUE state-
ment would be triggered is indicated by an arrow.

Switching range: P_2*start to P_5.

Maximum negative offset … Maximum positive offset …

Up to start point (provided that this 
is not approximated)

Up to end point (provided that this is 
not approximated)

If the start point is an approximate 
positioning point: 

 If the start point is an approxi-
mated PTP point: 

Up to the end of the approxi-
mate positioning arc

 If the start point is a different ap-
proximated point: 

Up to the start of the approxi-
mate positioning arc

If the end point is an approximate 
positioning point: 

 In the case of homogenous ap-
proximate positioning: up to the 
next exact positioning point after 
the TRIGGER statement

 In the case of mixed approxi-
mate positioning (spline): up to 
the switching point an ON-
START trigger with PATH = 0 
would have if it were in the mo-
tion to which approximate posi-
tioning is being carried out.

 (>>> 11.11.2.3 "Reference 
point for mixed approximate po-
sitioning (spline)" Page 430)

 In the case of mixed approxi-
mate positioning (LIN/CIRC/
PTP): up to the start of the ap-
proximate positioning arc

LIN P_2 C_DIS

TRIGGER WHEN PATH = -20.0 DELAY= -10 DO $OUT[2]=TRUE

LIN P_3 C_DIS

LIN P_4 C_DIS

LIN P_5

Fig. 11-14: Example of TRIGGER WHEN PATH
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If P_2 were not approximated, the switching range would be P_2 to P_5.

The switching range goes to P_5 because P_5 is the next exact positioning 
point after the TRIGGER statement. If P_3 were not approximated, the switch-
ing range would be P_2 to P_3, as P_3 is the next exact positioning point in 
the program after the Trigger statement.

Example

The Trigger in line 10 would have the same result if it was positioned directly 
before the spline block (i.e. between line 1 and line 2). In both cases, it refers 
to the last point of the spline motion: P8.

It is advisable, however, to position the trigger as shown in the example, and 
not directly before the spline block.

11.11.2.1Reference point for approximate positioning – overview

Where is the reference point of a PATH trigger if the start or end point is 
approximated?

This depends primarily on whether homogenous or mixed approximate posi-
tioning is being carried out.

Homogenous Homogenous approximate positioning

 From a CP spline motion to a CP spline motion

 From a PTP spline motion to a PTP spline motion

 From a LIN or CIRC spline motion to a LIN or CIRC spline motion

Every spline motion can be a spline block or an individual instruction.

 (>>> 11.11.2.2 "Reference point for homogenous approximate positioning" 
Page 429)

1  PTP P0

2  SPLINE

3   SPL P1

4   SPL P2

5   SPL P3

6   SPL P4

7   TRIGGER WHEN PATH=0 ONSTART DELAY=10 DO $OUT[5]=TRUE

8   SCIRC P5, P6

9   SPL P7

10  TRIGGER WHEN PATH=-20.0 DELAY=0 DO SUBPR_2() PRIO=-1

11  SLIN P8

12 ENDSPLINE

Fig. 11-15: Example of TRIGGER WHEN PATH (for spline)
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Mixed Mixed approximate positioning

In this case, the position of the reference point also depends on whether the 
motions are spline motions or conventional motions.

 From a CP spline motion to a PTP spline motion or vice versa

Every spline motion can be a spline block or an individual instruction.

 (>>> 11.11.2.3 "Reference point for mixed approximate positioning 
(spline)" Page 430)

 From a PTP spline motion to a LIN or CIRC spline motion or vice versa

 (>>> 11.11.2.4 "Reference point for mixed approximate positioning (LIN/
CIRC/PTP)" Page 431)

11.11.2.2Reference point for homogenous approximate positioning

The principle is explained here using an example with CP spline blocks. It also 
applies to other types of homogenous approximate positioning.

Example

Triggers 1 and 2 both refer to P3. P3 is approximated. The robot controller 
transfers the point onto the approximate positioning arc by a distance corre-
sponding to the approximation distance (= P3').

End point approx-

imated

Reference point of Trigger 1:

The robot controller calculates how far the distance would be from the start of 
the approximate positioning arc to the end point with exact positioning. This 
distance is then applied to the approximate positioning arc.

The distance PStartApprox → P3 is the same as PStartApprox → P3'Trigger 1.

SPLINE

  ...  

  SLIN P2  

  TRIGGER WHEN PATH=0 DELAY=0 DO ...  ;Trigger 1

  SLIN P3

ENDSPLINE C_SPL

SPLINE

  TRIGGER WHEN PATH=0 ONSTART DELAY=0 DO ...  ;Trigger 2

  SLIN P4

  ...

ENDSPLINE

Fig. 11-16: Trigger 1: Reference point for homogenous approximate po-
sitioning

PStartApprox Start of the approximate positioning arc

P3 Reference point for exact positioning

P3'Trigger 1 Reference point for approximate positioning
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Start point 

approximated

Reference point of Trigger 2:

The robot controller calculates how far the distance would be from the end of 
the approximate positioning arc back to the start point with exact positioning. 
This distance is then applied to the approximate positioning arc.

The distance PEndApprox → P3 is the same as PEndApprox → P3'Trigger 2.

11.11.2.3Reference point for mixed approximate positioning (spline)

Example

Triggers 1 and 2 both refer to P3. P3 is approximated. 

Start point 

approximated

Reference point of Trigger 2:

The reference point is determined in the same way as for homogenous ap-
proximate positioning.

 (>>>  "Start point approximated" Page 430)

End point approx-

imated

Reference point of Trigger 1:

The reference point for Trigger 1 is in the same position as that for Trigger 2.

The distance PStartApprox → P3'Trigger 1 is generally shorter than PStartApprox 
→ P3.

Fig. 11-17: Trigger 2: Reference point for homogenous approximate po-
sitioning

PEndApprox End of the approximate positioning arc

P3 Reference point for exact positioning

P3'Trigger 2 Reference point for approximate positioning

PTP_SPLINE

  ...

  SPTP P2  

  TRIGGER WHEN PATH=0 DELAY=0 DO ...  ;Trigger 1

  SPTP P3

ENDSPLINE C_SPL

  

SPLINE

  TRIGGER WHEN PATH=0 ONSTART DELAY=0 DO ...  ;Trigger 2

  SLIN P4

  ...

ENDSPLINE

This reference point must be considered first, as the reference point 
of Trigger 1 refers to it!
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If Trigger 1 were to be shifted to between PStartApprox and P3', the exact po-
sition would be determined as follows:

The robot controller calculates the percentage of the distance PStartApprox → 
P3 at which the switching point would be located if the end point were an exact 
positioning point. This proportion is then applied to the approximate position-
ing arc. The switching point is thus at x% of the distance PStartApprox → 
P3'Trigger 1

11.11.2.4Reference point for mixed approximate positioning (LIN/CIRC/PTP)

Start point 

approximated

PTP-CP approximate positioning:

The reference point is at the end of the approximate positioning arc. 

End point approx-

imated

CP-PTP approximate positioning:

The reference point is at the start of the approximate positioning arc. 

11.11.3 Constraints for functions in the trigger

The values for DELAY and PATH can be assigned using functions. The follow-
ing constraints apply to these functions:

 The KRL program containing the function must have the attribute Hidden.  
(>>> 7.4.2 "Displaying or modifying properties of files and folders" 
Page 233)

 The function must be globally valid.

 The functions may only contain the following statements or elements:

 Value assignments

 IF statements

 Comments

 Blank lines

 RETURN

 Read system variable

 Call predefined KRL function

Fig. 11-18: Trigger 1: Reference point for mixed approximate positioning

PStartApprox Start of the approximate positioning arc

PEndApprox End of the approximate positioning arc

P3 Reference point for exact positioning

P3' Reference point for approximate positioning
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11.11.4 Useful system variables for working with PATH triggers

11.11.4.1$DIST_NEXT

Description $DIST_NEXT specifies the length of the path from the current TCP position to 
the next taught point.

Type: REAL. Unit:

 For CP motions (spline and conventional): mm

 For SPTP motions: No unit

$DIST_NEXT cannot be used for PTP motions. The value is always zero in 
this case.

$DIST_NEXT is write-protected. 

Procedure $DIST_NEXT can be used as an aid for programming PATH triggers without 
ONSTART. It can be used to determine the value that must be assigned to the 
PATH parameter.

1. Move to the position on the path where the switching point is to be located.

2. Read the system variable. 

3. Program the trigger before the next point. 

 Program the trigger without ONSTART.

 Assign the value of the system variable to the PATH parameter.

11.11.4.2$DIST_LAST

Description $DIST_LAST specifies the length of the path from the current TCP position to 
the previous taught point. The value is generally positive. 

Type: REAL. Unit:

 For CP motions (spline and conventional): mm

 For SPTP motions: No unit

$DIST_LAST cannot be used for PTP motions. The value is always zero in this 
case.

$DIST_LAST is write-protected. 

Procedure $DIST_LAST can be used as an aid for programming PATH triggers with ON-
START. It can be used to determine the value that must be assigned to the 
PATH parameter.

1. Move to the position on the path where the switching point is to be located.

2. Read the system variable.

3. Program the trigger after the previous point.

 Program the trigger with ONSTART.

 Assign the value of the system variable to the PATH parameter.

11.12 Communication

Information about the following statements is contained in the Expert docu-
mentation CREAD/CWRITE.

 CAST_FROM

 CAST_TO

 CCLOSE

 CHANNEL
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 CIOCTL

 COPEN

 CREAD

 CWRITE

 SREAD

 SWRITE

11.13 Operators

In each operation, the compiler checks the legitimacy of the operands.

11.13.1 Arithmetic operators

Description All 4 basic arithmetic operations are permissible in KRL. 

The arithmetic operators can be applied to the data types INT and REAL.

If the result of an INT division is not an integer, it is cut off at the decimal point.

Examples

Operator Description

+ Addition or positive sign

- Subtraction or negative sign

* Multiplication

/ Division

Operand Operand Result

INT INT INT

INT REAL REAL

REAL REAL REAL

DEF ARITH()

DECL INT A,B,C,D,E

DECL REAL K,L,M

INI

A = 2           ;A=2

B = 9.8         ;B=10

C = 9.50        ;C=10

D = 9.48        ;D=9

E = 7/4         ;E=1

K = 3.5         ;K=3.5

L = 1.0         ;L=1.0

M = 3           ;M=3.0

...

A = A * E       ;A=2

B = B - ’HB’    ;B=-1

E = E + K       ;E=5

K = K * 10      ;K=35.0

L = 10/4        ;L=2.0

L = 10/4.0      ;L=2.5

L = 10/4.       ;L=2.5

L = 10./4       ;L=2.5

E = 10./4.      ;E=3

M = (10/3) * M  ;M=9.0

END
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11.13.2 Geometric operator

Description Positions can be geometrically added using the geometric operator. The geo-
metric addition is also called a “frame operation”.

The geometric operator is symbolized by a colon “:” in KRL. 

The geometric operator is suitable, for example, for the following purposes:

 Shifting positions to adapt them to a modified workpiece size

 Return motion strategies

Example This statement causes the tool to retract 100 mm against the tool direction, ir-
respective of the position at which the robot is currently located.

The precondition is that the tool direction is located along the X axis.

$POS_ACT is a system variable of structure type E6POS and contains the 
current Cartesian robot position.

Linked types The geometric operator can link the data types FRAME and POS/E6POS. 

The components X, Y, Z, A, B and C must be assigned a value. The compo-
nents S and T remain unaffected by the operation and therefore do not have 
to be assigned a value.

The result always has the data type of the operand on the far right.

Operation with 2 operands:

Examples of operations with 3 operands:

Meaning of the 

operands

How can one visualize what the operands mean? 

This is illustrated using the previous example for a return motion:

11.13.2.1Sequence of the operands

The result of a geometric addition differs according to the sequence of the op-
erands. The following example illustrates this graphically.

 A = {x 1, y 1, z 0, a 0, b 0, c 0}

LIN  $POS_ACT : {x -100, y 0, z 0, a 0, b 0, c 0}

Left : Right Result

POS : POS POS

POS : FRAME FRAME

FRAME : FRAME FRAME

FRAME : POS POS

Left : Middle : Right Result

POS : POS : POS POS

POS : POS : FRAME FRAME

POS : FRAME : FRAME FRAME

FRAME : FRAME : POS POS

Left operand : Right operand

$POS_ACT : {x -100, y0, z0, a0, b0, c0}

Go to this destination …

… relative to the coordi-
nates and orientation of 

this position.
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 B = {x 3, y 2, z 0, a -45, b 0, c 0}

 CS = original coordinate system

The result of an operation can be calculated using KRL. It specifies the posi-
tion of the right-hand operand relative to the coordinate system of the left-hand 
operand. 

Sequence A:B R = A : B means:

 A refers to CS.

 B refers to A.

The result specifies the position of B relative to CS: 

R = {x 4, y 3, a -45}

Sequence B:A R = B : A means:

 B refers to CS. 

 A refers to B.

The result specifies the position of A relative to CS: 

R = {x 4.414, y 2, a -45}

11.13.2.2Example of a double operation

Description This example shows how multiple coordinate systems can be linked. 

In order to show the effect of the operations, the robot is moved to the origin 
of each coordinate system and of the operation. The robot waits there for 
2 seconds to highlight the position. In order to illustrate the change in orienta-
tion, the tip of the tool first moves 100 mm in the X direction, then 100 mm in 
the Y direction and finally 100 mm in the Z direction.

Fig. 11-19: R = A : B

Fig. 11-20: R = B : A
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Program  1  DEF geo_operator( )

 2  DECL AXIS home

 3  DECL FRAME ref_pos_x, ref_pos_y, ref_pos_z

 4  DECL FRAME My_BASE[2]

...

 5  INI

 6  home={AXIS: A1 0,A2 -90,A3 90,A4 0,A5 30,A6 0}

 7  $BASE={X 1000,Y 0,Z 1000,A 0,B 0,C 0}

 8  ref_pos_X={X 100,Y 0,Z 0,A 0,B 0,C 0}

 9  ref_pos_Y={X 100,Y 100,Z 0,A 0,B 0,C 0}

10  ref_pos_Z={X 100,Y 100,Z 100,A 0,B 0,C 0}

11  My_BASE[1]={X 200,Y 100,Z 0,A 0,B 0,C 180}

12  My_BASE[2]={X 0,Y 200,Z 250,A 0,B 90,C 0}

...

13  PTP home 

14  PTP $BASE

15  WAIT SEC 2

16  PTP ref_pos_X

17  PTP ref_pos_Y

18  PTP ref_pos_Z

19  PTP My_BASE[1]

20  WAIT SEC 2

21  PTP My_BASE[1]:ref_pos_X

22  PTP My_BASE[1]:ref_pos_Y

23  PTP My_BASE[1]:ref_pos_Z

24  PTP My_BASE[1]:My_BASE[2]

25  WAIT SEC 2

26  PTP My_BASE[1]:My_BASE[2]:ref_pos_X

27  PTP My_BASE[1]:My_BASE[2]:ref_pos_Y

28  PTP My_BASE[1]:My_BASE[2]:ref_pos_Z

29  PTP My_BASE[2]:My_BASE[1]

30  WAIT SEC 2

31  PTP My_BASE[2]:My_BASE[1]:ref_pos_X

32  PTP My_BASE[2]:My_BASE[1]:ref_pos_Y

33  PTP My_BASE[2]:My_BASE[1]:ref_pos_Z

34  PTP home

35  END

Line Description

8 … 10 Initialization of 3 frames for the motion in the X, Y and Z direc-
tions. 

11, 12 Initialization of 2 user-specific coordinate systems. These 
serve as examples for the operations.

14 Move to the origin of the $BASE coordinate system.

16 … 18 In $BASE, first move 100 mm in the X direction, then 100 mm 
in the Y direction and finally 100 mm in the Z direction.

19 In $BASE, move to the origin of the coordinate system 
My_BASE[1]. 

21 … 23 Move to the same coordinates as in lines 16 … 18, but this 
time in the coordinate system My_BASE[1], not in $BASE.

i.e. the location of these points in space is different from that in 
lines 16 … 18.

24 In My_BASE[1], move to the origin of the coordinate system 
My_BASE[2]. 

My_BASE[1] itself is located in $BASE.
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11.13.3 Relational operators

Description Using relational operators, it is possible to form logical expressions. The result 
of a comparison is always of type BOOL.

 Operand combinations of INT, REAL and CHAR are permissible.

The comparison of numeric values (INT, REAL) and character values 
(CHAR) is permissible because each ASCII character is assigned an 
ASCII code. The code is a number.

 A BOOL type may only be compared with a BOOL type.

 An ENUM type may only be compared with the same ENUM type.

Examples Multiple comparisons are also permissible:

Example of a comparison with an ENUM type:

26 … 28 The robot moves to the same coordinates as in lines 16 … 18, 
but this time in the coordinate system 
My_BASE[1]:My_BASE[2].

29 In My_BASE[2], move to the origin of the coordinate system 
My_BASE[1]. 

My_BASE[2] itself is located in $BASE.

31 … 33 The robot moves to the same coordinates as in lines 16 … 18, 
but this time in the coordinate system 
My_BASE[2]:My_BASE[1].

Line Description

Operator Description Permissible data types

== equal to INT, REAL, CHAR, ENUM, BOOL

<> not equal to

> greater than INT, REAL, CHAR, ENUM

< less than

>= greater than or 
equal to

<= less than or 
equal to

In the case of REAL values, the test for equality or inequality is of only 
limited use: due to the limited number of places after the floating 
point, rounding errors are possible. These can result in identical for-

mulae having different values.

...

DECL BOOL A, B

...

B= 10 < 3                                     ;B=FALSE

A = 10/3 == 3                                 ;A=TRUE

B = ((B == A) <> (10.00001 >= 10)) == TRUE    ;B=TRUE

A = "F" < "Z"                                 ;A=TRUE

...

DEF TEST()

ENUM color_typ orange, blue

DECL BOOL A

DECL color_typ KUKA_color, my_color

INI

KUKA_color = #orange
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11.13.4 Logic operators

Description Logic operators are used for performing logic operations on Boolean vari-
ables, constants and simple logic expressions, as are formed with the aid of 
relational operators.

The operands of a logic operation must be of type BOOL. The result is also 
always of type BOOL.

The following table shows the results of the possible operations:

The table also applies to operations with bit operators.

Examples Multiple operations are also permissible.

11.13.5 Bit operators

Description Bit operators are used to link whole numbers by performing logic operations 
on the individual bits of the whole numbers. 

The results of the operations correspond to those of the logic operators.

 Bit value 1 corresponds to TRUE.

 Bit value 0 corresponds to FALSE.

The bit operators can be applied to the data types INT and CHAR. 

my_color = #orange

...

A = my_color == KUKA_color                 ;A=TRUE

END

Operator Number of operands Description

NOT 1 Inversion

AND 2 Logic AND

OR 2 Logic OR

EXOR 2 Exclusive OR

Operation NOT A A AND B A OR B A EXOR B

A = TRUE B = TRUE FALSE TRUE TRUE FALSE

A = TRUE B = FALSE FALSE FALSE TRUE TRUE

A = FALSE B = TRUE TRUE FALSE TRUE TRUE

A = FALSE B = FALSE TRUE FALSE FALSE FALSE

...

DECL BOOL A,B,C

...

A = TRUE                                ;A=TRUE

B = NOT A                               ;B=FALSE

C = (A AND B)OR NOT (B EXOR NOT A)      ;C=TRUE

A = NOT NOT C                           ;A=TRUE

...

Operator Number of operands Description

B_NOT 1 Bit-by-bit inversion

B_AND 2 Bit-by-bit ANDing

B_OR 2 Bit-by-bit ORing

B_EXOR 2 Bit-by-bit exclusive ORing
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INT has 32 bits in KRL and has a sign. CHAR has 8 bits and does not have a 
sign.

In the following examples for B_AND, B_OR and B_EXOR with integer values, 
the results are positive numbers (most significant bit = 0). The results can be 
converted directly into the decimal system in the same way as unsigned val-
ues.

The 28 leading zeros of the operands are indicated by “0 0 […]”. 

B_AND

B_OR

B_EXOR

B_NOT In this integer example, the operation results in a negative number (most sig-
nificant bit = 1). The result can thus not be converted to the decimal system in 
the same way as an unsigned number. 

In order to be able to follow the results of bit operations, it is neces-
sary to bear in mind that the robot controller interprets signed binary 
numbers as a twos complement. The most significant bit determines 

whether the number is positive or negative. For this reason, all bits must be 
taken into consideration.

Fig. 11-21: Example: Linking the integer values 5 and 12

Fig. 11-22: Example: Linking the integer values 5 and 12

Fig. 11-23: Example: Linking the integer values 5 and 12

In order for the user to be able to understand the decimal result of the 
robot controller, it is necessary to be familiar with the rules for inter-
preting twos complement numbers. The rules are not dealt with in this 

documentation.

Fig. 11-24: Example: B_NOT with integer value 10
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The decimal result of a B_NOT operation on a signed operand can also be cal-
culated as follows: 

1. Decimal value of the operand plus 1

2. Invert sign

Further examples

Setting and checking bits:

B_AND and B_OR can be used to set individual bits of a bit sequence to 1 or 
0. The other bits remain unchanged.

 B_AND can be used to set individual bits to 0. 

 B_OR can be used to set individual bits to 1. 

It is also possible to check whether individual bits are set to 1 or 0.

Example:

A digital output has a bit width of 8 bits. The output can be addressed via the 
INT variable DIG.

Set bits 1, 2 and 6 to 0:

Set bits 0, 2, 3 and 7 to 1:

Check whether bits 0 and 7 are set to 1. If so, my_result is set to TRUE:

Check whether one of the two bits 0 or 7 is set to 1. If so, my_result is set to 
TRUE:

11.13.6 Priority of the operators

The priority specifies the order in which the operators are evaluated within a 
statement. 

...

DECL INT A

...

A = 10 B_AND 9                               ;A=8

A = 10 B_OR 9                                ;A=11

A = 10 B_EXOR 9                              ;A=3

A = B_NOT 197                                ;A=-198

A = B_NOT 'HC5'                              ;A=-198

A = B_NOT 'B11000101'                        ;A=-198

A = B_NOT "E"                                ;A=154

...

DIG = DIG B_AND 'B10111001'

DIG = DIG B_OR 'B10001101'

DECL BOOL my_result

...

my_result = DIG B_AND ('B10000001') == 'B10000001'

DECL BOOL my_result

...

my_result = DIG B_AND ('B10000001') > 0

Priority Operator

1 NOT; B_NOT

2 *; /

3 +; -

4 AND; B_AND
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The following general rules apply:

 Bracketed expressions are processed first.

 Non-bracketed expressions are evaluated in accordance with their priority.

 Logic operations with operators of the same priority are evaluated from left 
to right.

11.14 System functions

11.14.1 DELETE_BACKWARD_BUFFER()

Description DELETE_BACKWARD_BUFFER() can be used to prevent backward motion for 
specific motions. The function deletes the recorded forward motions. If the 
user attempts to perform backward motion, the robot controller generates the 
following message: Backward motion not possible: no trace available.

The function can be used with all interpreters. It can also be used in the trigger.

The function triggers an advance run stop. 

DELETE_BACKWARD_BUFFER() refers to backward motion using the Start 
backwards key. It has no effect on other backward motion functionalities, e.g. 
backward motion as part of fault strategies in technology packages.

Example 1 In the following example, it is still possible to start backward motion during the 
motion from P4 to P5. At P5, it is no longer possible:

If it is desirable for backward motion already to be no longer possible during 
the motion from P4 to P5, this can be achieved by means of a trigger:

Example 2 In the following example, the following actions are possible or not possible:

If, for example, it is desirable for no backward motion to be possible after P3 
has been left and before P6 has been reached, several triggers must be pro-
grammed:

5 EXOR; B_EXOR

6 OR; B_OR

7 ==, <>; <, >, <=, >=

Priority Operator

PTP P4

PTP P5

DELETE_BACKWARD_BUFFER()

PTP P4

TRIGGER WHEN DISTANCE=0 DELAY=0 do DELETE_BACKWARD_BUFFER() PRIO=-1

PTP P5

Action Possible?

Move backwards to P6 Yes

Move backwards to P5 No

Move backwards from P5 Yes

PTP P3

PTP P4

PTP P5

TRIGGER WHEN DISTANCE=0 DELAY=0 do DELETE_BACKWARD_BUFFER() PRIO=-1

PTP P6

PTP P7
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11.14.2 ROB_STOP() and ROB_STOP_RELEASE()

Description ROB_STOP() and ROB_STOP_RELEASE() can only be used in submit pro-
grams.

 ROB_STOP() stops the robot and prevents further motions. This affects all 
possible motions, irrespective of whether they arise from program execu-
tion, manual jogging or command mode.

 ROB_STOP_RELEASE() cancels a blockade caused by ROB_STOP().

If ROB_STOP() is called several times in succession without a 
ROB_STOP_RELEASE() in between, only the first call has any effect. The 
subsequent calls have no effect, i.e. they do not trigger a stop or cause a mes-
sage to be generated.

If ROB_STOP_RELEASE() is called without ROB_STOP() being called first, 
this has no effect.

Messages ROB_STOP() triggers the following status message: Robot stopped by submit

ROB_STOP_RELEASE() in a Test mode triggers the following acknowledge-
ment message: Ackn. Robot stopped by submit

ROB_STOP_RELEASE() in an Automatic mode triggers no message.

Syntax result = ROB_STOP (stop_type: IN)

Explanation of 

the syntax

ProConOS The “Robot stop” function can also be used from ProConOS. The following 
functions are available for this:

 PLC_ROB_STOP()

The desired stop type is defined with PLC_ROB_STOP_RAMP_DOWN or 
PLC_ROB_STOP_PATH_MAINT.

 PLC_ROB_STOP_RELEASE()

The effect is the same, irrespective of whether a stop is triggered by submit or 
by ProConOS. ProConOS generates its own message texts; these are:

PTP P3

TRIGGER WHEN DISTANCE=0 DELAY=0 do DELETE_BACKWARD_BUFFER() PRIO=-1

PTP P4

TRIGGER WHEN DISTANCE=0 DELAY=0 do DELETE_BACKWARD_BUFFER() PRIO=-1

PTP P5

TRIGGER WHEN DISTANCE=0 DELAY=0 do DELETE_BACKWARD_BUFFER() PRIO=-1

PTP P6

PTP P7

Element Description

result Type: BOOL

Variable for the return value. Return value:

 TRUE: The stop has been executed.

 FALSE: An invalid parameter has been transferred for 
stop_type.

stop_type Type: ROB_STOP_T

Stop type to be used to stop the robot:

 #RAMP_DOWN: ramp stop

 #PATH_MAINTAINING: path-maintaining EMERGEN-
CY STOP

Other stop types are not possible.
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 Robot stopped by SoftPLC ({Name of the task calling it})

 Ackn. Robot stopped by SoftPLC

If a stop is requested by both submit and ProConOS, this is indicated in each 
case by a status message. A maximum of 2 status messages can thus be dis-
played for an executed stop. In this case, robot motion cannot be resumed un-
til the blockade has been canceled by both submit and ProConOS.

If different stop types are requested by submit and ProConOS, the type actu-
ally carried out is generally the one that was requested first.

A stop triggered by ProConOS cannot be canceled by a submit program and 
vice versa.

11.14.3 SET_BRAKE_DELAY()

Description The function SET_BRAKE_DELAY can be used to reduce the brake delay 
with reference to an individual point. 

SET_BRAKE_DELAY is intended for use at the end of a cycle. When the robot 
stops there before the next cycle begins, SET_BRAKE_DELAY can be used 
to make the brakes close earlier, thereby also causing the drives to be deac-
tivated sooner. Energy can be saved in this way.

Brake delay:

The brake delay is the time after which the brakes are applied when the robot 
(or the external axis) has reached an exact positioning point. It is irrelevant 
whether the exact positioning point was programmed as such, or whether it 
just works out that way because approximate positioning cannot be carried 
out. 

If the robot stops at the point until the time has elapsed, e.g. at the end of the 
program, the brakes are applied. If the robot resumes motion before the time 
has elapsed, the brakes are not applied. 

The generally applicable brake delay is defined in system variables. 
SET_BRAKE_DELAY can be used to set a lower value for an individual point, 
i.e. the brakes are applied earlier. 

System variables for the generally applicable brake delay:

 $BRK_DEL_COM: 

Brake delay for robot axes in command mode (= jogging) (default: 
10,000 ms)

 $BRK_DEL_PRO: 

Brake delay for robot axes in program mode (default: 20,000 ms)

 $BRK_DEL_EX: 

Brake delay for external axes (default: 200 ms)

$BRK_DEL_EX only applies if the external axis mode is set 
($BRK_MODE, bit 3 =1) and the external axis is not mathematically cou-
pled. Otherwise, the brakes of the external axis respond in the same way 
as the robot axes and the corresponding delay times apply.

Additional 

characteristics

SET_BRAKE_DELAY triggers an advance run stop. The advance run stop ap-
plies separately for synchronous and asynchronous axes. For example, if a 
synchronous axis is specified using axes_nr, the advance run stop applies for 
all synchronous axes, but not for any asynchronous axis that may be present.

SET_BRAKE_DELAY can be processed by all interpreters. 

Further information about $BRK_MODE can be found in the docu-
mentation Configuration of Kinematic Systems.
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SET_BRAKE_DELAY only has an effect if the robot is at an exact positioning 
point: 

 SET_BRAKE_DELAY must come after the point in the program to which 
it is to apply. Since it triggers an advance run stop, this point is automati-
cally an exact positioning point.

 If it is triggered by a trigger, it can only take effect if the trigger refers to the 
end point and this is an exact positioning point.

Syntax result = SET_BRAKE_DELAY (axes_nr, delay)

Explanation of 

the syntax

$BRAKE_SIG The state of the brakes (open or closed) can be displayed by means of the sys-
tem variable $BRAKE_SIG. 

 (>>>  "$BRAKE_SIG" Page 213)

Element Description

result Type: INT

Variable for the return value. The bits indicate the axes for 
which delay has been set. 

 Bit n = 0: value was not set for this axis. 

 Bit n = 1: value was set for this axis. 

The return value does not indicate whether the brakes 
were actually applied.

axes_nr Type: INT

Bit array for the axes for which delay is to be set.

 Bit n = 0: value is not set for this axis. 

 Bit n = 1: value is set for this axis. 

The value can be specified in the program as an integer or 
using bit notation, e.g. “63” or “ 'B111111' ” for “all robot 
axes”.

By default, the brakes of robot axes are applied simultane-
ously. In this case, the value applies to all robot axes, 
including those that are not specified here.

If the brakes of external axes are applied simultaneously 
(dependent on $BRK_MODE), the value applies to all 
external axes, including those that are not specified here. 
The brakes of master/slave axes are always applied simul-
taneously. 

delay Type: INT, unit: ms

Desired delay. Range of values:

 0 … defined general brake delay

If a higher value is defined, it is limited internally to the 
value of the relevant system variable: $BRK_DEL_COM, 
$BRK_DEL_PRO or $BRK_DEL_EX

The value 0 is permissible. The actual closing time, how-
ever, is always at least as long as the time required 
mechanically for the brake to close. This is just a few frac-
tions of a second. The exact value depends on the specific 
axis.

Bit n 11 … 5 4 3 2 1 0

Axis E6 … A6 A5 A4 A3 A2 A1
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Example At the end of the following program, the brakes of the robot axes are to be ap-
plied as quickly as possible. For this reason, SET_BRAKE_DELAY(63, 0) has 
been programmed after the last point.

Negative example It is not generally helpful to use SET_BRAKE_DELAY during a cycle. There 
are often no points at which the brakes are applied and where this operation 
would need to be accelerated. On the contrary, the advance run stop triggered 
by SET_BRAKE_DELAY would actually have a negative effect on the cycle 
time.

 1  DEF my_test()

 2  DECL INT my_result

 3  DECL INT brake_state

    ...

 4  PTP HOME Vel= 100 % DEFAULT

 5  PTP P1 ...

    ...

 6  PTP HOME Vel= 100 % DEFAULT

 7  my_result = SET_BRAKE_DELAY(63, 0)

 8  brake_state = $BRAKE_SIG

 9  END

Line Description

6 Last point in program

7 Here, the brake delay is set to 0 ms for all robot axes for the 
point in line 6.

8 The monitoring reveals that the brakes are (still) open at this 
point. 

The reason for this is that the brakes cannot close in 0 ms; 
they require a certain time to close for mechanical reasons. 
Once this time has elapsed, the brakes are closed.

 1  DEF my_test()

 2  DECL INT my_result

    ...

 3  PTP HOME Vel= 100 % DEFAULT

 4  PTP P1 C_DIS ...

 5  my_result = SET_BRAKE_DELAY(63, 0)

 6  ;WAIT SEC 0.5

 7  PTP P2 ...

    ...

Line Description

5 Here, the brake delay is set to 0 ms for all robot axes for P1. 
P1 is programmed with approximate positioning. Since 
SET_BRAKE_DELAY triggers an advance run stop, the mo-
tion to P1 is carried out with exact positioning.

The brakes do not close at P1, however. The reason for this is 
that the brakes would need the time mechanically required to 
close. However, on reaching P1, the robot controller immedi-
ately starts the next motion. The brakes are thus not applied, 
even though the delay is set to 0 ms.

6 By contrast, if this line were uncommented, the brakes would 
close. 

The robot controller would not immediately start the next mo-
tion on reaching P1, but stop at P1 for 0.5 s. This would allow 
time for the brakes to be applied.
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11.14.4 VARSTATE()

Description VARSTATE() can be used to monitor the state of a variable.

VARSTATE() is a function with a return value of type VAR_STATE. 
VAR_STATE is an enumeration type that is defined as follows in the system:

VARSTATE is defined as follows in the system:

Example 1

Explanation of the state monitoring:

 The first IF condition is false, as MYVAR has already been declared. Out-
put 11 is not set.

 The second IF condition is true, as MYVAR has been declared. Output 12 
is set.

 The third IF condition is true, on the condition that there is also no variable 
with the name ANYVAR in $CONFIG.DAT. Output 13 is set.

 The fourth IF condition is false, as MYVAR has not only been declared, but 
has also already been initialized here. Output 14 is not set.

 The fifth IF condition is true, as MYVAR has been initialized. Output 15 is 
set.

Example 2

ENUM VAR_STATE DECLARED, INITIALIZED, UNKNOWN

VAR_STATE VARSTATE(CHAR VAR_STR[80]:IN)

DEF PROG1()

INT MYVAR

...

IF VARSTATE("MYVAR")==#UNKNOWN THEN

   $OUT[11]=TRUE

ENDIF

...

IF VARSTATE("MYVAR")==#DECLARED THEN

   $OUT[12]=TRUE

ENDIF

...

IF VARSTATE("ANYVAR")==#UNKNOWN THEN

   $OUT[13]=TRUE

ENDIF

...

MYVAR=9

...

IF VARSTATE("MYVAR")==#DECLARED THEN

   $OUT[14]=TRUE

ENDIF

...

IF VARSTATE("MYVAR")==#INITIALIZED THEN

   $OUT[15]=TRUE

ENDIF

...

END

DEF PROG2()

INT MYVAR

INT YOURVAR

DECL VAR_STATE STATUS

...

STATUS=VARSTATE("MYVAR")

UP()

...

STATUS=VARSTATE("YOURVAR")
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Explanation of the state monitoring:

In this example, the state is monitored indirectly, i.e. via an additional variable. 
The additional variable must be of type VAR_STATE. The keyword DECL 
must not be omitted in the declaration. The name of the additional variable 
may be freely selected. In this example it is STATUS.

11.15 Editing string variables

Various functions are available for editing string variables. The functions can 
be used in SRC files, in SUB files and in the variable correction function.

The functions can be used within IF branches without the return value being 
explicitly assigned to a variable. 

11.15.1 String variable length in the declaration

Description The function StrDeclLen() determines the length of a string variable ac-
cording to its declaration in the declaration section of a program.

Syntax Length = StrDeclLen(StrVar[])

Explanation of 

the syntax

Example

UP()

...

END

DEF UP()

...

IF VARSTATE("STATUS")==#DECLARED THEN

   $OUT[100]=TRUE

ENDIF

...

END

Element Description

Length Type: INT

Variable for the return value. Return value: Length of the 
string variable as declared in the declaration section

StrVar[] Type: CHAR array

String variable whose length is to be determined

Since the string variable StrVar[ ] is an array of type CHAR, 
individual characters and constants are not permissible for 
length determination.

 1  CHAR ProName[24]

 2  INT StrLength

    …

 3  StrLength = StrDeclLen(ProName)

 4  StrLength = StrDeclLen($Trace.Name[ ])

Line Description

3 StrLength = 24

4 StrLength = 64
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11.15.2 String variable length after initialization

Description The function StrLen() determines the length of the character string of a 
string variable as defined in the initialization section of the program.

Syntax Length = StrLen(StrVar)

Explanation of 

the syntax

Example

11.15.3 Deleting the contents of a string variable

Description The function StrClear() deletes the contents of a string variable.

Syntax Result = StrClear(StrVar[])

Explanation of 

the syntax

Example

The function can be used within IF branches without the return value being ex-
plicitly assigned to a variable. This applies to all functions for editing string vari-
ables.

11.15.4 Extending a string variable

Description The function StrAdd() can be used to expand a string variable with the con-
tents of another string variable.

Syntax Sum = StrAdd(StrDest[], StrToAdd[])

Element Description

Length Type: INT

Variable for the return value. Return value: Number of char-
acters currently assigned to the string variable

StrVar Type: CHAR

Character string or variable whose length is to be deter-
mined

 1  CHAR PartA[50]

 2  INT AB

    …

 3  PartA[] = "This is an example"

 4  AB = StrLen(PartA[])

Line Description

4 AB = 18

Element Description

Result Type: BOOL

Variable for the return value. Return value:

 The contents of the string variable have been deleted: 
TRUE

 The contents of the string variable have not been delet-
ed: FALSE

StrVar[] Type: CHAR array

Variable whose character string is to be deleted

IF (NOT StrClear($Loop_Msg[])) THEN

HALT

ENDIF
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Explanation of 

the syntax

Example

11.15.5 Searching a string variable

Description The function StrFind() can be used to search a string variable for a charac-
ter string.

Syntax Result = StrFind(StartAt, StrVar[], StrFind[], CaseSens)

Explanation of 

the syntax

Element Description

Sum Type: INT

Variable for the return value. Return value: Sum of StrD-
est[ ] and StrToAdd[ ]

If the sum is longer than the previously defined length of 
StrDest[ ], the return value is 0. This is also the case if the 
sum is greater than 470 characters.

StrDest[] Type: CHAR array

The string variable to be extended

Since the string variable StrDest[ ] is an array of type 
CHAR, individual characters and constants are not permis-
sible.

StrToAdd[] Type: CHAR array

The character string by which the variable is to be 
extended

 1  DECL CHAR A[50], B[50]

 2  INT AB, AC

    …

 3  A[] = "This is an "

 4  B[] = "example"

 5  AB = StrAdd(A[],B[])

Line Description

5 A[ ] = “This is an example”

AB = 18

Element Description

Result Type: INT

Variable for the return value. Return value: Position of the 
first character found. If no character is found, the return 
value is 0.

StartAt Type: INT

The search is started from this position.

StrVar[] Type: CHAR array

The string variable to be searched

StrFind[] Type: CHAR array

The character string that is being looked for.

CaseSens  #CASE_SENS: Upper and lower case are taken into 
consideration.

 #NOT_CASE_SENS: Upper and lower case are ig-
nored.
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Example

11.15.6 Comparing the contents of string variables

Description The function StrComp() can be used to compare two string variables.

Syntax Comp = StrComp(StrComp1[], StrComp2[], CaseSens)

Explanation of 

the syntax

Example

11.15.7 Copying a string variable

Description The function StrCopy() can be used to copy the contents of a string variable 
to another string variable.

 1  DECL CHAR A[5]

 2  INT B

 3  A[]="ABCDE"

 4  B = StrFind(1, A[], "AC", #CASE_SENS)

 5  B = StrFind(1, A[], "a", #NOT_CASE_SENS)

 6  B = StrFind(1, A[], "BC", #Case_Sens)

 7  B = StrFind(1, A[], "bc", #NOT_CASE_SENS)

Line Description

4 B = 0

5 B = 1

6 B = 2

7 B = 2

Element Description

Comp Type: BOOL

Variable for the return value. Return value:

 The character strings match: TRUE

 The character strings do not match: FALSE

StrComp1[] Type: CHAR array

String variable that is compared with StrComp2[].

StrComp2[] Type: CHAR array

String variable that is compared with StrComp1[].

CaseSens  #CASE_SENS: Upper and lower case are taken into 
consideration.

 #NOT_CASE_SENS: Upper and lower case are ig-
nored.

1  DECL CHAR A[5]

2  BOOL B

3  A[]="ABCDE"

4  B = StrComp(A[], "ABCDE", #CASE_SENS)

5  B = StrComp(A[], "abcde", #NOT_CASE_SENS)

6  B = StrComp(A[], "abcd", #NOT_CASE_SENS)

7  B = StrComp(A[], "acbde", #NOT_CASE_SENS)

Line Description

4 B = TRUE

5 B = TRUE

6 B = FALSE

7 B = FALSE
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Syntax Copy = StrCopy(StrDest[], StrSource[])

Explanation of 

the syntax

Example

Element Description

Copy Type: BOOL

Variable for the return value. Return value:

 The string variable was copied successfully: TRUE

 The string variable was not copied: FALSE

StrDest[] Type: CHAR array

The character string is copied to this string variable.

Since StrDest[ ] is an array of type CHAR, individual char-
acters and constants are not permissible.

StrSource[] Type: CHAR array

The contents of this string variable are copied.

1  DECL CHAR A[25], B[25]

2  DECL BOOL C

3  A[] = ""

4  B[] = "Example"

5  C = StrCopy(A[], B[])

Line Description

5 A[ ] = “Example”

 C = TRUE
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12 Submit interpreter
12 Submit interpreter

12.1 Function of the Submit interpreter

Function 2 tasks run in parallel on the robot controller:

 Robot interpreter

The motion program runs in the robot interpreter.

 Submit interpreter

A SUB program runs in the submit interpreter.

A SUB program can perform operator control or monitoring tasks. Exam-
ples: monitoring of safety equipment; monitoring of a cooling circuit. 

This means that no PLC is required for smaller applications, as the robot 
controller can perform such tasks by itself.

The Submit interpreter starts automatically when the robot controller is 
switched on. The program SPS.SUB is started.

The submit interpreter can be stopped or deselected manually and can also 
be restarted.

SUB programs are always files with the extension *.SUB. The program 
SPS.SUB can be edited and further SUB programs can be created. 

Display The program SPS.SUB is located in the directory R1\System. This directory is 
visible in the user group Expert or higher.

In the Navigator, SUB programs are indicated by the following symbol:

In user group Expert or higher, the file extension sub is displayed in addition.

By default, the execution of a selected SUB program is not displayed. This can 
be changed using the system variable $INTERPRETER. The SUB program 
can only be displayed, however, if a motion program is selected at the same 
time.

2

 

t

 

t

The submit interpreter must not be used for time-critical 
applications! A PLC must be used in such cases. Rea-

sons:

 The submit interpreter shares system resources with the robot interpret-
er, which has the higher priority. The submit interpreter is thus not exe-
cuted at the robot controller’s interpolation cycle rate of 12 ms. 
Furthermore, the runtime of the submit interpreter is irregular.

 The runtime of the submit interpreter is influenced by the number of lines 
in the SUB program. Even comment lines and blank lines have an effect.

If a system file, e.g. $config.dat or $custom.dat, is modified in such a 
way that errors are introduced, the Submit interpreter is automatically 
deselected. Once the error in the system file has been rectified, the 

Submit interpreter must be reselected manually.

$INTERPRETER Description

1 The selected motion program is displayed in the 
editor. (Default)

0 The selected SUB program is displayed in the ed-
itor.
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12.2 Manually stopping or deselecting the Submit interpreter

Precondition  User group "Expert".

 Operating mode T1 or T2.

Procedure  In the main menu, select Configuration > SUBMIT interpreter > Stop or 
Deselect.

Alternative 

procedure

 In the status bar, touch the Submit interpreter status indicator. A window 
opens.

Select Stop or Deselect.

Description

Once the submit interpreter has been stopped or deselected, the correspond-
ing icon in the status bar is red or gray.

12.3 Manually starting the Submit interpreter

Precondition  User group “Expert”

 Operating mode T1 or T2

 Submit interpreter has been stopped or deselected.

Procedure  In the main menu, select Configuration > SUBMIT interpreter > Select/
Start.

Alternative 

procedure

 In the status bar, touch the Submit interpreter status indicator. A window 
opens.

Select Select/Start.

Description If the submit interpreter is deselected, the command Start/Select selects the 
program SPS.SUB.

If the submit interpreter has been stopped, the command Start/Select re-
sumes the selected program at the point at which it was stopped.

Once the submit interpreter has been started, the corresponding icon in the 
status bar is green.

Command Description

Stop The submit interpreter is stopped. When it is restarted, the 
SUB program is resumed at the point at which it was 
stopped.

Deselect The submit interpreter is deselected. 

Symbol Color Description

rot The submit interpreter has been stopped.

grau The submit interpreter is deselected.
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12.4 Editing the program SPS.SUB

Description The following folds are available for user-defined adaptations in the program 
SPS.SUB:

 USER INIT

 USER PLC

Other parts of the SPS.SUB program must not be modified by the user.

Precondition  The program SPS.SUB is not selected or has been stopped.

 User group “Expert”

Procedure 1. Select the program SPS.SUB in the Navigator and press Open.

2. Enter the changes:

 Enter initializations in the USER INIT fold. This fold is located in the INI 
fold.

 Enter all other changes in the USER PLC fold.

3. Close the program. Respond to the request for confirmation asking wheth-
er the changes should be saved by pressing Yes.

4. The program SPS.SUB can now be started via the main menu with Con-
figuration > SUBMIT interpreter > Select/Start.

SPS.SUB Structure of the program SPS.SUB:

Icon Color Description

Yellow The submit interpreter is selected. The 
block pointer is situated on the first line of 
the selected SUB program.

Green A SUB program is selected and running.

If other parts of SPS.SUB are changed, this can affect the functional-
ity of technology packages.

USER INIT

  ; Please insert user defined initialization commands

USER PLC

    ; Make your modifications here

   1  DEF  SPS ( )

   2    DECLARATIONS

   3    INI

   4  

   5    LOOP

   6       WAIT FOR NOT($POWER_FAIL)

   7       TORQUE_MONITORING()

   8  

   9      ATB PLC LOOP

  10      USER PLC

  11    ENDLOOP
455 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



456 / 491

KUKA System Software 8.3
12.5 Creating a new SUB program

Precondition  “Expert” user group

Procedure 1. In the file list, select the folder in which the program is to be created. (Not 
all folders allow the creation of programs within them.)

2. Press the New button.

The Template selection window is opened.

3. Select the template Submit or Expert Submit and confirm with OK.

4. Enter a name for the program and confirm it with OK.

Description “Submit” template:

The Submit template generates a SUB file with the following structure:

“Expert Submit” template:

The Expert Submit template generates an empty SUB file. With this template, 
everything has to be programmed by the user.

Line Description

3 INI fold

This fold contains the USER INIT fold: here the user can enter 
statements which are to be executed only once after booting.

5 … 10 LOOP statement. For programs that are to run continuously in 
the background.

9 Some software options insert folds into the program 
SPS.SUB. Example: KUKA.ArcTech Basic inserts the fold 
ATB PLC LOOP.

The folds that are actually present depend on what options are 
installed on the robot controllers. 

10 USER PLC: Here the user can enter instructions that are to be 
executed in the LOOP.

1  DECLARATIONS

2  INI

3  

4  LOOP

5  USER PLC

6  ENDLOOP

7  USER SUBROUTINE

Line Description

1 Declaration section

2 Initialization section. For statements that are only to be execut-
ed once after the system has booted.

4, 5, 6 LOOP statement containing the Fold USER PLC. 

USER PLC is for programs that are to run continuously in the 
background.

7 For user-specific subroutines

Use a LOOP statement when programming. SUB programs without a 
LOOP statement are only executed once by the Submit interpreter. It 
is then automatically deselected.
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12.6 Programming

KRL code Almost all KRL instructions can be used in a SUB program. The following 
statements are not possible, however:

 Instructions for robot motions

Robot motions can only be interpreted by the robot interpreter. For this 
reason, SRC programs containing motion commands cannot be called as 
subprograms from a SUB program.

 Instructions referring to robot motions

These include BRAKE and all TRIGGER statements.

Motion commands for external axes can be used in a SUB program. Example:

External axes E2 and E3 are moved in accordance with specific inputs.

WAIT statements or wait loops have not been used here as they stop the cy-
cle.

System variables The Submit interpreter has read-access to all system variables and write-ac-
cess to many of them. Access works even if the system variables are being 
used in parallel by a motion program. 

If a system variable to which the Submit interpreter does not have write-access 
is modified in a SUB program, an error message is generated when the pro-
gram is started and the Submit interpreter stops.

System variables that are frequently required in SUB programs:

Example: 

If the programmed velocity is not reached, output 2 is set to FALSE.

IF (($IN[12] == TRUE) AND ( NOT $IN[13] == TRUE)) THEN

ASYPTP {E2 45}

ASYPTP {E3 200}

...

IF ((NOT $IN[12] == TRUE) AND  ($IN[13] == TRUE)) THEN

ASYPTP {E2 0}

ASYPTP {E3 90}

$MODE_OP = Value

Value Description

#T1 Robot controller is in T1 mode.

#T2 Robot controller is in T2 mode.

#AUT Robot controller is in Automatic mode.

#EX Robot controller is in Automatic External mode.

#INVALID Robot controller has no defined state.

$OV_PRO = Value

Element Data type Description

Value (%) INT Program override value

…

IF (($MODE_OP == #T1) OR ($OV_PRO < 100)) THEN

$OUT[2] = FALSE

ENDIF

…
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Inputs/outputs The Submit interpreter can access the inputs and outputs of the robot control-
ler. 

Subprograms Other programs can be called as subprograms in a SUB program. The follow-
ing are possible:

 Other SUB programs

 SRC programs without statements for robot motions

Example:

CELL.SRC can be called from the program SPS.SUB with a CWRITE state-
ment and RUN. The call only takes effect in the case of a cold start.

In the test modes, $OV_PRO must not be written to by 
the Submit interpreter, because the change may be un-

expected for operators working on the industrial robot. Death, injuries or 
damage to property may result.

If possible, do not modify safety-relevant signals and 
variables (e.g. operating mode, EMERGENCY STOP, 

safety gate contact) via the Submit interpreter.
If modifications are nonetheless required, all safety-relevant signals and vari-
ables must be linked in such a way that they cannot be set to a dangerous 
state by the submit interpreter or PLC.

No check is made to see if the robot interpreter and Sub-
mit interpreter are accessing the same output simultane-

ously, as this may even be desired in certain cases.
The user must therefore carefully check the assignment of the outputs. Oth-
erwise, unexpected output signals may be generated, e.g. in safety equip-
ment. Death, serious injuries or major damage to property may result.

Fig. 12-1: SPS.SUB selects CELL.SRC in the robot interpreter

Further information about the program CELL.SRC can be found in 
this documentation.
 (>>> 6.17.1 "Configuring CELL.SRC" Page 190)

Further information about CWRITE statements can be found in the Expert 
documentation CREAD/CWRITE.
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Communication The flags of the robot controller can be used to enable the exchange of binary 
information between a running motion program and a SUB program. A flag is 
set by the submit interpreter and read by the robot interpreter.
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13 Diagnosis

13.1 Logbook

13.1.1 Displaying the logbook

The operator actions on the smartPAD are automatically logged. 

Procedure  In the main menu, select Diagnosis > Logbook > Display.

The following tabs are available:

 Log  (>>> 13.1.2 "“Log” tab" Page 461)

 Filter  (>>> 13.1.3 "“Filter” tab" Page 462)

13.1.2 “Log” tab

 

s

s

Fig. 13-1: Logbook, Log tab
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The following buttons are available:

13.1.3 “Filter” tab

The Filter tab is only displayed if the log User-defined has been selected.

Item Description

1 Type of log event

Example : Filter type "Note" + filter class "System" = note 
originated by the kernel system of the robot.

The individual filter types and filter classes are listed on the Filter 
tab.

2 Log event number

3 Date and time of the log event

4 Brief description of the log event

5 Detailed description of the selected log event

6 Indication of the active filter

Button Description

Export Exports the log data as a text file.

 (>>> 13.1.4 "Configuring the logbook" 
Page 463)

Update Refreshes the log display.
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13.1.4 Configuring the logbook

Precondition  “Expert” user group

Procedure 1. In the main menu, select Diagnosis > Logbook > Configuration. A win-
dow opens.

2. Make the desired settings.

3. Press OK to save the configuration and close the window.

Description

Fig. 13-2: Logbook, Filter tab

Fig. 13-3: Logbook configuration window
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13.2 Displaying the caller stack

This function displays the data for the process pointer ($PRO_IP).

Precondition  User group "Expert"

 Program is selected.

Procedure  In the main menu, select Diagnosis > Caller stack.

Description

Item Description

1  Check box active: the log events selected with the filter are 
saved in the text file.

 Check box not active: all log events are saved in the text file.

2 Enter the path and name of the text file.

Default path: C:\KRC\ROBOTER\LOG\LOGBUCH.TXT

3  Check box active: log data deleted because of a buffer over-
flow are indicated in gray in the text file.

 Check box not active: log data deleted because of a buffer 
overflow are not indicated in the text file.

Fig. 13-4: Caller Stack window

Item Description

1  None: Call not initiated by interrupt

 [No.]: Call initiated by interrupt with the number [No.]

2 This file contains the call.

3 The program line with this number contains the call.

Preconditions in the program for the correct line to be determined 
using the number:

 Detail view (ASCII mode) is activated.

 All Point PLCs are open.

4 Source line

5 Detailed information about the entry selected in the list
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13.3 Displaying interrupts

Precondition  “Expert” user group

Procedure  In the main menu, select Diagnosis > Interrupts.

Description

The following buttons are available:

Fig. 13-5: Interrupts

Item Description

1 Status of the interrupt

  Interrupt ON or ENABLE

  Interrupt DISABLE

  Interrupt OFF or not activated

2 Number/priority of the interrupt

3 Validity range of the interrupt: global or local

4 Type of interrupt, dependent on the defined event in the interrupt 
declaration

 Standard: e.g. $IN[...]

 Error stop: $STOPMESS

 EMERGENCY STOP: $ALARM_STOP

 Measurement (Fast Measurement): $MEAS_PULSE[1…5]

 Trigger: Trigger subprogram

5 Module and program line of the interrupt declaration

Button Description

Submit/

Robot

Toggles between the displays for robot interrupts and 
Submit interrupts.

Refresh Refreshes the display. 
465 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



466 / 491

KUKA System Software 8.3
13.4 Displaying diagnostic data about the kernel system

Description The menu item Diagnostic monitor makes it possible to display a wide range 
of diagnostic data concerning numerous software sub-areas of the kernel sys-
tem.

Examples:

 Area Kcp3 driver (= driver for the smartPAD) 

 Network driver

The data displayed depend on the selected area. The display includes states, 
fault counters, message counters, etc. 

Procedure 1. In the main menu, select Diagnosis > Diagnostic monitor.

2. Select an area in the Module box.

Diagnostic data are displayed for the selected area.

13.5 Automatically compressing data for error analysis (KrcDiag)

Description If it is necessary for an error to be analyzed by KUKA Roboter GmbH, this pro-
cedure can be used to compress the data for sending to KUKA. The procedure 
generates a ZIP file in the directory C:\KUKA\KRCDiag. This contains the data 
required by KUKA Roboter GmbH to analyze an error (including information 
about system resources, screenshots, and much more).

Preparation A screenshot of the current view of the smartHMI is automatically generated 
for the data packet. 

 For this reason, display error-relevant information on the smartHMI if pos-
sible before starting the operation, e.g. expand the message window or 
display the logbook. 

What information is useful here depends on the specific circumstances.

Procedure via 

“Diagnosis”

 In the main menu, select Diagnosis > KrcDiag. 

The data are compressed. Progress is displayed in a window. Once the 
operation has been completed, this is also indicated in the window. The 
window is then automatically hidden again.

Procedure via 

smartPAD

This procedure uses keys on the smartPAD instead of menu items. It can thus 
also be used if the smartHMI is not available, due to Windows problems for ex-
ample.

Precondition:

 The smartPAD is connected to the robot controller.

 The robot controller is switched on.

1. Press the “Main menu” key and hold it down.

2. Press the keypad key twice.

3. Release the “Main menu” key.

The data are compressed. Progress is displayed in a window. Once the 
operation has been completed, this is also indicated in the window. The 
window is then automatically hidden again.

Procedure via 

“Archive”

Alternatively, the data can also be compressed via File > Archive > [...]. In this 
way, the data can be stored on a USB stick or network path.

 (>>> 7.10 "Archiving and restoring data" Page 247)

The keys must be pressed within 2 seconds. Whether or not the main 
menu and keypad are displayed in the smartHMI is irrelevant.
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14 Installation

The robot controller is supplied with a Windows operating system and an op-
erational version of the KUKA System Software (KSS). Therefore, no installa-
tion is required during initial start-up.

Installation becomes necessary, for example, in the event of the hard drive be-
ing damaged and exchanged.

14.1 System requirements

KSS 8.3 can be run on the following robot controller:

 KR C4 

 with Windows Embedded Standard 7 V4.x

 and with 2 GB RAM

14.2 Installing Windows and the KUKA System Software (KSS) (from image)

Description There are several variants for loading and finalizing the image. The most com-
monly required procedure is described here. The procedure also illustrates the 
step in which a master image can be created if required.

Precondition  Bootable KUKA USB stick with KUKA.RecoveryUSB 2.0 software and an 
image

 The stick has been configured with “Silent” mode active.

 2 GB RAM

 The robot controller is switched off.

Procedure 1. Connect the USB stick to the robot controller.

2. Switch on the robot controller. The installation starts automatically. 

4

 

s

t

t

The robot controller may only be operated using the software provid-
ed with the controller by KUKA. 
KUKA Roboter GmbH must be consulted if different software is to be 

used.  (>>> 15 "KUKA Service" Page 475)

Information about the other variants and related issues is contained 
in the following documentation:

KUKA.RecoveryUSB 2.0 documentation: information about the 
creation and restoration of images, configuration of the stick, and the 
possible modes

 WES7 System Preparation expert documentation: information about fi-
nalizing and creating master images

We strongly recommend installing the desired software options (e.g. 
technology packages) before Finalize Installation is started by se-
lecting Execute. The procedure below follows this approach.

During the finalizing process, the projects of the robot controller are rebuilt on 
the basis of the active project. Only the options already installed by this point 
are later included in all projects (active project, initial project and base proj-
ect).

The LEDs on the CSP provide information about the installation sta-
tus. Information about the LEDs is contained in the KUKA.Recovery-
USB documentation.
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Observe the LEDs on the CSP! Initially, there is no image displayed on the 
smartPAD. 

3. Once the LEDs indicate that the Windows installation has been completed, 
remove the stick.

 Following installation of Windows, the robot controller automatically re-
boots. 

 After this, the robot controller automatically reboots again a second 
time. (By now, at the latest, the stick must have been removed.)

4. The dialog Finalize Installation is displayed.

5. Click on Cancel in the Finalize Installation dialog box.

A message informs the user that the dialog box will appear again the next 
time the system is started.

6. Confirm the message with OK.

7. Install the desired software options.

If required, the robot controller can be rebooted between the individual in-
stallations. Following each start, the Finalize Installation dialog box must 
then again be answered with Cancel.

8. Once the last software option has been installed, reboot the robot control-
ler.

9. Now select Execute in response to the Finalize Installation dialog box.

A message informs the user that the system preparation will now be start-
ed.

Fig. 14-1: Finalize Installation dialog box

Fig. 14-2: Message after Cancel
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10. Confirm the message with OK.

The Generalize Phase is executed. After this, the robot controller reboots 
automatically and then shuts down automatically.

After the shutdown:

 If a master image is to be created: Continue with step 11.

 If not: Continue with step 12.

11. Only execute this step (step 11) if a master image is to be created.

a. Plug in the USB Recovery Stick.

b. Reboot the robot controller.

c. Create the image.

In GUI mode, the image must be created via the user interface. In Si-
lent mode, image creation starts automatically.

Once the image has been created, the robot controller shuts down au-
tomatically.

d. Once the robot controller has shut down: Remove the USB stick.

12. Now reboot the robot controller.

The Specialize Phase is executed. This causes the robot controller to au-
tomatically reboot twice.

13. Now Mini-Setup starts:

Select the desired language. Confirm with Next.

14. Information about the installation and copyright is displayed. Confirm with 
Next.

15. Specify whether the robot controller is an OPS (Offline Programming Sys-
tem), also called “Office PC”. This is generally not the case, i.e. do not ac-
tivate check box. Confirm with Next.

16. The system suggests a robot type. Confirm with Next.

Or: If the suggested type does not correspond to the type that is being 
used, select a different type. Then confirm with Next.

17. A summary of the setup settings is displayed. Confirm with Next. 

The Initial Project Setup phase is executed. (This phase is short.)

The robot controller then shuts down automatically.

The robot controller can now be restarted in order to load the active project in 
WorkVisual and configure it.

Fig. 14-3: Message after Execute

If a master image is to be created: Do not yet plug in a USB stick. Plug 
in the stick only after the second shutdown – as described below.

The configuration of the stick must now be such that an image can be 
created!
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Once the project has been configured in WorkVisual, it can again be trans-
ferred to the robot controller.

If necessary, the computer name can now be changed.

 (>>> 14.3 "Changing the computer name" Page 470)

14.3 Changing the computer name

Description KUKA.RecoveryUSB assigns a new computer name whenever an image is re-
stored. The name can be changed at any point after the finalizing process.

Precondition  User group “Expert”

 Operating mode T1 or T2.

 No program is selected.

Procedure 1. In the main menu, select Start-up > Additional software.

The Installed additional software window is opened.

2. Press the New software button.

The Selection window is opened.

3. Press the Configure button. 

The Configure installation paths window is opened.

4. Select a line in the Installation paths for options area. 

Note: If the line already contains a path, this path will be overwritten.

5. Press Path selection. The available drives are displayed.

6. Navigate to C:\KUKA and mark the WES7RenameComputer folder there.

7. Press Save. The Configure installation paths window is again dis-
played. It now contains the new path.

8. Mark the line with the new path and again press Save.

The Selection window is again displayed. 

9. Mark the WES7RenameComputer entry.

10. Press Install. Answer the request for confirmation with Yes. 

11. The W7RenCom window and a popup keyboard are displayed.

12. Enter the desired name and press the Set Computername button to con-
firm.

13. The following message is displayed: To finish the name setting you need to 
reboot the PC.

Confirm the message with OK.

14. Reboot the robot controller.

14.4 Installing additional software

This function can be used to install additional software, e.g. technology pack-
ages. New programs and updates can be installed. The software is installed 
from a USB stick. Alternatively, it can also be installed via a network path.

The system checks whether the additional software is relevant for the KSS. If 
not, the system rejects the installation. If a software package that the system 
has rejected is nonetheless to be installed, KUKA Roboter GmbH must be 
contacted.

The project contains the KR 210 robot by default. Make sure to re-
move the robot from the tree structure in WorkVisual and insert the 
robot actually being used. 

This exchange must also be performed if the robot actually being used is al-
ready the KR 210.
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Precondition  “Expert” user group

 T1 or T2 mode

 No program is selected.

 USB stick with the software to be installed

Procedure 1. Connect the USB stick to the robot controller or smartPAD.

2. In the main menu, select Start-up > Additional software.

3. Press New software: The new software must be displayed in the Name 
column and drive E:\ or K:\ in the Path column.

If not, press Refresh.

4. If the specified entries are now displayed, continue with step 5.

If not, the path from which the software is to be installed must be config-
ured first:

a. Press the Configure button. 

b. Select a line in the Installation paths for options area. 

Note: If the line already contains a path, this path will be overwritten.

c. Press Path selection. The available drives are displayed.

d. If the stick is connected to the robot controller: On E:\, select the level 
at which the software is located. This can be E:\ directly or a sublevel.

If the stick is connected to the smartPAD: K:\ instead of E:\

e. Press Save. The Installation paths for options area is displayed 
again. It now contains the new path.

f. Mark the line with the new path and again press Save.

5. Select the new software and press Install. Answer the request for confir-
mation with Yes. 

6. Confirm the reboot prompt with OK.

7. Remove the stick.

8. Reboot the robot controller.

Description The following buttons are available:

We recommend using a KUKA USB stick. Data may be 
lost if a stick from a different manufacturer is used.

Button Description

New software All programs available for installation are dis-
played.

Back Additional software already installed is displayed.

Refresh Refreshes the display, e.g. after a USB stick has 
been connected.

Install Displays additional buttons:

 Yes: the selected software is installed. If it is 
necessary to reboot the controller, this is indi-
cated by a message.

 No: the software is not installed.
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14.5 KSS update

Description This function can be used to install KSS updates, e.g. from KSS 8.3.0 to KSS 
8.3.1.

Following installation or update of the KUKA System Software, the robot con-
troller always performs an initial cold start.

It is advisable to archive all relevant data before updating a software package. 
If necessary, the old version can be restored in this way. It is also advisable to 
archive the new version after carrying out the update.

Overview There are 2 ways of installing a KSS update:

 From USB memory stick

 (>>> 14.5.1 "Update from USB stick" Page 472)

 From the network

 (>>> 14.5.2 "Update from the network" Page 473)

14.5.1 Update from USB stick

Precondition  “Expert” user group

 T1 or T2 mode

 No program is selected.

 USB stick with the software to be installed

Procedure 1. Plug in USB stick.

2. In the main menu, select Start-up > Software update > Automatic.

3. A request for confirmation is displayed, asking if the update should be car-
ried out. Confirm by pressing Yes.

Configure This button is only displayed if New software has 
been pressed.

Paths for the installation of additional software or 
KSS updates can be selected and saved here.

Displays additional buttons:

 Path selection: a new path can be selected.

 Save: saves the displayed paths.

Uninstall Displays additional buttons:

 Yes: the selected software is uninstalled.

 No: the software is not uninstalled.

Button Description

Do not use this function to install a new version, e.g. from KSS 8.2 to 
KSS 8.3. Nor may this function be used to install a variant, e.g. from 
KSS 8.3 to KSS 8.3 sr. KUKA Roboter GmbH must be consulted be-

fore a new version or variant is installed.
This function cannot be used to install updates of additional software, such 
as technology packages. 

A non-bootable USB stick must be used.
We recommend using a non-bootable KUKA stick. Data 

may be lost if a stick from a different manufacturer is used.
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14 Installation
The following message is now displayed in the message window: To com-
plete software update, please REBOOT computer!

4. Select Shutdown in the main menu and then the option Reboot control 
PC (Reload files is not necessary).

5. Confirm the request for confirmation with Yes. The robot controller is re-
booted and performs the update. 

The robot controller then reboots again.

6. Once the robot controller has rebooted for the second time, the USB stick 
can be removed. 

The updated System Software is now available.

14.5.2 Update from the network

Description In the case of an update from the network, the installation data are copied to 
the local drive D:\. If there is already a copy of a system software version pres-
ent on D:\, that copy will now be overwritten.

Installation is started on completion of the copying operation.

Precondition For the preparation:

 No program is selected.

 T1 or T2 operating mode

 “Expert” user group

For the procedure:

 No program is selected.

 T1 or T2 operating mode

Preparation Configure the network path from which the update installation is to be carried 
out:

1. In the main menu, select Start-up > Additional software.

2. Press New software.

3. Press Configure.

4. Select the Installation path for KRC update via the network box. Press 
Path selection.

5. Select the desired network path (= the directory in which the Setup.exe file 
is located). Press Save.

6. The selected path is now displayed in the Installation path for KRC up-
date via the network box. 

Press Save again.

7. Close the window.

Procedure 1. In the main menu, select Start-up > Software update > Net.

2. A request for confirmation is displayed, asking if the update should be car-
ried out. Confirm by pressing Yes.

Depending on the network utilization, the procedure may take up to 
15 min.

3. A message is displayed, indicating that a cold start will be forced next time 
the system is booted. Switch the controller off.

4. Wait until the computer has shut down completely. Then switch the con-
troller back on.

It is only necessary to configure the network path once. It remains 
saved for subsequent updates.
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5. Once the update has been completed, the computer is automatically shut 
down and rebooted.
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15 KUKA Service
15 KUKA Service

15.1 Requesting support

Introduction This documentation provides information on operation and operator control, 
and provides assistance with troubleshooting. For further assistance, please 
contact your local KUKA subsidiary.

Information The following information is required for processing a support request:

 Description of the problem, including information about the duration and 
frequency of the fault

 As comprehensive information as possible about the hardware and soft-
ware components of the overall system

The following list gives an indication of the information which is relevant in 
many cases:

 Model and serial number of the kinematic system, e.g. the manipulator

 Model and serial number of the controller

 Model and serial number of the energy supply system

 Designation and version of the system software

 Designations and versions of other software components or modifica-
tions

 Diagnostic package KrcDiag:

Additionally for KUKA Sunrise: Existing projects including applications

For versions of KUKA System Software older than V8: Archive of the 
software (KrcDiag is not yet available here.)

 Application used

 External axes used

15.2 KUKA Customer Support

Availability KUKA Customer Support is available in many countries. Please do not hesi-
tate to contact us if you have any questions.

Argentina Ruben Costantini S.A. (Agency)

Luis Angel Huergo 13 20

Parque Industrial

2400 San Francisco (CBA)

Argentina

Tel. +54 3564 421033

Fax +54 3564 428877

ventas@costantini-sa.com

Australia KUKA Robotics Australia Pty Ltd

45 Fennell Street

Port Melbourne VIC 3207

Australia

Tel. +61 3 9939 9656

info@kuka-robotics.com.au

www.kuka-robotics.com.au

 

A

 

v
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Belgium KUKA Automatisering + Robots N.V.

Centrum Zuid 1031

3530 Houthalen

Belgium

Tel. +32 11 516160

Fax +32 11 526794

info@kuka.be

www.kuka.be

Brazil KUKA Roboter do Brasil Ltda.

Travessa Claudio Armando, nº 171

Bloco 5 - Galpões 51/52

Bairro Assunção

CEP 09861-7630 São Bernardo do Campo - SP

Brazil

Tel. +55 11 4942-8299

Fax +55 11 2201-7883

info@kuka-roboter.com.br

www.kuka-roboter.com.br

Chile Robotec S.A. (Agency)

Santiago de Chile

Chile

Tel. +56 2 331-5951

Fax +56 2 331-5952

robotec@robotec.cl

www.robotec.cl

China KUKA Robotics China Co., Ltd.

No. 889 Kungang Road

Xiaokunshan Town

Songjiang District

201614 Shanghai

P. R. China

Tel. +86 21 5707 2688

Fax +86 21 5707 2603

info@kuka-robotics.cn

www.kuka-robotics.com

Germany KUKA Roboter GmbH

Zugspitzstr. 140

86165 Augsburg

Germany

Tel. +49 821 797-4000

Fax +49 821 797-1616

info@kuka-roboter.de

www.kuka-roboter.de
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France KUKA Automatisme + Robotique SAS

Techvallée

6, Avenue du Parc

91140 Villebon S/Yvette

France

Tel. +33 1 6931660-0

Fax +33 1 6931660-1

commercial@kuka.fr

www.kuka.fr

India KUKA Robotics India Pvt. Ltd.

Office Number-7, German Centre,

Level 12, Building No. - 9B

DLF Cyber City Phase III

122 002 Gurgaon

Haryana

India

Tel. +91 124 4635774

Fax +91 124 4635773

info@kuka.in

www.kuka.in

Italy KUKA Roboter Italia S.p.A.

Via Pavia 9/a - int.6

10098 Rivoli (TO)

Italy

Tel. +39 011 959-5013

Fax +39 011 959-5141

kuka@kuka.it

www.kuka.it

Japan KUKA Robotics Japan K.K.

YBP Technical Center

134 Godo-cho, Hodogaya-ku

Yokohama, Kanagawa

240 0005

Japan

Tel. +81 45 744 7691

Fax +81 45 744 7696

info@kuka.co.jp

Canada KUKA Robotics Canada Ltd.

6710 Maritz Drive - Unit 4

Mississauga

L5W 0A1 

Ontario

Canada

Tel. +1 905 670-8600

Fax +1 905 670-8604

info@kukarobotics.com

www.kuka-robotics.com/canada
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Korea KUKA Robotics Korea Co. Ltd.

RIT Center 306, Gyeonggi Technopark

1271-11 Sa 3-dong, Sangnok-gu

Ansan City, Gyeonggi Do

426-901

Korea

Tel. +82 31 501-1451

Fax +82 31 501-1461

info@kukakorea.com

Malaysia KUKA Robot Automation (M) Sdn Bhd

South East Asia Regional Office

No. 7, Jalan TPP 6/6

Taman Perindustrian Puchong

47100 Puchong

Selangor

Malaysia

Tel. +60 (03) 8063-1792

Fax +60 (03) 8060-7386

info@kuka.com.my

Mexico KUKA de México S. de R.L. de C.V.

Progreso #8

Col. Centro Industrial Puente de Vigas

Tlalnepantla de Baz

54020 Estado de México

Mexico

Tel. +52 55 5203-8407

Fax +52 55 5203-8148

info@kuka.com.mx

www.kuka-robotics.com/mexico

Norway KUKA Sveiseanlegg + Roboter

Sentrumsvegen 5

2867 Hov

Norway

Tel. +47 61 18 91 30

Fax +47 61 18 62 00

info@kuka.no

Austria KUKA Roboter CEE GmbH

Gruberstraße 2-4

4020 Linz

Austria

Tel. +43 7 32 78 47 52

Fax +43 7 32 79 38 80

office@kuka-roboter.at

www.kuka.at
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Poland KUKA Roboter Austria GmbH

Spółka z ograniczoną odpowiedzialnością

Oddział w Polsce

Ul. Porcelanowa 10

40-246 Katowice

Poland

Tel. +48 327 30 32 13 or -14

Fax +48 327 30 32 26

ServicePL@kuka-roboter.de

Portugal KUKA Sistemas de Automatización S.A.

Rua do Alto da Guerra n° 50

Armazém 04

2910 011 Setúbal

Portugal

Tel. +351 265 729780

Fax +351 265 729782

kuka@mail.telepac.pt

Russia KUKA Robotics RUS

Werbnaja ul. 8A

107143 Moskau

Russia

Tel. +7 495 781-31-20

Fax +7 495 781-31-19

info@kuka-robotics.ru

www.kuka-robotics.ru

Sweden KUKA Svetsanläggningar + Robotar AB

A. Odhners gata 15

421 30 Västra Frölunda

Sweden

Tel. +46 31 7266-200

Fax +46 31 7266-201

info@kuka.se

Switzerland KUKA Roboter Schweiz AG

Industriestr. 9

5432 Neuenhof

Switzerland

Tel. +41 44 74490-90

Fax +41 44 74490-91

info@kuka-roboter.ch

www.kuka-roboter.ch
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Spain KUKA Robots IBÉRICA, S.A.

Pol. Industrial

Torrent de la Pastera

Carrer del Bages s/n

08800 Vilanova i la Geltrú (Barcelona)

Spain

Tel. +34 93 8142-353

Fax +34 93 8142-950

Comercial@kuka-e.com

www.kuka-e.com

South Africa Jendamark Automation LTD (Agency)

76a York Road

North End

6000 Port Elizabeth

South Africa

Tel. +27 41 391 4700

Fax +27 41 373 3869

www.jendamark.co.za

Taiwan KUKA Robot Automation Taiwan Co., Ltd.

No. 249 Pujong Road

Jungli City, Taoyuan County 320

Taiwan, R. O. C.

Tel. +886 3 4331988

Fax +886 3 4331948

info@kuka.com.tw

www.kuka.com.tw

Thailand KUKA Robot Automation (M)SdnBhd

Thailand Office

c/o Maccall System Co. Ltd.

49/9-10 Soi Kingkaew 30 Kingkaew Road

Tt. Rachatheva, A. Bangpli

Samutprakarn

10540 Thailand

Tel. +66 2 7502737

Fax +66 2 6612355

atika@ji-net.com

www.kuka-roboter.de

Czech Republic KUKA Roboter Austria GmbH

Organisation Tschechien und Slowakei

Sezemická 2757/2

193 00 Praha

Horní Počernice

Czech Republic

Tel. +420 22 62 12 27 2

Fax +420 22 62 12 27 0

support@kuka.cz
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Hungary KUKA Robotics Hungaria Kft.

Fö út 140

2335 Taksony

Hungary

Tel. +36 24 501609

Fax +36 24 477031

info@kuka-robotics.hu

USA KUKA Robotics Corporation

51870 Shelby Parkway

Shelby Township

48315-1787 

Michigan

USA

Tel. +1 866 873-5852

Fax +1 866 329-5852

info@kukarobotics.com

www.kukarobotics.com

UK KUKA Automation + Robotics

Hereward Rise

Halesowen

B62 8AN

UK

Tel. +44 121 585-0800

Fax +44 121 585-0900

sales@kuka.co.uk
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Index
Index

Symbols
_TYP 366
_TYPE 367
#BSTEP 263
#CSTEP 264
#IGNORE 294, 295
#ISTEP 263
#MSTEP 263
#PSTEP 264
$ 360
$ACCU_STATE 92
$ADAP_ACC 181, 186
$ADVANCE 264
$ALARM_STOP 196
$ALARM_STOP_INTERN 196
$ANIN 345
$ANOUT 345
$AUT 197
$BRAKE_SIG 213
$BRAKES_OK 226
$BRAKETEST_MONTIME 225
$BRAKETEST_REQ_EX 225
$BRAKETEST_REQ_INT 226
$BRAKETEST_WARN 226
$BRAKETEST_WORK 226
$BRK_DEL_COM 443
$BRK_DEL_EX 443
$BRK_DEL_PRO 443
$BRK_MODE 443
$BWD_INFO 275
$BWDSTART 275
$CHCK_MOVENA 194
$CIRC_MODE 296
$CIRC_TYPE 296
$COLL_ALARM 182
$COLL_ENABLE 182
$CONF_MESS 194
$CONST_VEL 388
$CONST_VEL_C 388
$COOLDOWN_TIME 180
$COULD_START_MOTION 52
$DIST_LAST 432
$DIST_NEXT 432
$DRIVES_OFF 194
$DRIVES_ON 194
$ECO_LEVEL 170
$ERR 395
$EX_AX_IGNORE 390
$EXT 197
$EXT_START 194
$HOLDING_TORQUE 214
$I_O_ACT 195
$I_O_ACTCONF 196
$IN 345
$IN_HOME 197
$LDC_CONFIG 151
$LDC_LOADED 150
$LDC_RESULT 151

$LOAD_BWINI 275
$MOVE_ENABLE 194
$NEAR_POSRET 197
$ON_PATH 197
$ORI_TYPE 280, 294
$OUT 345
$PAL_MODE 99
$PATHTIME 386
$PERI_RDY 52, 196
$POS_ACT 434
$PRO_ACT 196
$PRO_IP 464
$PRO_MODE 263
$PRO_MOVE 197
$RC_RDY1 195
$ROB_CAL 196
$ROB_STOPPED 197
$ROBRUNTIME 90, 91
$SPL_ORI_JOINT_AUTO 295
$STOP_CONST_VEL_RED 388
$STOPMESS 196
$T1 197
$T2 197
$TOOL_DIRECTION 124
$TORQ_DIFF 181, 186
$TORQ_DIFF2 181
$TORQMON_COM_DEF 181
$TORQMON_DEF 181
$TORQMON_TIME 182, 187
$TORQUE_AXIS_ACT 212, 214
$TORQUE_AXIS_LIMITS 213
$TORQUE_AXIS_MAX 213
$TORQUE_AXIS_MAX_0 213
$US2_VOLTAGE_ON 96
$USER_SAF 53, 196
$VW_BACKWARD 275
$VW_CYCFLAG 275
$VW_MOVEMENT 275
$VW_RETRACE_AMF 275
$WARMUP_CURR_LIMIT 180
$WARMUP_MIN_FAC 180
$WARMUP_RED_VEL 179
$WARMUP_SLEW_RATE 180
$WARMUP_TIME 179

Numbers
2004/108/EC 43
2006/42/EC 43
3-point method 132
89/336/EEC 43
95/16/EC 43
97/23/EC 43

A
A6, mastering position 115
ABC 2-point method 129
ABC World method 129
Accessories 17, 21
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Activation, project 251
Actual position 79
Addition 433
Addition, geometric 434
Administrator 63
Advance run 264
Advance run stop 391
Analog inputs 403
Analog outputs 404
ANIN 403
ANOUT 347, 404
ANSI/RIA R.15.06-2012 44
APPL_RUN 197
Applied norms and regulations 43
Approximate positioning 279, 312
Approximate positioning, homogenous 428
Approximate positioning, mixed 429
Archiving overview 247
Archiving, logbook 249
Archiving, network 249
Archiving, to USB stick 248
Areas of validity 362
AUT and EXT Consistency 220
AUT and EXT consistency 220
Automatic mode 40
Auxiliary point 278, 369, 370
Axis monitoring functions, checking 165
Axis monitoring functions, configuring 163
Axis range 22
Axis range limitation 32
Axis range monitoring 32

B
Backup configuration (window) 258
Backup Manager 254
Backup Manager, configuring 258
Backward motion 270
Backward motion, configuring 188
Backward motion, prevention 441
BACKWARD_STEP 189
Base calibration 131
BASE coordinate system 64, 131
Battery state 92
Bit operators 438
Block pointer 238, 264
Block selection 268, 286
BRAKE 416
Brake defect 34
Brake delay 443
Brake release device 32
Brake test 222
Brake test cycle time 223
Brake test, function test 229
Brake test, programs 224
Brake test, signals 225, 226
Brake test, teaching positions 227
Brake, defective 228
BrakeTestBack.SRC 225, 228
BrakeTestPark.SRC 224, 228
BrakeTestReq.SRC 224, 229
BrakeTestSelfTest.SRC 225, 230

BrakeTestStart.SRC 224, 228
Braking distance 22
Branch, conditional 393

C
Calibrating an external kinematic system 142
Calibration 124
Calibration points (menu item) 89
Calibration tolerances, defining 187
Calibration, base 131
Calibration, external TCP 135
Calibration, fixed tool 134
Calibration, linear unit 140
Calibration, root point, kinematic system 142
Calibration, tool 124
Calibration, TOOL kinematic system 146
Calibration, workpiece 134
Call by Reference 412
Call by Value 412
Caller stack 464
Caller stack (menu item) 464
Cancel program 237
CASE 400
CAST_FROM 432
CAST_TO 432
CCLOSE 432
CE mark 22
CELL.SRC 269
CHANNEL 432
Checksum , safety configuration 167
CIOCTL 433
CIRC 369
CIRC motion 309
CIRC_REL 370
CIRC, motion type 278
Circular angle 300
Circular motion 369, 370
Cleaning work 41
Close all FOLDs (menu item) 243
Cold start 58
Cold start, initial 55, 57, 58, 472
Collision detection 180, 182, 311
Collision detection (menu item) 182, 183
Collision detection, Automatic External 184
Collision detection, offset 182
Collision detection, system variables 181
Collision detection, variable 184
Comment 244
Comparison, data from kernel system and hard 
drive 220
Conditional branch 393
Configuration 157
Configuration (menu item) 168
Configuring CELL.SRC 190
Connecting cables 17, 21
Connection manager 45
CONST 364
CONST_VEL 386
Constant velocity range 325, 335, 386
Constants 363, 364
CONTINUE 391
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Continuous Path 277
Coordinate system for jog keys 50
Coordinate system for Space Mouse 49
Coordinate systems 64
Coordinate systems, angles 65
Coordinate systems, orientation 65
COPEN 433
Copy 246
Counterbalancing system 41
Counters, displaying 87
CP motions 277
CP spline block 313, 375
CREAD 433
Creating a new folder 231
Creating a new program 231
Cut 246
CWRITE 433

D
Danger zone 23
DAT 359
Data list 359
Data type, user-defined 363, 365, 366
Data types 361
Data, restoring 250
DECL 364
Declaration of conformity 22
Declaration of incorporation 21, 22
Decommissioning 42
DEF line (menu item) 241
DEF line, displaying/hiding 241
DEFAULT 400
DEFFCT ... ENDFCT 411
Delay time, power failure 58
Delay time, power-off 57, 59
DELETE_BACKWARD_BUFFER 441
Deleting mastering 121
Detail view (ASCII) (menu item) 241
Detail view, activating 241
Diagnosis 461
Diagnostic monitor (menu item) 466
Dial gauge 112
Directory structure 232
Display (menu item) 84
Displaying a variable, single 82, 83
Displaying the logbook 461
Displaying variables, in overview 84
Displaying, robot controller information 90
Displaying, robot information 90
Disposal 42
DISTANCE 421
Division 433
Documentation, industrial robot 15
Drive bus 57
Drives, switching on/off 53

E
EC declaration of conformity 22
Edit (button) 50
Editor 237
Electromagnetic compatibility (EMC) 44

ELSE 393
EMC Directive 22, 43
EMERGENCY STOP 46
EMERGENCY STOP device 28, 29, 34
EMERGENCY STOP, external 29, 36
EMERGENCY STOP, local 36
EN 60204-1 + A1 44
EN 61000-6-2 44
EN 61000-6-4 + A1 44
EN 614-1 44
EN ISO 10218-1 44
EN ISO 12100 43
EN ISO 13849-1 43
EN ISO 13849-2 43
EN ISO 13850 43
Enabling device 30, 34
Enabling device, external 30
Enabling switch 47
Enabling switches 30
ENDFCT 411
ENDFOR 392
ENDIF 393
Endless loop 394
ENDLOOP 394
ENDSPLINE 375, 376
ENDSWITCH 400
ENDWHILE 402
Energy consumption, measuring 77
ENUM 365
Enumeration type 365
ERR_RAISE 395
Even parity 195
Event planner (menu item) 220
EXIT 391, 394
Exiting, KSS 55
Expert Submit (template) 456
Export (button) 168
External axes 21, 24, 79, 90
External kinematic system, calibration 142

F
F 416
FALSE 410
Faults 35
File list 232
File, properties 233
Filter 233
Find 247
First mastering 107, 116
Fixed tool, calibration 134
Flags, displaying 85, 86
FLANGE coordinate system 65, 125
Folder, creating 231
Folder, properties 233
Folds 242
Folds, creating 245
Folds, displaying 242
Fonts 359
FOR 401
FOR ... TO ... ENDFOR 392
Frame operation 434
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Function test 36
Function, calling 410
Function, syntax 411

G
General safety measures 34
Geometric addition 434
Global 362
GLOBAL (interrupt declaration) 417
GOTO 392
Guard interlock 28

H
HALT 393
Hardware, options 96
Hazardous substances 41
Header 232
Hibernate 58
HOME position 240
Homogenous approximate positioning 428
HOV 70

I
I/O driver, reconfiguring 163
I/Os, reconfiguring 163
Identification plate 47
IF ... THEN ... ENDIF 393
Impact 181, 183
IN parameters 412
Increment 75
Incremental jogging 75
Indirect method 133
Industrial robot 17, 21
Info (menu item) 90
Inline forms 307
Inputs/outputs, analog 81, 345
Inputs/outputs, Automatic External 81, 191
Inputs/outputs, digital 79, 345
Installation 467
Intended use 18, 21
INTERN.ZIP 248, 249
Interpolation mode 311, 316
INTERRUPT 417, 418
Interrupt 416
Interrupt program 417
Interrupts 465
Introduction 15
IP addresses 157

J
Jerk 316, 317, 321, 323, 328, 330
Jog keys 46, 66, 71
Jog mode 31, 34
Jog mode “Jog keys” 68
Jog mode “Space Mouse” 68
Jog mode, activating 70
Jog override 70
Jogging, axis-specific 65, 71
Jogging, Cartesian 65, 71, 75
Jogging, external axes 76
Jogging, robot 65

Jump 392

K
Keyboard 46
Keyboard key 46
Keypad 50
Keywords 360
Kinematics group 50, 68
KLI, configuring 157
KrcDiag 466
KRL syntax 357
KUKA Customer Support 90, 475
KUKA Line Interface, configuring 157
KUKA smartHMI 49
KUKA smartPAD 23, 45
KUKA.Load 148
KUKA.LoadDataDetermination 148

L
Labeling 33
Language 59
Liability 21
LIN 369
LIN motion 308
LIN_REL 370
LIN, motion type 278
Line break (menu item) 242
Line mark for mastering 116
Linear motion 369, 370
Linear unit 21, 139
Load data 148
Logbook 461
Logbook, configuring 463
Logic Consistency 221
Logic consistency 220
Long texts, exporting 152
Long texts, importing 152
LOOP ... ENDLOOP 394
Loss of mastering 107, 111, 115, 120
Low Voltage Directive 22

M
Machine data 37, 90, 91, 95
Machinery Directive 22, 43
Main menu, calling 54
Maintenance 40, 154
Manipulator 17, 21, 23
Manual mode 39
Marked region 247
Mastering 100
Mastering after maintenance work 113
Mastering marks 103
Mastering methods 101
Mastering position, A6 115
Mechanical axis range limitation 32
Mechanical end stops 31
MEMD 102, 114
Message window 49
Messages, show help 60
Micro Electronic Mastering Device 102, 114
Minimizing KUKA smartHMI 54
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Mixed approximate positioning 429
Mode selection 26, 27
Modifying a logic instruction 356
Modifying a variable 82
Modifying coordinates 338
Modifying motion parameters 338
Modifying variables 84
Module 61, 359
Monitoring, velocity 31
Motion conditions (window) 52
Motion programming, basic principles 277
Motion types 277
Motor, exchange 114
Multiplication 433

N
Name, archive 91
Name, control PC 90
Name, robot 90, 91
Names 360
Navigator 232
Non-rejecting loop 399
Numeric entry, external TCP 136
Numeric entry, external tool 147
Numeric entry, linear unit 141
Numeric entry, root point, kinematic system 144
Numeric input, base 134
Numeric input, tool 131

O
Odd parity 195
Offset 107, 110, 115, 119, 347
OLDC 149
ON_ERROR_PROCEED 394
Online documentation 59
Online help 59
Online load data check 149
Online optimizing 220, 222
Open all FOLDs (menu item) 243
Opening a program 237
Operating hours 91
Operating hours meter 91
Operating mode, changing 63
Operation 45
Operator 25, 63
Operator safety 26, 28, 34, 53
Operator safety acknowledgement 96
Operator, geometric 434
Operators for bit operations 438
Operators for comparison operations 437
Operators, arithmetic 433
Operators, logic 438
Operators, priority 440
Options 17, 21
Orientation behavior, SCIRC 296
Orientation control, LIN, CIRC 280
Orientation control, spline 294
OUT 345
OUT parameters 412
Output, analog 347
Output, digital 345

Overload 34
Override 70, 267
Override (menu item) 77
Overriding, power failure 57, 58
Overview of the industrial robot 17

P
Palletizing robots 99, 126, 131
Panic position 30
Parameters, transferring 412
Parity 195
Parity bit 195
Parity, even 195
Parity, odd 195
Password, changing 170
Paste 246
PATH 424
Payload data 148
Payload data (menu item) 149
Performance Level 26
Performing a manual brake test 228
Peripheral contactor 38, 96, 98
Personnel 24
PGNO_FBIT 193
PGNO_FBIT_REFL 196
PGNO_LENGTH 193
PGNO_PARITY 193
PGNO_REQ 197
PGNO_TYPE 192
PGNO_VALID 193
Pinning 250, 254
Plant integrator 24
PLC_ROB_STOP_RELEASE() 442
PLC_ROB_STOP() 442
Point correction, defining limits 176
Point-to-point 277
Point-to-point motion 368
Positionally accurate robot, checking activation 
99
Positioner 21, 142
POV 267
Power failure delay time 58
Power failure, overriding 57, 58
Power-off delay time 57, 59
Pre-mastering position 103, 104
Pressure Equipment Directive 41, 43
Preventive maintenance work 41
Printing, program 247
Priority 417, 422, 426
Probe 102
Product description 17
PROFIenergy 77
PROFINET interface 158
Program execution 263
Program execution control 391
Program lines, deleting 245
Program override 267
Program run mode, selecting 263
Program run modes 263
Program, cancel 237
Program, closing 238
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Program, creating 231
Program, editing 243
Program, opening 237
Program, printing 247
Program, selecting 237
Program, starting 267, 268
Program, stopping 268, 269
Programmer 63
Programming, Expert 357
Programming, inline forms 307
Programming, KRL syntax 357
Programming, User 307
Project management (window) 252
Project, activation 251
Project, inactive 253
Properties, file or folder 233
Protective equipment 31
PTP 368
PTP motion 307
PTP spline block 313, 376
PTP_REL 368
PTP_SPLINE ... ENDSPLINE 376
PTP, motion type 277
PUBLIC 363
PULSE 346, 405
Pulse 346, 405
Pulse, path-related 355

R
Rating plate 95
RDC data backup 92
RDC, exchange 114
Re-teaching 338
Reaction distance 22
Recommissioning 36, 95
Reference mastering 113
REFLECT_PROG_NR 193
Rejecting loop 402
Release device 32
Renaming a file 231
Renaming a folder 231
Renaming the base 139
Renaming the tool 139
Repair 40
REPEAT ... UNTIL 399
Replace 247
Resetting a program 269
RESUME 420
Reteaching, defining limits 176
RETURN 411
ROB_STOP_RELEASE() 442
ROB_STOP() 442
Robot controller 17, 21
Robot data (menu item) 90
ROBROOT coordinate system 64
Runtime variable 362

S
Safe operational stop 23, 30
Safeguards, external 33
Safety 21

Safety configuration, Checksum 167
Safety configuration, export 168
Safety configuration, import 168
Safety controller 27
Safety functions 26, 34
Safety functions, overview 26
Safety instructions 15
Safety of machinery 43
Safety options 23
Safety STOP 0 23
Safety STOP 1 23
Safety STOP 2 23
Safety STOP 0 23
Safety STOP 1 23
Safety STOP 2 23
Safety stop, external 31
Safety zone 23, 25
Safety, general 21
SCIRC 377, 378
SCIRC motion, programming 329
SCIRC segment, programming 318
SEC 402
Selecting a program 237
Selecting the base 71
Selecting the tool 71
SEMD 102, 106
Serial number 91
Service life 23, 90
Service, KUKA Roboter 475
SET_BRAKE_DELAY() 443
SET_TORQUE_LIMITS 208, 211
SGTLCRC.XML 167
Shutdown (menu item) 56
SIGNAL 409
Signal diagrams 199
Signals, brake test 225
Signals,brake test 226
Simulation 40
Single (menu item) 82, 83, 186
Single point of control 42
Singularities 304
Singularity, CP spline 294, 295
Singularity, LIN/CIRC 280
SLIN 377, 378
SLIN motion, programming 327
SLIN segment, programming 317
smartHMI 17, 49
smartPAD 23, 35, 45
Soft axes 205
Software 17, 21
Software limit switches 31, 34, 121
Software limit switches, modifying 121
Space Mouse 46, 66, 72, 74, 75
Special characters 307
SPL 377, 378
SPL segment, programming 317
SPLINE ... ENDSPLINE 375
Spline block, programming 313
Spline segment 283
Spline, motion type 283
SPOC 42
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SPS.SUB, editing 455
SPTP 380
SPTP motion, programming 331
SPTP segment, programming 319
SPTP_REL 381
SRC 359
SREAD 433
Stamp 244
Standard Electronic Mastering Device 102, 106
Standstill monitoring 164
Start backwards key 46
Start key 46, 47
Start type, KSS 55
Start types 58
Start-up 36, 95
Start-up mode 38
Start-up wizard 95
Starting a program, automatic 268
Starting a program, manual 267
Starting Automatic External mode 269
Starting the KSS 54
Status 301
Status bar 49, 51, 232
Status keys 46
STEP 392
STOP 0 22, 24
STOP 1 22, 24
STOP 2 22, 24
Stop category 0 24
Stop category 1 24
Stop category 2 24
STOP key 46
Stop reactions 26
STOP WHEN PATH 389
Stopping a program 268, 269
Stopping distance 22, 25
Stopping the robot 416, 442
Storage 42
Storage capacities 90
String variable length after initialization 448
String variable length in the declaration 447
String variable, deleting contents 448
String variables 447
String variables, comparing contents 450
String variables, copying 450
String variables, extending 448
String variables, searching 449
STRUC 366
Structure type 366
SUB program, creating 456
Submit (template) 456
Submit interpreter 51, 453
Submit interpreter, editing SPS.SUB 455
Submit interpreter, starting 454
Submit interpreter, stopping 454
Subprogram, calling 410
Subtraction 433
Supplementary load data (menu item) 149
Support request 475
SWITCH ... CASE ... ENDSWITCH 400
Switching action, path-related 350

Switching on the robot controller 54
SWRITE 433
Symbols 359
SYN OUT 350
SYN PULSE 355
System integrator 22, 24, 25
System requirements 18, 467
System variables 274

T
T1 24
T1 and T2 Consistency 220
T1 and T2 consistency 220
T2 24
TCP 124
TCP, external 134
Teach pendant 17, 21
Teaching 338
Technology packages 17, 90, 307, 360
Terms used, safety 22
Time block 384
TIME_BLOCK 383
Timers, displaying 88
tm_useraction 180
tm_useraction, editing 185
TMx 184
Tool calibration 124
Tool Center Point 124
TOOL coordinate system 64, 124
Tool direction 124
Tool, external 146
Torque 181, 182
Torque mode, diagnosis 212
Torque mode, examples 207, 215
Torque mode, overview 205
Torque monitoring 186
Torque monitoring (menu item) 186
Touch screen 45, 50
Trademarks 16
Training 15
Transforming coordinates 339
Transportation 35
TRIGGER 421, 424
Trigger, for spline inline form 323
Turn 301
Turn-tilt table 21, 142
Type, robot 90
Type, robot controller 90

U
Unmastering 121
UNTIL 399
Update 472
US2 38, 96, 98
USB connection 47
USB sticks 18
Use, contrary to intended use 21
Use, improper 21
User 23, 24
User group, changing 62
User group, default 63
489 / 491Issued: 14.01.2015 Version: KSS 8.3 SI V4



490 / 491

KUKA System Software 8.3
User interface 49

V
Variable correction 82
Variable overview, configuring 168
VARSTATE() 83, 446
Velocity 71, 267
Velocity monitoring 31
Version, kernel system 90
Version, operating system 90
Version, robot controller 90
Version, user interface 90
Voltage 81, 347, 348

W
WAIT 348, 401, 402
WAIT FOR 401
Wait function, signal-dependent 348
WAIT SEC 402
Wait time 348, 402
WAITFOR 348
Warm-up 177
Warnings 15
WHILE ... ENDWHILE 402
Windows interface 54, 157, 158
WITH (permissible system variables 382
Working range limitation 32
Workpiece base calibration 144
Workpiece base, numeric entry 146
Workspace 22, 25
Workspace monitoring, bypassing 76
Workspaces, axis-specific 171
Workspaces, Cartesian 171
Workspaces, cubic 171
Workspaces, mode 176
WORLD coordinate system 64
Wrist root point 176

X
XML export 168
XML import 168
XYZ 4-point method 126
XYZ Reference method 128
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